User Manual
for Leapfrog Works version 2.0
# Contents

## Getting Started

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Launching Leapfrog Works</td>
<td>1</td>
</tr>
<tr>
<td>Recording Reference Codes</td>
<td>3</td>
</tr>
<tr>
<td>Starting a New Project</td>
<td>3</td>
</tr>
<tr>
<td>Managing Project Files</td>
<td>3</td>
</tr>
<tr>
<td>Saving Projects</td>
<td>4</td>
</tr>
<tr>
<td>Saving Zipped Copies of Projects</td>
<td>4</td>
</tr>
<tr>
<td>Saving Backup Copies of Projects</td>
<td>4</td>
</tr>
<tr>
<td>Compacting Projects</td>
<td>4</td>
</tr>
<tr>
<td>Upgrading Projects</td>
<td>5</td>
</tr>
<tr>
<td>Converting Leapfrog Geo and Leapfrog Geothermal Projects</td>
<td>5</td>
</tr>
<tr>
<td>The Graphics Test</td>
<td>5</td>
</tr>
<tr>
<td>Video Card Issues</td>
<td>7</td>
</tr>
<tr>
<td>Updating Your Video Card Driver</td>
<td>7</td>
</tr>
<tr>
<td>Checking Your 3D/OpenGL Settings</td>
<td>8</td>
</tr>
<tr>
<td>An Overview of Leapfrog Works</td>
<td>9</td>
</tr>
<tr>
<td>Organising Your Workspace</td>
<td>10</td>
</tr>
<tr>
<td>Detaching and Minimising the Project Tree</td>
<td>11</td>
</tr>
<tr>
<td>Organising the Scene View Tab</td>
<td>12</td>
</tr>
<tr>
<td>Keyboard Shortcuts in the Main Window</td>
<td>13</td>
</tr>
<tr>
<td>The Project Tree</td>
<td>13</td>
</tr>
<tr>
<td>Project Tree Keyboard Shortcuts</td>
<td>16</td>
</tr>
<tr>
<td>Restricted Objects</td>
<td>16</td>
</tr>
<tr>
<td>Subfolders</td>
<td>17</td>
</tr>
<tr>
<td>Finding Objects</td>
<td>18</td>
</tr>
<tr>
<td>Deleting Objects</td>
<td>18</td>
</tr>
<tr>
<td>Renaming Objects</td>
<td>19</td>
</tr>
<tr>
<td>Copying Objects</td>
<td>19</td>
</tr>
<tr>
<td>Comments</td>
<td>20</td>
</tr>
<tr>
<td>Sharing Objects</td>
<td>20</td>
</tr>
<tr>
<td>Unsharing a Polyline</td>
<td>21</td>
</tr>
<tr>
<td>Processing Tasks</td>
<td>21</td>
</tr>
<tr>
<td>Prioritising Tasks</td>
<td>22</td>
</tr>
<tr>
<td>Correcting Errors</td>
<td>23</td>
</tr>
<tr>
<td>Object Properties</td>
<td>23</td>
</tr>
<tr>
<td>The General Tab</td>
<td>23</td>
</tr>
<tr>
<td>The Histogram Tab</td>
<td>24</td>
</tr>
<tr>
<td>The Statistics Tab</td>
<td>24</td>
</tr>
<tr>
<td>The 3D Scene</td>
<td>24</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Navigation</td>
<td>25</td>
</tr>
<tr>
<td>Locating an Object from the Scene</td>
<td>28</td>
</tr>
<tr>
<td>Clicking in the Scene</td>
<td>28</td>
</tr>
<tr>
<td>Clicking in the Shape List</td>
<td>29</td>
</tr>
<tr>
<td>Slicing Through the Data</td>
<td>29</td>
</tr>
<tr>
<td>Measuring in the Scene</td>
<td>31</td>
</tr>
<tr>
<td>Determining a Location</td>
<td>32</td>
</tr>
<tr>
<td>The Moving Plane</td>
<td>33</td>
</tr>
<tr>
<td>The Ruler</td>
<td>34</td>
</tr>
<tr>
<td>Drawing in the Scene</td>
<td>36</td>
</tr>
<tr>
<td>The Drawing Toolbar</td>
<td>37</td>
</tr>
<tr>
<td>Drawing Hotkeys</td>
<td>38</td>
</tr>
<tr>
<td>Drawing 3D Lines</td>
<td>39</td>
</tr>
<tr>
<td>Drawing 2D Lines</td>
<td>41</td>
</tr>
<tr>
<td>Polyline Properties</td>
<td>41</td>
</tr>
<tr>
<td>Tangents and Ribbons</td>
<td>41</td>
</tr>
<tr>
<td>Drawing Points</td>
<td>42</td>
</tr>
<tr>
<td>Editing Normals</td>
<td>43</td>
</tr>
<tr>
<td>Settings</td>
<td>45</td>
</tr>
<tr>
<td>Display and Navigation Settings</td>
<td>45</td>
</tr>
<tr>
<td>3D Acceleration Mode</td>
<td>46</td>
</tr>
<tr>
<td>Font Size</td>
<td>46</td>
</tr>
<tr>
<td>Z Axis Scale</td>
<td>47</td>
</tr>
<tr>
<td>Rotation Settings</td>
<td>47</td>
</tr>
<tr>
<td>Camera Settings</td>
<td>48</td>
</tr>
<tr>
<td>Overlay Settings</td>
<td>48</td>
</tr>
<tr>
<td>Screen Grid Settings</td>
<td>48</td>
</tr>
<tr>
<td>Axis Lines Settings</td>
<td>48</td>
</tr>
<tr>
<td>Other Overlay Settings</td>
<td>48</td>
</tr>
<tr>
<td>Colour Scheme</td>
<td>49</td>
</tr>
<tr>
<td>Lighting Settings</td>
<td>49</td>
</tr>
<tr>
<td>Processing Settings</td>
<td>50</td>
</tr>
<tr>
<td>User Interface Settings</td>
<td>50</td>
</tr>
<tr>
<td>Show Tree Lines</td>
<td>50</td>
</tr>
<tr>
<td>Show Save Scene Button</td>
<td>50</td>
</tr>
<tr>
<td>Tab Position</td>
<td>51</td>
</tr>
<tr>
<td>Central Settings</td>
<td>51</td>
</tr>
<tr>
<td>View Settings</td>
<td>52</td>
</tr>
<tr>
<td>Help Settings</td>
<td>52</td>
</tr>
<tr>
<td>Central Integration</td>
<td>53</td>
</tr>
<tr>
<td>Enabling Central</td>
<td>53</td>
</tr>
</tbody>
</table>
### Displaying a Structural Trend ................................................................. 79
### Applying a Structural Trend ................................................................. 80
### Editing Surfaces with Polylines ............................................................. 81
### Editing Surfaces with Structural Data .................................................... 83
### Extending a Surface ................................................................................ 84
### Boundaries ............................................................................................. 87
### The Clipping Boundary ............................................................................ 87
### Defining a Topography ............................................................................ 90
    - Topography From Elevation Grid ......................................................... 90
    - Topography From Surfaces, Points or GIS Vector Data ....................... 91
### Fixed Elevation Topography .................................................................. 91
### Adding Height Data to the Topography .................................................. 92
### Changing Topography Settings .............................................................. 92
    - Changing the Size of the Topography ................................................. 93
    - Topography Resolution ..................................................................... 93
    - Applying a Trend to the Topography .................................................. 94
    - Topography Display Options ............................................................ 94
### Projecting Collars onto the Topography ................................................ 95
### Object Extents ....................................................................................... 95
### Interpolant Functions ............................................................................ 97
    - The Spheroidal Interpolant Function .................................................. 97
        - Total Sill ...................................................................................... 99
        - Nugget ....................................................................................... 99
        - Nugget to Total Sill Ratio .............................................................. 99
        - Base Range ................................................................................ 99
        - Alpha ......................................................................................... 101
        - Drift ......................................................................................... 102
        - Accuracy ................................................................................... 103
    - The Linear Interpolant Function ........................................................... 103
        - Total Sill and Base Range .............................................................. 105
        - Nugget ....................................................................................... 105
        - Drift ......................................................................................... 105
        - Accuracy ................................................................................... 106
### Data Types ............................................................................................ 107
    - The Table Dialog .............................................................................. 107
    - Correcting Data Errors ..................................................................... 108
    - Exporting Data Errors ..................................................................... 108
    - Correcting Errors in Leapfrog Works ................................................. 109
        - Checking for Missing Files .......................................................... 110
        - Ignoring Errors ......................................................................... 110
        - Ignoring Duplicates (Points Data Tables) ................................... 110
| Contents |

Modifying Data ................................................................. 110
Fixing Collar Max Depths (Borehole Data Tables) .................................. 110
Replacing All ................................................................. 111
Replacing a Selection ................................................................ 111
Special Values ........................................................................... 112
Query Filters ............................................................................. 113
Creating a New Query Filter ......................................................... 114
Leapfrog Works Query Syntax ....................................................... 115
Building a Query ....................................................................... 116
Advanced Queries ...................................................................... 117
GIS Data, Maps and Images ......................................................... 118
Importing Vector Data ............................................................... 118
Importing a MapInfo Batch File .................................................... 119
Importing Data from an ESRI Geodatabase ....................................... 120
Reloading GIS Data ................................................................... 121
  Reloading Points, Lines and Polygons ............................................ 121
  Reloading an ESRI Database ....................................................... 121
2D Grids .................................................................................. 122
Importing a Map or Image .......................................................... 122
  Manual Georeferencing ............................................................ 124
  Automatic Georeferencing ........................................................ 125
  Exporting a Georeferenced Image ............................................... 125
Setting Elevation for GIS Objects and Images ................................... 125
Creating a New GIS Line ................................................................ 126
  Drawing a New GIS Line .......................................................... 127
  Creating a New GIS Line from Intersecting Meshes ...................... 127
Exporting GIS Data .................................................................... 128
Borehole Data ............................................................................ 129
Importing Borehole Data ............................................................ 130
  Expected Borehole Data Tables and Columns ............................. 130
    The Collar Table .................................................................. 130
    The Survey Table .................................................................. 131
    The Screens Table ................................................................ 131
    Interval Tables .................................................................... 131
  Selecting Files ........................................................................ 133
Working Through the Data .......................................................... 133
AGS Format Borehole Data .......................................................... 136
  The Collar Table .................................................................. 137
  The Survey Table .................................................................. 137
  Interval Tables .................................................................... 137
  Selecting the ODBC Data Source .......................................... 137

© 2017 ARANZ Geo Limited t/a Seequent
Contents

Setting Up the ALS Interface ................................................................. 175
Using the ALS Interface ......................................................................... 177
Removing the ALS Link ........................................................................ 177
The Coreshed Core Photo Interface ...................................................... 177
Setting Up the Coreshed Interface ........................................................ 177
Using the Coreshed Interface ................................................................ 178
Removing the Coreshed Link .................................................................. 179
Deleting Borehole Data ......................................................................... 179
Reloading Borehole Data ....................................................................... 179
Exporting Borehole Data ....................................................................... 179
Exporting All Borehole Data ................................................................... 180
Exporting a Single Borehole Data Table ............................................... 181
Designs ................................................................................................... 182
Design Meshes ...................................................................................... 182
Design Lines .......................................................................................... 183
Points Data ............................................................................................ 184
Importing Points Data ........................................................................... 184
Selecting the ODBC Data Source .......................................................... 185
Reloading Points Data .......................................................................... 185
Appending Points Data ......................................................................... 185
Importing a Column .............................................................................. 185
Setting Elevation for Points ................................................................... 186
Evaluating Points Data .......................................................................... 186
Exporting Points Data ........................................................................... 187
Exporting Intrusion Values .................................................................... 187
Exporting Interval Midpoints ................................................................. 187
Extracting Points from Borehole Data .................................................... 187
Extracting Contact Points from Borehole Data ...................................... 188
Extracting Intrusion Values from Borehole Data .................................... 190
Intrusion Point Generation Parameters ............................................... 191
Extracting Interval Midpoints from Borehole Data ................................ 192
Categorising Points .............................................................................. 193
Structural Data ...................................................................................... 196
Creating New Planar Structural Data Tables ......................................... 196
Importing Planar Structural Data .......................................................... 198
Selecting the ODBC Data Source ........................................................ 199
Importing Lineations ............................................................................ 199
Assigning Structural Data to Categories .............................................. 200
Editing the Orientation of Planar Structural Data ................................. 201
Declustering Planar Structural Data ...................................................... 202
Setting Elevation for Structural Data .................................................... 203

© 2017 ARANZ Geo Limited t/a Seequent
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Estimating Planar Structural Data</td>
<td>204</td>
</tr>
<tr>
<td>Importing a Mesh</td>
<td>205</td>
</tr>
<tr>
<td>Cleaning Up a Mesh</td>
<td>205</td>
</tr>
<tr>
<td>Importing Meses from Central</td>
<td>206</td>
</tr>
<tr>
<td>Importing Central Meses</td>
<td>207</td>
</tr>
<tr>
<td>Updating Out-of-date Meshes</td>
<td>208</td>
</tr>
<tr>
<td>Importing an Elevation Grid</td>
<td>208</td>
</tr>
<tr>
<td>Creating a Mesh</td>
<td>210</td>
</tr>
<tr>
<td>Mesh from the Moving Plane</td>
<td>210</td>
</tr>
<tr>
<td>Combining Meses</td>
<td>211</td>
</tr>
<tr>
<td>Clipping a Volume</td>
<td>211</td>
</tr>
<tr>
<td>Clipping a Mesh</td>
<td>212</td>
</tr>
<tr>
<td>Extracting Mesh Parts</td>
<td>212</td>
</tr>
<tr>
<td>Interpolated Meses</td>
<td>213</td>
</tr>
<tr>
<td>Creating an Interpolated Mesh</td>
<td>213</td>
</tr>
<tr>
<td>Refining an Interpolated Mesh</td>
<td>214</td>
</tr>
<tr>
<td>Surface Resolution Settings</td>
<td>215</td>
</tr>
<tr>
<td>Snap Settings</td>
<td>215</td>
</tr>
<tr>
<td>Other Options</td>
<td>215</td>
</tr>
<tr>
<td>Triangulated Meses</td>
<td>216</td>
</tr>
<tr>
<td>Offset Meses</td>
<td>217</td>
</tr>
<tr>
<td>Editing an Offset Mesh</td>
<td>218</td>
</tr>
<tr>
<td>Draping an Image on a Mesh</td>
<td>219</td>
</tr>
<tr>
<td>Mesh Export</td>
<td>219</td>
</tr>
<tr>
<td>Exporting a Single Mesh</td>
<td>220</td>
</tr>
<tr>
<td>Exporting Multiple Meshes from the Meshes Folder</td>
<td>222</td>
</tr>
<tr>
<td>Exporting Multiple Mesches from Models</td>
<td>223</td>
</tr>
<tr>
<td>Elevation Grid Export</td>
<td>223</td>
</tr>
<tr>
<td>Thickness Grid Export</td>
<td>224</td>
</tr>
<tr>
<td>Polylines</td>
<td>225</td>
</tr>
<tr>
<td>Import Polyline</td>
<td>225</td>
</tr>
<tr>
<td>Reload Polyline</td>
<td>226</td>
</tr>
<tr>
<td>Export Polyline</td>
<td>226</td>
</tr>
<tr>
<td>Analysing Data</td>
<td>227</td>
</tr>
<tr>
<td>Visualising Data</td>
<td>228</td>
</tr>
<tr>
<td>The Shape List and Shape Properties Panel</td>
<td>228</td>
</tr>
<tr>
<td>Removing Objects from the Scene</td>
<td>229</td>
</tr>
<tr>
<td>The View List</td>
<td>229</td>
</tr>
<tr>
<td>Colour Options</td>
<td>230</td>
</tr>
<tr>
<td>Contents</td>
<td></td>
</tr>
<tr>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>Opacity ..........................................................................................................................</td>
<td>230</td>
</tr>
<tr>
<td>Property Buttons ............................................................................................................</td>
<td>231</td>
</tr>
<tr>
<td>Legends ..........................................................................................................................</td>
<td>231</td>
</tr>
<tr>
<td>The Shape Properties Panel ..........................................................................................</td>
<td>231</td>
</tr>
<tr>
<td>Slice Mode .......................................................................................................................</td>
<td>232</td>
</tr>
<tr>
<td>Filtering Data Using Queries .........................................................................................</td>
<td>232</td>
</tr>
<tr>
<td>Filtering Data Using Values and Categories ..................................................................</td>
<td>232</td>
</tr>
<tr>
<td>Selecting Multiple Objects ............................................................................................</td>
<td>233</td>
</tr>
<tr>
<td>Display Colours .............................................................................................................</td>
<td>233</td>
</tr>
<tr>
<td>Colourmaps and Colour Gradients ..................................................................................</td>
<td>234</td>
</tr>
<tr>
<td>Colourmap Import and Export ........................................................................................</td>
<td>234</td>
</tr>
<tr>
<td>Colourmap Import .........................................................................................................</td>
<td>235</td>
</tr>
<tr>
<td>Colourmap Export .........................................................................................................</td>
<td>235</td>
</tr>
<tr>
<td>Editing a Colourmap .......................................................................................................</td>
<td>235</td>
</tr>
<tr>
<td>Continuous Colourmaps .................................................................................................</td>
<td>236</td>
</tr>
<tr>
<td>Discrete Colourmaps .....................................................................................................</td>
<td>236</td>
</tr>
<tr>
<td>Displaying Dates ............................................................................................................</td>
<td>237</td>
</tr>
<tr>
<td>Colour Gradients ...........................................................................................................</td>
<td>238</td>
</tr>
<tr>
<td>Deleting Colour Gradients .............................................................................................</td>
<td>239</td>
</tr>
<tr>
<td>Displaying Boreholes ......................................................................................................</td>
<td>239</td>
</tr>
<tr>
<td>Displaying Boreholes as Lines or Cylinders .................................................................</td>
<td>241</td>
</tr>
<tr>
<td>Hiding Lithologies ..........................................................................................................</td>
<td>242</td>
</tr>
<tr>
<td>Displaying a Legend ......................................................................................................</td>
<td>242</td>
</tr>
<tr>
<td>Changing Colourmaps ....................................................................................................</td>
<td>243</td>
</tr>
<tr>
<td>Viewing Multiple Interval Tables ..................................................................................</td>
<td>243</td>
</tr>
<tr>
<td>Selecting from Multiple Columns ................................................................................</td>
<td>243</td>
</tr>
<tr>
<td>Displaying Interval Data in the Scene ..........................................................................</td>
<td>244</td>
</tr>
<tr>
<td>Displaying Points ..........................................................................................................</td>
<td>245</td>
</tr>
<tr>
<td>Displaying Surfaces .......................................................................................................</td>
<td>246</td>
</tr>
<tr>
<td>Displaying Structural Data ............................................................................................</td>
<td>246</td>
</tr>
<tr>
<td>Planar Structural Data .................................................................................................</td>
<td>247</td>
</tr>
<tr>
<td>Lineations .....................................................................................................................</td>
<td>248</td>
</tr>
<tr>
<td>Displaying Sliced Data .................................................................................................</td>
<td>250</td>
</tr>
<tr>
<td>Displaying GIS Data .......................................................................................................</td>
<td>250</td>
</tr>
<tr>
<td>Custom Topography Views ............................................................................................</td>
<td>251</td>
</tr>
<tr>
<td>Evaluations ....................................................................................................................</td>
<td>253</td>
</tr>
<tr>
<td>Statistics .......................................................................................................................</td>
<td>254</td>
</tr>
<tr>
<td>Statistics on Interval Tables and Points Tables ............................................................</td>
<td>254</td>
</tr>
<tr>
<td>Statistics on Composites ...............................................................................................</td>
<td>255</td>
</tr>
<tr>
<td>Correlation Statistics on Back-flagged Boreholes ..........................................................</td>
<td>255</td>
</tr>
<tr>
<td>Statistics Visualisations ...............................................................................................</td>
<td>256</td>
</tr>
</tbody>
</table>

© 2017 ARANZ Geo Limited t/a Seequent
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scatter Plots</td>
<td>256</td>
</tr>
<tr>
<td>Q-Q Plots</td>
<td>259</td>
</tr>
<tr>
<td>Box Plots</td>
<td>259</td>
</tr>
<tr>
<td>Interval Length Statistics</td>
<td>261</td>
</tr>
<tr>
<td>Univariate Graphs</td>
<td>262</td>
</tr>
<tr>
<td>Compositing Comparison</td>
<td>264</td>
</tr>
<tr>
<td>Compositing Interval Lengths</td>
<td>265</td>
</tr>
<tr>
<td>Borehole Correlation Tool</td>
<td>266</td>
</tr>
<tr>
<td>Selecting Collars</td>
<td>266</td>
</tr>
<tr>
<td>The Correlation Set Window</td>
<td>267</td>
</tr>
<tr>
<td>Navigating in the Correlation Set Window</td>
<td>269</td>
</tr>
<tr>
<td>Correlation Column Layouts</td>
<td>270</td>
</tr>
<tr>
<td>Managing Styles</td>
<td>271</td>
</tr>
<tr>
<td>Interpretation Tables</td>
<td>271</td>
</tr>
<tr>
<td>Assigning Lithologies</td>
<td>272</td>
</tr>
<tr>
<td>Modifying the Interpretation Table</td>
<td>272</td>
</tr>
<tr>
<td>Stereonets</td>
<td>275</td>
</tr>
<tr>
<td>Creating a Steronet</td>
<td>275</td>
</tr>
<tr>
<td>Displaying the Steronet in the 3D Scene</td>
<td>276</td>
</tr>
<tr>
<td>Plot Options</td>
<td>277</td>
</tr>
<tr>
<td>Data Display Options</td>
<td>277</td>
</tr>
<tr>
<td>Viewing Steronet Statistics</td>
<td>280</td>
</tr>
<tr>
<td>Selecting Data in the Steronet</td>
<td>280</td>
</tr>
<tr>
<td>Using the Scene Window with the Steronet</td>
<td>284</td>
</tr>
<tr>
<td>Exporting a Steronet</td>
<td>284</td>
</tr>
<tr>
<td>Form Interpolants</td>
<td>285</td>
</tr>
<tr>
<td>Creating a Form Interpolant</td>
<td>285</td>
</tr>
<tr>
<td>Setting a Trend</td>
<td>286</td>
</tr>
<tr>
<td>Adding Isosurfaces</td>
<td>286</td>
</tr>
<tr>
<td>The Form Interpolant in the Project Tree</td>
<td>287</td>
</tr>
<tr>
<td>Form Interpolant Statistics</td>
<td>287</td>
</tr>
<tr>
<td>Planning Boreholes</td>
<td>289</td>
</tr>
<tr>
<td>Adding Planned Boreholes</td>
<td>290</td>
</tr>
<tr>
<td>Planning Options</td>
<td>291</td>
</tr>
<tr>
<td>Drilling Prognoses</td>
<td>292</td>
</tr>
<tr>
<td>Exporting Planned Boreholes</td>
<td>292</td>
</tr>
<tr>
<td>Importing Planned Boreholes</td>
<td>293</td>
</tr>
<tr>
<td>Modelling</td>
<td>294</td>
</tr>
<tr>
<td>Geological Models</td>
<td>295</td>
</tr>
<tr>
<td>Creating a New Geological Model</td>
<td>295</td>
</tr>
<tr>
<td>The Base Lithology</td>
<td>295</td>
</tr>
</tbody>
</table>

© 2017 ARANZ Geo Limited t/a Seequent
<table>
<thead>
<tr>
<th>Contents</th>
<th>xi</th>
</tr>
</thead>
<tbody>
<tr>
<td>Surface Resolution ..........................................................</td>
<td>296</td>
</tr>
<tr>
<td>Model Extents ........................................................................</td>
<td>296</td>
</tr>
<tr>
<td>The Geological Model in the Project Tree ..................................</td>
<td>297</td>
</tr>
<tr>
<td>Geological Model Display ......................................................</td>
<td>297</td>
</tr>
<tr>
<td>Copying a Geological Model ....................................................</td>
<td>298</td>
</tr>
<tr>
<td>Creating a Static Copy of a Geological Model ...............................</td>
<td>298</td>
</tr>
<tr>
<td>Geological Model Volumes and Surfaces Export Options ................</td>
<td>298</td>
</tr>
<tr>
<td>Editing a Geological Model ......................................................</td>
<td>299</td>
</tr>
<tr>
<td>Changing the Query Filter ......................................................</td>
<td>299</td>
</tr>
<tr>
<td>Surface Generation Options ....................................................</td>
<td>299</td>
</tr>
<tr>
<td>Volume Generation Options .....................................................</td>
<td>300</td>
</tr>
<tr>
<td>Surface Resolution for a Geological Model ...................................</td>
<td>300</td>
</tr>
<tr>
<td>Modifying a Geological Model’s Boundary ....................................</td>
<td>301</td>
</tr>
<tr>
<td>Creating Extents for a Geological Model ....................................</td>
<td>302</td>
</tr>
<tr>
<td>Extent from a Polyline ...........................................................</td>
<td>303</td>
</tr>
<tr>
<td>Extent from GIS Vector Data ....................................................</td>
<td>304</td>
</tr>
<tr>
<td>Extent from Points .................................................................</td>
<td>305</td>
</tr>
<tr>
<td>Extent from Structural Data .....................................................</td>
<td>305</td>
</tr>
<tr>
<td>Extent from a Surface ..............................................................</td>
<td>306</td>
</tr>
<tr>
<td>Extent from Distance to Points ..................................................</td>
<td>307</td>
</tr>
<tr>
<td>Extent from a Distance Function ...............................................</td>
<td>308</td>
</tr>
<tr>
<td>Base from Lithology Contacts ..................................................</td>
<td>309</td>
</tr>
<tr>
<td>Changing an Extent’s Settings ...................................................</td>
<td>310</td>
</tr>
<tr>
<td>Surface Resolution ...............................................................</td>
<td>310</td>
</tr>
<tr>
<td>Contact Honouring .................................................................</td>
<td>310</td>
</tr>
<tr>
<td>Applying a Trend .......................................................................</td>
<td>311</td>
</tr>
<tr>
<td>Adding Data to an Extent .........................................................</td>
<td>311</td>
</tr>
<tr>
<td>Editing an Extent with a Polyline ..............................................</td>
<td>312</td>
</tr>
<tr>
<td>Editing an Extent with Structural Data .......................................</td>
<td>312</td>
</tr>
<tr>
<td>Removing an Extent from a Geological Model ................................</td>
<td>312</td>
</tr>
<tr>
<td>Model Lithologies .....................................................................</td>
<td>313</td>
</tr>
<tr>
<td>Faulted Models .......................................................................</td>
<td>314</td>
</tr>
<tr>
<td>The Fault System .................................................................</td>
<td>315</td>
</tr>
<tr>
<td>Fault Interactions .................................................................</td>
<td>317</td>
</tr>
<tr>
<td>Activating the Fault System .....................................................</td>
<td>318</td>
</tr>
<tr>
<td>Copying the Surface Chronology to an Empty Fault Block ...............</td>
<td>318</td>
</tr>
<tr>
<td>Faulted Model Display Options ................................................</td>
<td>319</td>
</tr>
<tr>
<td>Editing Faults .......................................................................</td>
<td>319</td>
</tr>
<tr>
<td>Surfacing Options for Faults .....................................................</td>
<td>320</td>
</tr>
<tr>
<td>Boundary Filtering ....................................................................</td>
<td>320</td>
</tr>
<tr>
<td>Snapping to Data ......................................................................</td>
<td>320</td>
</tr>
</tbody>
</table>

© 2017 ARANZ Geo Limited t/a Seequent
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changing Fault Inputs</td>
<td>321</td>
</tr>
<tr>
<td>Replacing Fault Inputs with a Single Mesh</td>
<td>321</td>
</tr>
<tr>
<td>Adding Data to the Fault</td>
<td>322</td>
</tr>
<tr>
<td>Snap Settings for Individual Inputs</td>
<td>322</td>
</tr>
<tr>
<td>Boundary Filtering Settings for Individual Inputs</td>
<td>322</td>
</tr>
<tr>
<td>Applying a Trend to a Fault</td>
<td>322</td>
</tr>
<tr>
<td>Contact Surfaces</td>
<td>323</td>
</tr>
<tr>
<td>Contact Surfaces in the Surface Chronology</td>
<td>323</td>
</tr>
<tr>
<td>Contact Surfaces Types</td>
<td>326</td>
</tr>
<tr>
<td>Deposit and Erosion Contact Surfaces</td>
<td>327</td>
</tr>
<tr>
<td>Intrusion Contact Surfaces</td>
<td>328</td>
</tr>
<tr>
<td>Vein Contact Surfaces</td>
<td>330</td>
</tr>
<tr>
<td>Younging Direction</td>
<td>331</td>
</tr>
<tr>
<td>Deposits and Erosions</td>
<td>332</td>
</tr>
<tr>
<td>Creating Deposits and Erosions</td>
<td>332</td>
</tr>
<tr>
<td>Deposits and Erosions From the Base Lithology</td>
<td>332</td>
</tr>
<tr>
<td>Deposits and Erosions From Other Lithology Contacts</td>
<td>337</td>
</tr>
<tr>
<td>Deposits and Erosions From Other Data</td>
<td>337</td>
</tr>
<tr>
<td>Deposits/Erosions in the Project Tree</td>
<td>339</td>
</tr>
<tr>
<td>Refining Deposits and Erosions</td>
<td>339</td>
</tr>
<tr>
<td>Surfacing Options for Deposits and Erosions</td>
<td>340</td>
</tr>
<tr>
<td>Boundary Filtering</td>
<td>340</td>
</tr>
<tr>
<td>Snapping to Data</td>
<td>340</td>
</tr>
<tr>
<td>Setting the Surface Resolution</td>
<td>341</td>
</tr>
<tr>
<td>Applying a Trend to a Deposit/Erosion</td>
<td>341</td>
</tr>
<tr>
<td>Intrusions</td>
<td>341</td>
</tr>
<tr>
<td>Creating Intrusions</td>
<td>342</td>
</tr>
<tr>
<td>Intrusions from Lithology Contacts</td>
<td>342</td>
</tr>
<tr>
<td>Intrusions from Other Data</td>
<td>344</td>
</tr>
<tr>
<td>Intrusions in the Project Tree</td>
<td>345</td>
</tr>
<tr>
<td>Displaying Intrusion Points</td>
<td>346</td>
</tr>
<tr>
<td>Refining Intrusion Points</td>
<td>346</td>
</tr>
<tr>
<td>Surfacing Options for Intrusions</td>
<td>346</td>
</tr>
<tr>
<td>Boundary Filtering</td>
<td>347</td>
</tr>
<tr>
<td>Snapping to Data</td>
<td>347</td>
</tr>
<tr>
<td>Surface Resolution</td>
<td>348</td>
</tr>
<tr>
<td>Applying a Trend to an Intrusion</td>
<td>348</td>
</tr>
<tr>
<td>Clipping Values for Intrusions</td>
<td>349</td>
</tr>
<tr>
<td>Interpolation Settings</td>
<td>350</td>
</tr>
<tr>
<td>Veins</td>
<td>350</td>
</tr>
<tr>
<td>Creating Veins</td>
<td>351</td>
</tr>
</tbody>
</table>
Contents

Veins From Lithology Contacts ............................................................... 351
Veins From Other Data ................................................................. 352
Veins in the Project Tree ..................................................................... 352
Displaying Veins ............................................................................... 354
Refining Veins .................................................................................. 354
Surfacing Options for Veins .............................................................. 354
  Boundary Filtering .......................................................................... 354
  Snapping to Data ........................................................................... 355
  Surface Resolution ......................................................................... 355
  Vein Thickness ................................................................................ 355
  Vein Pinch Out ............................................................................... 356
The Vein Reference Surface ............................................................... 357
  Adding Data to the Reference Surface ........................................... 358
  Using a Planar Reference Surface .................................................. 359
The Vein Boundary ........................................................................... 359
  Adding a Polyline to the Vein Boundary ....................................... 360
  Adjusting the Vein Boundary Plane .............................................. 360
Editing Vein Segments ..................................................................... 361
  Vein Segment Orientation ............................................................ 361
Vein Systems .................................................................................... 361
  Creating a Vein System ................................................................ 363
Adding Veins to the Vein System ....................................................... 363
Editing the Veins ............................................................................ 363
Vein System Lithology Settings ........................................................ 363
Vein Interactions .............................................................................. 364
Stratigraphic Sequences .................................................................. 365
  Creating a Stratigraphic Sequence ................................................ 366
    Boundary Filtering ..................................................................... 368
    Snapping to Data ....................................................................... 368
    Surface Stiffness ....................................................................... 369
Editing the Stratigraphic Sequence .................................................. 369
  Correcting Pinch-out Errors ......................................................... 369
Surfacing Options .......................................................................... 370
  Applying a Trend ........................................................................... 370
Editing Individual Surfaces .............................................................. 370
  Contact Honouring and Boundary Filtering for Individual Surfaces 370
  Adding Data to Individual Surfaces .............................................. 371
  Editing Surface Contacts ............................................................. 371
Offset Surfaces ................................................................................... 372
  Creating an Offset Surface ........................................................... 373
The Offset Surface in the Project Tree .............................................. 374

© 2017 ARANZ Geo Limited t/a Seequent
Refining an Offset Surface ................................................................. 374
Changing Surfacing Options for an Offset Surface ........................... 374
  Boundary Filtering .................................................................. 375
  Snapping to Data ................................................................. 375
  Surface Resolution ................................................................ 376
  Smoothing ............................................................................. 376
Changing Offset Limits ................................................................... 376
Changing to a Constant Offset ....................................................... 376
Changing to an Offset to Points ..................................................... 377
Changing the Reference Mesh ......................................................... 377
Editing the Reference Mesh ............................................................ 377
Structural Surfaces ....................................................................... 377
  Creating a Structural Surface .................................................. 378
  The Structural Surface in the Project Tree .................................. 379
  Refining a Structural Surface .................................................. 379
Surfacing Options for a Structural Surface ...................................... 380
  Setting the Surface Resolution ................................................ 380
  Boundary Filtering .................................................................. 380
  Snapping to Input Data ............................................................. 380
Non-contact Structural Inputs Settings .......................................... 381
Applying a Trend to a Structural Surface ....................................... 381
Value Clipping ........................................................................... 381
The Surface Chronology ................................................................. 382
Refined Lithological Volumes .......................................................... 383
Editing the Sub-Model .................................................................. 385
Numeric Models ........................................................................... 387
  Importing a Variogram Model .................................................. 387
  Copying a Numeric Model .......................................................... 388
  Creating a Static Copy of a Numeric Model ................................. 388
  Exporting Numeric Model Volumes and Surfaces ......................... 388
  Exporting Numeric Model Midpoints ......................................... 389
  RBF Interpolants .................................................................... 389
  Creating an RBF Interpolant ..................................................... 390
   Values Used ........................................................................... 390
   Applying a Query Filter ......................................................... 391
   Applying a Surface Filter ........................................................ 391
  The Interpolant Boundary ......................................................... 391
  Compositing Options ................................................................ 391
  General Interpolant Properties ................................................... 392
  The RBF Interpolant in the Project Tree ........................................ 392
Interpolant Display ....................................................................... 393
<table>
<thead>
<tr>
<th>Contents</th>
<th>xv</th>
</tr>
</thead>
<tbody>
<tr>
<td>RBF Interpolant Statistics</td>
<td>393</td>
</tr>
<tr>
<td>Modifying an RBF Interpolant’s Boundary with Lateral Extents</td>
<td>393</td>
</tr>
<tr>
<td>Creating Lateral Extents</td>
<td>393</td>
</tr>
<tr>
<td>Extent from a Polyline</td>
<td>394</td>
</tr>
<tr>
<td>Extent from GIS Vector Data</td>
<td>395</td>
</tr>
<tr>
<td>Extent from Points</td>
<td>396</td>
</tr>
<tr>
<td>Extent from Structural Data</td>
<td>396</td>
</tr>
<tr>
<td>Extent from a Surface</td>
<td>397</td>
</tr>
<tr>
<td>Extent from Distance to Points</td>
<td>398</td>
</tr>
<tr>
<td>Extent from a Distance Function</td>
<td>398</td>
</tr>
<tr>
<td>Changing a Lateral Extent’s Settings</td>
<td>399</td>
</tr>
<tr>
<td>Surface Resolution</td>
<td>399</td>
</tr>
<tr>
<td>Contact Honouring</td>
<td>400</td>
</tr>
<tr>
<td>Applying a Trend</td>
<td>400</td>
</tr>
<tr>
<td>Adding Data to an Extent</td>
<td>401</td>
</tr>
<tr>
<td>Editing an Extent with a Polyline</td>
<td>401</td>
</tr>
<tr>
<td>Editing an Extent with Structural Data</td>
<td>401</td>
</tr>
<tr>
<td>Removing an Extent from an Interpolant</td>
<td>402</td>
</tr>
<tr>
<td>Changing the Settings for an RBF Interpolant</td>
<td>402</td>
</tr>
<tr>
<td>Adjusting the Values Used</td>
<td>402</td>
</tr>
<tr>
<td>Adding a Contour Polyline</td>
<td>403</td>
</tr>
<tr>
<td>Adding Points</td>
<td>404</td>
</tr>
<tr>
<td>Compositing Parameters for an RBF Interpolant</td>
<td>405</td>
</tr>
<tr>
<td>Adjusting the Interpolant Boundary</td>
<td>406</td>
</tr>
<tr>
<td>Clipping and Transforming Values for an RBF Interpolant</td>
<td>407</td>
</tr>
<tr>
<td>Changing the Trend for an RBF Interpolant</td>
<td>408</td>
</tr>
<tr>
<td>Using a Global Trend</td>
<td>408</td>
</tr>
<tr>
<td>Using a Structural Trend</td>
<td>409</td>
</tr>
<tr>
<td>Adjusting Interpolation Parameters</td>
<td>410</td>
</tr>
<tr>
<td>Output Settings for an RBF Interpolant</td>
<td>411</td>
</tr>
<tr>
<td>Multi-domained RBF Interpolants</td>
<td>411</td>
</tr>
<tr>
<td>Creating a Multi-domained RBF Interpolant</td>
<td>412</td>
</tr>
<tr>
<td>Compositing and Filtering the Values Used</td>
<td>413</td>
</tr>
<tr>
<td>Selecting Domains</td>
<td>414</td>
</tr>
<tr>
<td>Clipping and Transforming Values</td>
<td>414</td>
</tr>
<tr>
<td>Setting the Trend</td>
<td>414</td>
</tr>
<tr>
<td>Interpolation Parameters</td>
<td>414</td>
</tr>
<tr>
<td>Output Options</td>
<td>414</td>
</tr>
<tr>
<td>The Multi-domained RBF Interpolant in the Project Tree</td>
<td>416</td>
</tr>
<tr>
<td>Interpolant and Sub-interpolant Display</td>
<td>416</td>
</tr>
<tr>
<td>Sub-interpolant Statistics</td>
<td>417</td>
</tr>
</tbody>
</table>
# Creating a 2D FEFLOW Model

- Boundary Options ................................................. 447
- Element Size ......................................................... 449
- Adding Features to the Grid .................................... 449

# Creating a 3D FEFLOW Model ..................................... 451

# FEFLOW Evaluations .............................................. 454
- Assigning an Evaluation for Export .......................... 454
- Combined Evaluations ........................................... 455

# FEFLOW Material Types .......................................... 455

# FEFLOW Model Export ............................................ 457

## Presentation .......................................................... 458
- Sections ................................................................... 459
  - Evaluating Sections ............................................. 459
  - Exporting Sections ............................................... 459
    - Export in DXF Format .......................................... 459
    - Export Section Layouts ....................................... 460
  - Creating Cross Sections ....................................... 460
  - Importing Cross Sections ...................................... 461
  - Fence Sections .................................................... 463
  - Serial Sections .................................................. 463
    - Setting the Base Section ..................................... 464
    - Setting the Offset Sections .................................. 465
    - The Serial Section in the Project Tree .................. 466
    - Displaying a Serial Section ................................ 466
    - Exporting a Serial Section .................................. 466
  - Alignment Serial Sections ...................................... 467
    - Creating an Alignment Serial Section .................... 467
      - Using an Existing Line ..................................... 468
      - Using a New Polyline ....................................... 468
    - The Alignment Serial Section in the Project Tree .... 469
    - Displaying an Alignment Serial Section ................ 469
    - Exporting an Alignment Serial Section .................. 469
  - Section Layouts .................................................. 470
    - Creating New Section Layouts ............................... 472
      - Scale ............................................................ 472
      - Page Properties .............................................. 473
      - Evaluations .................................................. 473
      - Extents .......................................................... 473
    - Creating Master Section Layouts .......................... 473
    - The Section Layout Editor .................................... 474
    - Object Names and Colours ................................... 476

© 2017 ARANZ Geo Limited t/a Seequent
Getting Started

This topic describes how to get started with Leapfrog Works. It is divided into:

- Launching Leapfrog Works
  - Recording Reference Codes
- Starting a New Project
- Managing Project Files
- Saving Projects
- Compacting Projects
- Upgrading Projects
- Converting Leapfrog Geo and Leapfrog Geothermal Projects
- The Graphics Test

Launching Leapfrog Works

To use Leapfrog Works, you need a licence, which is managed via your My Leapfrog ID. Launch Leapfrog Works, enter your details and click the button to sign in. If you do not have a My Leapfrog ID, you can sign up for one by clicking the Register button.

To get an entitlement for Leapfrog Works, contact Customer Support as described in Getting Support.

With the Hydrogeology Solutions Kit, you can work with ModFlow and FEFLOW models, as described in Flow Models. Contact Customer Support for more information about licensing the Hydrogeology Solutions Kit.

If you are licensed for the Hydrogeology Solutions Kit, you will be prompted to select whether or not you will be using it once you have signed in. Once you have signed in, you can change whether or not you are using the Hydrogeology Solutions Kit by signing out and then signing in again. Select Switch User from the Leapfrog Works menu.
After you have signed in to My Leapfrog, the Leapfrog Works main window will appear with the **Projects** tab displayed:

Thumbnails for the most recent projects are displayed in the **Recent projects** list. The second set of thumbnails is for projects contained in the **Search** folder:

- Click on the folder button (.shader) or press the F5 key to change the **Search** folder. The **Search** folder is useful if you have one folder in which you keep most of your Leapfrog Works projects.
- Click on the **Refresh** button (.shader) or press the F4 key to update the list of projects in the **Search** folder.

Projects from other Leapfrog modelling products are indicated in the **Projects** tab. Leapfrog Geo and Leapfrog Geothermal projects can be converted to Leapfrog Works projects. See [Converting Leapfrog Geo and Leapfrog Geothermal Projects](#) for more information. Leapfrog Hydro projects can be opened without converting them, and you will still be able to open them in Leapfrog Hydro.

Click on a thumbnail to open a project. You can also navigate directly to the required project file by clicking on **Open Project File**.
Once a project file has been opened, Leapfrog Works switches to displaying the **Scene View** tab.

### Recording Reference Codes

You can enter a reference code to track work on specific projects. The number of days associated with each reference code is included in your monthly usage report.

To enter a code, click the button in the status bar on the bottom edge of the Leapfrog Works main window:

![Reference Code Entry](image)

Enter the required **Reference code** and then click **OK**. The code entered will be displayed in the status bar:

![Reference Code Display](image)

To work without a code, click on the button, delete the current code and then click **OK**.

### Starting a New Project

To start a new project, click **New Project** at the top of the **Projects** tab. The new project will be saved in the **Search** folder.

### Managing Project Files

Leapfrog Works project files use the extension **.aproj**. A folder is also created that contains information used by the project.

Do not change the name of your project folder or alter its contents. Doing so could render your project file unusable.
A `.lock` file is created when a project is opened. The `.lock` file protects the project from being moved while the project is open and from being opened by another instance of Leapfrog Works, which can happen when projects are saved on shared network drives.

If processing and display of objects in your project is too slow and your project is stored on a network drive or on a USB drive, consider moving your project onto a local drive. Leapfrog Works is optimised for working off your local hard drive, and working from network drives and USB drives risks corrupting the project.

**Saving Projects**

Leapfrog Works automatically saves an open project each time a processing task has been completed or settings have changed. Projects are also saved when they are closed so that scene settings can be restored when the project is next opened.

**Saving Zipped Copies of Projects**

You can save a zipped copy of a project by selecting Save A Zipped Copy from the Leapfrog Works menu. You will be prompted to choose a name and location for the zipped project. Click Save to create the zip file.

**Saving Backup Copies of Projects**

You can save a backup copy of a project by selecting Save A Copy from the Leapfrog Works menu. You will be prompted to choose a new name and location for the saved project. Click OK to create the new project file. Leapfrog Works will save a copy of the project in the location selected.

Once the backup copy is saved, you can open and use it from the Projects tab. Otherwise, you can keep working in the original copy of the project.

**Compacting Projects**

When you delete objects from a project file, Leapfrog Works retains those objects but notes that they are no longer used. Over time, the project file will grow in size and data stored in the database may become fragmented.

Compacting a project removes these unused objects and any unused space from the database. When you compact a project, Leapfrog Works will close the project and back it up before compacting it. Depending on the size of the project, compacting it may take several minutes. Leapfrog Works will then reopen the project.

To compact a project, select Compact This Project from the Leapfrog Works menu. You will be asked to confirm your choice.
Upgrading Projects

When you open a project that was last saved in an earlier version of Leapfrog Works, you may be prompted to upgrade the project. A list of affected objects will be displayed. For large projects with many objects that need to be reprocessed, the upgrade process may take some time.

It is a good idea to back up the project before opening it. Tick the Back up the project before upgrading button, then click Upgrade and Open. Navigate to the folder in which to save the backup and click Save.

For large projects with many objects, upgrading without backing up the project is not recommended.

Converting Leapfrog Geo and Leapfrog Geothermal Projects

Leapfrog Geo and Leapfrog Geothermal projects can be converted to Leapfrog Works projects. However, the process is one-way, and projects opened in Leapfrog Works can no longer be opened in Leapfrog Geo/Leapfrog Geothermal.

When you open a Leapfrog Geo/Leapfrog Geothermal project, you will be prompted to save a backup before converting the project.

It is strongly recommended that you back up the project before converting it.

The Graphics Test

Leapfrog Works can run in one of three acceleration modes. These modes are selected by clicking on the button at the bottom of the main window:

See 3D Acceleration Mode in Settings for more information on these settings.

When you first run Leapfrog Works, run the graphics test to test the capability of your computer’s video card.
To start the test, open Leapfrog Works and select Test Graphics from the Leapfrog Works menu:

The graphics test displays a series of image pairs that test the capabilities of your video card for the currently selected acceleration mode. For each pair, compare the images:

Even if the differences are slight, click the Images Differ button. If the images match, click the Images Match button. The next test will be displayed.

At the conclusion of the test, the result is displayed. If one or more tests have failed, information about solving problems will be displayed.

If you click on Save Report, you will be prompted to save the file on your computer.

If the test has failed, try switching to a different acceleration mode and running the test again. If possible, avoid using Software Rendering as it can be very slow.

If you cannot resolve the problem following the steps described in Video Card Issues, save a copy of the graphics test report and contact technical support as described in Getting Support. Be sure to include information about your system copied from the About > System Info tab.
Video Card Issues

If the graphics test fails, there are two steps you can take to correct the problem:

- Ensure your video driver is up-to-date. See Updating Your Video Card Driver.
- Check your video card’s 3D/OpenGL settings. See Checking Your 3D/OpenGL Settings.

Updating Your Video Card Driver

The best way to update your video driver is to do this using any tools that your computer’s manufacturer provides. For example, some manufacturers allow you to update drivers using a tool installed in the Start screen (Windows 8 or later) or Start menu (Windows 7). Look for items that carry the manufacturer’s name. Another option is to right-click on the desktop to see if there is an update tool available. In the example below, the manufacturer has included an option for updating video drivers called “NVIDIA Control Panel”:

If your computer appears to have no manufacturer-installed tools for updating drivers, you can go to the manufacturer’s website and see if updates are available there. Look for parts of the website relating to support and driver downloads or driver updates.

If your computer’s manufacturer does not provide information to help you update your video driver, you can run the Hardware Update Wizard to see if a newer driver is available. To do this:

1. Open the Control Panel.
2. Open the System option.
4. Click on the Device Manager option.
5. Click to open the Display adapters option.
6. Right-click on the display adapter and choose the **Update Driver Software** option:

![Device Manager](image)

Next, follow the steps to complete the wizard. If the wizard cannot update your software because your computer already has the latest software, it may be that your video driver is already up-to-date and that the reason the graphics test fails may lie in the card’s 3D/OpenGL settings. See **Checking Your 3D/OpenGL Settings**.

If your video card’s driver has been updated, run the graphics test again to see if the computer passes the tests. If the test still fails, contact technical support as described in **Getting Support**. Be sure to include information about your system copied from the **About > System Info** tab.

**Checking Your 3D/OpenGL Settings**

The step or steps at which your computer fails the graphics test may indicate what 3D/OpenGL settings need to be changed. Save the graphics test report, as described in **The Graphics Test** and contact technical support as described in **Getting Support**.
An Overview of Leapfrog Works

This topic provides an overview of the different parts of the Leapfrog Works main window. It is divided into:

- Organising Your Workspace
- Detaching and Minimising the Project Tree
- Organising the Scene View Tab
- Keyboard Shortcuts in the Main Window

The Leapfrog Works main window is divided into three main parts:

1. The **Project Tree** contains all the data in the project and tools for working with that data. When you want to change how this data is used in the project, work with the objects in the project tree. See [The Project Tree](#).

2. The **Scene View** tab displays a 3D representation of selected objects from the project tree. Changing how you view objects in the scene window does not change those objects in the project tree. See [The 3D Scene](#).

3. Tools for changing the appearance of data in the scene window are available in the shape list and the shape properties panel. Changing the appearance of these objects does not change those objects in the project tree. See [Visualising Data](#).

You can add objects to the scene window by dragging them from the project tree. You can temporarily hide them in the scene or remove them altogether using the controls in the shape list.
When you open a Leapfrog Works project, the project is displayed in the state it was in when it was closed.

**Organising Your Workspace**

You can split the Leapfrog Works main window into separate parts to make better use of your screen space. In addition, some Leapfrog Works windows open in separate tabs that can be used either docked or detached.

To detach a tab, either:

- Click on it and drag it away from the main window.
- Right-click on it and select **Move to New Window**.

You can then move and resize the detached tab.

To dock a detached tab, click on it and drag it to where you want to dock it:

![Detached and docked tabs](image)

When the plus sign appears, release the mouse and the tab will dock.

Tabs can be docked to the main window or to other tabs. Drag tabs to reorder them.

You can view a list of all open tabs by clicking the down arrow to the right of the processing queue button:

![List of open tabs](image)

When you close a project, the position of open tabs will be saved and restored when the project is next opened.
For Leapfrog Works windows that open in separate tabs, the position in which tabs open is determined by the **New tab position** setting in the **Settings** window:

- Open all tabs in the main window.
- Open all tabs in separate windows.
- Tabs can open where the last tab was moved to. This setting can be used for creating a window in which all tables and dockable windows open, with the scene window, project tree and shape list in another window.

To change this setting, click on the **Leapfrog Works** menu, select **Settings** and then click on the **User Interface** tab.

**Detaching and Minimising the Project Tree**

The project tree can also be detached from the main window. To do this, right-click at the top of the project tree and select **Detach**:

![Detaching the Project Tree](image1)

To reattach the project tree, click the red X to close the tab. It will reappear docked to the main window.

You can also minimise the project tree. To do this, right-click on it and choose **Minimise** or press the F8 key. Restore the project tree by clicking the button:

![Minimising the Project Tree](image2)

Pressing the F8 key once again also restores the project tree.
Organising the Scene View Tab

The Scene View tab is made up of the scene window, the shape list and the shape properties panel. The shape list and shape properties panel can be displayed on the right-hand side of the scene rather than below the scene. To do this, right-click in the shape list and select Move List to Right:

You can also detach the shape list and display it as a tab, which can then be detached from the main window. To do this, right-click in the shape list and select Put List in Separate Tab:

You can then detach the tab from the main window:

To dock the shape list to the Scene View tab, right-click in the Shape List tab and choose where you wish to dock the list:
Keyboard Shortcuts in the Main Window

Use the Tab and Shift+Tab keys to move between the different parts of the main window in the following order:

- Project tree
- Scene toolbar
- Scene window
- Shape list
- Shape properties panel

<table>
<thead>
<tr>
<th>Key(s)</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>F8</td>
<td>Maximise scene, minimise project tree and shape list. Press F8 again to restore.</td>
</tr>
<tr>
<td>Ctrl+1</td>
<td>Activate the Select tool (-select)</td>
</tr>
<tr>
<td>Ctrl+2</td>
<td>Activate the Draw slicer line tool (sliceline)</td>
</tr>
<tr>
<td>Ctrl+3</td>
<td>Activate the Draw plane line tool (planeline)</td>
</tr>
<tr>
<td>Ctrl+4</td>
<td>Activate the Ruler tool (ruler)</td>
</tr>
<tr>
<td>F10 or Alt L</td>
<td>Open the Leapfrog Works menu</td>
</tr>
<tr>
<td>F1</td>
<td>Open Leapfrog Works help</td>
</tr>
<tr>
<td>Ctrl+Q</td>
<td>Quit Leapfrog Works</td>
</tr>
</tbody>
</table>

The Project Tree

This topic provides an introduction to working with the project tree. It is divided into:

- Project Tree Keyboard Shortcuts
- Restricted Objects
- Subfolders
- Finding Objects
- Deleting Objects
- Renaming Objects
- Copying Objects
- Comments
- Sharing Objects
- Unsharing a Polyline

The series of folders in the project tree are used to organise objects such as maps, images and datasets into categories. These folders also provide tools that let you import information into the project and generate models. Right-click on each folder to view the actions you can perform using that folder.
You can also right-click on objects within the top-level folders to view more information on that object or carry out actions specific to that object. For example, right-clicking on a table of imported borehole data reveals a menu showing possible actions:

When a bold option appears in the right-click menu, as Open does in the menu above, that option can also be selected by double-clicking on the object.

You can select more than one object in the project tree by holding down the Shift key or the Ctrl key while clicking. This is useful for viewing or deleting multiple objects at once.

The way folders and objects are organised in the project tree lets you reveal or hide information about an object to focus on objects you are currently working with. This is also useful when you are exploring a project and want to determine how something was put together. The arrows next to objects in the project tree let you reveal or hide an object’s details to focus on objects you are currently working with. Here, the Topographies folder is expanded to show a Topography object that is made up of a mesh:
Also note that:

- The mesh itself is stored in the **Meshes** folder, but is hyperlinked to from wherever it is used in the project.
- The **Borehole Data** folder and the **Boreholes** object have been expanded to show the borehole data tables. Tables shown in bold are those displayed in the scene.
- Folders that have no arrow have no detail stored.

Expanding a geological model reveals information about how it was built. Here, a geological model has been expanded to show the basic objects that make up a model:

The five objects underneath the geological model “GM” represent the five basic parts of a geological model:

- The **Boundary** object defines the outer limits of the geological model.
- The **Fault System** object defines faults and their interactions in the geological model.
- The **Lithologies** object defines the lithologies in the model.
- The **Surface Chronology** object defines the structure of the model’s contact surfaces.
- The **Output Volumes** folder contains the generated units (outputs) that make up the geological model.
Here, boundary objects for a geological model have been expanded to show how they were created:

The Topography object is included as the model’s upper boundary. The “East boundary” object was created using a polyline from the Polylines folder and the “West boundary” object was created using a GIS data object in the GIS Data, Maps and Photos folder. Clicking on the hyperlinks will locate the object from which the extent was created.

**Project Tree Keyboard Shortcuts**

Keyboard shortcuts for navigating in the project tree are as follows:

<table>
<thead>
<tr>
<th>Key(s)</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up and down arrows</td>
<td>Navigate up and down the tree</td>
</tr>
<tr>
<td>Right arrow</td>
<td>Expand folder/object or go down one level</td>
</tr>
<tr>
<td>Left arrow</td>
<td>Close folder/object or go up one level</td>
</tr>
<tr>
<td>Ctrl+shift+left arrow</td>
<td>Close all folders/objects</td>
</tr>
<tr>
<td>Shift+right arrow</td>
<td>Expand the selected folder/object and any objects in it</td>
</tr>
<tr>
<td>Shift+left arrow</td>
<td>Close the selected folder/object and any objects in it</td>
</tr>
<tr>
<td>Ctrl+A and Ctrl+/</td>
<td>Selects all folders and objects</td>
</tr>
<tr>
<td>Ctrl+F</td>
<td>Search for objects</td>
</tr>
<tr>
<td>Enter</td>
<td>The equivalent of double-clicking on an object</td>
</tr>
<tr>
<td>Ctrl-X</td>
<td>Cut an object or subfolder. Use with Ctrl-V to move objects and subfolders.</td>
</tr>
<tr>
<td>Ctrl-V</td>
<td>Paste an object or subfolder</td>
</tr>
</tbody>
</table>

Some actions are not available until data has been imported into the project.

**Restricted Objects**

Some objects may appear in the project tree as restricted:
Restricted objects were created using features only available in the Hydrogeology Solutions Kit. You can display restricted objects in the scene and change how they are displayed, but you cannot make changes to the objects themselves. Contact Customer Support as described in Getting Support for more information about licensing the Hydrogeology Solutions Kit.

Subfolders

In many project tree folders, you can create subfolders that help in organising large numbers of data objects. For example, here colour gradients have been organised into subfolders:

To add a subfolder, right-click on a folder in the project tree and select New Subfolder. Add objects to subfolders by dragging and dropping them. You can also use Cut (Ctrl-X) and Paste (Ctrl-V) shortcuts to move objects and subfolders.

Subfolders can be renamed, moved and deleted, but cannot be moved to other top-level folders.

Subfolders have the same right-click commands as their parent folder, which means you can import or create new data objects inside the subfolder rather than in the parent folder. You can also add comments to folders to aid in keeping data organised:

You can view all objects in the subfolder by dragging the folder into the scene or by right-clicking on the subfolder and selecting View All.
When lists of objects are displayed, the subfolder organisation will be reflected in the list. For example, when creating an interpolant, the list of data objects that can be interpolated is displayed organised by subfolder:

Subfolders cannot be created in the Borehole Data folder, although they can be created in the Composites and Planned Boreholes folders.

**Finding Objects**

To find objects in the project tree, click the search button at the top of the project tree:

You can also click anywhere in the project tree and type “Ctrl-F”.

The Find window will be displayed:

Enter the information you are searching for, then click Backwards or Forwards to locate the object in the project tree.

**Deleting Objects**

When you delete an object from the project tree, a window will be displayed listing all other objects in the project that will also be deleted and those that will be reprocessed. Some objects
will be put into an error state; you will need to correct those errors before the affected object can be used elsewhere in the project.

Consider carefully the effects on other objects in the project, as once an object is deleted, it cannot be recovered.

Deleting data from the project may cause other objects to be reprocessed, which can take some time.

To delete more than one object from the tree, hold down the Shift key or the Ctrl key while selecting objects.

Renaming Objects

When an object is created in Leapfrog Works, it is given a default name. It is a good idea to give objects in Leapfrog Works names that will help you distinguish them from other objects, as large projects with complicated models will contain many objects.

To rename an object in the project tree, right-click on the object and select Rename. The Rename Object window will be displayed:

![Rename Object window]

Enter a new name for the object. Click Rename to change the object’s name.

Copying Objects

Many objects in the project tree can be copied. Right-click on an object and select Copy. You will be prompted to enter a name for the object’s copy.

The copied object is not linked to the original object. However, if the original object is linked to other objects in the project, the copy will also be linked to those objects.
Comments

Another aid to documenting work in a project is comments.

You can record comments on many objects in the project tree, including subfolders. This can be helpful when the project contains many objects and when several different people are working on a model. Objects that have comments are indicated in the project tree by a comment balloon (粉色). The comment will be displayed when you right-click on the object:

Tab or click to add a new comment or edit an existing one. You can also add standard information to a comment, such as date and time.

You can add information about the project as a whole using the Notes object (粉色), which is the last object in the project tree. Double-click on the Notes object to open it and add information. When viewing projects in the Projects tab, information in a project's Notes will be displayed when you hold the mouse cursor over the project’s thumbnail:

Sharing Objects

Some objects are created as part of working with other objects and are not available elsewhere in the project. An example of this is a polyline drawn as part of creating a model boundary. To
Unsharing a Polyline

To share such objects within the project, right-click on the object in the project tree and click **Share**. The shared object will be copied to the relevant location in the project tree and a hyperlink added to the object it was shared from.

For example, here a polyline created as part of a lateral extent is shared:

![Polyline in project tree](image)

The polyline is saved to the **Polylines** folder and a hyperlink to it appears as part of the model’s boundary. Whenever the polyline is updated, changes will be made wherever it is shared in the project.

**Unsharing a Polyline**

Polylines that have been shared can be unshared by making a local copy of the polyline. To do this, right-click on the shared polyline and select **Create Local Copy**:

![Create Local Copy](image)

The polyline in the **Polylines** folder remains, but a local copy of it is made and the hyperlink to the **Polylines** folder copy is deleted. This means you can now work on, for example, the **Polylines** folder copy without changes to it affecting the geological model’s copy.

**Processing Tasks**

The processing queue button shows how many tasks are currently being processed:
Objects will be added to the processing queue when you make changes to them via the project tree.

- To view the queue and progress on processing, click the queue button or press Alt + P.
- To pause processing, press Ctrl + P. To resume processing, press Ctrl + P again.

The button will turn grey when all processing is complete.

You can close a project while it is still running tasks. When you next open the project, the remainder of the tasks in the processing queue will be processed.

**Prioritising Tasks**

Tasks can be prioritised and their inputs processed before other objects. To prioritise a task, right-click on an object in the project tree and select **Prioritise**. Prioritised tasks are marked in the project tree with an arrow:

Prioritising an object is useful when you are editing it and wish to view the effect of changes without reprocessing all objects in the project. For example, you may be modifying a surface that is used for a model boundary. You can prioritise the surface, then run it each time you make changes.

To run only prioritised tasks, click the processing queue button, then click **Priority Only**:

The processing queue button will change to show that only priority tasks will be run:

The number of objects that have been prioritised is indicated by the button at the top of the project tree (↑). To view prioritised tasks, click the button. All prioritised objects will be selected and displayed in the project tree.

To reset a priority object, right-click on it and select **Clear Priority**.

Click the processing queue button, then click **Run All** to resume normal processing.
Correcting Errors

If processing of an object fails, all other objects dependent on that object will also fail. Click the processing queue button to view the errors. To inspect the source of error, right-click on the object in the task queue and select Go to Project Tree > Show Error:

The object’s Properties window will be opened with the Errors tab displayed. The information in this tab may be helpful in fixing the error.

Object Properties

You can view the properties of most objects imported into or created in Leapfrog Works. To do this, right-click on the object in the project tree and select Properties.

The information available in the Properties window depends on the type of object. There are two tabs that appear for each type of object:

- The Processing tab shows the current status of the processing (queued to process, processing, finished).
- The Errors tab shows errors that have occurred while processing the object. See Processing Tasks.

The General Tab

Many objects also have a General tab that summarises information about the object. The amount of information in the General tab will vary according to the type of object. For example, for table objects, the General tab shows the table’s data structure.
The Histogram Tab
When you view properties for some objects, a **Histogram** tab is available. For example, when you view the properties for interval tables and numeric data tables, the **Histogram** tab shows the distribution of the data in a particular column:

![Histogram Tab](image)

If the table contains several columns, you can display histograms for each column. If so, you will be able to choose the other columns from the list. You can also:

- **Adjust** the number of intervals in the histogram by changing the **Bin count**.
- **Remove** values less than zero by ticking the **Semilog X** box.

Changes made to the way the histogram is displayed are not saved when the **Properties** window is closed.

The Statistics Tab
When you view properties for some objects, a **Statistics** tab is available. For more information, see **Statistics**.

The 3D Scene
This topic describes how to interact with the 3D scene. It is divided into:

- **Navigation**
- **Locating an Object from the Scene**
  - **Clicking in the Scene**
  - **Clicking in the Shape List**
- **Slicing Through the Data**
Navigation

The best way to navigate the 3D scene in Leapfrog Works is using the mouse. If you are running Leapfrog Works on a laptop, it is recommended that you plug in a mouse rather than using the laptop’s touchpad for navigation. However, you can also navigate in the scene using the keyboard.

<table>
<thead>
<tr>
<th>Action</th>
<th>Mouse</th>
<th>Keyboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changing the viewing angle</td>
<td>Click and drag to rotate the scene</td>
<td>Press the arrow keys to rotate the scene For smaller steps, hold down the Shift key while pressing the arrow keys</td>
</tr>
<tr>
<td>Zooming in and out of the scene</td>
<td>Use the scroll wheel Hold the right mouse button while moving the mouse</td>
<td>Press the Page Up or Page Down keys For smaller steps, hold down the Shift key while pressing the Page Up or Page Down keys</td>
</tr>
<tr>
<td>Panning the scene</td>
<td>Click and hold both mouse buttons, then drag Hold the scroll wheel and drag</td>
<td>Hold down the Alt key while pressing the arrow keys</td>
</tr>
<tr>
<td>Centre an object in the scene</td>
<td>Click the scroll wheel Click both mouse buttons together</td>
<td></td>
</tr>
</tbody>
</table>

Use the Look menu above the scene window to switch to different viewing angles:
If you prefer to navigate using the keyboard, use the following keyboard shortcuts:

<table>
<thead>
<tr>
<th>Key(s)</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrow keys</td>
<td>Rotate the scene in 10 degree steps</td>
</tr>
<tr>
<td>Shift+Arrow keys</td>
<td>Rotate the scene in 2 degree steps</td>
</tr>
<tr>
<td>Home</td>
<td>Reset the view, showing all visible objects in scene</td>
</tr>
<tr>
<td>U, D, E, W, N, S</td>
<td>Look Up, Down, East, West, North and South</td>
</tr>
<tr>
<td>L</td>
<td>Look at the slicing plane</td>
</tr>
<tr>
<td>Shift+L</td>
<td>Look at the back of the slicing plane</td>
</tr>
<tr>
<td>M</td>
<td>Look at the moving plane</td>
</tr>
<tr>
<td>Shift+M</td>
<td>Look at the back of the moving plane</td>
</tr>
<tr>
<td>Ctrl+M</td>
<td>Look down the moving plane pitch</td>
</tr>
<tr>
<td>Shift+Ctrl+M</td>
<td>Look up the moving plane pitch</td>
</tr>
<tr>
<td>P</td>
<td>Select <strong>Perspective</strong> view</td>
</tr>
<tr>
<td>O</td>
<td>Select <strong>Orthographic</strong> view</td>
</tr>
<tr>
<td>Ctrl+Delete</td>
<td>Clear the scene</td>
</tr>
<tr>
<td>Ctrl+B</td>
<td>Bookmark the viewing angle and zoom</td>
</tr>
<tr>
<td>B</td>
<td>Display the bookmarked viewing angle and zoom</td>
</tr>
<tr>
<td>Ctrl+`</td>
<td>Save the scene</td>
</tr>
<tr>
<td>Ctrl+C</td>
<td>Copies the scene to the clipboard. The image can then be pasted into another application, such as an image editor.</td>
</tr>
<tr>
<td>Ctrl+/</td>
<td>Add the slicer to the scene. Press Ctrl+/ to remove the slicer from the scene.</td>
</tr>
<tr>
<td>Ctrl++;</td>
<td>Add the moving plane to the scene. Press Ctrl++; to remove the moving plane from the scene.</td>
</tr>
</tbody>
</table>

The current viewing angle and scale are displayed in the lower right-hand corner of the scene window:

You can change how the viewing angle and scale are displayed in the **Overlays** tab of the **Settings** window.
You can save the current viewing angle as a bookmark by selecting **Bookmark Viewing Angle** from the **Look** menu or by pressing Ctrl+B. Restore the bookmark by selecting **Look > Restore Bookmark** or by pressing B.

Only one viewing angle bookmark can be saved. The bookmark is not saved when Leapfrog Works is shut down.

The scene window displays a 3D representation of selected data from the project tree. You can add objects from the project tree to the scene in two ways:

- Click on the object and drag it into the scene. Hold down the Shift key or the Ctrl key while clicking to select multiple items, then add them to the scene.
- Right-click on the object and tick the **View Object** box.

Dragging objects into the scene window may be blocked by other applications on your computer. For example, if you are sharing a screen using Skype, you will not be able to drag objects into the scene.

Once you have added objects to the scene window, you can change the appearance of those objects using the controls in the shape list and the shape properties panel.

Changing how you view objects in the scene window does not change those objects in the project tree.

**Visualising Data** describes in detail how to change the visualisation of data in the scene, which is an important part of interpreting data in the project and making modelling decisions.
Locating an Object from the Scene

When you have a number of objects displayed in the scene, it may not be readily apparent where you can find more information about those objects. Leapfrog Works helps you find the object in the project tree and the shape list in two ways, by Clicking in the Scene and by Clicking in the Shape List.

Clicking in the Scene

Clicking on an object in the scene displays a window that contains a summary of the data and, for many objects, a link to the corresponding data in the project tree. For example, here borehole data is displayed in the scene and clicking on a segment displays the corresponding data:

Note that clicking on an object in the scene also selects it in the shape list.
Clicking in the Shape List

When you have objects displayed in the shape list and want to locate them in the project tree, simply right-click on the object in the shape list and select **Go to Project Tree**:

![Shape List](image1)

The object’s location in the project tree will be expanded and the object will be selected.

Slicing Through the Data

The slicer is a powerful tool for revealing data that is concealed behind other objects and for emphasising data. Slicing can be considered a form of dynamic sectioning.

Two buttons in the toolbar can be used to add the slicer to the scene:

![Slicer Toolbar](image2)

You can add the slicer to the scene by clicking the **Show slicer** button (🧩). The slicer will appear in the scene and you can adjust its position using the controls in the shape list:

You can also click the **Draw slicer line** button (🪓), then click and drag in the scene to cut a slice through the scene.

© 2017 ARANZ Geo Limited t/a Seequent
The scene may appear empty because the slicer has removed all visible data. Reposition the slicer or turn it off.

You can change the way the slice appears in the scene using the controls in the shape list, and finer controls are available in the shape properties panel:

Right-click on the slicer in the shape list to view more information about each option:

The Lock to Camera option locks the slice to the current view so that moving the scene changes the direction of the slice.

These options can also be controlled from the Look menu:

The Set to list in the shape properties panel contains standard views, together with any sections displayed in the scene:
To move the slicing plane in a direction orthogonal to the slicing plane, hold down the Ctrl key and the right mouse button while dragging the mouse.

To change the thickness of a thick slice, hold down the Ctrl key and the middle mouse button while dragging the mouse. If you have a two-button mouse, hold both buttons.

Use the following keyboard shortcuts to control the slicer:

<table>
<thead>
<tr>
<th>Key(s)</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+/</td>
<td>Add the slicer to the scene. Press Ctrl+/ to remove the slicer from the scene.</td>
</tr>
<tr>
<td>L</td>
<td>Look at the slicing plane</td>
</tr>
<tr>
<td>Shift+L</td>
<td>Look at the back of the slicing plane</td>
</tr>
<tr>
<td>T</td>
<td>Thick slice</td>
</tr>
<tr>
<td>F</td>
<td>Remove front</td>
</tr>
<tr>
<td>K</td>
<td>Remove back</td>
</tr>
<tr>
<td>Ctrl+V</td>
<td>Orient the slicer to the current view</td>
</tr>
<tr>
<td>Ctrl+E</td>
<td>Slice the east (X) axis</td>
</tr>
<tr>
<td>Ctrl+N</td>
<td>Slice the north (Y) axis</td>
</tr>
<tr>
<td>Ctrl+D</td>
<td>Slice the elevation (Z) axis</td>
</tr>
<tr>
<td>Ctrl+L</td>
<td>Lock the slicer to the camera</td>
</tr>
<tr>
<td>C</td>
<td>Centre the slicer in the scene</td>
</tr>
<tr>
<td>Ctrl+right mouse button</td>
<td>Move the slicer forward and backward in the scene</td>
</tr>
<tr>
<td>Ctrl+middle (or left+right) mouse button</td>
<td>Change the slice width</td>
</tr>
<tr>
<td>, (comma)</td>
<td>Step the slicer forward</td>
</tr>
<tr>
<td>. (full stop)</td>
<td>Step the slicer backward</td>
</tr>
<tr>
<td>L and Shift+L</td>
<td>Look orthogonally at the slicer plane</td>
</tr>
</tbody>
</table>

### Measuring in the Scene

Leapfrog Works has a number of tools for making quantitative measurements in the scene. These include:

- Clicking on an object in the scene. This will open a window containing more information about the object.
- Viewing an object’s properties to determine its size. Right-click on the object in the project tree and select Properties. Information on the size of the object will be displayed in the General tab.

- Using the cursor to determine an approximate location in the scene. See Determining a Location.
Using the moving plane to measure trends. See The Moving Plane.

Using the ruler to measure in the scene. See The Ruler.

**Determining a Location**

The simplest way of measuring an approximate location in the scene is to first display an object in the scene window, then position the cursor over the location. The position of the cursor is displayed at the bottom of the Leapfrog Works window:

The position of the cursor in the scene is calculated using the depth buffer on the graphics card and so is not an exact method of measuring in the scene.

If you require an exact position, click on the object. Leapfrog Works will compute the exact position and display it in a pop-up window:

The point selected is highlighted in the scene.
The Moving Plane

In Leapfrog Works, the moving plane is used for measuring planar structures and defining coordinate system orientations. There are two tools in the toolbar that relate to the moving plane:

To use the moving plane, click the **Show plane** button ( jó ) and position the plane in the scene. The main axis of the moving plane is defined by the green line. The second axis is defined to be in the plane at right angles (orthogonal) to the main axis. Third axis is perpendicular to the plane.

There are three ways to position the plane. You can:

- Use the handles in the scene window to move the plane. If you cannot see the handles, click on the moving plane.
- Use the **Plane** controls in the shape properties panel to change the **Dip**, **Dip Azimuth**, **Pitch** and **Centre Point**.
- Orient the scene to look parallel to the required plane position, then click on the **Draw plane line** button ( ó ). Draw the required line in the scene.

Plane movement can be aligned to the **Axes** or to the **Camera**:

- With the **Axes** option, the handles move in cartesian coordinates.
- With the **Camera** option, the handles move relative to the camera angle.

Drawing the plane line is usually the most convenient method of defining a planar structure.

To remove the moving plane from the scene:
Click the **Show plane** button ( ).
In the shape list, click the delete button ( ) for the moving plane.

Use the following keyboard shortcuts to control the moving plane:

<table>
<thead>
<tr>
<th>Key(s)</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl++;</td>
<td>Add the moving plane to the scene. Press Ctrl++; to remove the moving plane from the scene.</td>
</tr>
<tr>
<td>M</td>
<td>Look at the moving plane</td>
</tr>
<tr>
<td>Shift+M</td>
<td>Look at the back of the moving plane</td>
</tr>
<tr>
<td>Ctrl+M</td>
<td>Look down the moving plane pitch</td>
</tr>
<tr>
<td>Shift+Ctrl+M</td>
<td>Look up the moving plane pitch</td>
</tr>
</tbody>
</table>

**The Ruler**

You can use the ruler to measure distances in three dimensional space and between boreholes and planned boreholes.

The easiest way to use the ruler is to click on the **Ruler** button ( ) and click and drag between points in the scene to start making measurements. A ruler line will appear in the scene to indicate the measurement. Information about the distance measured will appear in the scene and in the shape properties panel:

The ruler tool stays active in the scene so you can make as many measurements as required.
You can also measure the distance between boreholes or between boreholes and a point. To do this, click on the **Calculate Distance** button in the shape properties panel. The **Distance Calculator** window will appear:

You can select both boreholes and planned boreholes. Click **Calculate** to calculate the distance and update the ruler in the scene. The distance value will appear in the **Distance Calculator** window.

You can also select a point in the scene by clicking the **Select** button in the **Distance Calculator** window, then clicking in the scene. The location of the point in the scene will appear in the **Distance Calculator** window.

After measuring a distance, it is a good idea to change the viewing angle to confirm that the measurement has been made between the correct points in three dimensions.

There are two ways to remove the ruler from the scene:

- Click the **Select** button.
- Click the delete button for the ruler object in the shape list.
Drawing in the Scene

In Leapfrog Works, you can draw polylines to define many surfaces, including lateral extents and contact surfaces. You can also use polylines to make adjustments to surfaces and create new GIS lines.

This topic describes drawing polylines in Leapfrog Works. It is divided into:

- **The Drawing Toolbar**
- **Drawing Hotkeys**
- **Drawing 3D Lines**
- **Drawing 2D Lines**
- **Polyline Properties**
- **Tangents and Ribbons**
- **Drawing Points**
- **Editing Normals**

For information on importing and exporting polylines, see [Polylines](#).

When drawing in Leapfrog Works, you can draw on surfaces or on the slicer.

- If you are drawing on surfaces, the line will be in 3D.
- If you are drawing on the slicer, the line will be in 2D and locked to the plane it was drawn in. It can be converted to a 3D line.

When you start drawing a polyline, drawing tools are added to the scene window. If you are drawing a GIS line or if the slicer was already in the scene, the drawing mode will be set to be on the slicer.

Toggle between the two options using the toolbar buttons:
When drawing and otherwise working with the polyline, tooltips are displayed in the scene that show what actions are currently possible:

For example, if the drawing mode is set to on slicer ( ), you will be warned if the slicer is not in the scene:

You can disable these tooltips once you are more familiar with how the polyline tool works. Open the Settings window by clicking on the Leapfrog Works menu and selecting Settings. Click on Overlays and disable the Polyline help text option.

The Drawing Toolbar

The Draw lines ( ) and Draw points ( ) tools are used to create new lines and points. The tools in the second row are for controlling whether the polyline is drawn (on the slicer ( ) or on surfaces ( )). The Select list lets you select different parts of the polyline.

The other tools are for working with selected parts of the polyline:

- Making line segments straight ( ) or curved ( )
- Adding nodes ( ) to lines
- Adding tangents to lines or reorienting selected tangents ( )
- Flipping selected tangents and disks ( )
- Add disks to points ( )
- Converting a 2D polyline to 3D ( )
- Setting the slicer to a 2D polyline ( )
There are also buttons for undoing (♀) and redoing actions (♂), as well as saving the polyline (♂) or deleting selected parts of it (♀).

**Drawing Hotkeys**

Use the following keyboard shortcuts while drawing:

<table>
<thead>
<tr>
<th>Key(s)</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+S</td>
<td>Draw lines (♂)</td>
</tr>
<tr>
<td>Ctrl+6</td>
<td>Draw points/disks (♂)</td>
</tr>
<tr>
<td>Ctrl+S</td>
<td>Save (♂)</td>
</tr>
<tr>
<td>Ctrl+W</td>
<td>Close editor (♂)</td>
</tr>
<tr>
<td>Ctrl+Z</td>
<td>Undo (♀)</td>
</tr>
<tr>
<td>Ctrl+Y</td>
<td>Redo (♂)</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete the selected segment, node, tangent or disk (♀)</td>
</tr>
<tr>
<td>X</td>
<td>Draw/move on slicer (♂)</td>
</tr>
<tr>
<td>Shift+X</td>
<td>Draw/move on objects (♂)</td>
</tr>
<tr>
<td>Q</td>
<td>Make segments curved (♂)</td>
</tr>
<tr>
<td>Shift+Q</td>
<td>Make segments straight (♂)</td>
</tr>
<tr>
<td>Shift-A</td>
<td>Add node (♀)</td>
</tr>
<tr>
<td>A</td>
<td>Add/reorient tangent (♀)</td>
</tr>
<tr>
<td>V</td>
<td>Flip tangent/disks (♀)</td>
</tr>
<tr>
<td>Shift+D</td>
<td>Add/remove disk (♀)</td>
</tr>
<tr>
<td>Shift+E</td>
<td>Make selected line 3D (♀)</td>
</tr>
<tr>
<td>Shift+W</td>
<td>Set slicer to selected 2D line (♀)</td>
</tr>
<tr>
<td>Ctrl+A</td>
<td>Select all</td>
</tr>
<tr>
<td>Shift+Ctrl+Alt+L</td>
<td>Select all lines</td>
</tr>
<tr>
<td>Shift+Ctrl+Alt+T</td>
<td>Select all tangents</td>
</tr>
<tr>
<td>Shift+Ctrl+Alt+P</td>
<td>Select all points without disks</td>
</tr>
<tr>
<td>Shift+Ctrl+Alt+D</td>
<td>Select all points with disks</td>
</tr>
</tbody>
</table>
**Drawing 3D Lines**

Polylines are made up of nodes, which are added where you click in the scene using the **Draw lines** tool. This is a 3D polyline, which is indicated in the scene by the dashed line:

Click to select a node and drag to move it in the scene parallel to the screen. If you hold down the Ctrl key while moving the node, it will snap onto surfaces in the scene.

When borehole segments are in the scene, the polyline tool will snap to the end of nearby intervals.

When you click to add a node, dragging the mouse before releasing the button lets you control the curvature:

When you start drawing a polyline, a tangent is automatically added to the first node. This is oriented in the direction of the camera, and you will need to rotate the scene to see that it is a cone.
There are also bezier control points for curved segments. Bezier control points are used to control the curvature of the segment. Click on a control point and drag it to change the curve of the segment:

![Bezier Control Point](image)

When you have finished drawing, right-click to end the polyline. Switch to the Select tool ( 선택) to make changes to the polyline.

- Click on a node to move it.
- Click on a segment away from a node and drag it to change its curvature.
- Click on one or more segments, then make them straight (직선화) or curved (곡선).
- Select a point on the polyline, then click ( 출처) to add a node.
- Select a point on the polyline. The point selected is indicated in the scene by a red cone. You can then click ( 출처) to add a tangent oriented in the direction of the camera.
- Select a tangent and click ( 출처) to change the orientation of the segment to that of the camera.
- Select a tangent and click ( 출처) to flip it.

Begin drawing again by selecting the Draw lines button ( 드로잉). To continue from an existing node at the start or end of a polyline, click on the node.

Although you can make the line curved while adding nodes, an easy way to draw a curved polyline is to simply click to add a series of points. Set the curvature of the whole line by selecting all segments and then clicking the Make selected segments curved button ( 곡선화):
You can then make any adjustments to the curves required by dragging the segments or using the bezier control points.

**Drawing 2D Lines**

Working with a 2D polyline is similar to working with a 3D polyline, except that drawing is restricted to the 2D plane set by the slicer.

In this scene, a 2D polyline is indicated by an unbroken line:

To convert a 2D polyline into a 3D polyline, click the 3D polyline button (§).

**Polyline Properties**

In the shape list, you can control the colour of the positive (red) and negative (blue) surfaces of the line and of the line itself (green):

For contact surfaces, the colour of the positive and negative sides of a ribbon will be determined by the lithologies or categories assigned to either side of the surface.

With the **Node size** and **Point size** controls in the properties panel, you can change the size of nodes and points in the scene to make working with the polyline easier.

**Tangents and Ribbons**

The **Surface ribbon** (ribbon) and **Normal ribbon** (ribbon) help you to determine the orientation of the polyline in the scene. The surface ribbon reflects the orientation of the polyline and the normal ribbon is perpendicular to the surface ribbon.
For example, click on the **Surface ribbon** button (러브) to determine which side of the polyline is positive (red) and which side is negative (blue):

If you are having trouble seeing the ribbons, you can change their size using the **Ribbon width** control in the properties panel.

When you first draw a polyline, it has only one tangent, located at the first node and oriented in the direction of the camera. You can add more nodes by clicking at a point along the polyline and then clicking the **Tangent** button (러브). A tangent is added to the polyline, which is updated to reflect the new information. The tangent’s orientation is taken from the camera angle. To reorient a tangent, click on it in the scene, change the camera angle to reflect the orientation you wish to set, then click the **Tangent** button (러브).

You can also flip selected tangents by clicking on the **Flip tangents and disks** button (러브).

You can add as many tangents as required, although it is best to keep them to a minimum.

**Drawing Points**

Polylines can also include points, which are drawn using the **Draw points** tool (러브). Clicking adds a point, and clicking and dragging adds a point with a normal:

Normals are shown in the scene as disks intersecting the points.
The scene below shows one point with a normal and one without:

To move a point without a normal, switch to the Select tool ( ). Click on the point and drag it. To add a normal to the point, click on it in the scene and click the Add disk button ( ).

**Editing Normals**

To edit the orientation of a point with a normal, click on it in the scene. There are two rotation modes. In the first, the handles adjust the dip and azimuth of the disk:

Click on the disk to change the rotation mode.

In the second rotation mode, dragging the disk rotates it in the plane indicated by the handles:

Change the angle of the plane by moving the mouse cursor over the disk.
You can also change the orientation of a disk by drawing over it. To do this, make sure the **Draw points** tool (ASET) is selected. Hold the cursor over the point you want to edit. The cursor will turn green to indicate that you can adjust the disk’s angle:

Drag to adjust the angle and release the mouse button when finished:

You can also flip selected disks by clicking on the **Flip tangents and disks** button (M).
Settings

Open the Settings window by clicking on the Leapfrog Works menu and selecting Settings:

The settings available in this window are described below:

- **Display and Navigation Settings**
  - 3D Acceleration Mode
  - Font Size
  - Z Axis Scale
  - Rotation Settings
  - Camera Settings
- **Overlay Settings**
  - Screen Grid Settings
  - Axis Lines Settings
  - Other Overlay Settings
- **Colour Scheme**
- **Lighting Settings**
- **Processing Settings**
- **User Interface Settings**
- **Central Settings**
- **View Settings**
- **Help Settings**

To close the Settings window and leave settings unchanged, click the Revert button, then click Close.

**Display and Navigation Settings**

In the Settings window, click on Scene to change scene display and navigation settings.
3D Acceleration Mode
Leapfrog Works can run in one of three acceleration modes. Click the Acceleration mode button in the Settings > Scene window to use a different mode. The modes available are:

- **Software Rendering** uses software only, for maximum compatibility with any hardware. This option can be very slow displaying all but the simplest scenes, and is provided as a fall-back if display issues cannot be resolved with either of the other two options.

- **Partial Acceleration** uses hardware acceleration that has been provided on graphics cards for many generations. In this mode, Leapfrog Works renders scenes using “fixed function pipeline” hardware acceleration features that have been superseded in modern graphics cards by programmable shaders, but this legacy capability is widely supported and offers performance advantages over software rendering. Using Partial Acceleration can sometimes fix anomalies or problems encountered in Full Acceleration mode that may be due to bugs in old drivers, and it should work with even old or lower-featured hardware.

- **Full Acceleration** is the best option, assuming you have good hardware and up-to-date drivers. Because it makes use of programmable shaders provided by modern graphics cards, it is the fastest of the three modes and uses your available graphics memory more efficiently. It is the mode you should use, if your system supports it.

First, try using Full Acceleration and see how it renders scenes. If you seem to be having issues with how data is displayed in the scene, see The Graphics Test for information on testing your computer’s graphics capabilities. Note that especially when graphics cards are new on the market, there may be a number of driver versions released to address anomalies, so the use of a recent driver version is important. If using a laptop with dual graphics cards, use it with the power supply connected, and select the Performance Graphics option over the Power Saving option.

If that doesn’t resolve the graphics problems, then try Partial Acceleration mode. If possible, avoid using Software Rendering as it can be very slow.

If your current hardware is unable to support Full Acceleration mode, it may be worth considering upgrading your graphics card. Medium- to high-end home PC and gaming graphics cards are sufficient. High-end workstation grade cards also work very well, but you will also be paying for further capabilities that are not utilised by Leapfrog Works.

The acceleration mode can also be changed by clicking the button at the bottom of the Leapfrog Works main window:

![Acceleration Mode Button](image)

Font Size
This setting is the size of text used to display information on the grid and axes.
Z Axis Scale

The Z-axis scale setting lets you set a value greater than 1.0 for the z-axis relative to the x- and y-axes. This is useful when the area under study is very planar and extends over a wide area. In such cases, scaling the z-axis can accentuate the distribution of data along the z-axis. If you have a project open when you change this setting, the change will be reflected in the scene so you can experiment with different values before choosing the one that best accentuates the distribution of data.

The z-axis setting can also be changed by clicking the Z-Scale button at the bottom of the Leapfrog Works main window:

![Z-Scale button](image)

The Scale Z Axis window will appear:

![Scale Z Axis window](image)

Note that each project saves the z-axis scaling setting when the project is closed. In addition, when saving scenes (see Saved Scenes), the z-axis scale is saved as part of the scene.

Rotation Settings

The Geographic rotation and Free rotation settings determine whether or not the model displayed in the scene window can be “rolled”. With the Geographic rotation option, the azimuth and elevation can be varied, but the z-axis is constrained to be vertical. With the Free rotation option, however, the rotation of the model is not fixed to any axis and the model can be freely rolled around any axis. Select the option you prefer. When Leapfrog Works is installed, Geographic rotation is set as the default option as it is the most commonly used.

The Rotate with left button and Rotate with right button settings determine how the mouse is used to rotate the scene:

- When Rotate with left button is selected, you can rotate the scene by holding down the left mouse button and dragging in the scene. Clicking and holding the right mouse button zooms in and out of the scene.
- When Rotate with right button is selected, holding down the right mouse button and dragging rotates the scene. However, zooming and rotating functions are not swapped. Instead, the left mouse button can only be used for clicking on different objects in the scene. Select this option if you tend to accidentally move the scene when you intend to click.
Camera Settings
The Orthographic projection and Perspective projection settings determine the view of the model in the scene window.

If Perspective projection is selected, you can change the Perspective angle using the slider. This is similar to adjusting the zoom setting on a camera. Higher angles make nearby objects larger and more distant objects smaller. Lower angles will compress the scene. Experiment with the settings to see the effect on objects in the scene.

Select the option you prefer.

Overlay Settings
In the Settings window, click on Scene > Overlays to change what objects are included in the scene.

Changes you make to these settings are automatically updated in the scene so you can easily experiment to see what overlays you prefer.

Select Revert to return to the settings in place when the Settings window was first opened.

Screen Grid Settings
The Show screen grid setting determines whether or not the screen grid is displayed. Select the option you prefer. The Loose Spacing, Normal Spacing and Fine Spacing options determine the spacing of the grid.

Axis Lines Settings
The Axis Lines settings determine how X-Y-Z coordinates are displayed in the scene. When axis lines are enabled, the axes indicate the extent of data currently displayed in the scene.

- Enable Show axis lines to display the east (red), north (green) and elevation (blue) axis lines.
- Enable Put numbers on axes to display scale ticks along the grid. These are automatically adjusted to fit the extent of the data and the current zoom setting.
- Enable Show whole box to display the axis lines as a box that encloses the current data set.

Other Overlay Settings
The scale bar, compass ball and viewing angle text are the navigation aids in the lower right-hand corner of the scene window.

When the slicer is in the scene, text describing its position will be displayed in the lower left-hand corner if the Slicer position text option is enabled.

When drawing polylines, tooltips are displayed. If you do not wish to view these tooltips, untick the box for Polyline help text.
**Colour Scheme**

In the **Settings** window, click on **Scene > Colour Scheme** to change the colour scheme used in the scene. The options that can be changed include:

- The background colour used in the **Scene View** tab
- The colour and width used to display borehole traces
- The colour and width of mesh edges, together with the width of the line used when a mesh is sliced and the highlight colour used when mesh parts are selected in the scene
- The colours used for displaying the x, y and z axes
- Grid line width, style and colour
- Axes box line width, style and colour
- Slicer edge width, style and colour

Leapfrog Works is installed with three colours schemes: **Default**, **Black Background** and **White Background**. The scheme selected in the **Schemes** list will be used for all new Leapfrog Works projects and for existing projects when they are next opened.

- Experiment with the settings to see how they affect the scene window. The scene will be updated as you make changes.
- Select **Revert** to return to the settings in place when the **Settings** window was first opened.
- To create a new scheme, click on an existing scheme. This is the scheme that will be used as a basis for defining the new scheme. Next, click the **New Scheme** button and change its settings.
- Click **Factory Reset** to revert to the colour schemes defined when Leapfrog Works was first installed.

> Clicking on **Factory Reset** to revert to the original colour schemes deletes any custom colour schemes.

**Lighting Settings**

In the **Settings** window, click on **Scene > Lighting** to change how visual effects are displayed in the scene window. You may be able to use these settings to emphasise significance in the data displayed in the scene.

- The **Ambient level** setting determines the overall brightness of the scene.
- The **Specular brightness** and **Specular shininess** settings determine how light appears to fall on the surfaces in the scene. The **Specular brightness** setting has a stronger effect when **Specular shininess** is soft.

You can have up to four light sources defined for a project. By default, two light sources are defined.
Changes made to these settings are automatically applied to the scene.

- Click **Revert** to return to the settings in place when the **Settings** window was first opened.
- Click **Factory Reset** to revert to the lighting sources and settings defined when Leapfrog Works was first installed.

**Processing Settings**
In the **Settings** window, click on **Scene > Processing** to change how background processing is used to run changes to data and models.

- For the **Automatic** option, the number of background processes will be set based on your computer’s CPU and RAM.
- For the **Disabled** option, tasks will be run in the main process and no background processes will be used.

Select **Revert** to return to the settings in place when the **Settings** window was first opened.

**User Interface Settings**
In the **Settings** window, click on **User Interface** to change project tree and scene toolbar options.

**Show Tree Lines**
Ticking the box for **Show Tree Lines** displays objects in the project tree with lines:

Enable this option if you find it useful for displaying relationships between objects in the project tree.

**Show Save Scene Button**
Ticking the **Show Save Scene** box adds an extra button to the scene toolbar:

Click this button to save the current scene.
Tab Position

Some Leapfrog Works windows open in separate tabs that can be used either docked or detached. The position in which tabs open is determined by the **New tab position** setting:

- Open all tabs in the main window.
- Open all tabs in separate windows.
- Tabs can open where the last tab was moved to. This setting can be used for creating a window in which all tables and dockable windows open, with the scene window, project tree and shape list in another window.

Central Settings

To enable Central, open the **Settings** window by clicking on the **Leapfrog Works** menu. Select **Central** and tick the box to enable Central. A **Central Projects** tab will appear in the main window.

When you connect to Central, you can download projects and work on them locally. To change the location where projects are saved, click the **Change** button under **Project Management** and navigate to where you want to save projects:

The **Connection** settings determine the timeout settings for connection to the Central server. The **Large request timeout** is used for publishing, uploading attachments and getting a revision. All other communication with the Central server uses the **Default request timeout**. The **Default request timeout** and **Large request timeout** should only be adjusted upward if you have problems with a poor connection. The default values are 20 seconds and 600 seconds.

The **Upload chunk size** setting is useful if you have a poor connection. It determines the size of the chunks used to upload large files. For example, if the **Upload chunk size** is 10MB and you are uploading a 100MB file, the file will be uploaded in 10 chunks. If your connection is poor and you are experiencing issues, you can decrease the value of the **Upload chunk size**.
There is an option for checking the integrity of a revision after it has been uploaded. If you wish to do this, enable the Check file consistency after upload option.

See Central Integration for more information on using Central.

View Settings
See Uploading to View for more information on using View.

Help Settings
If you are working on a slow connection, you can download a copy of the help that can be saved to your hard drive. To do this:

- Click here to download a copy of the help.
- Once you have downloaded a copy of the help and installed it, select Settings from the Leapfrog Works menu.
- Click on the Help tab and then select Local folder.

Leapfrog Works help is updated at each release. If you are using a downloaded copy, you will need to download a new copy each time you update Leapfrog Works.
Central Integration

The Central platform is a model management system. Central’s integration with Leapfrog Works lets you work in different project revisions, publish models to the server, view documents and annotations and reply to annotations.

Projects shared within Central can be downloaded and worked on locally in Leapfrog Works. When you have finished working on a project, select the objects you wish to publish to Central and add notes about the revision. New projects can be added to Central by building them from scratch or by uploading an existing project.

This topic describes how to set up and work with Central from within Leapfrog Works. It is divided into:

- Enabling Central
- Setting Up the Connection
- Connecting to Central
- Viewing a Project’s History
- Downloading a Local Copy of a Project
- Publishing to Central
- New Central Projects
- Disconnecting a Project from Central
- Troubleshooting Connectivity Issues

To learn more about Central, see the [Central help](#).

Enabling Central

To enable Central, open the Settings window by clicking on the Leapfrog Works menu. Select Central and tick the box to enable Central. A Central Projects tab will appear in the main window.
When you connect to Central, you can download projects and work on them locally. To change the location where projects are saved, click the **Change** button under **Project Management** and navigate to where you want to save projects:

![Connection settings](image)

The **Connection** settings determine the timeout settings for connection to the Central server. The **Large request timeout** is used for publishing, uploading attachments and getting a revision. All other communication with the Central server uses the **Default request timeout**. The **Default request timeout** and **Large request timeout** should only be adjusted upward if you have problems with a poor connection. The default values are 20 seconds and 600 seconds.

The **Upload chunk size** setting is useful if you have a poor connection. It determines the size of the chunks used to upload large files. For example, if the **Upload chunk size** is 10MB and you are uploading a 100MB file, the file will be uploaded in 10 chunks. If your connection is poor and you are experiencing issues, you can decrease the value of the **Upload chunk size**.

There is an option for checking the integrity of a revision after it has been uploaded. If you wish to do this, enable the **Check file consistency after upload** option.

### Setting Up the Connection

The first time you connect to Central, you will need to set up your connection. Request an account from your Central administrator, who will provide you with your connection details. Once you have these details, click on the **Central Projects** tab. Click the **Add** button to add a new server:

![Central Projects](image)

Click **New user** to enter your activation code, then enter the information provided to you by your Central administrator.
The activation code can be used a single time and is for the purposes of setting up your user name and password.

Enter a new password, then accept the terms and conditions and click **Save**.

**Connecting to Central**

Once Central integration has been enabled, you can see the status of your connection to Central in the lower left-hand corner of the Leapfrog Works main window. Click this button to logout or change Central settings:

If you are logged out, click on the **Central Projects** tab and click the server you wish to connect to:

To hide the **Central Servers** panel, click the button:

**Viewing a Project’s History**

The **Central Projects** tab shows thumbnails of the projects available in Central. Projects will be organised by location if there are multiple projects at a given location; otherwise projects will simply appear in a list.

A project’s location is set in the Central Admin Portal. You cannot change its location from Leapfrog Works.

Click on a project to view its history, which will open in a new tab.
Central projects are organised into revisions and branches:

- Different points in the modelling process are captured as revisions, which are specific points in time.
- Any revision can be the basis for any number of alternate revisions, forming the start of a new branch.

These are displayed visually in a project’s history tab, with local copies of projects shown in the panel at the top of the tab:

Each local copy is numbered so that it can easily be seen what versions have local copies in the **Local** column. The number in the column corresponds to the project in the **Local copies** panel. You can also:

- Click a thumbnail to open a local copy.
- Click the branch/copy number button (●) to identify the parent version of the local copy in the project history.
- Click the **Publish** button (ientes) to publish the copy being edited to Central.
- Click the **Delete** button (●) to delete a local copy, if the project is not open.

In the **Project history**, revisions are displayed chronologically, from the most recent down to the oldest. In the **Graph**, offshoots from a revision are branches where an alternative hypothesis has been investigated. Changes made in a branch do not appear in other branches; branches effectively diverge from the base revision. The dots on the graph line up with the revision information.

To view more information about a revision, click on it in the history.

**Locking Branches**

When working on a branch in Leapfrog Works, the branch can be locked so no other Central users can make changes to it. This is useful for letting others users know that a model is being worked on.

The **Locked** column indicates whether or not the branch is available to be worked on. If a branch is locked, hold the cursor over it to see who locked it and when it will be available once again.
To lock a branch, right-click on it in the project history and select **Lock branch**:

In the window that appears, set the **Lock duration** and add any comments. The lock can be set for as little as one day; when the lock expires or when a new publish is completed, the branch will be unlocked for other users. While the branch is locked, other users are still able to download projects, create new branches and publish to branches that are not locked.

If you locked a branch, you can unlock it before the lock expires by right-clicking on it and selecting **Unlock branch**:

The Central administrator can also unlock branches via the Admin Portal.

---

**Project Included**

The **Project** column indicates whether or not the Leapfrog Works project was included when the revision was published. If there is no icon displayed, then no project was uploaded when the revision was published. You can view the revision in the Central Browser, but you cannot work on it in Leapfrog Works.

When Leapfrog Works projects are included in a revision, they can be published in a **Complete** state or in an **Unprocessed** state. The difference between the two is whether or not stored modelling calculations are included in the published project. Removing stored modelling calculations can make the upload/download size of a revision considerably smaller and is useful when internet connectivity is poor. The tradeoff is that when the project is downloaded by a Leapfrog Works user, the project will have to be reprocessed before they can use it. This may take some time.

**Project Stages**

The **Project Stage** is useful for promoting projects through an organisation’s procedures. For example, your organisation may have project stages defined that include “Experimental”, “Ready for Peer Review” and “Ready for Production”. Different stages are displayed in different colours so it is easy to see at a glance what revisions belong to each stage.
Annotations and Attachments

With Annotations, Central Browser and Leapfrog Works users can carry out conversations about specific aspects of the model. Annotations include a scene. If you already have the project open in Leapfrog Works, you can load any scene from that project’s history by clicking on it. Information about the selected scene will be displayed and you will be prompted to load all the objects or only the unchanged objects:

If the selected scene has a geotag, it will be added to the shape list and displayed in the scene. Central Browser users can also attach files, which can be downloaded in Leapfrog Works.

Downloading a Local Copy of a Project

Select a revision and then click Download to download a local copy of the project. The project will be downloaded to the location on your local drive specified in the Settings > Central window. A new revision of the project will be created in the history, as an unpublished project.

Click the Open button in the Local copies panel to open the project:

Work in the project as you would any other Leapfrog Works project.
Publishing to Central

When you are ready to submit your project to Central, you can start the publishing process by clicking on the Central button in the lower left-hand corner of the screen and selecting Publish:

You can also select the Publish button ( ) in the Local copies panel:

The steps in publishing a project to Central are:

- **Selecting Objects**
- **Setting the Project Workflow Stage**
- **Including the Project**
- **Adding Revision Information**
- **Preparing the Package**

When you click Publish, you may receive a message saying there is an unfinished publish event:

This occurs when a previous publish event was interrupted. Choose from the options presented.
If the publish event was abandoned, it can be removed via the Admin Portal.

Selecting Objects
Select the objects you wish to publish from those available in the project:

![Select objects to publish](image)

Click **Next** to choose options for how the project will be uploaded.

Setting the Project Workflow Stage
Project stages are useful for advancing projects through an organisation’s processes. If the project is ready to be moved on to a different stage, select a different **Project Workflow Stage** from the list.

Project stages can later be changed in the Central Browser.

Including the Project
Select whether or not to include the Leapfrog Works project. There are three options:

- **No**. The Leapfrog Works project will not be published. Other Central users will not be able to download the project and work on it in Leapfrog Works.

- **Complete**. This option publishes the complete Leapfrog Works project, including stored modelling calculations. Other Central users will be able to download the project and work on it in Leapfrog Works without reprocessing the project.

- **Unprocessed**. An unprocessed project has a smaller upload/download size because stored modelling calculations are removed. When an unprocessed project is downloaded again, all of the modelling calculations will need to be reprocessed from the underlying data. Other...
Central users will be able to download the project and work on it in Leapfrog Works. Depending on the size of the project, reprocessing may take some time.

Click Next.

Adding Revision Information
Enter information about the new revision. If you want to create a new branch, click the New Branch button and enter a name for the branch.

Preparing the Package
Click Next to begin the processes of packaging the project for publication. There are two options for starting the upload:

- If you want the upload to begin automatically once the package has been prepared, tick the Auto upload box.
- If you want the option to cancel the upload once it has been packaged, leave the Auto upload box unticked. Once the project has been packaged, click Publish to upload the project to Central.

If for some reason you need to stop the upload, click on the Central button in the lower left-hand corner of the screen and select Stop Upload:

You can resume the upload by clicking Publish in the project history. You will be prompted to resume the unfinished publish event, as described in Publishing to Central above.

If the upload is interrupted because the connection to the server is lost, you will be prompted to finish the publish event the next time you log in to Central.

New Central Projects
There are two options for putting a project into Central:

- Create a new Central project.
- Put an existing project into Central.

Creating a New Central Project
Use this option to create a new Leapfrog Works project and put it into Central. In the Central Projects tab, click Create blank project. Enter a name for the project and click OK. A new Leapfrog Works project will be created and saved in the location on your local drive specified in the Settings > Central window.
Work in the project as you would any other Leapfrog Works project. When you are ready to publish the project to Central, do so as described in Publishing to Central above.

Adding a Project to Central
Use this option to add an existing project to Central.

Open the project you wish to import, then in the Central Projects tab, click Import open project. Enter a new name for the project, if you wish, then click OK. The project will be opened and copied to the location on your local drive specified in the Settings > Central window.

Work in the project as you would any other Leapfrog Works project. When you are ready to publish the project to Central, do so as described in Publishing to Central above.

Disconnecting a Project from Central
Disconnecting a project from its Central server saves a copy of the project in a new location on your computer. When a project is disconnected, it will no longer be possible to publish the project to Central and its history will no longer be tracked.

If you wish to remove a project from Central, select Disconnect This Project from the Leapfrog Works menu. You will be prompted to confirm your choice. Once you click Proceed, you will be prompted for a new location in which to save the project.

Troubleshooting Connectivity Issues
Leapfrog Start checks to see if your network will support the connection of Leapfrog web-based services to your desktop applications. If you are having trouble with your connection to Central, see Checking Connectivity with Leapfrog Start.

Uploading to View
View is a web-based model-sharing platform that allows you to visualise 3D models and share them with collaborators, all in one online view. This topic describes:

- Enabling View Integration
- Uploading to View
  - Uploading the 3D View
  - Uploading Saved Scenes
- Troubleshooting Connectivity Issues

Enabling View Integration
To enable View, open the Settings window by clicking on the Leapfrog Works menu. Select View and tick the box to enable View.

Next, enter your email address and password and click Sign in. Once your ID has been verified, the Sign in button will change to Sign out. Close the Settings window.
You can use your My Leapfrog ID to sign in to View.

**Uploading to View**

There are two options for uploading to View:

- Uploading the current 3D view
- Uploading saved scenes

**Uploading the 3D View**

The first option for uploading to View is to upload some or all of the objects in the 3D scene. To do this, click the **View** button (_chart_ ) in the toolbar:

A list of the objects currently in the scene is displayed, along with information about the upload size for each object. Objects that are visible in the scene will automatically be selected, whereas any hidden objects will appear in the list but will not be selected.

If an object in the scene does not appear in the list, it is because the upload of that type of object to View is not supported at this time.

The maximum number of objects and the maximum amount of data that can be uploaded are displayed in the window, so if your scene contains large objects or too many objects, you can select which ones you wish to upload.

When uploading category data columns to View, there is a limit to how many unique codes can be uploaded. If your category data is displaying more than 250 unique codes, consider
simplifying your data before uploading to View.

Once you have chosen which objects you want to upload and entered information about the view, click the **Upload** button.

Upload progress is shown in the processing queue:

When the upload is complete, a message will be shown in the bottom right-hand corner of the Leapfrog Works window, along with a link to view the uploaded file.

---

**Uploading Saved Scenes**

To upload one of the scenes in the **Saved Scenes and Movies** folder, right-click on the scene and select **Upload to View**. The process is the same as described in **Uploading the 3D View** above.

**Troubleshooting Connectivity Issues**

Leapfrog Start checks to see if your network will support the connection of Leapfrog web-based services to your desktop applications. If you are having trouble with your connection to View, see **Checking Connectivity with Leapfrog Start**.

**Reporting a Problem**

If Leapfrog Works encounters an error, the **Leapfrog Works Problem** window will be displayed. Enter as much information as you can about the problem, then click **Send**.

© 2017 ARANZ Geo Limited t/a Seequent
Getting Support

Technical support is available by visiting https://my.leapfrog3d.com/support/new-request.

Checking Connectivity with Leapfrog Start

Leapfrog Start checks to see if your network will support the connection of Leapfrog web-based services to your desktop applications. To run Leapfrog Start, click on the Leapfrog Works menu and select Test Web Services:

Suppling Your Licence Details

When contacting technical support, please include your licence number and a full description of the problem or query, including any information provided in system error messages.

You can access your licence information by selecting About from the Leapfrog Works menu:
You may also be asked to provide a copy of the log files. To find out where these are stored, select **About** from the **Leapfrog Works** menu, then click on the **System Info** tab. Click on the link to open the folder that contains the log files:
Concepts

This section describes important Leapfrog Works concepts:

- **What is Implicit Modelling?** provides an introduction to the advantages implicit modelling brings to the geological modelling world.
- **Surfaces** describes the different types of surfaces in Leapfrog Works and important concepts such as surface resolution. It also describes the different tools for working with surfaces that are available in a Leapfrog Works project.
- **Boundaries** describes the different boundaries and their uses, including defining a topography that can be used as an upper boundary for models.
- Leapfrog Works's powerful 3D interpolation engine can interpolate any numeric data (e.g. ore grade or piezometric head measurements) to describe how a real, numerical quantity varies in three dimensional space. **Interpolant Functions** provides a brief introduction to interpolation.
What is Implicit Modelling?
Implicit modelling is a game-changing innovation in geological modelling.

Traditionally, geological models are produced using a manual drawing process. Sections are defined, and lithologies, faults and veins are drawn on the sections. Lines are then drawn to connect surfaces across multiple sections. Modelling geology in this manner is time-consuming and inflexible as it is difficult to update the model when more data becomes available. Early assumptions that later are proved incorrect could shape a model in a way that is never corrected because of the effort involved in starting over. Instead of using their knowledge to reveal important information about the study site, geologists spend significant proportions of their time engaged in mechanical drawing.

Implicit modelling, on the other hand, allows geologists to spend more time thinking about the geology. Implicit modelling eliminates the laborious legwork by using mathematical tools to derive the model from the data. A mathematical construct is built that can be used to visualise different aspects of the data in 3D. Leapfrog Works uses FastRBF™, a mathematical algorithm developed from radial basis functions. FastRBF uses the data and parameters supplied by the geologist to derive any one of a number of variables to be modelled. Discrete variables such as lithologies can be used to construct surfaces, as well as continuous variables such as ore grades.

Instead of presenting a model constructed from rigid geometric constructs, the visualisations echo the natural forms found in reality.

What are the Advantages of Implicit Modelling?
Implicit models are easy to keep up-to-date with the latest data. New borehole data can quickly be integrated, instead of taking weeks or longer manually modifying the model.

Implicit modelling allows several alternative hypothetical models to be produced from the data, quickly and easily. New data that affects the model, even in very significant or fundamental ways, can be assimilated and integrated with little effort. Models can be built rapidly, which means that a range of geological interpretations can be continually tested.

Because less effort is involved in creating a model, more time is available to spend on understanding the geology and studying more complex details such as faulting, stratigraphic sequences, trends and veins. The model can be developed to reflect reality to a greater degree of precision than was previously possible.

Geological risk is reduced when modelling is done implicitly. With traditional modelling, the effort involved means that the first model developed may be held to as the ground truth, despite mounting evidence that may discredit it. Instead, implicit modelling supports an approach that follows the proven scientific method, developing hypothetical models, experimenting to find new data to corroborate or discredit models and, ultimately, allowing the best model to be revealed. A geologist can experiment with alternative parameters at the limits of what is geologically reasonable to determine if there is any significant variation in the resulting models, which can then bracket the model with conceptual error bars. Geostatistical analysis can be conducted to identify what models are the most valid.
It is easy to change your mind when modelling implicitly. Perhaps models have been produced demonstrating isometric shells enclosing specific grades of ore. Commodity price changes then make it desirable to recreate the model using alternative ore grade values. If the model had been produced manually, doing so would not be practical. But with implicit modelling, the ease of generating a new model with new interpolation parameters means this valuable business information can be readily produced.

New questions can be answered more easily. A model tends to answer one question or class of questions well, and new questions require new models. If a model takes months to produce, those new questions may remain forever unanswered. If it can be produced with only days or hours worth of effort, valuable insights can be gained that could provide critical business value.

**Implicit Modelling Makes Assumptions Explicit**

Often, there is insufficient information in the data alone. For instance, borehole data may well need to be supplemented with known details about the geology. When a geologist is constructing a model using traditional techniques, they use their knowledge of the geology to make decisions about the model as it is constructed. This is something the geologist will do automatically, which irretrievably conflates measured data with hypothesised data, hiding away subjective assumptions that have influenced the development of the model.

Implicit modelling, however, keeps the measured data separate from interpretations. The geologist can use polylines and structural disks to interpret the data without equating them to measured data. Implicit modelling makes assumptions explicit; there is a clear separation between hard data and user-introduced interpretations.

Implicit modelling and the presentation of a selection of models communicating different aspects of the geology provide new tools a geologist can use to communicate with professionals in other parts of the business.

On a purely business level, specialist staff can be putting their skills to use in productive, valuable geological modelling, rather than drawing lines on sections ad infinitum.

Implicit models are more repeatable and, therefore, more auditable, because they are derived from actual data and explicitly communicated geological interpretations, with selected parametric variables as inputs and processed using a mathematical algorithm.

The only thing implied in implicit modelling is the unknown value between two known values. Everything else is explicit. For this reason, it is best to refer to traditional modelling techniques as ‘traditional modelling’ rather than ‘explicit modelling’, assuming that it should be labelled with a name that is the inverse of ‘implicit modelling’. Implicit modelling is much more explicit than traditional modelling.

**Best Practices**

- **Analyse data.** Analyse your data using Leapfrog Works’s borehole interpretation and data visualisation tools. Use 3D visualisation to look for errors in the data set.
- **Stay focussed.** Produce a model that answers a specific question or addresses a specific problem. Don’t unnecessarily model all the data available just because it is there. When a new question is asked, produce a model that answers that question using the necessary data.
Experiment and explore. Produce variations of the same model, or even models, using quite different fundamental assumptions. Plan boreholes that will help reveal what model fits best and then discard models that are inconsistent with new data.

Understand risk. Model using a range of input parameters and assumptions to understand the level of geologic risk.

Share. Discuss and explore alternatives.

Adapt. Previously, the effort of production and review of traditional models meant that there is reluctance to rebuild a model when new data becomes available soon after model completion. However, with implicit modelling, you should integrate new data and refine the model as soon as the new data is available. The revised model could indicate that planned activities should be redirected as expensive resources would be wasted persisting with the original plan, for little return.

Evaluate and review. Don't assume that because it's easy to generate a model that you have quickly produced the right model. Understanding the geology is vital for validating the model and producing something that is geologically reasonable.
Surfaces

In Leapfrog Works, meshes are used to represent surfaces in the form of vertices and triangles that define the 3D shape of the surface. Meshes can be open or closed.

Meshes are generated as part of the model-building process, but can also be imported into a project or created directly in the project. Leapfrog Works has several tools for adjusting meshes.

This section describes different aspects of working with surfaces in Leapfrog Works.

Surface Resolution in Leapfrog Works

In Leapfrog Works, meshes are used to represent surfaces in the form of vertices and triangles that define the 3D shape of the surface. The resolution of a surface is controlled by the size of the triangles used to create a surface. A lower surface resolution value means smaller triangles and, therefore, a finer resolution. A higher surface resolution value will take less time to process but the surface may not show the level of detail required.

When a surface is imported, Leapfrog Works automatically sets a surface resolution based on the information in the file. It is not possible to change the resolution of surfaces imported into Leapfrog Works. The exception is elevation grids (see Importing an Elevation Grid).

When surfaces are created, Leapfrog Works sets a default resolution based on the data available. You can set a lower value, but calculations will take longer. In addition, the resolution for many surfaces can be adaptive; that is, areas closer to data will have a finer resolution than areas further away from data.

To see the effect of different resolution settings, consider a simple geological model of three rock types. Here, the surface resolution is set to 50 and the adaptive isosurfercer is disabled:
Here, the resolution has been reduced, which results in smaller triangles:

For both resolution settings above, the triangles are the same size everywhere in each surface, even where real data is available. Once the adaptive isosurfacer has been enabled, the triangles closer to the boreholes are smaller than those further away:

Areas of the surface that have large triangles indicate that there is less data in those areas to guide the interpolation of the surface.

In Leapfrog Works, the resolution for different types of surfaces can be controlled as follows:

- For geological models, a resolution can be set for the model as a whole, but individual surfaces can have different settings. See Surface Resolution for a Geological Model.
- For interpolants, the resolution of the output isosurfaces is controlled by a single setting that can be overridden for individual surfaces. See Output Settings for an RBF Interpolant.
- The resolution can be changed for editable interpolated meshes and can be adaptive. See Interpolated Meshes.
- When the topography has been defined using multiple data sources, the resolution can be set and the adaptive option is available. See Changing Topography Settings.
Adding Data to Surfaces

Many surfaces can be refined by adding points, structural data, GIS data and polylines. If a surface can be modified in this way, an **Add** menu will appear for the object when you right-click on it in the project tree. For example, the **Add** menu for this contact surface shows the data types that can be used to refine the surface:

Select the type of data you wish to use to modify the surface. Leapfrog Works will display all the suitable objects in the project. Select the required object and click **OK**. A hyperlink to the added data will appear under the surface in the project tree. The added data can be removed from the surface by expanding the surface in the project tree, then right-clicking on the hyperlinked data object and selecting **Remove**.

**Contact Honouring**

In Leapfrog Works, surfaces can be created from borehole data, points data, structural data, GIS data and polylines. When surfaces are created from several different objects, it may be desirable to snap the surface to some data objects but not to others.

There are several options for snapping surfaces to data:

- **Off**. The surface does not snap to the data used to create it.
- **All data**. The surface snaps to data within the **Maximum snap distance**, which includes borehole data and any data added to the surface.
- **Drilling only**. The surface snaps to borehole data and data objects derived from borehole data within the **Maximum snap distance** but not to other data used to modify the surface. For example, the surface will honour points data derived from borehole data, but not points data imported into the Points folder.
- **Custom**. The surface snaps to selected data objects within the **Maximum snap distance**.

Snapping to data is off by default. Although you can snap to all data, doing so is not recommended as it increases the possibility that errors in the data or assumptions inherent in interpretations (e.g. polylines) will cause distortions in the meshes. If you do enable snapping, is best to snap only to drilling data.
For example, here the **Snap to data** has been set to **Drilling only** for a mesh created from multiple data objects:

![Image of Snap to data settings in Leapfrog Works](image1)

Note that the only objects **Snap** is enabled for are the contacts derived from borehole data.

Here, **Snap to data** has been set to **Custom**, which makes it possible to enable **Snap** for only the selected data objects:

![Image of Custom Snap settings in Leapfrog Works](image2)

In Leapfrog Works, the snap settings for different types of surfaces can be controlled as follows:

- For geological models, **Snap to data** can be set for the model as a whole, but individual surfaces can have different settings. For more information, see:
  - [Editing a Geological Model](#)
  - [Surfacing Options for Deposits and Erosions](#)
  - [Surfacing Options for Intrusions](#)
  - [Surfacing Options for Veins](#)
Global Trends

In Leapfrog Works, many surfaces can be adjusted by applying a trend to the surface. To do this, add the surface you wish to adjust to the scene so that it can be used in setting the trend. Double-click on the surface in the project tree and select the Trend tab. Here, the Trend tab is displayed for a contact surface:

Often the easiest way to apply a trend is to click on the Draw plane line button ( ) and draw a plane line in the scene in the direction in which you wish to adjust the surface. You may need to rotate the scene to see the plane properly.

The Ellipsoid Ratios determine the relative shape and strength of the ellipsoids in the scene, where:

- The Maximum value is the relative strength in the direction of the green line on the moving plane.
- The Intermed. value is the relative strength in the direction perpendicular to the green line on the moving plane.
- The Minimum value is the relative strength in the direction orthogonal to the plane.

Once you have adjusted the plane to represent the trend you wish to use, click the Set From Plane button to copy the moving plane settings.

The Set to list contains a number of different options Leapfrog Works has generated based on the data used in the project. Isotropic is the default option used when the surface was created. Settings made to other surfaces in the project will also be listed, which makes it easy to apply the same settings to many surfaces.

Click OK to apply the changes.
How the moving plane can be used to adjust a surface in this manner is illustrated by the following intrusive contact surface:

The intrusion surface has two bodies that are not connected, and we can apply a trend to connect the two parts. Here, the intrusion surface has been hidden in the scene and the scene rotated to line up the QzP segments. A plane line can then be drawn through the QzP segments:

Using the plane settings to adjust the surface results in the two parts of the intrusion joining up:
Structural Trends

Structural trends create a flat ellipsoid anisotropy that varies in direction with its inputs. This topic describes working with structural trends. It is divided into:

- Creating a Structural Trend
- Displaying a Structural Trend
- Applying a Structural Trend

Creating a Structural Trend

To create a new structural trend, right-click on the Structural Trends folder (in the Structural Modelling folder) and select New Structural Trend. The Structural Trend window will appear:

![Structural Trend window](image)

Structural trends can be created from surfaces and from structural data. Click Add to select from the suitable inputs available in the project. The list of inputs will be displayed:

![Select Trend Inputs](image)
Tick the box for each input required, then click OK. The selected inputs will be added to the **Structural Trend** window:

![Structural Trend window](image)

The **Strength** parameter determines the shape of the ellipsoid, and the **Range** parameter indicates how far the influence of this mesh reaches. If the **Trend Type** is **Non-decaying**, the distance from the mesh no longer affects the anisotropy and the **Range** value cannot be set.

Trends that are **Strongest along meshes** or **Blending** can include a global trend. To set this, click on the **Global Mean Trend** tab.

![Global Mean Trend tab](image)

You can enter the trend manually or add the moving plane to the scene and set the trend using the moving plane, as described in **Global Trends**.

Enter a **Name** for the trend and click **OK**. The new trend will appear under the **Structural Trends** folder.
Displaying a Structural Trend

When displayed in the scene, the trend is shown using disks placed on a regular grid:

The orientation of the disk gives the direction of the anisotropy. The size of a disk is proportional to the anisotropy strength. Where there are no disks (or the size is very small) the trend is isotropic.

If the **Trend Type** is set to **Non-decaying**, the distance from the mesh no longer affects the anisotropy and all disks have the same size:

The **Blending** option requires multiple meshes and blends them according to their individual strength settings. A trend with higher strength makes a stronger impact on the blending. The blended trend is of decaying-type, and its strength weakens further away from the mesh.
Applying a Structural Trend
To apply a structural trend to an interpolated editable mesh or an interpolant, double-click on the object in the project tree and click on the Trend tab:

To apply a structural trend to an intrusion contact surface, enable **Show additional surfacing options** in the Surfacing tab, then click on the Trend tab.

Click on **Structural Trend**, then select the required trend from the list. Click **OK** to apply the trend to the surface.

When a structural trend is applied, surfaces may appear distorted further away from the data:
Editing Surfaces with Polylines

In Leapfrog Works, many surfaces can be edited using polylines, including contact surfaces, geological model extents and editable meshes.

To edit a surface with a polyline, it is a good idea to first add the object you wish to edit to the scene and draw a slice across the scene where you plan to edit the surface. Next, right-click on the surface in the project tree and select **Edit > With Polyline**.

The drawing toolbar will appear for the type of polyline selected and a new polyline will be added to the scene. Draw the polyline and adjust it as described in **Drawing in the Scene**, then click the **Save** button (✓) to view the effect of the polyline on the surface. To remove the polyline from the surface, expand the surface in the project tree. Right-click on the polyline object and select **Remove**.

In cases where you have existing polyline edits (control points), you can import them and add them to the surface. To do this, import the polylines to the **Polylines** folder, then add them to the surface by right-clicking on the surface and selecting **Add > Polyline**.

If this is the case, experiment with the **Outside value** setting. The **Outside value** is the long-range mean value of the data. Setting a value of -1 for intrusions (where the positive values are on the inside) and +1 for other surfaces will result in a smoother surface in most cases. For example, here, the **Outside value** has been set to -1 for this intrusion, resulting in a much smoother surface:

© 2017 ARANZ Geo Limited t/a Seequent
How a polyline can be used to edit a surface can be illustrated by the following surface, where a small volume is disconnected from the main surface:

First, a slice is drawn through the surface where it will be edited:

Next, a polyline is created, using two lines to represent contacts that link up the surfaces:
When the polyline edits are saved, the surface is updated to reflect the edits:

It is best to keep polyline edits to a minimum, as small edits can have significant effects on the shapes of surfaces.

If editing a surface with a polyline results in a distorted surface, use the surface and normal ribbons to check the orientation of the polyline and its segments. See Tangents and Ribbons for more information.

When you save the polyline, the object will be updated to reflect the additional points. The polyline will be added to the project tree as part of the object that was edited. You can edit the polyline by double-clicking on it or by right-clicking and selecting Edit Polyline.

Editing Surfaces with Structural Data

In Leapfrog Works, many surfaces can be edited using planar structural data points drawn in the scene. Surfaces that can be edited in this way include contact surfaces, model extents and interpolated editable meshes. There are two ways to do this:

- If you have a structural data table created in or imported into Leapfrog Works that you want to use to adjust the surface, right-click on the surface in the project tree and select Add > Structural Data. You will be prompted to select from the structural data tables available in the project.
- If you want to create structural data points to use to adjust the surface, right-click on the surface in the project tree and select Edit > With Structural Data.
To edit a surface with structural data using the second option, it is a good idea to first add the object you wish to edit to the scene. Next, right-click on the surface in the project tree and select the **Edit > With Structural Data** option.

The structural data toolbar will appear and a new structural data object will be added to the scene. Draw the structural data points and adjust them as described in [Creating New Planar Structural Data Tables](#), then click the **Save** button (●) to view the effect on the surface. Structural data tables created in this way cannot be used by other objects in the project until the table has been shared. To do this, right-click on the table in the project tree and select **Share**. The structural data table will be saved to the **Structural Modelling** folder.

To remove the structural data from the surface, expand the surface in the project tree. Right-click on the structural data object and select **Remove**.

### Extending a Surface

Geological models created in a Leapfrog Works project automatically use the defined topography as an upper boundary. If a model is defined that extends outside the topography, an error will occur. A similar error occurs when surfaces used in geological models do not extend outside the model’s extents. In all cases, Leapfrog Works cannot process the surface and an error will be displayed.

In this example, an error has occurred during the process of creating a geological model because the topography (yellow) does not enclose the model extents (pink):
In order for Leapfrog Works to be able to divide the model into separate volumes, the topography needs to be extended to enclose the model’s boundary or the model’s boundary needs to be restricted so it falls inside the topography. When the model is processed, the following error results:

The solutions proposed will depend upon the data used to create the surfaces that conflict, but fall into three broad categories:

- Reduce the size of the model’s or interpolant’s extents. Click the Edit Extents button. This will open the object’s Boundary window and you can change the boundary.

- Enlarge the topography by manually adjusting it. Click on the Edit Topography Extents button. This option is only available when the topography has been created from more than one data source. See Adding Height Data to the Topography and Changing Topography Settings.

- Use the surface’s vertices to create the boundary or contact with extents large enough to be used in the model or interpolant. Click the Use Vertices button to create a new vertices object and use it as the source data for the boundary or contact.

If you have a solution to the problem that is not covered by the options presented, click Do Nothing. For example:

- If the topography is not large enough, there may be additional data available. If it is not already in the project, import the data and add it to the topography as described in Adding Height Data to the Topography.

- If a surface being used to define a contact surface or boundary in a geological model or interpolant is not large enough, you can add additional data to the surface.

Using vertices to create the boundary or contact results in the creation of a new points object that will be saved in the Points folder.
In the case of using topography vertices as an upper boundary, the vertices will be applied as a lateral extent and the defined topography will not be used. For example, here the geological model does not use the defined topography but instead uses the “GM: Topography” surface created from the vertices:

![Geological Model - GM](image)

Using topography vertices can take some time to process.

An additional disadvantage to using vertices is that the vertices object created is not linked to the original object. When the object used to create the vertices changes, the vertices will not be updated.
**Boundaries**

A newly-created project has only a basic set of X-Y-Z coordinates, and the coordinate system used by the project is determined by the data imported to the project. It is not necessary to specify what coordinate system is used; however, it is necessary to ensure that data you import into the project uses the same coordinate system.

Leapfrog Works is unit-less and adopts the units used in the data you import. For example, if your imported data is in metres, the units displayed will be metres, and figures such as resolution, measured distances and slicer thickness will be in metres. It is important, therefore, to be consistent in the units used in the data you import. If you are importing data that uses different coordinate systems, you will need to pre-process the data so that it is using the same coordinate system.

Often the best way to set the coordinates for the project as a whole is to import a map or aerial photo. Adding georeference data to a map will set the location of the map in three-dimensional space and set the coordinates for the project. See [Importing a Map or Image](#) for more information.

An important consideration in defining the project space is setting the clipping boundary. See **The Clipping Boundary**.

It is not necessary to define a topography to model in Leapfrog Works, but a defined topography can be used as an upper boundary for all models built in the project. See [Defining a Topography](#).

Part of creating many objects in Leapfrog Works is defining the basic rectangular boundary that defines the object’s extents. See [Object Extents](#).

You can modify the extents of geological models and interpolants using surfaces created from different types of data. See [Modifying a Geological Model’s Boundary](#) and [Modifying an RBF Interpolant’s Boundary with Lateral Extents](#).

**The Clipping Boundary**

An important consideration in defining the project space is setting the clipping boundary.

The default clipping boundary in a new project file encompasses everything in the project and grows as more data is added to the project. It is not necessary to set the clipping boundary. However, the clipping boundary defines the limits of the X-Y coordinates for the region in which data will be imported and models built and so defines the region in which calculations are made. Restricting the size of the clipping boundary limits the area in which calculations are made and is especially important if you are working with a large dataset.

The best way to set the clipping boundary is using an imported map or aerial photo, as this provides a visual reference that is helpful in working with data added to the project in the future. GIS data or borehole data can also be used to set the clipping boundary.

To set the clipping boundary, add to the scene the objects you wish to reference in setting the boundary. Right-click on the **Topographies** folder or on the **GIS Data, Maps and Photos** folder...
and select **Set Clipping Boundary**. The **Set Clipping Boundary** window will be displayed, together with controls in the scene you can use to resize the clipping boundary:

There are three ways to define the rectangular clipping boundary:

- Enter the coordinates.
- Select **Enclose Object** and choose from the list of objects in the project. The clipping boundary will be updated using the selected object.
- Use the controls that appear in the scene. The orange handle adjusts the corner of the clipping boundary and the red handles adjusts its size.

When you have finished adjusting the clipping boundary, click **OK**.

If you are going to import elevation data and use it to create a topography, it is important to set the clipping boundary before creating the topography. For example, here a map has been imported and a topography (yellow) created from an elevation grid. The map is displayed draped on the topography:

The red arrows and orange handle show the clipping boundary, which has been allowed to expand to encompass all data imported to the project. Because the topography was created before the clipping boundary was set, all the data in the imported elevation grid has been used and the resulting topography is larger than might be practical. Clearly, if the intention is to model within the area on the map, the clipping boundary should be limited to the region indicated by the map.
If the map is the only object in the project, it can easily be used to set the clipping boundary by selecting <Everything> from the Enclose Object list:

This results in a clipping boundary that is limited to the extents of the map:

Once the clipping boundary has been set, further data imported into the project will be clipped to it. For example, importing the elevation grid and using it to create a topography only after the clipping boundary has been set to the map extents will result in a topography (with the map draped) that looks like this:

Once the clipping boundary has been set, a good next step is defining the topography. See Defining a Topography.
Defining a Topography

It is not necessary to define a topography to model in Leapfrog Works, but a defined topography can be used as an upper boundary for all models built in the project.

A key advantage of defining a topography is that it provides consistent elevation data for objects imported to and created in the project. The quality of elevation information can be poor compared to X- and Y-coordinates, which can create problems when using objects to build a model. A topography can be created from the most reliable elevation data, and other objects can have elevation set from this topography.

An important consideration when defining the topography is ensuring that it is large enough to encompass the models you will be building in the project. If you create a small topography but then later create a model that extends outside the topography, you will need to enlarge the topography, which can result in considerable reprocessing of all objects in the project that use the topography as a boundary. See Extending a Surface for more information.

This topic describes creating and working with a topography. It is divided into:

- Topography From Elevation Grid
- Topography From Surfaces, Points or GIS Vector Data
- Fixed Elevation Topography
- Adding Height Data to the Topography
- Changing Topography Settings
  - Changing the Size of the Topography
  - Topography Resolution
  - Applying a Trend to the Topography
- Topography Display Options
- Projecting Collars onto the Topography

The topography can be created from an imported elevation grid, points data, surfaces and GIS data. It is not necessary to decide on a single source of information, as information can be combined, and you can add and remove data as required.

Once defined, you can export the topography as a mesh or as an elevation grid. See:

- Mesh Export
- Elevation Grid Export

Topography From Elevation Grid

There are two ways to create the topography from an elevation grid:

- Right-click on the Topographies folder and select New Topography > Import Elevation Grid. Import the grid as described in Importing an Elevation Grid.
- Import the grid using the Meshes folder and then right-click on the Topographies folder and select New Topography > From Surface.
Enter a name for the topography and click OK. A hyperlink to the elevation grid will appear in the Topographies folder under the defined topography.

Once the topography has been defined, additional height data can be added by right-clicking on the topography and selecting from the options available. See "Adding Height Data to the Topography" for more information.

Topography From Surfaces, Points or GIS Vector Data

To create the topography from a surface, points or GIS data, first import the data into the project.
- Import surfaces into the Meshes folder.
- Import borehole data into the project or points data into the Points folder.
- Import GIS vector data into the GIS Data, Maps and Photos folder.

Next, right-click on the Topographies folder and select one of the New Topography options. A list of suitable objects available in the project will be displayed. Select the required object and click OK. Enter a name for the topography and click OK. A hyperlink to the source object will appear in the Topographies folder under the defined topography.

Once the topography has been defined, additional height data can be added by right-clicking on the topography and selecting from the options available. See "Adding Height Data to the Topography" for more information.

See also Changing Topography Settings below.

Fixed Elevation Topography

If you don’t have any data suitable for creating a topography, you can set a fixed elevation. To do this, right-click on the Topographies folder and select New Topography > Fixed Elevation. In the window that appears, enter a value for the elevation and click OK. Enter a name for the new topography and click OK.

The new topography will appear in the project tree under the Topographies folder.

Once a topography has been defined, the only way to set a fixed elevation is to remove the objects that have been used to define the topography. To do this, right-click on the hyperlinked object and click Remove. You will then be able to set a fixed elevation for the topography.
Adding Height Data to the Topography

When creating the topography, it is not necessary to decide on a single source of information, as information can be combined. Once the topography has been defined, additional height data can be added by right-clicking on the topography and selecting from the options available:

For points, surfaces and GIS vector data, you will be prompted to select from the data sources available in the project. For an elevation grid, see Importing an Elevation Grid.

All data objects used to define the topography will appear under the topography, hyperlinked to their parent objects:

When you have added data to the topography, you may need to enlarge the topography extents. See Changing Topography Settings below.

To remove data objects from the topography, either:

- Delete the object from the topography. To do this, right-click on the hyperlinked object and click Remove.
- Delete the object from the project. If you choose this option, consider carefully the effects on other objects in the project, as once an object is deleted, it cannot be recovered.

When the topography is defined from multiple objects, you can set the resolution of the topography by double-clicking on it. See Changing Topography Settings below.

Changing Topography Settings

When the topography is created from points or GIS data or when the topography is created by combining data, you can change its boundary and resolution and apply a trend. To do this,
double-click on the topography in the project tree. The **Edit Topography** window will appear:

![Edit Topography window](image)

**Changing the Size of the Topography**

In the **General** tab, you can change the topography extents. Use the controls in the scene or enter the required values in the **Bounding Box** fields.

**Topography Resolution**

The resolution of the topography depends on how it was created.

- When the topography is created from a single mesh, the resolution of the topography is set from the resolution of the mesh and can only be changed when the mesh is imported. If you wish to change the resolution of the topography, you must first add more height data to the topography. See [Adding Height Data to the Topography](#).

- When the topography is created by setting a fixed elevation, the resolution cannot be set.

When the topography is created from points or GIS data or when the topography is created from combining data, you can set its resolution in the **Edit Topography** window.

When you set a specific **Surface resolution** without enabling the **Adaptive** option, the triangles used will be the same size for the whole topography. When you enable the **Adaptive** option, the resolution of the topography will be affected by the availability and density of real data. See [Surface Resolution in Leapfrog Works](#) for more information on these settings.
Applying a Trend to the Topography

In the **Trend** tab, you can apply a trend to the topography:

![Edit Topography window](image)

See [Global Trends](#) for more information.

**Topography Display Options**

To display the topography in the scene window, either:

- Right-click on the topography in the project tree and select **View Object**.
- Click on the topography object and drag it into the scene.

The topography will be displayed in the scene window and in the shape list:
The topography object in the shape list provides additional controls that can be used to change the way the topography is displayed and highlight features of interest. For example, selecting an imported map from the list results in it being displayed draped onto the topography:

The list is organised into:

- **Views.** This contains options for creating and editing custom topography views and also lists any views already defined. With custom topography views, you can view multiple GIS objects, maps and contours. See [Custom Topography Views](#) for more information.

- **Maps and Photos.** This lists all images stored in the GIS Data, Maps and Photos folder.

- **GIS objects.** This lists all GIS data objects stored in the GIS Data, Maps and Photos folder.

### Projecting Collars onto the Topography

If the collars are not lying on the topography, Leapfrog Works can make adjustments to the collar depth values so that the collars lie on the topography. This adjustment is reversible.

To make this adjustment, right-click on the collars table and tick the box for the **Project Collars Onto Topography** option. If you then open the collar table, the depth values will reflect the topography. Right-click on the collar table and untick the box for **Project Collars Onto Topography** to return to the uncorrected collar depth values.

### Object Extents

Part of creating many objects in Leapfrog Works is defining the basic rectangular boundary that defines the object’s extents. There are generally two options for defining an object’s extents:

- The first option is to define extents that are independent of other objects in the project. You can do this by entering coordinates or adjusting controls in the scene to set the size and shape of the extents. The new object’s extents are fixed to the specified size. This is a good choice if, for example, you are building a geological model from a map and wish to define the model extents based on information on the map.

- The second option is to define extents based on other objects in the project. This is done by selecting the other object from the **Enclose Object** list that appears in many Leapfrog Works screens.

For both methods, the new object’s extents are fixed to the selected size. Using the **Enclose Object** list does not link the two objects; it is simply using the X-Y-Z coordinates of the original object as the basis for the new extents.
When creating some objects, you have the option of sharing extents with another object. This is the case with editable meshes ( ), where you can choose whether the mesh has its own extents or shares extents with other objects in the project. Shared extents are updated when the original object’s extents are updated.

If you are unsure about relationships between objects, expand them in the project tree to view more information. Here, two meshes have been defined from the same set of points:

The first mesh shares its extents with another object in the project, which is indicated by the hyperlink. The second mesh has no hyperlink; it has its own extents that are not updated by other objects in the project.

Geological models and interpolants are created with a basic set of rectangular extents that can then be refined by adding extents created from other data in the project. Creating extents is a useful way of restricting modelling to a particular area of interest. For example, modelling can be restricted to a known distance from borehole data by applying a distance function as a lateral extent. See Modifying a Geological Model’s Boundary for more information.
Interpolant Functions

Leapfrog Works’s powerful 3D interpolation engine can interpolate any numeric data (e.g. ore grade or piezometric head measurements) to describe how a real, numerical quantity varies in three dimensional space. Interpolation produces an estimate or “interpolated value” of a quantity that is not known at a point of interest but is known at other points.

The simplest way to estimate values is to take the average of known values. Using this method, estimated values are the same everywhere, regardless of the distance from known data. However, this is not ideal as it is reasonable to assume that an estimated value will be more heavily influenced by nearby known values than by those that are further away. The estimates for unknown points when varying the distance from known point values is controlled by the interpolant function. Any interpolation function and the various parameters that can be set for each will produce a model that fits all the known values, but they will produce different estimates for the unknown points. It is important to select interpolation functions and parameters that make geologic sense. It may be necessary to identify a location that models predict differently, and plan boreholes to identify the best fit option.

Leapfrog Works uses two main interpolant functions: the spheroidal interpolant function and the linear interpolant function. See The Spheroidal Interpolant Function and The Linear Interpolant Function for more information.

The Spheroidal Interpolant Function

In common cases, including when modelling most metallic ores, there is a finite range beyond which the influence of the data should fall to zero. The spheroidal interpolant function can be used when modelling in these cases.

The spheroidal interpolant function closely resembles a spherical variogram, which has a fixed range beyond which the value is the constant sill. Similarly, the spheroidal interpolant function flattens out when the distance from X is greater than a defined distance, the range. At the range, the function value is 96% of the sill with no nugget, and beyond the range the function asymptotically approaches the sill. The chart below labels the y-axis interpolant. A high value on this axis represents a greater uncertainty relating to the known value, given its distance from X. Another way to think of this is that higher values on this axis represent a decreasing weight given to the known value.
Known values within the range are weighted proportionally to the distance from X. Known values further from X than the range will all be given approximately the same weight, and have about the same influence on the unknown value. Here, points A and B are near X and so have the greatest influence on the estimated value of point X. Points C and D, however, are outside the range, which puts them on the flat part of the spheroidal interpolant curve; they have roughly the same influence on the value of X, and both have significantly less influence than A or B:

The rest of this topic describes the parameters used to define a spheroidal interpolant. These parameters are **Total Sill**, **Nugget**, **Nugget to Total Sill Ratio**, **Base Range**, **Alpha**, **Drift** and **Accuracy**.

To edit the parameters for an interpolant, double-click on the interpolant in the project tree and click on the **Interpolant** tab. The graph on the tab shows how the interpolant function values vary with distance and is updated as you change interpolant parameters:

The yellow line indicates the **Base Range**. For this interpolant, the value of the interpolant is offset by the value of **Nugget**.
**Total Sill**

The **Total Sill** defines the upper limit of the spheroidal interpolant function, where there ceases to be any correlation between values. A spherical variogram reaches the sill at the range and stays there for increasing distances beyond the range. A spheroidal interpolant approaches the sill near the range, and approaches it asymptotically for increasing distances beyond the range. The distinction is insignificant.

**Nugget**

The **Nugget** represents a local anomaly in sampled values, one that is substantially different from what would be predicted at that point, based on the surrounding data. Increasing the value of **Nugget** effectively places more emphasis on the average values of surrounding samples and less on the actual data point, and can be used to reduce noise caused by inaccurately measured samples.

**Nugget to Total Sill Ratio**

It is the **Nugget to Total Sill ratio** that determines the shape of the interpolant function. Multiplying both these parameters by the same constant will result in an identical interpolant. Here, the interpolant on the left has a nugget of 3 and a sill of 10; the one on the right has a nugget of 9 and a sill of 30. Note that because the nugget and sill have been increased by the same factor, the function has the same shape.

**Base Range**

The **Base Range** is the distance at which the interpolant value is 96% of the **Total Sill**, with no **Nugget**. The **Base Range** should be set to a distance that is not significantly less or greater than the distance between boreholes, so it can reach between them. As a rule of thumb, it may be set to approximately twice the average distance between boreholes.
Here the effect of different range settings on the value of X is demonstrated using our trivial example of four boreholes:

When the range is set to 1, it is too small to describe any real effect between boreholes. When the range is set to 30, distant boreholes have more influence, increasing the spatial continuity. Also illustrated is the range set to approximately the average distance between boreholes (range = 4) and the range set to about twice the average distance between boreholes (range = 8). Of these, the range set to 8 might be the best choice.
Alpha

The **Alpha** constant determines how steeply the interpolant rises toward the **Total Sill**. A low **Alpha** value will produce an interpolant function that rises more steeply than a high **Alpha** value. A high **Alpha** value gives points at intermediate distances more weighting, compared to lower **Alpha** values. This figure charts an interpolant function for each alpha setting, using a nugget of 8, sill of 28, and range of 5000. A spherical variogram function is included for comparative purposes. The inset provides a detailed view near the intersection of the sill and range.

An alpha of 9 provides the curve that is closest in shape to a spherical variogram. In ideal situations, it would probably be the first choice; however, high alpha values require more computation and processing time, as more complex approximation calculations are required. A smaller value for alpha will result in shorter times to evaluate the interpolant.

The following demonstrates the difference between alpha = 3 and alpha = 9:

There is a measurable difference between the estimates at the point being examined, but for many purposes, using a lower alpha will result in satisfactory estimates and reduced processing time.
Drift

The Drift is a model of the value distribution away from data. It determines the behaviour a long way from sampled data.

- **Constant**: The interpolant goes to the approximated declustered mean of the data.
- **Linear**: The interpolant behaves linearly away from data, which may result in negative values.
- **None**: The interpolant pulls down to zero away from data.

Here, the three Drift options for the interpolant are shown evaluated on grids:
In this example, the boundary is larger than the extent of the data to illustrate the effect of different Drift settings.

Away from the data, the value of the interpolant when Drift is Constant and Linear is not reasonable in this case, given the distance from the data. The low value when Drift is None is more realistic, given the distance from the data.

If when using the spheroidal interpolant you get a grade shell that fills the model extents, it is likely that the mean value of the data is higher than the threshold chosen for the grade shell in question. If this occurs, try setting the Drift to None.

**Accuracy**

Leapfrog Works estimates the Accuracy from the data values by taking a fraction of the smallest difference between measured data values. Although there is the temptation to set the Accuracy as low as possible, there is little point to specifying an Accuracy significantly smaller than the errors in the measured data. For example, if values are specified to two decimal places, setting the Accuracy to 0.001 is more than adequate. Smaller values will cause the interpolation to run more slowly and will degrade the interpolation result. For example, when recording to two decimals, the range 0.035 to 0.044 will be recorded as 0.04. There is little point in setting the accuracy to plus or minus 0.000001 when intrinsically values are only accurate to plus or minus 0.005.

**The Linear Interpolant Function**

Generally, estimates produced using the linear interpolant will strongly reflect values at nearby points and the linear interpolant is a useful general-purpose interpolant for sparsely and/or irregularly sampled data. It works well for lithology data, but is not appropriate for values with a distinct finite range of influence.

The linear interpolant function is multi-scale, and, therefore, is a good general purpose model. It works well for lithology data, which often has localised pockets of high-resolution data. It can be used to quickly visualise data trends and whether or not compositing or transforming values will be required. It is not appropriate for values with a distinct finite range of influence as it aggressively extrapolates out from the data. Most ore grade data is not well interpolated using a linear interpolant function.
The linear interpolant function simply assumes that known values closer to the point you wish to estimate have a proportionally greater influence than points that are further away:

In the above diagram, points A and B will have the most effect on point X as they are closer to X than points C and D. Using the linear interpolant function in Leapfrog Works gives a value of 7.85, which is between the nearby high grade values of A (10) and B (7). Because of their distance from X, the low grade values at C and D have a much weaker effect on the estimate of point X, and they have not dragged the estimate for X lower.
This topic describes the parameters used to define a linear interpolant. These parameters are **Total Sill and Base Range**, **Nugget**, **Drift** and **Accuracy**.

To edit the parameters for an interpolant, double-click on the interpolant in the project tree and click on the **Interpolant** tab. The graph on the tab shows how the interpolant function values vary with distance and is updated as you change interpolant parameters:

The yellow line indicates the **Base Range**. For this interpolant, the value of the interpolant is offset by the value of **Nugget**.

### Total Sill and Base Range

A linear interpolant has no sill or range in the traditional sense. Instead, the **Total Sill and Base Range** set the slope of the interpolant. The **Base Range** is the distance at which the interpolant value is the **Total Sill**.

### Nugget

The **Nugget** represents a local anomaly in values, one that is substantially different from what would be predicted at that point based on the surrounding data. Increasing the value of **Nugget** effectively places more emphasis on the average values of surrounding samples and less on the actual data point, and can be used to reduce noise caused by inaccurately measured samples.

### Drift

The **Drift** is a model of the value distribution away from data. It determines the behaviour a long way from sampled data.

- **Constant**: The interpolant goes to the approximated declustered mean of the data.
- **Linear**: The interpolant behaves linearly away from data, which may result in negative values.
Here, the two Drift options for the interpolant are shown evaluated on grids:

In this example, the boundary is larger than the extent of the data to illustrate the effect of different Drift settings.

Accuracy
Leapfrog Works estimates the Accuracy from the data values by taking a fraction of the smallest difference between measured data values. Although there is the temptation to set the Accuracy as low as possible, there is little point to specifying an Accuracy significantly smaller than the errors in the measured data. For example, if values are specified to two decimal places, setting the Accuracy to 0.001 is more than adequate. Smaller values will cause the interpolation to run more slowly and will degrade the interpolation result. For example, when recording to two decimals, the range 0.035 to 0.044 will be recorded as 0.04. There is little point in asking Leapfrog Works to match a value to plus or minus 0.000001 when intrinsically that value is only accurate to plus or minus 0.005.
Data Types

This section describes how to import and work with data in Leapfrog Works. The first section describes how to use the table dialog, how to fix errors in data tables and how to build queries. Later sections describe working with the different types of data Leapfrog Works supports.

See Visualising Data in Analysing Data for information about using the shape list and shape properties panel to display data.

Leapfrog Works is unit-less and adopts the units used in the data you import. For example, if your imported data is in metres, the units displayed will be metres, and figures such as resolution, measured distances and slicer thickness will be in metres. It is important, therefore, to be consistent in the units used in the data you import. If you are importing data that uses different coordinate systems, you will need to pre-process the data so that it is using the same coordinate system.

The Table Dialog

To view the contents of a data table, double-click on it in the project tree. The Table window will appear:

Click on Query to open up the query editor. See Query Filters for more information on how to build and use queries.

If the Ignored column is ticked, then Leapfrog Works completely ignores that row, as though it had been deleted. This is useful for suppressing erroneous data from being processed. If a hole in a collar table is ignored, then all other data associated with that hole (e.g. surveys and interval measurements) are also ignored.

Collar tables have a trench column that indicates whether or not the borehole is from a trench. When the trench column is ticked for a borehole, the trench will be desurveyed in a different manner from other boreholes.

Survey tables have Compatibility options for changing the desurveying method for the survey table as a whole. See Survey Table Options for more information.
Correcting Data Errors

Leapfrog Works automatically identifies and flags common data errors when data tables are imported. There are three ways Leapfrog Works marks tables that contain conflicts or errors:

- Tables marked with a red X (📅) contain errors that mean data cannot be used for processing. These errors can be corrected by opening the Database Errors window, which is described in Correcting Errors in Leapfrog Works.
- Numeric data columns marked with a red X (📅) contain non-numeric values, which means that the rules that are used to handle non-numeric and negative values need to be reviewed. If a table has data that contain non-numeric and negative values, the affected rows cannot be used for further processing until the rules are verified, which is described in Special Values.
- Tables marked with a yellow exclamation mark (⚠️) contain warnings. Affected rows can be used for further processing, but the information in the warning can indicate that the data requires further attention. For example, if a warning indicates there is data missing for a borehole defined in the collar table, it may be that a borehole has been duplicated or that not all required data files have been loaded. Warnings are listed along with table errors in the Database Errors window.

Until errors are corrected, the rows that contain those errors are excluded for all processing that uses the table, including viewing in the scene. For example, if the ID for a collar position contains an invalid coordinate, that collar will not be displayed in the scene as its location is not known. Likewise, any processing will ignore data associated with this borehole.

It is worth correcting errors as soon as possible, as correcting them later can result in significant recomputation time.

When a table contains errors and warnings, only the errors will be apparent in the project tree view. However, all errors and warnings relevant to a particular table will be displayed in the Database Errors window.

There are two approaches to correcting errors in data:

- Correct the data in the primary source. Export the errors as described in Exporting Data Errors. Then, when the errors have been corrected, reload the borehole data as described in Reloading Borehole Data.
- Correct the data in Leapfrog Works. If you need a record of corrected errors, first export the errors as described in Exporting Data Errors. Then correct errors as described in Correcting Errors in Leapfrog Works.

Exporting Data Errors

If you need a record of corrected errors, first export the errors. This must be done first, as once errors have been corrected in Leapfrog Works, they cannot be exported, as they no longer exist.
There are two options for exporting borehole data errors:

- Export all errors in the borehole data set.
- Export only the errors from a single table.

To export all errors in the borehole data, right-click on the Boreholes object and select Export Errors. The Export Borehole Errors window will appear:

The list shows the files that will be created, one for each table that contains errors. Choose a folder where the files will be saved, then enter a Base file name, which will be added to the front of each file name.

Click Export to export the error files.

To export errors from a single table, right-click on that table and select Export Errors. Choose a location where the file will be saved and click Save.

Correcting Errors in Leapfrog Works

If you require a record of the errors in borehole data, export the errors as described in Exporting Data Errors before starting to correct the errors in Leapfrog Works.

To correct errors in a data table, right-click on the table and select Fix Errors. The Errors window will appear. Expand the list to view the details of the selected error:

When a row that contains an error is selected, a red box indicates the source of the error.

Errors are automatically grouped by Type. If there are many errors, you may find it useful to view them grouped by Table or HoleID. You can change the size of the Errors window and the
columns in the table to view more information easily. When you have finished fixing errors, click the Save button ( ). Leapfrog Works will then update the database.

There are many possible sources of errors. Some useful techniques for fixing errors are:

- Checking for Missing Files
- Ignoring Errors
- Ignoring Duplicates (Points Data Tables)
- Modifying Data
- Fixing Collar Max Depths (Borehole Data Tables)
- Replacing All
- Replacing a Selection

**Checking for Missing Files**
Sometimes data is spread across several files and not all files have been imported. When you have many errors in freshly imported data, make sure that all necessary files have been imported.

**Ignoring Errors**
Ticking the Ignored box for a row results in that row being omitted from all processing, as though it has been deleted.

**Ignoring Duplicates (Points Data Tables)**
In points data tables, duplicates rows will be flagged as errors. Click the Ignore Duplicates button ( ). When you save the table, all duplicate rows will be marked as ignored.

**Modifying Data**
You can double click on any cell to edit its contents, except for the id column. If the cell you wish to edit is already selected, press the space bar to start editing.

Changes made to data in this way are immediately saved to the database.

**Fixing Collar Max Depths (Borehole Data Tables)**
In borehole data tables, if there is a borehole segment that falls beyond the maximum depth defined in the collar table, a maxdepth exceeded error will be reported. To fix this error, click on the Fix Max Depths button ( ). This results in the collar table being updated with a maximum depth value that reflects the data in the interval tables.
Replacing All

With Replace All, you can replace an incorrect value that occurs multiple times in a column. To do this, click the Replace All button. Select the Column to search and enter the new value:

Click Replace All Occurrences to make the changes.

Replacing a Selection

You can also select a number of rows and replace values in a selected column with a single value. To do this, use the Shift and Ctrl keys to select the rows you wish to edit, then click the Edit button and select Write to Selected Rows:

In the fields that appear, enter the New value, then click the Write to Selected Rows button:
Special Values

Assay data often contains special values to represent different situations, such as grade values that are below a detection limit, cores that have been lost or segments that were not sampled. In addition, it is not uncommon for a borehole to contain some intervals that have no values.

When borehole data tables and points data are imported, Leapfrog Works will mark columns containing non-numeric special values and missing intervals so that you can review these missing and non-numeric values and determine how Leapfrog Works will handle them. For example, here numeric data columns that contain errors are marked with a red X:

To review these errors, double-click on the column. The **Invalid Value Handling** window will appear:

Leapfrog Works will automatically set missing and non-numeric intervals to be omitted from further processing. Negative values are automatically set to **keep**. To change the **Action**, select another action from the list:

- Select **replace** to enter a numeric value to be used for further processing.
- Select **keep** to use a negative value in further processing.
For non-numeric and negative values, all values are initially treated as a single rule. However, if values have different meanings, you can define specific rules to determine how each value is handled. To do this, click on the Add Rule button. The window that appears will show the values present in the data. To define a new rule for a specific value:

- Select that value in the list.
-Tick the box for The value I want is not in the list.
- Enter the Value.
- Click OK.

In the Invalid Value Handling window, the value will be listed separately and you can choose the Action to apply.

Once you have reviewed the rules that will be applied to the column, tick the These rules have been reviewed box and click OK. The rules will be applied and used in further processing.

When you open a data table, the original values will be displayed. In all further processing of that data, the assigned special values will be used.

### Query Filters

Query filters can be used to select or view a subset of rows in a table. When used on a collar table, this amounts to selecting collars. When used on an interval table, measurement intervals are selected. Query filters can be used to model using a subset of data and to filter information displayed in the scene window.

A query can be created for any type of table in a project, including GIS data, points data and structural data.

When a query filter has been defined for an object and the object is displayed in the scene, the query filter can be applied by clicking on the object in the shape list and selecting the query filter in the shape properties panel:
For a borehole data table, this displays only the data selected by the filter. The trace lines remain displayed in the scene. To filter trace lines, tick the **Filter trace lines** box:

![Filter trace lines](image)

Query filters defined for collar tables are available to all other borehole data tables.

The rest of this topic describes how to build queries. It is divided into:

- Creating a New Query Filter
- Leapfrog Works Query Syntax
- Building a Query
- Advanced Queries

### Creating a New Query Filter

To create a query filter, right-click on the required table in the project tree and select **New Query Filter**. The **Query Filter** window will appear:

![Query Filter window](image)

Type the required criteria into the **Query** box, using the query syntax described below. Press Ctrl-Enter for a new line in longer queries. Click the ... button for more advanced query building options, which are described in Building a Query and Advanced Queries below.

Assign the filter a name and click **OK** to save it. It will appear in the project tree under the table to which it applies. To apply a query filter to the scene, select the object in the shape list, then select the filter from the **Query filter** list in the shape properties panel:
In this case, because the query filter was created for the collar table, it is also available for the lithology table.

**Leapfrog Works Query Syntax**

The Leapfrog Works query syntax is based on the WHERE clause of the Structured Query Language (SQL) with some restrictions:

- Unary operators are not allowed
- SQL functions cannot be used
- The SELECT statement should not be used (as in 'holeid in (SELECT holeid FROM ...)')
- Following statements are also prohibited: CASE, WHEN or MATCH

There is also one main SQL extension:

- **IN** and **NOT IN** will accept a partition group for the value list. E.g. ‘zone IN layers.weathered’ where “layers” is a partition of the “zone” column that has a group called ‘weathered’.

These are some examples of valid Leapfrog Works query statements:

- `holeid in ('m-001', 'm-002')`
- `holeid not in ('m-001', 'm-002')`
- `holeid not like 'MAR%'`

To enter a query that contains an apostrophe, enter two apostrophes. For example, the following query will result in an error:

Adding the second apostrophe results in a valid query:

The **Query** box allows the following shortcut queries:

- Typing a single word will match all hole-ids starting with that string. For example, typing “MAR” is a shortcut for “holeid like ‘MAR%’”
• Typing a comma-separated list of words will match all hole-ids that exactly match the given words. For example typing “M001, M002” is a shortcut for “holeid in (’M001’, ’M002’)”.

**Building a Query**

Many common queries can be built using the **Build Query** window:

This window aims to be easy to use rather than comprehensive in its support for the full Leapfrog Works query syntax. For more advanced queries, click on the **Advanced** button. See [Advanced Queries](#) for more information.

To add a criteria, click **Column** to view a list of columns available in the table. Select a **Test** and enter a **Value**. What can be entered for the **Value** depends on the type of column and test selected.

Quotes are not required around text values entered in the value column as they are in SQL. Leapfrog Works will add quotes and brackets to the value "MX, PM" to make a valid SQL list of strings "(’MX’, ’PM’)" when the query is saved.

Click on the **Apply** button to apply to query to the context in which the dialog was opened.

Use the **Delete** button to delete the criteria in the selected row and the **Add** button to add a blank row.
Advanced Queries

The Advanced Query window provides a powerful and flexible query building using the Leapfrog Works query language.

![Advanced Query window](image)

Enter the query in the **Criteria to Match** area on the left. The query is displayed as a tree structure with AND and OR terms as the branch nodes and conditions as the leaves. Use the **Delete** button to delete a row from the query and the **Add** button to add a blank row. The **Check** button can be used at any time to check if the current query statement is valid. Below the buttons is a box showing the raw SQL form of the query.

Except for the arrow buttons, the buttons down the middle of the dialog are used for entering values into the query. The arrow buttons are used for moving the currently selected criteria to a different position in the query. The **Date, List** and **Value** buttons will open a builder dialog for the column selected in the current row. If there is no column found or the column is of the wrong type, an error message is displayed.

The tree on the right contains all the columns available to the query. Double-click on a column name to insert it into the query.
GIS Data, Maps and Images

Often the first data imported into a new project is information that sets the coordinates for the project as a whole. This includes GIS data, maps, aerial photos and 2D grids. This section describes importing and working with GIS data and images.

You can view the attribute table for most GIS data objects by right-clicking and selecting Attribute Table. You can also create query filters that can be used when displaying the GIS object. See The Table Dialog and Query Filters for more information.

If, during the course of a project, GIS data changes, it can be reloaded and models that are dependent on that data will automatically be updated.

Importing Vector Data

Vector data formats Leapfrog Works supports include:

- Shape Files (*.shp)
- MapInfo Files (*.tab, *.mif)
- ESRI Personal GeoDatabase Files (*.mdb, *.accdb)

You can also import data from MapInfo and ESRI databases. See Importing a MapInfo Batch File and Importing Data from an ESRI Geodatabase for more information.

To import vector data, right-click on the GIS Data, Maps and Photos folder and select Import Vector Data. Navigate to the folder that contains the GIS data and select the file. You can select multiple files using the Shift and Ctrl keys.

Click Open to begin importing the data.

If you are importing a single file, the Import GIS Vector Data window will show a summary of the data in the selected file:

You can choose what field in the data to use for the Elevation Field from the list.
If you are importing multiple files, all files being imported are listed in the **Import GIS Vector Data** window and no summary of each file is displayed:

Data is automatically clipped to the clipping boundary, but you can change how the data is filtered to suit any bounding box that exists in the project. If you do not wish to clip the data, untick the **Filter data** box.

Click **OK** to add the data to the project. The object or objects will appear in the project tree under the **GIS Data, Maps and Photos** folder. If a topography has been defined for the project, the imported GIS data objects will automatically be projected onto the topography and saved in the **Topographies > Draped GIS Objects** folder.

You can then view an object’s attributes by right-clicking on it and selecting **Attribute Table**.

When importing files, you may be prompted to select whether or not to filter elevation data. If you wish to use another data source for your elevation data, select **Filter data**. For example, if you import a GIS line that has suspect elevation data, you can discard the elevation data and set the elevation from the topography, as described in **Setting Elevation for GIS Objects and Images**.

If data changes outside the project, it can be reloaded as described in **Reloading GIS Data**.

**Importing a MapInfo Batch File**

You can import a collection of GIS data exported from MapInfo. The MapInfo file can include points, lines, polygons, images and elevation grids.

To import GIS data in this way, right-click on the **GIS Data, Maps and Photos** folder and select **Batch Import > from MapInfo**. In the window that appears, navigate to the folder that contains the MapInfo batch file, which is an XML file. Click **Open**.
The data that can be imported will be displayed and you can select which files to import:

You can select multiple files using the Shift and Ctrl keys.

Data is automatically clipped to the clipping boundary, but you can change how the data is filtered to suit any bounding box that exists in the project. If you do not wish to clip the data, untick the Filter data box.

Click OK to import the selected files, which will be added to the GIS Data, Maps and Photos folder as a group ( ), with the exception of elevation grids, which will be added to the Meshes folder.

Points, lines and polygons can be reloaded on an individual basis, which is described in Reloading GIS Data.

Importing Data from an ESRI Geodatabase

You can import points, lines and polygons from an ESRI geodatabase. However, the import of raster data is not supported.

To import GIS points, lines and polygons in this way, right-click on the GIS Data, Maps and Photos folder and select Batch Import > from ESRI Geodatabase. In the window that appears, navigate to the folder that contains the database and click Open.

Leapfrog Works imports uncompressed ESRI geodatabases.
The data that can be imported will be displayed and you can select which files to import:

You can select multiple files using the Shift and Ctrl keys.

Data is automatically clipped to the clipping boundary, but you can change how the data is filtered to suit any bounding box that exists in the project. If you do not wish to clip the data, untick the Filter data box.

Click OK to import the selected files, which will be added to the GIS Data, Maps and Photos folder as a group (†). Data in the group can be reloaded individually or as a group, which is described in Reloading GIS Data.

Reloading GIS Data

If during the course of a project GIS points, lines and polygons change, they can be reloaded and dependent models will automatically be updated. Objects originally imported as part of an ESRI database (†) can be reloaded individually or as part of the group.

Although the GIS data will be overwritten, any elevation data set in Leapfrog Works will be retained.

Reloading Points, Lines and Polygons

To reload a GIS point, line or polygon, right-click on it in the project tree and select Reload Data. Navigate to the folder containing the GIS file and select the file. Click Open.

The process is the same as importing GIS data. Click OK to reload the data. The original data will be overwritten and dependent objects will be updated to reflect the new data.

Reloading an ESRI Database

To reload an ESRI database, right-click on it in the project tree and select Reload Data. In the window that appears, select the layers to reload, then click OK.

Points, lines and polygons imported as part of an ESRI database can also be reloaded on an
2D Grids

Leapfrog Works imports the following 2D grid formats:

- Arc/Info ASCII Grid (*.asc, *.txt)
- Arco/Info Binary Grid (*.adf)
- Digital Elevation Model (*.dem)
- Intergraph ERDAS ER Mapper 2D Grid (*.ers)
- ESRI .hdr Labelled Image (*.img, *.bil)
- SRTM .hgt (*.hgt)
- Surfer ASCII or Binary Grid (*.grd)

2D grids can also be imported from MapInfo files. See Importing a MapInfo Batch File for more information.

To import a 2D grid, right-click on the GIS Data, Maps and Photos folder and select Import 2D Grid. Navigate to the folder that contains grid and select the file. Click Open to begin importing the data.

The Import 2D Grid window will appear, displaying the grid and each of the bands available. Select the data type for each band and set the georeference information, if necessary. See Importing a Map or Image for information on georeferencing imported files.

Once the grid has been imported, you can set its elevation, which is described in Setting Elevation for GIS Objects and Images.

When you display the grid in the scene, select the imported bands from the shape list:

Grids can be displayed as points (●) or as cells and the values filtered, as described in Displaying Points.

Importing a Map or Image

Image formats Leapfrog Works supports include:

- PNG Files (*.png)
- JPEG Files (*.jpg, *.jpeg)
- TIFF and GeoTIFF Files (*.tiff, *.tif)
- Windows Bitmap Files (*.bmp)
- Graphics Interchange Format Files (*.gif)

Images larger than 16,384 by 16,384 pixels will be scaled down. Reducing your images in size below this limit will avoid scaling; you can do this by cropping the image during the import process or by scaling down the image in an external image editor.

If the file contains georeference information, it too will be imported.

To import a map or image, right-click on the **GIS Data, Maps and Photos** folder and select **Import Map**. Navigate to the folder that contains the image and select the file. The **Import Image** window will be displayed:

The rest of this topic describes georeferencing images. It is divided into:

- **Manual Georeferencing**
- **Automatic Georeferencing**
- **Exporting a Georeferenced Image**

Adding georeference data to a map will set the location of the map in the three-dimensional viewer. It is often used as a first step in setting the coordinates for the project as a whole.

The three reference markers (▲, ◆, ◊) are used to set coordinates for the image in the scene. If the image is the first object added to the project, this will, in effect, set the coordinate system for the project. The scene markers (▲, ◆, ◊) let you copy georeference information from the scene.

Cropping the image to only the area of interest will reduce video RAM usage and may improve graphics performance. To crop the image, click on the **Crop Image** button (✸) at the top of the
window, then drag around the part of the image you wish to use. Click on the **Remove Crop** button (\(\text{\textsuperscript{1}}\)) to clear the cropping.

**Manual Georeferencing**

If the image does not contain georeference information, you will need to add it manually by adding the three reference markers (\(\text{\textsuperscript{1}}, \text{\textsuperscript{2}}, \text{\textsuperscript{3}}\)) to the image. To select a marker, click on its marker button (**Marker 1**, **Marker 2** or **Marker 3**), then move it to the required location on the image using the mouse or the arrow keys.

Once each marker is correctly positioned, enter the real-world X and Y coordinates for each marker:

There are two ways to do this:

- Enter the coordinates for each marker in the **East (X)** and **North (Y)** fields. As you enter the coordinates, the positions of the markers will be displayed in the scene.
- Copy coordinates from the scene using the three scene markers (\(\text{\textsuperscript{1}}, \text{\textsuperscript{2}}, \text{\textsuperscript{3}}\)).

The second method is useful when you already have other objects correctly georeferenced in the project. For example, if you have a larger map in the project and wish to import a more detailed map, you can copy the coordinates from the georeferenced map to the detailed one. To do this, move the **Import Map** tab so you can see enough of the scene to work in both windows. Next:

- In the **Import Map** tab, position the marker (\(\text{\textsuperscript{1}}, \text{\textsuperscript{2}}, \text{\textsuperscript{3}}\)) on the image being imported.
- Click the corresponding copy coordinates marker (\(\text{\textsuperscript{1}}, \text{\textsuperscript{2}}, \text{\textsuperscript{3}}\)).
- Zoom in to the point in the scene window where you wish to place the marker and click.

The coordinates in the scene will be copied to the **Import Map** tab.
Once you have set the coordinates for each marker, click **OK** to return to the main window. Once Leapfrog Works saves the image, it will appear in the project tree under the **GIS Data, Maps and Photos** folder.

**Automatic Georeferencing**

If the image contains georeference data, it will automatically be displayed. If the georeference data in the imported image uses a different coordinate system than that used for the project, you can change the georeference data by ticking the **Override georeference data from image** box, then editing the information.

Click **OK** to import the image. It will appear in the project tree under the **GIS Data, Maps and Photos** folder.

**Exporting a Georeferenced Image**

Leapfrog Works exports georeferenced images as GeoTIFFs. To do this, right-click on it in the project tree and select **Export**. You will be prompted for a filename and location. Click **Save**.

**Setting Elevation for GIS Objects and Images**

You can set the elevation for GIS objects and images by:

- Using a fixed elevation
- Using the elevation data from one of the object’s attributes
- Using the elevation data from a surface in the project

The options available depend upon the type of object.

<table>
<thead>
<tr>
<th></th>
<th>Fixed Elevation</th>
<th>From Attribute</th>
<th>From Surface</th>
</tr>
</thead>
<tbody>
<tr>
<td>GIS lines</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>GIS points</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>2D grids</td>
<td>X</td>
<td>-</td>
<td>X</td>
</tr>
<tr>
<td>GIS lines drawn in Leapfrog Works</td>
<td>X</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>GIS lines extracted from polylines</td>
<td>X</td>
<td>-</td>
<td>X</td>
</tr>
<tr>
<td>Images</td>
<td>X</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>
To set the elevation for a GIS object or an image, right-click on it in the project tree and select Set Elevation. The Set Elevation window will appear, displaying the available options. Select the option required and click OK.

Creating a New GIS Line

There are three ways to create a new GIS lines object in Leapfrog Works:

- If you do not have GIS data for a topographical feature you wish to use in model building, you can draw a new GIS line. See Drawing a New GIS Line.

- If you have two surfaces that intersect, you can generate a new GIS line from their intersection. You can use any surface in the project, including those that are generated in building models. See Creating a New GIS Line from Intersecting Meshes.

- If you have a polyline you wish to use as a GIS lines object, right-click on it in the project tree and select Extract GIS Line. The new GIS line ( Ipsum) will appear in the GIS Data, Maps and Photos folder. It is not linked to the original polyline.

To view new GIS line draped on the topography, select the object from the GIS data > GIS objects list, as described in Topography Display Options.
Drawing a New GIS Line

GIS lines can be drawn on the slicer or on a surface.

Right-click on the GIS Data, Maps and Photos folder and select New GIS Line > From New Drawing. In the window that appears, enter a name for the new object and click OK.

The object will be created in the project tree and added to the shape list. The scene view will change to view the objects in the scene from above and tools for drawing polylines will appear. Click on the Draw lines button (раффа) and start drawing in the scene, as described in Drawing in the Scene.

When you have finished drawing, click the Save button (раффа). The new line (raphfa) will be saved in the project tree.

You can edit the GIS line by right-clicking on it in the project tree and selecting Edit. If it is in the shape list, you can edit it by clicking on the Edit button (раффа).

Creating a New GIS Line from Intersecting Meshes

You can create a new GIS line from two intersecting meshes. You can use any surface in the project, including those that are generated in building models.

To create a new GIS line from two intersecting meshes, right-click on the GIS Data, Maps and Photos folder and select New GIS Line > From Intersecting Meshes. In the window that appears, select the meshes to use, enter a name for the new object and click OK.

The new line (raphfa) will be saved in the project tree. It is not linked to the meshes used to create it and will not be updated when the meshes are updated.
Exporting GIS Data

To export GIS data, right-click on the GIS data object in the GIS Data, Maps and Photos folder and select Export. The Export GIS window will be displayed:

Select whether elevation information will come from the topography or from the GIS object itself, or untick the Use 2.5D format with elevations from box to export the object without elevation information.

Click Export. You be prompted for a filename and location.
Borehole Data

Borehole data forms the basis for creating models in Leapfrog Works. Because borehole data often contains errors that reduce the reliability of a model, Leapfrog Works has tools that help you to identify and correct errors and work with the data.

Borehole data defines the physical 3D shape of boreholes. It is made up of:

- A collar table, containing information on the location of the borehole.
- A survey table, containing information that describes the deviation of each borehole.
- At least one interval table, containing information on measurements such as lithology, date or any numeric or textual values. An interval table must also include collar IDs that correspond to those in the collar table and sample start and end depth.

When a project is first created, the only options available via the Borehole Data folder are for importing data. See Importing Borehole Data for more information on these options.

Once data has been added to the project, a Boreholes object will be created that serves as a container for the tables imported:

When there are errors in the data, the relevant table will be marked with a red X (❌). See Correcting Data Errors for more information on fixing borehole data errors.

Leapfrog Works also has tools for creating new lithology data columns from existing columns in order to solve problems with the borehole data. See Processing Borehole Data for more information.

You can open each table by double-clicking on the table (📑). The table will be displayed and you can make changes. See The Table Dialog.

See Displaying Boreholes in Visualising Data for information about displaying borehole data in the scene.

With Leapfrog Works, you can also plan boreholes and evaluate them against any model in the project. See Planning Boreholes for more information.
Importing Borehole Data
Borehole data can be imported from:

- Files stored on your computer or a network location. This process is described below.
- From any database that runs an ODBC interface. See Selecting the ODBC Data Source.

For each of these options, once the data source is selected, the process of importing borehole data is the same.

The rest of this topic discusses the data format required and the steps for importing borehole data. It is divided into:

- Expected Borehole Data Tables and Columns
- Selecting Files
- Working Through the Data
- AGS Format Borehole Data

Expected Borehole Data Tables and Columns
Leapfrog Works expects borehole data that is stored in a collar table and at least one interval table. A survey table can also be imported, and a screens table can be imported if you are licensed for the Hydrogeology Solutions Kit.

The following formats are supported:

- CSV Text File (*.csv)
- AGS Files (*.ags)
- ASCII Text File (*.asc)
- Plain Text Files (*.txt)
- Data Files (*.dat)
- TSV Text Files (*.tsv)

For data imported in CSV, ASCII, TXT, DAT and TSV formats, separate files are required for each type of table. For data imported in AGS format, a single file is imported that contains each type of table and a summary of the relevant data is presented at each stage of the importation process so you can select from the available groups of data.

The Collar Table
The collar table should contain five columns:

- A borehole identifier
- The location of the borehole in X, Y and Z coordinates
- The maximum depth of the borehole

© 2017 ARANZ Geo Limited t/a Seequent
A collar table can also contain a trench column, and collars marked as trenches will be desurveyed in a manner different from other boreholes.

The borehole ID is used to associate data in different tables with a single borehole. The ID for a borehole must be identical in all tables in order for data to be associated with that borehole. Inconsistencies in the way boreholes are identified are common sources of errors.

The maximum depth column is optional. If it is present, is used to validate the data imported for the interval tables. The maximum depth specified is often a planned quantity, whereas the interval table records actual measurements. For this reason, Leapfrog Works has an option for fixing the maximum depth value in the collar table to match the data in an interval table.

If maximum depth information is not included in a collar file, Leapfrog Works will determine it from the maximum depth sampled as indicated by data in the interval tables.

Boreholes in AGS format may also include a Project ID column that can be used to identify boreholes that have the same hole ID but are actually from different projects.

**The Survey Table**

For the survey table, Leapfrog Works expects a minimum of four columns:

- A borehole identifier
- Depth, dip and azimuth values

By default, Leapfrog Works assumes that negative dip values point up. If this is not the case, tick the **Negative survey dip points down** option.

Boreholes in AGS format may also include a Project ID column that can be used to identify boreholes that have the same hole ID but are actually from different projects.

See [Survey Table Options](#) for more information on the borehole desurveying algorithms used in Leapfrog Works.

**The Screens Table**

A screens table can be imported if you are licensed for the Hydrogeology Solutions Kit.

For the screens table, Leapfrog Works expects a minimum of four columns:

- A borehole identifier
- Start/from and end/to depths
- A value column

Boreholes in AGS format may also include a Project ID column that can be used to identify boreholes that have the same hole ID but are actually from different projects.

**Interval Tables**

For interval tables, Leapfrog Works expects, at minimum, four columns:
- A borehole identifier
- Start/from and end/to depths
- A column of measurements

If a borehole ID in an interval table does not correspond to one in the collar table, the table can still be imported but the interval table will contain errors.

Supported column types are:
- Lithology columns containing lithologic data, which can be used for geological modelling.
- Numeric columns containing numeric values, which can be used for interpolating data.
- Category columns, which is text representing categories such as company, geologist, or mineralisation.
- Text columns containing text data that is not categorical, such as comments. Text columns are not validated when imported.
- Date columns containing date data. Custom date and timestamps formats are supported.
- URL columns. Use the prefix file:/// to link to local files.

When an interval table is displayed in the scene and an interval is selected, clicking on a link in the URL column will open the link. This is a useful way of linking to, for example, data files or core photo images from within Leapfrog Works:

Boreholes in AGS format may also include a Project ID column that can be used to identify boreholes that have the same hole ID but are actually from different projects.
Selecting Files

To import borehole data, right-click on the Borehole Data folder and select Import Boreholes. The Import Borehole Data window will appear:

![Import Borehole Data window](image)

For the Collar, click on the Browse button to locate the collar file.

If you are importing borehole data in AGS format, click on the Browse button for the Collar file and select the source file.

When a collar file is added to the Import Borehole Data window, Leapfrog Works will look for interval tables with names such as “lithology” or “geology” in the same location and will add them to the Interval Tables list. If an interval table file is not automatically added to the list, click Add and browse for the required file.

When data is in AGS format, the file selected as the Collar file will also be added as the Survey and Intervals files.

In the screen below, a collar file, a survey file and two interval tables have been selected for import:

![Selected files](image)

Working Through the Data

Clicking on Import starts the process of importing data, which involves matching the data in the selected files with the columns Leapfrog Works expects for each type of table. Leapfrog Works will display a series of windows and will attempt to match the data in the files with the columns expected, based on the header rows in each file. For data in AGS format, you will be prompted...
to select from the groups in the file before mapping columns. See AGS Format Borehole Data for more information.

Progress in working through the data is shown at the top of the window:

The file currently displayed is shown in bold.

For *.csv files that use characters other than the comma as the separator, you can specify the delimiter, comment leader, quote and decimal characters in the Import Borehole Data window. Click on CSV characters to enter the characters used in the data files:

The row at the top of the table indicates the data type to which Leapfrog Works will assign each column:
Click at the top of a column to view the column assignments available. The columns highlighted below are the column types required for the collar table:

Each type of table being imported will have different column assignments available, but all table types will display:

- The categories columns can be assigned to (top of the list)
- The option to not import the column
- The required columns, e.g. borehole Id, East (X), North (Y) and Elev (Z) for the collar table
- Any optional columns, e.g. Max Depth and Trench
- The option to select a custom name

Boreholes in AGS format may also include a Project ID column that can be used to identify boreholes that have the same hole ID but are actually from different projects.

If the header row for a column cannot be matched, Leapfrog Works will mark the column as “Not Imported” and you can select from the column assignments available. If you choose not to import a column then wish to do so later, you can add it later using the Import Column option. See Importing Columns.
You can also work with the **Column Summary**:

![Column Summary](image)

If you wish to import all columns, click on the **Import All Columns** button, then check that all columns have been correctly mapped.

You can select a column for import, then use it as a **Unique Row ID**. This can specify the column being used in other data systems to uniquely identify rows in a table. The column must not contain duplicate values. If a **Unique Row ID** is specified, Leapfrog Works will use this column to match rows when appending columns or reloading tables.

If the data contains date and time information and the date and time format is not detected, click on **Date and Time Formats** to reveal more information:

![Date and Time Formats](image)

If the date and time format you wish to use is not among the options, you can create a custom format.

For each file, check the column mapping and click **Next** to proceed to the next step. If any of the information Leapfrog Works expects is missing, an error message will appear. Return to the table and correct the problem described.

Once you have checked the last file, click on **Finish**. Once Leapfrog Works has imported the data, it will appear in the project tree under a new **Boreholes** object.

### AGS Format Borehole Data

Leapfrog Works supports the importation of borehole data using the Association of Geotechnical and Geoenvironmental Specialists (AGS) format. AGS versions 3.1 and 4 are supported. The process for importing boreholes in AGS format is the same as that for importing data described in the rest of this topic, except that a single file is selected for import. For each
type of table, a summary of the relevant data in the file is presented, allowing you to select
groups of data.

The Collar Table
For the collar data group, the HOLE group (v 3.1)/LOCA group (v 4.0) will automatically be
selected. Click OK to accept the selection. The selected data will be mapped and you can
change how it is mapped as described in Working Through the Data above.

The Survey Table
For the survey table data group, the HOLE group (v 3.1)/HORN group (v 4.0) will automatically
be selected. Click OK to accept the selection.

If there is no survey information in the file, click OK, then click the Skip button in the Import
Boreholes window to move on to the interval table data.

Interval Tables
All remaining groups that contain suitable interval data are displayed, although you can display
all groups in the file by disabling the Only show groups suitable for interval data option.

Only one group can be selected, and typically the GEOL table contains the lithology data.
However, if you need to import more groups, there are two options:

- Import the other groups as additional interval tables (see Importing Interval Tables). Select
  Import From File and then select whether you wish to import intervals or points, then select
the AGS file again.
- Append the dataset, as described in Appending Boreholes.

Selecting the ODBC Data Source
To import borehole data directly from any database that uses an ODBC interface, right-click on
the Borehole Data folder and select Import Borehole Data via ODBC. The Select ODBC Data
Source window will appear:

Leapfrog Works supports database files in Access Database (*.mdb, *.accdb) and glnt Project
(*.gpj) formats.
Enter the information supplied by your database administrator and click OK.

**Selecting Tables**

Leapfrog Works will select the collar, survey and interval tables from the data in the file, which is displayed in the Select Tables To Import window:

Click on the Collar Table, Survey Table and Screen Table dropdown lists to select from the data available in the file.

To change one of the Interval Tables to a different column in the file, click on the table name to highlight it, then click to the right of the column name to activate the dropdown list:

To remove an interval table from the list, click the - button.
To add an interval table, click the **Add Interval Table** button. A - button will be added to the **Interval Tables** list.

![Select Tables To Import](image1)

Click on the blank space to highlight it, then click to the right of the column name to activate the dropdown list:

![Select Tables To Import](image2)

Click **OK** to begin the process of importing the data, which is similar to that described in **Importing Borehole Data**.

**Appending Boreholes**

If borehole data is stored in multiple files or new borehole data is available, you can import other files into the project and add them to the existing borehole data. To do this, right-click on the **Boreholes** object and select **Append Boreholes**.

Appending borehole data when you have new boreholes or wish to add extra length to existing
boreholes. If you wish to refresh borehole data, overwriting all existing borehole data, use the **Reload Boreholes** option.

The **Append Boreholes** window will be displayed. Appending borehole data is similar to importing the original data (see **Importing Borehole Data**):

- If the borehole data was loaded from a file on your computer or a network location, you will be asked to specify the file locations. Step through the files, checking the **Column Summary** for each file to ensure that the correct information will be imported, then click **Finish** to add the new files.
- If the interval table is stored in an ODBC database, you will be prompted to connect to the database. See **Selecting the ODBC Data Source**.

### Importing Interval Tables

Interval tables that have not been imported during the borehole data import process can be added to the project at any time. To add an interval table, right-click on the **Boreholes** object in the project tree and select from the options available:

- If the interval table is stored in a file on your computer or a network location, select **Import From File > Interval Values**. Leapfrog Works will ask you to specify the file location, and then will display the data in the file in the **Import Interval** window.
- If the interval table is stored in an ODBC database, select **Import From ODBC > Interval Values**. You will be prompted to select the data source. See **Selecting the ODBC Data Source**.

Columns required are:

- A borehole identifier
- Start/from and end/to depths
- A column of measurements

See **Importing Borehole Data** for more information on the supported column types.

Select the required columns and assign the data type for each column. Click **Finish** to import the file, which will appear under the **Boreholes** object.

### Importing Columns

Columns of an interval table that have not been imported during the borehole data import or that are stored in a separate file can be added to the table at any time. To do this, right-click on the interval table in the project tree and select **New Column > Import Column**.

Importing a column is similar to importing interval tables themselves. Leapfrog Works will ask you to specify the file location, and then will display the data in the file in the **Add Column To Table** window. Select as many columns to import as required and assign the appropriate data type. Before finishing, check the **Column Summary** to ensure that the correct information will be imported.
It is not necessary to re-import any columns that are already part of the project. The borehole ID and To and From data columns, however, will be used to check the validity of the new column against existing data. Any rows that do not match will not be imported.

Click Finish to import the new column.

**Importing Point Values Down Boreholes**

To import a set of points on boreholes, right-click on the Boreholes object in the project tree and select Import From File > Point Values or Import From ODBC > Point Values.

When importing from a file, Leapfrog Works will ask you to specify the file location and then will display the data in the file in the Import Depth Points window.

When importing from ODBC, you will first be prompted to select the data source. See Selecting the ODBC Data Source.

Columns required are:

- A borehole identifier
- Depth

Select the required columns and assign the data type for each column. Click Finish to import the file, which will appear under the Boreholes object.

**Importing LAS Points Down Boreholes**

Leapfrog Works imports LAS points down boreholes in LAS 1.2 and LAS 2.0 formats. An imported set of LAS files appears as one object with its associated data columns plus a LAS Boreholes folder that contains a filter for each borehole. Importing the data preserves the metadata from the LAS files, which can be viewed in the Properties window for the LAS points object and in the Properties window for each borehole.

To import LAS points down boreholes, right-click on the Boreholes object and select Import From File > LAS Data. Select the files you wish to import and click Open.

Next, the Import LAS Data window will appear. The data displayed in this window is combined from the selected files, with blank and invalid values indicated by “nan”. For example, if a borehole file does not contain columns that are included in other borehole files, those missing columns will be marked as “nan”.

Leapfrog Works expects borehole ID and Depth columns and will attempt to match the data in the files with the expected format. Select the columns to import, then click Finish. The files will be added to the project tree as part of the Boreholes object, as described above.

To view LAS points, add the LAS points object (\(^\text{\text{141}}\)) to the scene. You can also display individual boreholes by adding their filters to the scene.
LAS File Mapping

The Properties window for LAS Boreholes includes a LAS Mapping tab that shows what data files have been used for the selected borehole:

This is useful when data for a borehole originates in different files.

LAS File Inconsistencies

When importing LAS files, inconsistencies in the files are handled as follows:

- If there are two files with the same curve values at the same depth, the duplicate values will be added to the existing column and flagged as overlapping segments. See Correcting Data Errors for more information about correcting borehole data errors.

- If there are more than two files with the same curve values at the same depth, Leapfrog Works will not be able to import the files. Note the conflicting files shown in the error message and reimport the files, leaving the conflicting files out.

- If there are multiple logs of the same name in the files, Leapfrog Works will not be able to import the data. Edit the LAS file header outside of Leapfrog Works to change the names.

Importing Downhole Structural Data

Leapfrog Works supports structural measurements in .csv or text formats. This topic describes importing downhole structural data tables. Structural data tables that include location information can also be imported to the Structural Modelling folder. See Importing Planar Structural Data.
To import a set of structural data on boreholes, right-click on the Boreholes object in the project tree and select Import From File > Planar Structural Data or Import From ODBC > Planar Structural Data.

When importing from a file, Leapfrog Works will ask you to specify the file location and then will display the data in the file in the Import Planar Structural Data window.

When importing from ODBC, you will first be prompted to select the data source. See Selecting the ODBC Data Source.

Leapfrog Works expects columns describing the borehole identifier, the depth and the structural orientation. Structural orientation can be specified using either dip and dip azimuth or alpha and beta.

Match the values in the file to the required column headers, then click Finish to import the file. The table will appear under the Boreholes object.

If the structural orientation is specified using alpha and beta, the reference line from which the beta is measured can be the bottom or top of the borehole. When the table is imported, the default setting is Bottom of core. To change this, double-click on the structural data table in the project tree. Next, click on Compatibility to change the Beta reference mark setting to Top of core:
Survey Table Options

To view borehole desurveying options, double-click on the survey table to open it, then click on Compatibility. There are two options for changing the way survey table data is handled in Leapfrog Works:

When the survey table is imported, Leapfrog Works sets the **Negative survey dip points down** value according to the data in the imported table. When the majority of the dip data in the table is positive, Leapfrog Works assumes all these boreholes will point down and leaves the field **Negative survey dip points down** disabled. When most of the values are negative, the field is enabled. If you are going to change the automatically set value of this field, consider carefully the implications if there is a mix of boreholes pointing down and up.

When borehole data is imported, the **Desurveying method** applied is **Leapfrog spherical arc approximation**. The **Balanced tangent algorithm** option is compatible with Vulcan and Minesight. These options are described in more detail below.

Borehole desurveying computes the geometry of a borehole in three-dimensional space based on the data contained in the survey table.

Under ideal conditions, the borehole path follows the original dip and azimuth established at the top of the borehole. Usually, though, the path deflects away from the original direction as a result of layering in the rock, variation in the hardness of the layers and the angle of the drill bit relative to those layers. The drill bit will be able to penetrate softer layers more easily than harder layers, resulting in a preferential direction of drill bit deviation.

There are a number of paths a borehole could take through available survey measurements, but the physical constraints imposed by drilling are more likely to produce smoother paths. Selecting the desurveying method that gives the best likely approximation of the actual path of the borehole will ensure that subsequent modelling is as accurate as possible.

Leapfrog Works implements three algorithms for desurveying boreholes.
**Spherical Arc Approximation**

The default algorithm used in Leapfrog Works is spherical arc approximation, which is sometimes referred to as the minimum curvature algorithm. Downhole distances are desurveyed exactly as distances along a circular arc:

The algorithm matches the survey at the starting and end positions exactly and the curvature is constant between these two measurements. At the survey points, the direction remains continuous and, therefore, there are no unrealistic sharp changes in direction.

If you wish to use spherical arc approximation, there is no need to change any settings.

**Raw Tangent**

The raw tangent algorithm assumes the borehole maintains the direction given by the last survey measurement until the next new measurement is reached:

This implies that the borehole makes sharp jumps in direction whenever a measurement is taken, which is unlikely, except when the borehole is being used to define a trench.

To use the raw tangent algorithm for a borehole, double-click on the collar table in the project tree. Tick the **trench** box for the boreholes you wish to desurvey using the raw tangent algorithm.

**Balanced Tangent**

The balanced tangent algorithm uses straight lines but attempts to improve the accuracy of the raw tangent algorithm by assigning equal weights to the starting and end survey
measurements:

It is an improvement on the raw tangent algorithm but still suffers from an unrealistic discontinuity in the borehole path. It is, however, a better approximation of the overall borehole path and is reasonably accurate when the spacing between measurements is small.

To use the balanced tangent algorithm, double-click on the survey table in the project tree. Click on **Compatibility** tab and change the **Desurveying method**.

### Processing Borehole Data

Once imported and corrected, borehole data usually requires further processing before any models are built. Use the techniques described in [Displaying Boreholes](#) to aid in making decisions on what further processing is required.

Often, selecting a small portion of intervals can be achieved using a query filter (see [Query Filters](#)). In some cases, however, you may wish to composite data to focus on a single unit. There may also be issues with how borehole data has been recorded; for example, two units have been catalogued as one, or a single unit may be divided into multiple units.

Leapfrog Works has a number of tools for processing borehole data, including:

- **Category Composites**. Sometimes unit boundaries are poorly defined, with fragments of other lithologies within the lithology of interest. This can result in very small segments near the edges of the lithology of interest. Modelling the fine detail is not always necessary, and so compositing can be used to smooth these boundaries.

- **Numeric Composites**. Compositing numeric data takes unevenly-spaced borehole data and turns it into regularly-spaced data, which is then interpolated. Numeric data can be composited along the entire borehole or in selected regions. You can also set the compositing length from the base interval table.

- **Majority Composites**. Category data can be composited into interval lengths from another table or into fixed interval lengths. The compositing is based on a majority percentage where each interval is assigned a category based on the category that makes up the highest percentage of the new interval.

- **Grouping Lithologies**. The group lithologies tool lets you define a new unit to which existing units are added. For example, a sandstone deposit might appear in an interval table as poorly-sorted and well-sorted units. The group lithologies tool lets you group both units into a single sandstone unit.
- **Splitting Lithologies.** Lithology units may be incorrectly grouped, which can become apparent when you display boreholes in the scene. The split lithologies tool lets you create new units by selecting from intervals displayed in the scene.

- **Interval Selection.** If the lithologies in a column are poorly sorted, you can display the column in the scene and use the interval selection tool to work with all the segments and sort them into new units.

- **Overlaid Lithology Column.** You may have two versions of an interval column, one that contains draft data and one that contains the final version. The final version may contain gaps, which can be filled in using the draft version. The overlaid lithology tool lets you combine the two columns to create a new column.

- **Category Column from Numeric Data.** When you have numeric data you wish to use with the lithology and category modelling tools, you can convert the numeric data to a category column.

- **Back-flagging Borehole Data.** Evaluating geological models on boreholes creates a new lithology table containing the lithologies from the selected model.

Each of these tools creates a new interval table or creates a new column in an existing interval table, preserving the original data. New tables and columns can be used as the basis for new models in the project and can be incorporated into existing models using From Other Contacts options. When a new table is created, you can view it in the scene along with the original table to see the differences between the processed and the unprocessed data.

If you are working with columns in different interval tables, you can create a new merged table that includes columns from these different tables. Columns created in Leapfrog Works can be included in a merged table. See Merged Borehole Data Tables.

### Category Composites

Sometimes unit boundaries are poorly defined, with fragments of other lithologies within the lithology of interest. This can result in very small segments near the edges of the lithology of interest. Modelling the fine detail is not always necessary, and so compositing can be used to smooth these boundaries.

In Leapfrog Works, you can composite category data in two ways:

- Composite the borehole data directly. This creates a new interval table that can be used to build models, and changes made to the table will be reflected in all models based on that table. This process is described below.

- Composite the points used to create an object.
The rest of this topic describes compositing borehole data directly.

Right-click on the Composites folder, which is in the project tree as part of the Boreholes object, and select New Category Composite. You will be prompted to select from the category columns available in the borehole data. Next, the New Composited Table window will appear, showing the options for sorting intervals in the selected column:

Compositing category data sorts segments into three categories:

- **Primary.** This is the unit of interest. In the case of compositing on intrusion contact surfaces, this will be the interior/intrusive lithology.
- **Ignored.** These are units that are, generally, younger than the unit of interest and should, therefore, be ignored in generating contact surfaces.
- **Exterior.** These are units that occur outside of the unit of interest. For an intrusive lithology, other lithologies the intrusion contacts should be classified as Exterior.

Unspecified intervals can be handled as Ignored, Primary or Exterior.

The additional compositing parameters determine how ignored segments flanked by interior or exterior segments are handled and the length of segments that will be filtered. Each of these settings is discussed below.

Click OK to create the table. Once you have created a composited table, you can edit it by right-clicking on it and selecting Edit Composited Table.

**Converting Ignored Segments**

The Convert enclosed ignored segments setting determines how ignored segments are handled when they are flanked by either two interior segments or two exterior segments. If Convert enclosed ignored segments is enabled, Leapfrog Works will convert enclosed ignored segments to match the surrounding segments. In cases where an ignored segment does not lie between two interior or exterior segments, it will remain ignored.
If you wish to set a maximum size for ignored enclosed segments, tick the **Shorter than** box and set the maximum length.

If **Convert enclosed ignored segments** is disabled, this processing does not occur and ignored segments are never converted. When an intrusive contact surface is created, this setting is disabled by default.

For example, this scene shows two ignored segments that are flanked by the unit of interest. Because **Convert enclosed ignored segments** is disabled, the segments remain ignored:
Enabling **Convert enclosed ignored segments** results in the segments being converted to the **Primary** unit:

Enabling **Shorter than** and setting it to 4 results in the shorter segment being converted to the **Primary** unit and the longer segment remaining **Ignored**.
Zooming out, we can see that the ignored segments at the top of the boreholes have not been converted:

Filtering Short Segments

The Filter primary segments and Filter exterior segments parameters determine how short a segment must be before it is composited:

- Short Exterior segments flanked by Primary segments will be converted to Primary segments.
- Short Primary segments flanked by Exterior segments will be converted to Exterior segments.

When the value is set to zero, no segments will be converted.

To see how these parameters can smooth the shape of a unit of interest, let’s look at a series of boreholes where we wish to create an intrusion boundary based on the red segments. Short segments are highlighted in the intervals that have not been composited:
An intrusion generated from these intervals will have more detail than is necessary for modelling. However, when compositing settings are applied and the short intervals are converted, we can see that the intrusion boundary is more geologically reasonable:

![Diagram of intrusion boundary before and after compositing with improved geological reasonableness]

**Numeric Composites**

Compositing numeric data takes unevenly-spaced borehole data and turns it into regularly-spaced data, which is then interpolated. Compositing parameters can be applied to entire boreholes or only within a selected region of the borehole. For example, you may wish to composite Au values only within a specific lithology.

There are two approaches to compositing numeric data in Leapfrog Works:

- Composite the borehole data directly. This creates a new interval table that can be used to build models, and changes made to the table will be reflected in all models based on that table. This process is described below.
- Composites the points used to create an interpolant. This is carried out by generating an interpolant and then setting compositing parameters for the interpolant’s values object. This isolates the effects of the compositing as the compositing settings are only applied to the interpolant.

Intervals that have no data can have a significant effect when compositing data as they are ignored by the compositing algorithm. The effect of these missing intervals can be managed using the **Minimum coverage** parameter, but it’s best to assign special values where intervals have no data. For example, intervals that are missing data can be assigned a value of 0 or that of the background mineralisation. See [Special Values](#) for more information.

The rest of this topic describes compositing borehole data directly. It is divided into:

- [Creating a Numeric Composite](#)
- [Selecting the Compositing Region](#)
- [Compositing Parameters](#)
Creating a Numeric Composite

To create a numeric composite, right-click on the Composites folder and select New Numeric Composite. The New Composed Table window will appear:

Set the compositing region and parameters; this is described in detail below. Then click on the Output Columns tab to select from the available columns of numeric data. Click OK to create the table.

Double-clicking on the table displays the data in its columns. Edit the table by right-clicking on it and selecting Edit Composed Table.

Selecting the Compositing Region

Compositing parameters can be applied to entire boreholes or only within a selected region of the borehole. There are four options for selecting the region in which numeric data will be composited, and each is discussed below.

Compositing in the Entire Borehole

For this option, Compositing Parameters are applied to all values down the length of boreholes. Select Entire borehole, then set the compositing parameters.

Compositing in a Subset of Codes

If you wish to select specific category codes in which to composite numeric data, there are two options:

- Subset of codes, grouped
- Subset of codes, ungrouped
The difference between the two is that for the grouped option, the selected codes are combined and the same Compositing Parameters are applied to the grouped intervals:

For the ungrouped option, however, you can set compositing parameters for each code in the selected Base column:

For the Action column, the options are:

- **Composite.** Numeric data that falls within the selected code will be composited according to the parameters set.
- **No compositing.** Numeric data is not composited within the selected code. The raw data will be used in creating the new data table.
- **Filter out.** Numeric data within the selected code will not be included in the new data table.

Compositing in Intervals
For the Intervals from table option, the interval lengths from the Base table are used to determine composite lengths. The value assigned to each interval is the length-weighted average value, and there are no further compositing parameters to set.
Compositing Parameters

When the compositing region is Entire borehole, Subset of codes, grouped or Subset of codes, ungrouped, the interval lengths are determined by applying three compositing parameters. These parameters are applied as follows:

- The boreholes are divided into intervals wherever numeric data occurs. The Compositing length determines the length of each composite interval, and the Minimum coverage length determines whether or not residual segments (those shorter than the Compositing length) are retained for further processing. Composite lengths are generated from the collar down the borehole, so any residual segments produced will be at the bottom of the borehole and where there is data missing down the length of the borehole. How residual segments are handled is described below.

Intervals that have no data can have a significant effect when compositing data as they are ignored by the compositing algorithm. The effect of these missing intervals can be managed using the Minimum coverage parameter, but it’s best to assign special values where intervals have no data. For example, intervals that are missing data can be assigned a value of 0 or that of the background mineralisation. See Special Values for more information.

- The For end lengths less than parameter is applied to determine what happens to the residual segments that may result from applying the Compositing length and Minimum coverage parameters. The three possibilities are Discard, Add to Previous Interval and Distribute Equally.
- Composite values are calculated for each composite interval. This is simply the length-weighted average of all numeric borehole data that falls within the composite interval.
- Composite points are generated at the centre of each composite interval from the composite values.

Discard

With the Discard option, residual segments that meet or exceed the Minimum coverage length are retained; those shorter are discarded.

For example, consider two boreholes. A is 49 metres long and B is 44 metres long. The Compositing length is set to 10 and the For end lengths less than length is set to 5. There will be a residual segment 9 metres long for Borehole A and one 4 metres long for Borehole B. Borehole A’s residual segment will be retained as a segment, whereas Borehole B’s residual segment will be discarded. This results in:

- Borehole A: 10m, 10m, 10m, 10m, 9m (residual length > Minimum coverage length so the 9m segment is kept)
- Borehole B: 10m, 10m, 10m, 10m (residual length < Minimum coverage length so the 4m segment is discarded)
Add to Previous Interval

With the Add to previous interval option, the Minimum coverage length is automatically set to zero. Residual segments longer than the For end lengths less than value are retained as separate segments; those shorter are added to the previous interval.

For our two boreholes, when the Compositing length is 10, there will be a residual segment 9 metres long for Borehole A and one 4 metres long for Borehole B. When For end lengths less than is set to 5, Borehole A’s residual segment will be retained as a segment, whereas Borehole B’s residual segment will be added to the previous interval. This results in:

- Borehole A: 10m, 10m, 10m, 10m, 9m (residual length > For end lengths less than length so the 9m length is kept as a separate segment)
- Borehole B: 10m, 10m, 10m, 14m (residual length < For end lengths less than length so the 4m segment is added to the previous interval)

Distribute Equally

With the Distribute equally throughout borehole option, the Minimum coverage parameter is automatically set to zero. Residual segments longer than the For end lengths less than value are retained as separate segments; those shorter will have their length distributed among the other intervals.

For our two boreholes, Borehole A’s residual segment will be retained as an individual segment, whereas Borehole B’s residual segment will have its length distributed among the rest of the intervals. The segments for each composited borehole will be:

- Borehole A: 10m, 10m, 10m, 10m, 9m (residual length > For end lengths less than length so the 9m segment is kept as a separate segment)
- Borehole B: 11m, 11m, 11m, 11m (residual length < For end lengths less than length so the 4m length is distributed among the other intervals)

Majority Composites

Category data can be composited into interval lengths from another table or into fixed interval lengths. The compositing is based on a majority percentage where each interval is assigned a category based on the category that makes up the highest percentage of the new interval. If two categories are equally represented, the category that occurs further up the borehole (closest to the collar) is assigned.

This is useful for comparing lithology and assay data; the intervals from an assay table can be applied to a category column to produce a new lithology column with the shorter intervals typical of assay tables. The majority composite column can then be used to create a merged table containing both lithology and assay data.
Borehole data is composited from the **Composites** folder, which is in the project tree as part of the **Boreholes** object. To create a majority composite, right-click on the **Composites** folder and select **New Majority Composite**. The **New Composed Table** window will appear:

Select the interval table that will be used to specify the intervals for the new majority composite or specify a fixed **Compositing Length**. Next, select the columns that will be composited. Click **OK** to create the composite. The composite will be added to the **Composites** folder in the project tree. You can edit it by right-clicking on it and selecting **Edit Composed Table**.

Here assay intervals are shown inside the much longer lithology intervals. The selected interval goes from 14.0 to 23.7 metres:
Here a majority composite has been created based on the lithology table using the assay table intervals. The category column displayed in the scene appears similar to the category column used to create it, but selecting an interval in the scene shows that the lithology has been composited into smaller intervals that match the assay intervals:

Grouping Lithologies

The group lithologies tool lets you define a new unit to which existing units are added. For example, a sandstone deposit might appear in an interval table as poorly-sorted and well-sorted units. With the group lithologies tool, you can group both units into a single sandstone unit.

When you group lithologies, the original lithology column is preserved and a new lithology column is added to the interval table. You can then select the original lithology column or the new one when displaying data and creating models.

To start grouping two or more lithologies, right-click on the interval table in the project tree and select New Column > Group Lithologies. The New Lithology Column window will appear:

Select the lithology column you wish to use from the Base Column list, then enter a Name for the new lithology column. Click OK.
A window will appear displaying all lithologies in the base lithology column:

In this example, two spellings of Alluvium have been used and these lithologies should be combined into a single lithology.

The most straightforward way to group lithologies is to select the first of the lithologies, then click **New Group**. A group will be created for the selected lithology with only that lithology as a member.
Next, click on a lithology in the **Ungrouped Lithologies** pane and drag it onto the group:

Grouping lithologies creates a new lithology column and any lithologies left in the **Ungrouped Lithologies** pane will be excluded from the new column. For this reason, once you have grouped the required lithologies, move all remaining lithologies to the **Groups** pane by clicking on each lithology, then on the **New Group** button. This will make each remaining lithology a new group with a single member:

When you are finished, click **OK** to create the new lithology column. It will appear in the project tree as an additional lithology column in the interval table.

Select the new column from the shape list to display it:

Click on the **Edit** button (✏️) to start editing the selected column.

The other way to group lithologies is to let Leapfrog Works create the lithology groups.
Automatic Lithology Groups

Leapfrog Works can automatically create lithology groups. To do this, create a new lithology column, as described above. Click the Auto Group button to reveal more options:

The First letter(s) and Last letter(s) options let you create groups according to the names of the existing lithologies. Click Group to create the new groups.

Here, the first two letters have been used to create a new set of lithologies:

The two alluvium lithologies have been added to a single group.

The One group per value option creates a group for each original lithology. You can then drag and drop lithologies into different groups, move lithologies you do not wish to group back into the Ungrouped Lithologies pane and use the Delete Groups options to remove any empty groups.

Splitting Lithologies

With the split lithologies tool, you can create new units from a single unit by selecting from intervals displayed in the scene. When you split lithologies, the original lithology column is
preserved and a new lithology column is added to the interval table. You can then select the original lithology column or the new one when displaying data and creating models.

The difference between the interval selection tool and the split lithologies tool is that with splitting lithologies, you are limited to selecting intervals from a single lithology. If you wish to select intervals from multiple lithologies, see Interval Selection.

To start splitting a lithology, first add the borehole data to the scene. Then right-click on the interval table in the project tree and select New Column > Split Lithologies. The New Lithology Column window will appear:

Select the lithology column you wish to use from the Base Column list, then enter a Name for the new lithology column. Click OK.

The Lithologies and Splits window will appear, together with a set of tools that will help you to select intervals in the scene:

Alluvium (gold) appears both above and below Coarse Sand (blue) and so should be split into two separate lithologies.

The first step is to select the lithology that will be split in the Lithologies and Splits window. In the example above, Alluvium is already selected.
Next, click on the **Select Intervals** button () and click the **Add Intervals** button (). In the scene, draw a line across each interval you wish to select.

To change the width of the line used to select intervals, click on the **Change Line Width** button () and enter a new value. You can keep the **Set Line Width** window open while you select intervals so you can change the line width as required.

Selected intervals are highlighted in the scene. If you accidentally select the wrong interval, either:

- Click the **Remove Intervals** button () and draw across the interval once again.
- Hold the **Ctrl** key while drawing across the interval.

You can also:

- Select all visible intervals by clicking on the **Select All** button () or by pressing Ctrl+A.
- Clear all selected intervals by clicking on the **Clear Selection** button () or by pressing Ctrl+Shift+A.
- Swap the selected intervals for the unselected intervals by clicking on the **Invert Selection** button () or by pressing Ctrl+I.
Once you have selected some segments, click on the **Assign to** button in the **Lithologies and Splits** window and select **Create New Split**:

![Image of Lithologies and Splits window]

The **New Split** window will appear:

![Image of New Split window]

Enter a **Name** for the new lithology, then click **OK**. The new lithology will be created and the scene updated to reflect the changes:
Once you have created a new lithology, you can add to it by selecting intervals, then selecting the lithology from the Assign to list.

When you are finished, click the Save button and close the Lithologies and Splits window. The new lithology column will appear in the project tree as an additional lithology column in the interval table.

Select the new column from the shape list to display it:

Click on the Edit button to start editing the selected column.

**Interval Selection**

When you wish to select a small portion of intervals or you don’t have suitable parameters to use a query filter, you can select intervals from boreholes displayed in the scene to create a new lithology column. The original lithology column is preserved and a new lithology column is added to the interval table. You can then select the original lithology column or the new one when displaying data and creating models.

The difference between the interval selection tool and the split lithologies tool is that with splitting lithologies, you are limited to selecting intervals from a single lithology. With interval selection, you can choose intervals from any lithology displayed in the scene.

To start selecting intervals, first add the borehole data to the scene. Then right-click on the interval table in the project tree and select New Column > Interval Selection. For a merged table, right-click on it and select Interval Selection.

The New Lithology Column window will appear:

Select the lithology column you wish to use from the Base Column list, then enter a Name for the new lithology column. Click OK.
The **Interval Selection** window will appear, together with a set of tools that will help you to select intervals in the scene. To select intervals, click on the **Select Intervals** button (●) and click the **Add Intervals** button (□). In the scene, draw a line across each interval you wish to select:

![Image of Interval Selection window]

Selected intervals are highlighted in the scene. If you accidentally select the wrong interval, either:

- Click the **Remove Intervals** button (●) and draw across the interval once again.
- Hold the **Ctrl** key while drawing across the interval.

You can also:

- Select all visible intervals by clicking on the **Select All** button (■) or by pressing Ctrl+A.
- Clear all selected intervals by clicking on the **Clear Selection** button (□) or by pressing Ctrl+Shift+A.
- Swap the selected intervals for the unselected intervals by clicking on the **Invert Selection** button (F) or by pressing Ctrl+I.

To change the width of the line used to select intervals, click on the **Change Line Width** button (□) and enter a new value. You can keep the **Set Line Width** window open while you select intervals so you can change the line width as required.
When you have selected at least one interval, click on the **Assign to** button, then either select an existing lithology or create a new lithology by selecting **Create New Lithology**:

Enter a **Name** for the new lithology, then click **OK**:

The new lithology will be created and the scene updated to reflect the changes:

Once you have created a new lithology, you can add to it by selecting intervals, then selecting the lithology from the **Assign to** list.
When you are finished, click the Save button and close the Interval Selection window. The new lithology column will appear in the project tree as an additional lithology column in the interval table. Select the new column from the shape list to display it:

**Overlaid Lithology Column**

You may have two versions of an interval column, one that contains draft data and one that contains the final version. The final version may contain gaps, which can be filled in using the draft version. The overlaid lithology tool lets you combine the two columns to create a new column.

Both columns must be part of the same interval table. If they are not, use the merged table tool to create a new table that contains both columns. See Merged Borehole Data Tables.

To create an overlaid lithology column, right-click on the interval table in the project tree and select New Column > Overlaid Lithology Column. For a merged table, right-click on it and select Overlaid Lithology Column.

The New Overlaid Lithology Column window will appear:

For the Primary column, select the column that you wish to have precedence. Data in the Fallback column will be used when no data is available from the Primary column.

Click Create to create the new column. The new column will appear in the project tree.

You can display borehole data with the new column by selecting it from the shape list:
**Category Column from Numeric Data**

When you have numeric data you wish to use with the lithology and category modelling tools, you can convert the numeric data to a category column. To do this, right-click on the numeric data column and select **New Column > Category From Numeric**. In the window that appears, select the **Base Column**, then enter a name for the new column. Click **OK**.

The next step is to sort the numeric data into categories:

Leapfrog Works automatically assigns three categories calculated from the distribution of data. To add a new category, click the **Add** button and enter the required value. Click the **Show Histogram** button to view the distribution of data in deciding what categories to define.

Click **OK** to create the new column, which will appear in the project tree as part of the original interval table.

**Back-flagging Borehole Data**

Evaluating geological models on boreholes creates a new lithology table containing the lithologies from the selected model. This is useful for validating models created from borehole data as you can generate statistics for the correlation between modelled geology and drilling data.

To created a back-flagged borehole data table, right-click on the **Boreholes** object in the project tree and select **New Evaluation**. The **New Evaluation** window will appear:

Select the model to use and enter names for the column and table.
Click OK to create the new table, which will appear in the project tree as part of the Boreholes object. The new table contains From, To and Lithology columns defined using the intersection between the model’s output volumes and the boreholes.

See:

- Comparing Modelled Values to Drilling Lithologies
- Comparing Drilling Lithologies to Modelled Values
- Refining the Geological Model to Improve Correlation Statistics

You can export the information displayed in the Correlation Statistics window in CSV format for use in other applications. To do this, click Export.

Comparing Modelled Values to Drilling Lithologies

Comparing model values to drilling lithologies shows how accurately drilling lithologies are modelled in the selected geological model. High matching percentages for drilling lithologies in the left-hand side of the window mean the model closely matches the drilling data for that lithology:

The right-hand side of the window shows the composition of the modelled values for the selected Drilling Lithology. Here, D1 in the geological model corresponds to D1 in the lithology data for 88.2% of the length of the borehole:
D1 in the model is actually D2 for 2.37% of the length of the boreholes, and 9.44% of the drilled D1 values fall outside of the boundary of the geological model.

In the images that follow, we will look at the correlation between the D5 drilling lithology and modelled D5. Here, two borehole data tables are displayed with the D5-D4 contact surface from the geological model:

The inner boreholes show the original borehole data. The outer boreholes show the geological model back-flagged onto the borehole data table. In the highlighted borehole, we can see there is a discrepancy between the actual lithology data and that modelled. When we view correlation statistics for this model, we can see that this discrepancy is explained by the fact that 17.97% of the D5 drilling length is modelled as D4:

You might consider this an acceptable match, but if it is too low, there are several ways to refine the geological model so that the geological model more closely reflects the original boreholes, which are discussed below. For this example, we will adjust the resolution of the geological model. The modelled segment now corresponds more closely to the original borehole data:

© 2017 ARANZ Geo Limited t/a Seequent
Viewing the correlation statistics shows that 99.62% of modelled boreholes now match the original data:

Comparing Drilling Lithologies to Modelled Values
Comparing drilling lithologies to model values shows the lithological composition of modelled values. Again, high matching percentages in the left-hand side of the window mean the model closely matches the drilling data for that modelled lithology:
The non-matching percentage indicates how much of the modelled lithology is not the borehole lithology. You can see in the right-hand side of the window the lithologies that make up the non-matching portions of the modelled value.

In the images that follow, we will look at the correlation between the D5 drilling lithology and modelled D5 once again. The non-matching percentage is 4.8, and on the right-hand side of the window, we can see that this is exclusively drilling lithology I2:

Adjusting the resolution of the geological model improves the matching percentage to the point where only 0.09 percent of the D5 modelled value is drilling lithology I2:

Refining the Geological Model to Improve Correlation Statistics

If the matching percentages are too low for the lithologies of interest, there are several ways to refine the geological model so that the geological model more closely matches the boreholes:

- Reduce the resolution of the geological model or of its contact surfaces. See Surface Resolution for a Geological Model and Surface Resolution in Leapfrog Works.
- Add more data to the model’s surfaces. See Adding Data to Surfaces.
- Snap surfaces to the data used to create them. See Contact Honouring.
Merged Borehole Data Tables

When you have more than one borehole interval table in a project, you can create a new table using selected columns from existing interval tables. You can include columns created by, for example, grouping or splitting lithologies or compositing.

To create a merged table, right-click on the Boreholes object in the project tree and select New Merged Table. The New Merged Table window will appear showing all interval columns available in the project:

![New Merged Table window]

You can change the columns included once you have created the table.

Select the columns you wish to include in the new table and click OK. The new table will appear in the project tree as part of the Boreholes object.

You can create query filters for a merged data table, as described in Query Filters. You can also select intervals (see Interval Selection) and create an overlaid lithology column (see Overlaid Lithology Column). You cannot, however, use the group lithologies and split lithology tools on a merged table.

To edit the table, right-click on it and select Edit Merged Table.

Core Photo Links

Leapfrog Works can link borehole data to ALS Webtrieve and Coreshed core photo databases. When borehole data has been linked, a photo link object will appear in the project tree:
You can only have one type of core photo link associated with the borehole data. To add a link, right-click on the Boreholes object and select Add Core Photo Link. In the window that appears, select the core photo provider and click OK:

An alternative to linking to a core photo database is to link to files stored locally or on a network drive. This can be achieved by having a URL column in an interval table. When the interval is selected in the scene, you can click the link to view the file:

Use the prefix file:/// to link to local files.

For information on setting up ALS Webtrieve and Coreshed links, see:

- Setting Up the ALS Interface
- Setting Up the Coreshed Interface

To use the core photo links, see:

- Using the ALS Interface
- Using the Coreshed Interface

**The ALS Core Photo Interface**

This topic describes how to set up and use the ALS core photo interface. It is divided into:

- Setting Up the ALS Interface
- Using the ALS Interface
- Removing the ALS Link

**Setting Up the ALS Interface**

Before you can view core photos, you must first log in to the ALS database. Two levels of security are provided, one set up in Leapfrog Works and the next via your browser.
To set up the interface between Leapfrog Works and the ALS database, right-click on the Boreholes object and select Add Core Photo Link. In the window that appears, select ALS Webtrieve and click OK. The ALS Core Photo Settings window will appear. Information required to access core data is the Project Name and the Encryption Key. This information provides the first level of security for information in the ALS database. Click on each field and enter the required information. The information is case-sensitive, so ensure that the characters entered are correctly capitalised.

For Leapfrog depths measured in, ensure that the units used for depth match in Leapfrog Works and ALS.

For Open selection in new browser, choose whether each core photo will be opened in a separate browser Window or Tab.

Click OK to save the information. If login is successful, the ALS Core Photos button ( ) will appear in the toolbar:

A link will also appear in the project tree as part of the Boreholes object:

You can edit the link by double-clicking on it.
Using the ALS Interface

To view core photos, click on a borehole in the scene, then click on the ALS Core Photo Link button in the window that appears:

Your browser will be launched and you will be prompted to log in to the ALS database. Enter the User Name and Password, which are case-sensitive. Remember to allow the browser to save the details so that you will not be prompted to log in each time you wish to view a photo.

Your browser settings may require that you install a plugin or make changes to settings in order to view core photos. If you are not able to access the ALS database from Leapfrog Works and have ensured your Project Name, Encryption Key, User Name and Password have been entered correctly, contact Customer Support as described in Getting Support.

If you want to view core photos in rapid succession, click on the ALS Core Photos button (↑) in the toolbar, then click on a borehole in the scene. This will simultaneously:

- Display information on the segment selected in Leapfrog Works
- Display the core photo in your browser

Removing the ALS Link

To remove an ALS link, right-click on it in the project tree and select Delete.

The Coreshed Core Photo Interface

This topic describes how to set up and use the Coreshed core photo interface. It is divided into:

- Setting Up the Coreshed Interface
- Using the Coreshed Interface
- Removing the Coreshed Link

Setting Up the Coreshed Interface

Before you can view core photos, you must first set up the Coreshed interface. To do this, right-click on the Boreholes object and select Add Core Photo Link. In the window that appears,
select **Coreshed** and click **OK**. The **Coreshed Photo Settings** window will appear. Select whether each core photo will be opened in a separate browser **Window** or **Tab**.

Click **OK** to save the information. The **Coreshed Core Photos** button ( pä ) will appear in the toolbar:

![Coreshed Photo Settings window](image)

A link will also appear in the project tree as part of the **Boreholes** object:

![Project tree with Coreshed link](image)

You can edit the link by double-clicking on it.

**Using the Coreshed Interface**

To view core photos, click on a borehole in the scene, then click on the **Coreshed Photo Link** button in the window that appears:

![Core photos window](image)

Your browser will be launched and you will be prompted to log in to the Coreshed database. Enter the **Username** and **Password**, which are case-sensitive. Remember to allow the browser to save the details so that you will not be prompted to log in each time you wish to view a photo.
Your browser settings may require that you install a plugin or make changes to settings in order to view core photos. If you are not able to access the Coreshed database from Leapfrog Works and have ensured your Username and Password have been entered correctly, contact Customer Support as described in Getting Support.

If you want to view core photos in rapid succession, click on the Coreshed Photo Link button ( ) in the toolbar, then click on a borehole in the scene. This will simultaneously:

- Display information on the segment selected in Leapfrog Works
- Display the core photo in your browser

Removing the Coreshed Link

To remove a Coreshed link, right-click on it in the project tree and select Delete.

Deleting Borehole Data

To delete a lithology or numeric data table, right-click on the table in the project tree and select Delete. You will be asked to confirm your choice.

When you right-click on the borehole or collar table object in the project tree and select Delete, the resulting action will also remove all lithology and numeric data tables from the project. You will be asked to confirm your choice.

Reloading Borehole Data

Reloading data is necessary when the imported data is modified externally. All borehole data can be reloaded by right-clicking on the Boreholes object and selecting Reload Boreholes. If you only need to reload a single table, right-click on that table and select Reload Data.

Reloading borehole data overwrites all existing borehole data. If you have data you wish to add to the project without overwriting existing data, use the Append Boreholes option.

The process is similar to that for importing borehole data:

- If the borehole data was loaded from a file on your computer or a network location, you will be prompted to specify the file locations.
- If the interval table is stored in an ODBC database, you will be prompted to connect to the database. See Selecting the ODBC Data Source.

When you reload data, Leapfrog Works retains the table structure and refreshes the data contained in the tables. This ensures that you do not need to reassign the data type for each column and select the columns to be imported.

Exporting Borehole Data

Changes made to the borehole data in Leapfrog Works only affect the Leapfrog Works database, not the original data files. You can export Leapfrog Works borehole data, which is
useful if you wish to keep a copy of borehole data outside the project.

You can:

- Export all data. See Exporting All Borehole Data.
- Export only a single data table. See Exporting a Single Borehole Data Table.

These export options export the borehole data tables using To and From values to indicate location information. If you wish to export data with X-Y-Z values, extract points data using one of the following options:

- Extracting Contact Points from Borehole Data
- Extracting Intrusion Values from Borehole Data
- Extracting Interval Midpoints from Borehole Data

Then export the data object as described in Exporting Points Data.

Exporting All Borehole Data

To export all borehole data, right-click on the Boreholes object and select Export. The Export Borehole Data window will appear:

Once you have selected how you wish to export the data, click OK. The Export Borehole Data Files window will appear:

The list shows the files that will be created, one for each data table. Choose the Folder where the files will be saved, then enter a Base file name, which will be added to the front of each file name.

Click Export to save the files.
Exporting borehole data in this way uses To and From values to indicate location information. If you wish to export data with X-Y-Z values, extract points data using one of the following options:

- Extracting Contact Points from Borehole Data
- Extracting Intrusion Values from Borehole Data
- Extracting Interval Midpoints from Borehole Data

Then export the data object as described in Exporting Points Data.

**Exporting a Single Borehole Data Table**

To export a single borehole data table, right-click on that table and select Export. The Export Borehole Data window will appear:

Once you have selected how you wish to export the data, click OK. You will be prompted for a filename and location.

Exporting a single borehole data uses To and From values to indicate location information. If you wish to export data with X-Y-Z values, extract points data using one of the following options:

- Extracting Contact Points from Borehole Data
- Extracting Intrusion Values from Borehole Data
- Extracting Interval Midpoints from Borehole Data

Then export the data object as described in Exporting Points Data.
Designs

Leapfrog Works imports design models in two formats, *.dxf and *.dwg.

Leapfrog Works does not support native Autodesk Civil 3D objects in *.dwg files. To import these into Leapfrog Works, export them from Civil 3D to an AutoCAD *.dwg file. They can then be imported into Leapfrog Works in a *.dwg file.

To import a design model, right-click on the Designs folder and select Import Designs. In the window that appears, navigate to the folder where your design model is stored and select the file. Click Open.

All layers available in the project will be displayed:

Select the layers you want to import. If the file contains information on more than one coordinate system, select the system you want to use from the Coordinate system list. Click OK to import the selected layers.

The model will be added to the project tree; expand it to see the different layers:

The meshes and lines in the design can be used as inputs to geological models and cross sections.

Design Meshes

You can also carry out standard operations on the design meshes, including the options available for working with meshes described in Cleaning Up a Mesh. Double-click on a design mesh to open the selected model.
mesh in the project tree to view the options available. Right-click on a mesh to see the other options available.

See Meshes for more information on working with meshes in Leapfrog Works.

A mesh marked with an exclamation mark (⚠️) is not closed.

**Design Lines**

If you need to edit a design line, right-click on it and select **Extract Polyline**. The new polyline object will appear in the **Polylines** folder. You can then edit the polyline and use it as an input to models and cross sections.
Points Data

Points are sets of X-Y-Z coordinates, with or without associated values. In Leapfrog Works, points are used to define surfaces and for interpolation. You can use the Points folder to:

- Import points data
- Extract contact points, intrusion values and interval midpoints from borehole data
- Create guide points
- Create grids of points that can be evaluated against geological and numeric models and exported for use in other modelling

The rest of this topic describes importing and exporting points, setting elevation for points and evaluating points. It is divided into:

- Importing Points Data
  - Selecting the ODBC Data Source
- Reloading Points Data
- Appending Points Data
- Importing a Column
- Setting Elevation for Points
- Evaluating Points Data
- Exporting Points Data
  - Exporting Intrusion Values
  - Exporting Interval Midpoints

Importing Points Data

Leapfrog Works supports the following file types for points data:

- CSV files (*.csv)
- ASCII text files (*.asc)
- DXF files (*.dxf)
- Leapfrog Works 3D Point Data files (*.pl3, *.ara)

Points data can be imported from:

- Files stored on your computer or a network location. Right-click on the Points folder and select Import Points. You will be prompted to select a file.
- From any database that runs an ODBC interface. Right-click on the Points folder and select Import Points via ODBC. See Selecting the ODBC Data Source below.

For each of these options, once the data source is selected, the process of importing the data is the same.
When importing a file that has multiple features, you will be prompted to select which ones to import. You can also choose to:

- Import the features as separate objects. Each feature will appear in the project tree as a separate object.
- Flatten all features into one object. Leapfrog Works will treat all features as a single object.

Once imported, the file will be added to the Points folder. If there are errors in the data, the errors can be corrected as described in Correcting Data Errors.

To view the imported data, double-click on the object that has been added to the Points folder.

Once points data has been imported to the project, it can be modified and evaluated against geological and numeric models, as described in Evaluating Points Data.

Selecting the ODBC Data Source

When importing points data from an ODBC database, you will need to specify the ODBC data source. Enter the information supplied by your database administrator and click OK.

Once the data source is selected, the import process is similar to that described above.

Reloading Points Data

Reloading data is necessary when the imported data is modified externally. Points data can be reloaded by right-clicking on the table and selecting Reload Data.

Reloading points data overwrites all data in the existing table. If you have data you wish to add to the project without overwriting existing data, use the Append Data option.

The process is similar to that for importing the original table.

Appending Points Data

If points data is stored in multiple files, you can import these files into the project and add them to existing points data. To do this, right-click on the object you wish to append and select Append Data. You will be prompted to select a file.

Next, the Import Tables For Appending window will be displayed.

Check the data to ensure that the correct information will be imported, then click Finish to add the new file.

Importing a Column

Columns of points data that were not imported when the original data was imported or that are stored in a separate file can be added to the table at any time. To do this, right-click on the points table in the project tree and select Import Column.

The process is similar to importing the original table; select the file and map the columns you wish to import.
Setting Elevation for Points

You can set the elevation for points objects (\( \mathcal{P} \)) by projecting them onto a surface. Any elevation data in the points table will be overwritten by the elevation values from the selected surface.

To set the elevation for points, right-click on it in the project tree and select Set Elevation. The Set Elevation from Surface window will appear:

Select from the surfaces available in the project.

Unprojected points are points that do not vertically intersect the selected surface. There are two options for handling these points:

- Leave the elevation field empty.
- Assign a fixed elevation value.

Click OK to set elevation values.

Evaluating Points Data

Once points data has been imported to the project, it can be modified and evaluated against geological and numeric models, as described in Evaluations.

In the case of geological models, you can also combine two or more models to evaluate the points data and set the priority used for evaluation. To do this, click on the Combined Evaluation button in the Select Models To Evaluate window. In the window that appears, select the evaluations to combined, then set their priority. Click OK to create the combined evaluation, then click OK in the Select Models To Evaluate window. The combined evaluation will be available from the colour list.

To delete a combined evaluation, click on the Delete Combined button in the Select Models To Evaluate window.
Exporting Points Data

To export points data, right-click on the points data object in the project tree and select Export. For many points objects, you will be prompted to select which rows to include. Points data can be exported in CSV format (*.csv) or DXF format (*.dxf). Additional export options are available for some types of points, which are described below.

Once you have selected how you wish to export the data, click Export. You will be prompted for a filename and location.

Exporting Intrusion Values

Intrusion values can be extracted from borehole data as described in Extracting Intrusion Values from Borehole Data.

There are two options for exporting intrusion values:

- Export only the contact points. To do this, right-click on the intrusion values object and select Export. If you choose this option, you can export the points in CSV format (*.csv) or DXF format (*.dxf).

- Export all the points used in creating an intrusion. To do this, right-click on the intrusion values object and select Export Volume Points. If you choose this option, you can only export the points in CSV format (*.csv).

In both cases, you will be prompted for a filename and location.

Exporting Interval Midpoints

Interval midpoints can be extracted from borehole data, which is described in Extracting Interval Midpoints from Borehole Data. You can also export midpoints directly from an RBF interpolant, which is described in Exporting Numeric Model Midpoints.

To export interval midpoints, right-click on the points data object in the project tree and select Export. Interval midpoints can be exported in the following formats:

- CSV text file (*.csv)
- Snowden Supervisor CSV file (*.csv)
- Isatis 3D points file (*.asc)

The values exported are the midpoints of each segment, the X-Y-Z values and the hole ID. The Snowden Supervisor and Isatis 3D points formats also include the interval length.

In each case, you will be prompted for a filename and location.

Extracting Points from Borehole Data

This topic describes extracting different types of points from imported borehole data. It is divided into:
188 | Leapfrog Works User Manual

- Extracting Contact Points from Borehole Data
- Extracting Intrusion Values from Borehole Data
- Extracting Interval Midpoints from Borehole Data

If you wish to save and export points data with X-Y-Z information, use these options, then right-click on the data object to export the data as described in Exporting Points Data.

**Extracting Contact Points from Borehole Data**

Contact points define the boundary between two lithology layers. You can extract contact points from interval tables to create a new points object in the Points folder. The values extracted are the x-y-z values of the contact points.

To extract contact points from an interval table, right-click on the Points folder and select New Contact Points. A window will appear listing the lithology and category columns available in the project:

Select the required column and click OK.
Next, the **New Contact Points** window will appear:

![New Contact Points window](image)

Select the lithology required from the **Select primary lithology** list, then select the adjacent lithologies you wish to extract in the **Contacting lithologies** list.

Unspecified intervals are intervals that have no data. By default, unspecified intervals are ignored when creating new contact points, but you can also treat them as the primary lithology or as contacting lithologies.

For complex geologies, the up and down directions for the surface may not be clear. If this is the case, untick the **Horizontal Plane** box. A reference plane will appear in the scene, with the up-facing surface labelled A and the downward-facing surface labelled B:

![Reference plane](image)

Controlling the position of the reference plane is similar to controlling the position of the moving plane:

- Use the handles in the scene window to move the plane.
- Set the **Dip** and **Dip Azimuth** values in the **New Contact Points** window. The reference plane will be updated in the scene.

Once the reference plane is correctly oriented, click the **Set From Plane** button.
A reference plane set for contact points in the Points folder will be applied wherever the contact points are used.

Click OK to create the points, which will appear in the project tree under the Points folder. To edit the points, double-click on them.

Extracted contact points can be exported as described in Exporting Points Data.

**Extracting Intrusion Values from Borehole Data**

You can extract intrusion points from interval tables to create a new points object in the Points folder.

To extract intrusion values from an interval table, right-click on the Points folder and select New Intrusion Values. A window will appear listing the lithology and category columns available in the project:

Select the required column and click OK.

Next, the New Intrusion window will appear:

Select the intrusion lithology, then move any younger lithologies to the Ignore list.
Intrusion Point Generation Parameters | 191

Unspecified intervals are intervals that have no data. By default, unspecified intervals are ignored when extracting intrusion values, but you can also treat them as the interior lithology or as exterior lithologies.

The settings in the Compositing tab are described in Category Composites. Click OK to create the new points object, which will appear in the project tree under the Points folder. To edit the points, double-click on the points object ( ) in the project tree. See Intrusion Point Generation Parameters below.

When you view the intrusion points in the scene, you can display only the contact points or all the points used determining the extrusion values. To display all points, click on the points object in the shape list and tick the box for Show volume points:

Extracted intrusion points and values can be exported as described in Exporting Points Data.

Intrusion Point Generation Parameters

To change the way intrusion values are generated, double-click on the points object ( ) in the project tree:

The Edit Intrusion window will appear, displaying the Point Generation tab.

Here, the surface and volume points are displayed to show the effects of the Surface offset distance and Background fill spacing parameters:
The **Surface offset distance** parameter sets the top and bottom ends of the interval and affects how a surface behaves when it approaches a contact point. A smaller distance restricts the angles that an approaching surface can take. Another factor that affects the angles a surface will take is whether or not a trend has been applied to the surface.

The **Background Fill Spacing** parameter determines the approximate length of segments in the remaining intervals. If the remaining interval is not a multiple of the **Background Fill Spacing** value, Leapfrog Works will automatically adjust the spacing to an appropriate value. A smaller value for **Background Fill Spacing** means higher resolution and, therefore, slightly smoother surfaces. However, computation can take longer.

**Extracting Interval Midpoints from Borehole Data**

You can extract interval midpoints from raw or composited numeric and category tables to create a new points object in the **Points** folder. The extracted points will be dynamically linked to the original borehole segments and can be evaluated against other data in the project. The values extracted are the midpoints of each segment, the X-Y-Z values and the hole ID.

If you are exporting points data for use in Snowden Supervisor, use this option for extracting points from borehole data. If you wish to export midpoints from an interpolant, see [Exporting Numeric Model Midpoints](#).

To extract midpoints from an interval table, right-click on the **Points** folder and select **New Interval Mid Points**. In the window that appears, select the required **Source table**, then select which data columns to use:

![New Interval Mid Points](image)

Apply a query filter, if required, then click **OK**. The new points object will appear in the project tree under the **Points** folder. To edit the points, double-click on the points object (تان) in the project tree.
Changes made to the source data table, such as changes to compositing parameters or special values rules, will be reflected in the extracted points object.

Extracted interval midpoints can be exported as described in Exporting Points Data.

Categorising Points

When you wish to select a small portion of points and you don’t have suitable parameters to use a query filter, you can select points in the scene and assign them to categories. This adds a new column to the points object, preserving the original data.

To start categorising points, right-click on the points object (§) in the project tree and select New Category Selection.

The New Category Selection window will appear:

If you select an existing column as the Source Column, you can assign selected points to the existing categories or create new categories. If you select <None> for the Source Column, you will have to define each category manually.

When you click OK, the points object will be added to the scene, along with a set of tools for selecting points. To select points, click on the Select Points button (•) and click the Add Points button (√). In the scene, draw a line across each point you wish to select:

Selected points are highlighted in the scene. If you accidentally select the wrong point, either:

- Click the Remove Points button (☐) and draw across the point once again.
- Hold the Ctrl key while drawing across the point.
You can also:

- Select all visible points by clicking on the **Select All** button (ヶ) or by pressing Ctrl+A.
- Clear all selected points by clicking on the **Clear Selection** button (ꀁ) or by pressing Ctrl+Shift+A.
- Swap the selected points for the unselected points by clicking on the **Invert Selection** button (ꀇ) or by pressing Ctrl+I.

To change the width of the line used to select points, click on the **Change Line Width** button (ꀆ) and enter a new value. You can keep the **Set Line Width** window open while you select points so you can change the line width as required.

When you have selected at least one point, click on the **Assign to** button, then select **Create New Lithology**.

Enter a **Name** for the new category, then click **OK**.

The new category will be created and the scene updated to reflect the changes:

Once you have created a new category, you can add to it by selecting further points, then selecting the category from the **Assign to** list.
When you are finished, click the **Save** button and close the **Category Selection** window. The new category column will appear in the project tree as an additional column in the points table. Select the new column from the shape list to display it.
Structural Data

In Leapfrog Works, you can create and edit planar structural data tables directly or from other objects in the project. Structural data can also be used to create and edit many surfaces. Downhole planar structural data and lineations can also be imported, although structural data imported in this way cannot be edited.

This topic describes how to work with structural data in Leapfrog Works. It covers:

- Creating New Planar Structural Data Tables
- Importing Planar Structural Data
- Importing Lineations
- Assigning Structural Data to Categories
- Editing the Orientation of Planar Structural Data
- Declustering Planar Structural Data
- Setting Elevation for Structural Data
- Estimating Planar Structural Data

See Stereonets and Form Interpolants for information on tools for analysing structural data.

Creating New Planar Structural Data Tables

There are two ways to create a new planar structural data table in Leapfrog Works:

- Create a new table as part of creating or editing another object. See Editing Surfaces with Structural Data.
- Create a new table using the Structural Modelling folder. Use this technique when, for example, you are creating structural data points from a map or image. Right-click on the Structural Modelling folder and select New Planar Structural Data. In the window that appears, enter a name for the new table and click OK.

Before creating the new data table, add the map, image or data object you wish to work from to the scene and orient the scene for drawing the new data points.
When a new structural data table is created, it will be added to the scene. The Planar Structural Data window will open, together with a set of tools for adding structural data points:

Click on the New Structural Data Point button and click and drag along the strike line in the scene to add a new data point:
You can adjust the data point using the controls in the Planar Structural Data window:

**Importing Planar Structural Data**

Leapfrog Works supports planar structural measurements in .csv or text formats. This topic describes importing structural data tables that include location information. Downhole structural data can also be imported, as described in [Importing Downhole Structural Data](#).

Structural data containing location information can be imported from:

- Files stored on your computer or a network location. Right-click on the Structural Modelling folder and select Import Planar Structural Data. You will be prompted to select a file.
- From any database that runs an ODBC interface. Right-click on the Structural Modelling folder and select Import Planar Structural Data via ODBC. See [Selecting the ODBC Data Source](#) below.
For each of these options, once the data source is selected, the process of importing the data is the same. Leapfrog Works will display the data and you can select which columns to import:

Leapfrog Works expects **East (X)**, **North (Y)**, **Elev (Z)**, **Dip** and **Dip Azimuth** columns. The **Polarity** column is optional. The **Base Category** column can be used for filtering data once it has been imported.

Click **Finish** to import the data. The structural measurements will appear in the **Structural Modelling** folder.

Once the data has been imported, you can reload and append the data and add columns to the data in a similar manner to borehole data. See [Appending Boreholes](#), [Reloading Borehole Data](#) and [Importing Columns](#) for more information.

### Selecting the ODBC Data Source

When importing planar structural data from an ODBC database, you will need to specify the ODBC data source. Enter the information supplied by your database administrator and click **OK**.

Once the data source is selected, the import process is similar to that described above.

### Importing Lineations

Lineations containing location information can be imported from files stored on your computer or a network location in .csv or text formats. To do this, right-click on the **Structural Modelling** folder and select **Import Lineations**. You will be prompted to select a file.

Leapfrog Works expects **East (X)**, **North (Y)**, **Elev (Z)**, **Trend** and **Plunge** columns. The **Polarity** column is optional. The **Category** column can be used for filtering data once it has been imported.
Click Finish to import the data. The lineations will appear in the Structural Modelling folder.

Once the data has been imported, you can reload and append the data and add columns to the data in a similar manner to borehole data. See Appending Boreholes, Reloading Borehole Data and Importing Columns for more information.

Assigning Structural Data to Categories

There are two ways to initiate structural data selection: from the data object in the project tree/shape list and from a stereonet. The advantage of initiating structural data selection from a stereonet is that the data will be displayed both on the stereonet and in the scene window. This provides the most flexibility for analysing what data belongs to what category. See Selecting Data in the Stereonet and Using the Scene Window with the Stereonet for more information.

If you wish to assign planar structural data points or lineations to categories, right-click on the data table in the project tree and select New Category Selection. First, select the Source Column. If you select an existing column as the Source Column, you can assign selected data points to existing categories or create new categories. If you select <None> for the Source Column, you will have to define each category manually.

Select points by clicking on the Select points tool ( ), then drawing over those points in the scene:
Once you have selected points, you can assign them to existing categories or create new ones. To create a new category, click on the Assign to > Create New Category button:

Enter a name for the new category and click OK.

When you have finished selecting points and adding them to categories, close the Category Selection window to close the editor.

Editing the Orientation of Planar Structural Data

If you need to edit the orientation of planar structural data points, you can do so in two ways:

- Edit the data in the table directly by double-clicking on the structural data table in the project tree. See The Table Dialog.
- Edit the structural data orientation in the scene.

To edit the structural data in the scene, right-click on the table in the project tree and select Edit Orientation in Scene. If the table is displayed in the scene, in the shape list, click on the Edit button ( ). The Planar Structural Data window will appear in the scene, together with controls for editing the data points. To edit a data point, click on it. Information about the selected point will be displayed in the Planar Structural Data window, together with controls in the scene you can use to adjust the point.
You can also add new data points in the same manner described in [Creating New Planar Structural Data Tables](#).

## Declustering Planar Structural Data

If a planar structural data table contains multiple duplicate or near-duplicate measurements, you can create a declustered structural data set that will make the table easier to work with. Declustering is intended to work with large, machine-collected data sets rather than smaller sets that might be edited manually.

Declustering preserves the original data table and creates the set as a “filter” by applying two parameters: the **Spatial search radius** and the **Angular tolerance**.

- The **Spatial search radius** determines the size of the declustering space. All points inside the **Spatial search radius** are compared searching for duplicates.
- The **Angular tolerance** measures whether points have the same or similar orientation. The orientation of all points inside the **Spatial search radius** is measured and the mean taken. If a point’s orientation is less than the **Angular tolerance** from the mean, then the point is regarded as a duplicate. The point that is retained is the one that is closest to the mean.

When a structural data set has a numeric column that gives some indication of the measurement’s uncertainty, this column can be used to prioritise values. Select the **Priority column** and set how the values should be handled.

Another factor in declustering the points is the category columns selected. When you choose multiple category columns, all criteria must match for points to be regarded as duplicates. What this means is that points will be kept if they have different category values in just one column, even if they meet the criteria for duplicates established by the **Spatial search radius** and the **Angular tolerance** and match in other columns. For example, in this table, assume that applying the **Spatial search radius** and the **Angular tolerance** parameters without using the Lithology category results in three points. However, including the Lithology column results in five points, indicated by the colours:

<table>
<thead>
<tr>
<th>Dip</th>
<th>Dip-azimuth</th>
<th>Lithology</th>
</tr>
</thead>
<tbody>
<tr>
<td>25</td>
<td>334</td>
<td>A</td>
</tr>
<tr>
<td>25</td>
<td>334</td>
<td>A</td>
</tr>
<tr>
<td>25</td>
<td>334</td>
<td>B</td>
</tr>
<tr>
<td>25</td>
<td>139</td>
<td>C</td>
</tr>
<tr>
<td>25</td>
<td>139</td>
<td>C</td>
</tr>
<tr>
<td>25</td>
<td>139</td>
<td>C</td>
</tr>
<tr>
<td>15</td>
<td>114</td>
<td>B</td>
</tr>
<tr>
<td>15</td>
<td>114</td>
<td>B</td>
</tr>
<tr>
<td>15</td>
<td>114</td>
<td>A</td>
</tr>
</tbody>
</table>

The more columns you select, the lower the likelihood that points will be regarded as duplicate.
The declustered set can be used like an ordinary structural data table. However, it is a filter on a planar structural data table and can be used as such when the parent table is displayed in the scene. For example, here the filters available for the planar structural data table include the query filters (奋斗目标) defined for the table as well as the declustered set (奋斗目标):

To create a declustered structural data set, right-click on the Structural Modelling folder and select New Declustered Structural Data. Select the source data table and a query filter, if required. Set the parameters and the columns you wish to use, then click OK. The declustered set will be added to the Structural Modelling folder.

Edit the set by right-clicking on it in the project tree and selecting Edit Declustered Structural Data.

**Setting Elevation for Structural Data**

You can set the elevation for planar structural data points or lineations by projecting the data onto a surface. Any elevation data in the data table will be overwritten by the elevation values from the selected surface.

To set the elevation for planar structural data points or lineations, right-click on the table in the project tree and select Set Elevation. The Set Elevation from Surface window will appear:

Select from the surfaces available in the project.

Unprojected points are data points that do not vertically intersect the selected surface. There are two options for handling these points:

- Leave the elevation field empty.
- Assign a fixed elevation value.
Click **OK** to set elevation values.

**Estimating Planar Structural Data**

You can generate a set of planar structural measurements from points, polylines and GIS lines. To do this, right-click on the points or lines object in the project tree and select **Estimate Structural Data**. In the window that appears, enter a name for the structural data table, then click **OK**. The new structural data table will appear in the project tree and you can view and edit it as described in **Displaying Structural Data** and **Editing the Orientation of Planar Structural Data**.
### Meshes

The **Meshes** folder contains all meshes imported into Leapfrog Works and created in Leapfrog Works outside of the model building process.

Two types of meshes are stored in the **Meshes** folder:

- Non-editable meshes are meshes imported into Leapfrog Works and meshes created in Leapfrog Works from the moving plane, **Meshes > Mesh Operations** tools and by extracting mesh parts from other surfaces in the project.
- Editable meshes are created in Leapfrog Works from data objects such as points data, GIS data and polylines. Editable meshes can be refined by adding more data. Editable meshes can be interpolated meshes (using FastRBF) or triangulated meshes (using Delaunay triangulation). Interpolated meshes can also be created from structural data and values objects.

This topic describes importing meshes, creating meshes and modifying editable meshes. See [Adding Data to Surfaces], [Global Trends] and [Editing Surfaces with Polylines] for information about different techniques for refining other surfaces in the project.

### Importing a Mesh

Mesh formats Leapfrog Works supports include:

- Leapfrog Files (*.msh, *.ara)
- DXF Files (*.dxf)
- DXF Polyface Files (*.dxf)
- Alias Wavefront Object Files (*.obj)

Once a mesh has been imported to the project, you can evaluate it against any interpolant or distance function in the project. See [Evaluations] for more information.

To import a mesh, right-click on the **Meshes** folder and select **Import Mesh**. Navigate to the folder that contains the mesh file and select the file. You can select multiple files using the Shift and Ctrl keys. Click **Open** to import the file.

The **Cleanup Mesh** window will be displayed. See [Cleaning Up a Mesh] below.

### Meshes with Textures

- PNG Files (*.png)
- JPEG Files (*.jpg, *.jpeg)
- TIFF and GeoTIFF Files (*.tiff, *.tif)
- Windows Bitmap Files (*.bmp)
- Graphics Interchange Format Files (*.gif)

The texture is automatically imported when the mesh is imported and will appear in the project tree under the mesh.

© 2017 ARANZ Geo Limited t/a Seequent
Cleaning Up a Mesh

There are several options for cleaning up a mesh that can be applied to meshes imported into Leapfrog Works and to non-editable meshes created in Leapfrog Works.

To clean up a mesh, double-click on the mesh in the **Meshes** folder or right-click on the mesh and select **Open**. The **Cleanup Mesh** window will be displayed:

![Cleanup Mesh window](image)

The **Cleanup Mesh** window will also be displayed when you import meshes.

The first option, **Combine identical vertices**, is intended for snapping cases where vertices occupy the exact same point in space. When enabled, vertices that have the exact same coordinates will be merged.

When enabled, **Combine identical vertices** occurs before the other processing actions in the **Cleanup Mesh** window.

The next four options are automatically applied to meshes created in or imported into Leapfrog Works:

- **Consistently orient faces** ensures that a mesh can be used for inside/outside testing.
- **Remove non-vertex points** removes points that are not used by any triangles.
- **Remove degenerate faces** removes triangles with duplicate vertices.
- **Orient concentric parts** ensures that internal parts have the correct orientation.

Other options are:

- **Invert mesh orientation** reverses the polarity of the mesh.
- **Remove vertical edges** removes any vertical faces from the mesh boundary.
- **Rotate locations about X axis** lets you rotate the mesh 90 degrees clockwise or anticlockwise.
- **Move Mesh** lets you offset the mesh by a vector. Tick the **Move Mesh** box and enter the required values. The offset values can be changed by opening the **Clean Mesh** window once again.

Select the options required, then click **OK**.
The mesh will be added to the project tree under the **Meshes** folder.

**Importing Meshes from Central**

When you are working in a Central project, you can import meshes from other Central projects on the same server. Importing meshes from Central allows you to easily share data between projects without having to manually export and re-import the data. In addition, if the mesh is out-of-date, you can reload it from Central.

**Importing Central Meshes**

To import a mesh from Central, first make sure you are already connected to Central. Then right-click on the **Meshes** folder and select **Import Mesh From Central**. In the window that appears, select one of the projects in the repository. Next, the project history will be displayed. Select a version to view a list of available objects, then click on a model to load its list of surfaces. Here, the surfaces from the Lithology geological model have been loaded, while the surfaces in the **Numeric Models** folder have not:

Use the Shift and Ctrl keys to select as many objects as required. Click **Import** to import the objects, which will be saved into the **Meshes** folder.
A different colour is used to indicate meshes imported from Central, and viewing the properties shows you what version of the project the mesh came from:

When you import a mesh from Central, Leapfrog Works checks to see if the mesh is the latest version from that branch. Out-of-date meshes are indicated in the project tree.

**Updating Out-of-date Meshes**

There are two options for updating an out-of-date mesh:

- **Reload Latest on Branch** imports the newest mesh available on the branch the out-of-date mesh was imported from.
- **Reload From Central** displays the project history and allows you to pick any point in time on any branch.

Right-click on a mesh and choose one of these options.

If you have selected multiple meshes in the project tree, the **Reload Latest on Branch** option is the only one available:

**Importing an Elevation Grid**

Elevation grid formats Leapfrog Works supports include:

- Arc/Info ASCII Grid Files (*.asc, *.txt)
- Arc/Info Binary Grid Files (*.adf)
- Digital Elevation Model Files (*.dem)
- Surfer ASCII or Binary Grid Files (*.grd)
- SRTM Files (*.hgt)
There are two ways to import an elevation grid:

- Import the grid to the Meshes folder. Right-click on the Meshes folder and select Import Elevation Grid.
- Import the grid as part of creating a topography. Right-click on the Topographies folder and select New Topography > Import Elevation Grid.

Navigate to the folder that contains the elevation grid file and open the file. The Import Elevation Grid window will be displayed:

Leapfrog Works automatically sets a **Surface resolution** based on the information in the file, but you can change the value if you wish. A lower value will produce more detail, but calculations will take longer. See **Surface Resolution in Leapfrog Works** for more information.

When importing an elevation grid, note that the resolution cannot be changed once the file has been imported.

Data is automatically clipped to the clipping boundary, but you can change how the data is filtered to suit any bounding box that exists in the project. If you do not wish to clip the data, untick **Clip data to bounding box**.

The **Margin** value determines how far outside the selected **Bounding box** the elevation grid will extend.

The **No Data Handling** option determines whether NoData values are displayed as gaps or at a fixed elevation setting.

Click **Import**. If you are creating a new topography, you will then be prompted to enter a name for it and click **OK**.
The elevation grid will be added to the **Meshes** folder. If you imported the grid as part of creating a topography, a hyperlink to the grid in the **Meshes** folder will appear as part of the defined topography.

**Creating a Mesh**

Leapfrog Works provides you with several tools for creating meshes:

- **Mesh from the Moving Plane**
- **Combining Meshes**
- **Clipping a Volume**
- **Clipping a Mesh**
- **Extracting Mesh Parts**

These tools produce non-editable meshes (educt) produced by Leapfrog Works.

You can also create editable meshes (educt) that are interpolated or triangulated:

- An interpolated mesh uses FastRBF to fit and interpolate surface data. The FastRBF is useful for creating meshes from sparse datasets or when data has large areas where there are no points. Interpolated meshes can be created from points data, GIS data, polylines, structural data and values objects.

- A triangulated mesh uses Delaunay triangulation to create the mesh. Triangulated meshes can be created from points data, GIS data and polylines. A triangulated mesh is suitable only for horizontal surfaces.

Editable meshes can be modified using other data in the project. See:

- **Interpolated Meshes**
- **Triangulated Meshes**
- **Offset Meshes**

**Mesh from the Moving Plane**

When a vertical wall, flat fault plane or other flat geological surface is required, the moving plane can be used to create a simple mesh.

To create a new mesh from the moving plane, first display the plane in the scene by clicking on the **Show Plane** button (educt). Use the controls in the scene to position the plane, then right-click on the **Meshes** folder and select **Mesh From Moving Plane**. The **Mesh From Plane** window will appear:
Set the Resolution for the mesh, enter a name and click OK. The new mesh will appear in the Meshes folder.

See Surface Resolution in Leapfrog Works for more information on the resolution setting.

**Combining Meshes**

To create a new mesh from two existing closed meshes, right-click on the Meshes folder and select Mesh Operations > Boolean Volume. The Boolean Volume window will appear:

![Boolean Volume Window](image)

The Available list shows all closed meshes available in the project. Select a mesh by double-clicking on it or by clicking on it, then on the arrow.

The Operation type can be Intersect or Union.

Click OK to save the new mesh, which will appear in the Meshes folder. To edit the mesh, double-click on it. The Boolean Volume window will appear.

When any of the meshes used to create the volume is modified, the volume will be updated.

**Clipping a Volume**

To clip a closed mesh using another mesh, right-click on the Meshes folder and select Mesh Operations > Clip Volume. The Clip Volume window will appear. Select the meshes you wish to use and whether to retain the inside or outside of the clipped mesh.

Click OK to save the new mesh, which will appear in the Meshes folder. To edit the mesh, double-click on it.

When either of the meshes used to create the clipped volume is modified, the clipped volume will also be updated.
Clipping a Mesh

This option creates a new mesh that consists of the parts of a Clip mesh that are inside, outside or overlap with the Using mesh. To clip one mesh using another mesh or boundary in this manner, right-click on the Meshes folder and select Mesh Operations > Clip Mesh. The Clip Mesh window will appear:

Select the meshes to use, then choose whether to retain the inside or the outside of the clipped mesh. Tick the Include overlap box to include the overlap between the two meshes as part of the new mesh.

Click OK to save the new mesh, which will appear in the Meshes folder. To edit the mesh, double-click on it. The Clip Mesh window will appear.

When either of the meshes used to create the clipped mesh is modified, the clipped mesh will be updated.

Extracting Mesh Parts

To extract the triangles from a mesh and create a new mesh, right-click on the surface and select Extract Mesh Parts. The Extract Mesh Parts window will appear:

The Extract clipped mesh option is only available for meshes that are clipped to a boundary. The largest part is initially selected. You can sort the mesh parts by Volume or by Area by clicking the heading of the respective column. Other options are:

- Select all parts by clicking the Select All button. To de-select all parts click the Remove All button.
- Inside-out parts have negative volume. To remove them, click the **Remove Inside-Out** button.
- To remove parts smaller than a given size, first click the **Select All** button. Select the last item you want to keep and click the **Remove Below Current** button.

Click **OK** to save the new mesh, which will appear in the **Meshes** folder. The mesh generated is a non-editable mesh.

Meshes created in this way are not connected to the mesh they were created from. Changes to the original mesh will not be reflected in the selected parts.

If the quality of the mesh produced is not acceptable, clip the mesh as described in **Clipping a Mesh**.

**Interpolated Meshes**

An interpolated mesh is a type of editable mesh. An interpolated mesh uses FastRBF to fit and interpolate surface data. The FastRBF is useful for creating meshes from sparse datasets or when data has large areas where there are no points. Interpolated meshes can be created from points data, GIS data, polylines, structural data and values objects.

Interpolated meshes can be edited by adding more data to the mesh and changing settings.

This topic describes creating and working with interpolated meshes. It is divided into:

- **Creating an Interpolated Mesh**
- **Refining an Interpolated Mesh**
  - **Surface Resolution Settings**
  - **Snap Settings**
  - **Other Options**

**Creating an Interpolated Mesh**

The steps for creating a mesh from data in the project are similar, regardless of the data used to create the mesh. The exception is creating an offset mesh, which requires additional parameters. See **Offset Meshes** for more information.

To create an interpolated mesh from data in the project, right-click on the **Meshes** folder and select from the **New Mesh** options.

Here, a new mesh is being created from points:
Select the required object from the list.

When defining the mesh’s extents, you can set the extents to be independent of other objects in the project (Own extents) or you can use the extents of another object (Shared with). When you select the Shared with option, the mesh will be updated when the extents object it shares is updated.

Leapfrog Works automatically sets the surface resolution based on the data available in the project. You can experiment with the surface resolution and adaptive settings once you have created the mesh. See Surface Resolution in Leapfrog Works for more information on the effects of these settings.

Enter a name for the new mesh and click OK.

If you are creating the mesh from a polyline, you will be prompted to select an existing polyline or draw a new one. If you draw a new polyline, it will not be able to be used elsewhere in the project unless it has been shared. To share the polyline, expand the mesh in the project tree, right-click on the polyline and select Share.

The new mesh will appear in the Meshes folder. Expand the mesh in the project tree to see how it was made. As further refinements are made to the mesh, that information will also be added to the mesh in the project tree.

Refining an Interpolated Mesh

Editable interpolated meshes can be refined by adding data, as described in Adding Data to Surfaces. The options available depend on how the mesh was created.

To add data to an editable mesh, right-click on it and select one of the options from the Add menu. A list of objects available in the project will be displayed. Select the required object and click OK. The mesh will be updated and the object used to modify it will appear under it in the project tree.

You can also refine editable interpolated meshes by changing the trend, transforming values, adjusting the interpolant and changing the boundary. To do this, double-click on the mesh. The Edit Mesh window will be opened:
See Offset Meshes for the options available for meshes from offset points.

**Surface Resolution Settings**
See Surface Resolution in Leapfrog Works for more information on the Surface resolution settings in the General tab.

**Snap Settings**
The mesh can be set to snap to the data objects used to create it. There are four options:

- **Off.** The mesh does not snap to the data.
- **All data.** The mesh snaps to data within the Maximum snap distance.
- **Drilling only.** The mesh snaps only to borehole data and data objects derived from borehole data within the Maximum snap distance but not to other data. For example, the mesh will honour points data derived from borehole data, but not points data imported into the Points folder.
- **Custom.** The mesh snaps to selected data objects within the Maximum snap distance.

Snapping to data is off by default. Although you can snap to all data, doing so not recommended as it increases the possibility that errors in the data or assumptions inherent in interpretations (e.g. polylines) will cause distortions in the meshes. If you do enable snapping, is best to snap only to drilling data.

When Snap to data is set to Custom, you can then set whether or not Snap is enabled for the objects used to create the mesh, as discussed in Contact Honouring. Custom is the most flexible options as you can select the specific data objects the mesh will or will not snap to.

If you will be exporting the mesh for use in another application, you may wish to adjust the snap settings.

Data used to create the mesh will appear in the Input list. When you add more data to the mesh, those objects will also be listed. You can remove those additional objects by expanding the mesh in the project tree, then right-clicking on the data object and selecting Remove.

**Other Options**
In the Boundary tab, you can change whether the mesh boundary is independent of other objects in the project (Own extents) or you can use the extents of another object (Shared with). When you select the Shared with option, the mesh will be updated when the extents object it shares is updated.

Options available in other tabs are similar to those available for interpolants. See:

- Structural Trends
- Clipping and Transforming Values for an RBF Interpolant

For information on the parameters in the Interpolants tab, see:

- Interpolant Functions
- The Spheroidal Interpolant Function
Triangulated Meshes

A triangulated mesh is a type of editable mesh. A triangulated mesh uses Delaunay triangulation to create the mesh and can handle more points than an interpolated mesh. Triangulated meshes can be created from points data, GIS data and polylines. Large datasets representing horizontal surfaces can be used to create a triangulated mesh.

The steps for creating a mesh from data in the project are similar, regardless of the data used to create the mesh. To create a triangulated mesh from data in the project, right-click on the Meshes folder and select from the New Triangulated Mesh options.

Here, a new triangulated mesh is being created from points:

Select the required object from the list.

When defining the mesh’s extents, you can set the extents to be independent of other objects in the project (Own extents) or you can use the extents of another object (Shared with). When you select the Shared with option, the mesh will be updated when the extents object it shares is updated.

The Use error threshold setting lets you exclude data points that fall within the threshold. This can be useful if you are using a large dataset and you require a more coarse surface that omits some data. When Use error threshold is disabled, the mesh will follow all the data.

Here, a mesh created from points has the Use error threshold disabled. The mesh follows all the points:
Here, a mesh has been created with the **Distance** set to 20. The mesh ignores points that fall outside the threshold:

![Mesh Image]

You will be able to change the **Use error threshold** setting once the mesh has been created. Enter a name for the new mesh and click **OK**.

If you are creating the mesh from a polyline, you will be prompted to select an existing polyline or draw a new one. If you draw a new polyline, it will not be able to be used elsewhere in the project unless it has been shared. To share the polyline, expand the mesh in the project tree, right-click on the polyline and select **Share**.

The new mesh will appear in the **Meshes** folder and you can edit its settings by double-clicking on it.

To add data to a triangulated mesh, right-click on it and select one of the options from the **Add** menu. A list of objects available in the project will be displayed. Select the required object and click **OK**. The mesh will be updated and the object used to modify it will appear under it in the project tree.

**Offset Meshes**

You can create a new interpolated mesh by offsetting an existing mesh with any points object in the project. To do this, first ensure the points and mesh you wish to use are already in the project. Next, right-click on the **Meshes** folder and select **New Mesh > From Offset Points**. In the window that appears, select the **Mesh** and **Points** to use:
When the mesh is created, it will automatically snap to the points, and points outside the Distance Limits will be ignored. These settings can be changed once the mesh has been created.

An offset mesh may be distorted if points used to offset the mesh lie too far outside the mesh extents. If this occurs, set a Maximum distance to exclude points far away from the mesh extents.

Enter a name for the new mesh and click OK. The new mesh will appear in the Meshes folder.

Editing an Offset Mesh

To edit the mesh, double-click on it. The Edit Offset Mesh window will appear:

The mesh can be set to snap to the data objects used to create it. There are four options:

- **Off.** The mesh does not snap to the data.
- **All data.** The mesh snaps to data within the Maximum snap distance.
- **Drilling only.** The mesh snaps only to borehole data and data objects derived from borehole data within the Maximum snap distance but not to other data. For example, the mesh will honour points derived from borehole data, but not points data imported into the Points folder.
- **Custom.** The mesh snaps to selected data objects within the Maximum snap distance.

Snapping to data is off by default. Although you can snap to all data, doing so not recommended as it increases the possibility that errors in the data or assumptions inherent in interpretations (e.g. polylines) will cause distortions in the meshes. If you do enable snapping, is best to snap only to drilling data.
Draping an Image on a Mesh

You can drape images on any mesh in the Meshes folder. To do this, right-click on the mesh in the Meshes folder and select one of the Drape Image options.

- For the Import Image option, you will be prompted for a file location. Navigate to the folder containing the image you wish to drape, select the file and click Open. Set georeferencing information for the image, if required, then click OK. See Importing a Map or Image for more information on georeferencing images. The imported image will appear in the project tree under the mesh.
- For the Select Existing Image option, select from the images available in the project and click OK. A hyperlink to the image will appear in the project tree under the mesh.

You can drape as many images as required. When the mesh is displayed in the scene, you will be able to select any draped images from the list of display options.

Mesh Export

You can export a mesh created in Leapfrog Works for use in other software. Formats Leapfrog Works can export are:

- Leapfrog Files (*.msh)
- DXF Files (*.dxf)
- Alias Wavefront Object Files (*.obj)

The rest of this topic describes the different ways to export meshes. It is divided into:

- Exporting a Single Mesh
- Exporting Multiple Meshes from the Meshes Folder
- Exporting Multiple Meshes from Models

When Snap to data is set to Custom, you can then set whether or not Snap is enabled for the objects used to create the mesh, as discussed in Contact Honouring. Custom is the most flexible options as you can select the specific data objects the mesh will or will not snap to.

If you will be exporting the mesh for use in another application, you may wish to adjust the snap settings.

Data used to create the mesh will appear in the Input list. When you add more data to the mesh, those objects will also be listed. You can remove those additional objects by expanding the mesh in the project tree, then right-clicking on the data object and selecting Remove.

You can modify an offset mesh by adding data, as described in Refining an Interpolated Mesh. You can also edit the mesh’s boundary, but you cannot apply a trend, clip and transform values or adjust the interpolant as you can for other interpolated editable meshes.
Exporting a Single Mesh

To export a mesh, right-click on the mesh and select Export. The Export Mesh Parts window will appear:

The Export clipped mesh option is only available for meshes that are clipped to a boundary. If the quality of the mesh produced is not acceptable, clip the mesh as described in Clipping a Mesh, then export the mesh.

Select the Parts to Export and Number of Significant Digits, then click OK. You will be prompted for a filename and location.

When exporting a mesh that has multiple parts, you can distinguish between the different parts by clicking on them in the Export Mesh Parts window. Here, the mesh was added to the scene before the Export Mesh Parts window was opened. Clicking on a mesh part in the list selects that part in the scene:
If the mesh is not in the scene when the Export Mesh Parts window is opened, selecting a part in the list will display it in the scene without reference to the other parts of the mesh:

Use the Shift and Ctrl keys to select and view multiple mesh parts in the scene:
Exporting Multiple Meshes from the Meshes Folder

To export multiple meshes from those in the Meshes folder, right-click on the Meshes folder and select Export Meshes. In the window that appears, select the meshes you wish to export:

The filename that will be used for each mesh is shown in the Filenames column. To change the filename for any of the meshes, click on its name in the Filenames column.

Next, select the format required and where to save the exported meshes. Click Export to save the meshes.
Exporting Multiple Meshes from Models

For geological models, if you wish to export surfaces other than the output volumes, untick the **Only Output Volumes** option. For faulted geological models, you also can select from the faulted volumes by ticking the **Faulted Volumes** box.

The filename that will be used for each mesh is shown in the **Filenames** column. To change the filename for any of the meshes, click on its name in the **Filenames** column.

Next, select the format required and where to save the exported meshes. For any of the export options other than Leapfrog Model Files format, you can save the meshes as a zip file.

| The Leapfrog Model File format exports a single *.lfm file. If the file is imported into the Meshes folder, each output volume will appear as a single mesh. |

Click **Export** to save the meshes.

**Elevation Grid Export**

For any mesh in a project, you can export an elevation grid for use in other software. Formats Leapfrog Works can export are:

- ARC/INFO ASCII Grid (*.asc)
- ESRIhdr Labelled (*.bil)
- ENVI Raster Image (*.img)
- Surfer ASCII Grid (*.grd)
To export an elevation grid, right-click on the mesh and select **Export Elevation Grid**. The **Export Grid** window will appear:

![Export Grid Window](image)

The **Snap to Grid** option changes the extents of the exported grid so that they coincide with the elevation grid spacing.

Enter the information required, then click **Export** to enter a filename and choose a location and format for the file.

### Thickness Grid Export

For any mesh in a project, you can export a grid made up of the area between two surfaces. Formats Leapfrog Works can export are:

- ARC/Info ASCII Grid (*.asc)
- ESRI.hdr Labelled (*.bil)
- ENVI Raster Image (*.img)
- Surfer ASCII Grid (*.grd)

To export a thickness grid, right-click on the mesh and select **Export Thickness Grid**. The **Export Thickness Grid** window will appear:

![Export Thickness Grid Window](image)

Select the surfaces required from the lists.

Enter the information required, then click **Export**. You will be prompted for a filename and location.
Polylines

Leapfrog Works imports many common polyline formats and also has tools for drawing and exporting polylines. See Import Polyline below. Polylines imported into Leapfrog Works are stored in the Polylines folder.

There are three ways to create polylines in Leapfrog Works:

- Create a new polyline using the Polylines folder. These polylines are stored in the Polylines folder.
- Create a new polyline as part of working with another tool. For example, a polyline can be drawn to create a lateral extent in a geological model. These polylines are stored in the tool used to create them and cannot be used elsewhere in the project unless they have been shared. To share a polyline, right-click on it and select Share. The polyline will be moved to the Polylines folder and can be used elsewhere in the project.
- Create a new polyline from a GIS line. To do this, right-click on the GIS lines object ( or ) in the GIS Data, Maps and Photos folder and select Extract Polyline. The new polyline object will appear in the Polylines folder. It is not linked to the original GIS lines object.

Polylines can be drawn using the curved polyline drawing tool or the straight line drawing tool. See Drawing in the Scene for more information on both tools.

Polylines can be exported in the formats described in Export Polyline below.

Import Polyline

Polyline formats Leapfrog Works supports include:

- Drawing Interchange Polylines (*.dxf)
- Leapfrog Polylines (*.lfpl)
- Leapfrog Polylines (*.csv, *.txt)

There are two ways to import a polyline:

- Right-click on the Polylines folder and select Import Polyline. In the Import Polyline window, navigate to the location where the polyline file is saved and select it. Click Open.
- Drag and drop polyline files directly into Leapfrog Works.

If the polyline file is in Leapfrog, Gocad or DXF formats, the importing will start immediately. For all other formats, the Polyline Import window will appear. If the polyline file is in one of the standard formats listed above, the default settings can be used. Click Import to finish the process. If, however, you wish to specify polyline import parameters, two pieces of information are required:

- The columns the polyline vertex coordinates are in
- How the polyline sections are separated in the file

Select the vertex coordinate columns by clicking on the heading at the top of a column and selecting one of East (X), North (Y) or Elev (Z) from the list.

© 2017 ARANZ Geo Limited t/a Seequent
When importing a file that has multiple features, you will be prompted to select which ones to import. You can also choose to:

- Import the features as separate objects. Each feature will appear in the project tree as a separate object.
- Flatten all features into one object. Leapfrog Works will treat all features as a single object.

The polyline will be imported and added to the project tree under the **Polylines** folder.

**Reload Polyline**

Reloading data is necessary when the imported data is modified externally. To reload a polyline, right-click on it in the project tree and select **Reload Data**.

Reloading a polyline overwrites any changes you have made to the polyline. Any dependent objects will be updated, which can take some time.

Select the file to be reloaded and click **Open**. The polyline will be updated, as will any dependent objects.

**Export Polyline**

Export a polyline by right-clicking on it and selecting **Export**. Leapfrog Works exports polylines in the following formats:

- Leapfrog Polylines (*.lfpl)
- Leapfrog Polylines (*.csv)
- Drawing Interchange Polylines (*.dxf)
Analysing Data

This part describes the tools available in Leapfrog Works for analysing data.

- Visualising data using the shape list and the shape properties panel is an important part of interpreting and refining data and making modelling decisions. The tools available depend on the type of object being displayed, and many objects can be displayed evaluated on other objects.
- Viewing statistical information about objects helps you to analyse your data.
- Stereonets are useful for visualising structural data and identifying trends in 2D. Errors in categorisation of structural data can also become apparent when the data is viewed on a stereonet.
- Form interpolants are useful for visualising structural data and identifying broad trends in 3D. The form interpolant’s meshes can then be used to control other surfaces in the project.
- With the borehole correlation tool, you can view and compare selected boreholes in a 2D view. You can then create interpretation tables in which you can assign and adjust intervals and create new intervals. Interpretation tables are like any other interval table in a project and can be used to create models.
- You can plan boreholes, view prognoses for models in the project and export planned boreholes in .csv format.
Visualising Data

Visualising data is an important part of interpreting and refining data and making modelling decisions.

This part describes the tools available in Leapfrog Works for visualising data. These tools are accessed via the shape list and the shape properties panel:

The tools available depend on the type of object being displayed:

- Boreholes can be displayed as lines or points and with the data associated with each segment. Data can be filtered using the shape properties panel controls and by applying query filters.
- Multiple borehole data tables can be displayed in the scene so that relationships between data in different tables can be explored.
- Some data can be displayed using a colour gradient, with the colourmap adjusted to enhance values of interest. Discrete colourmaps can also be applied to view numeric data in groups.
- Points data can be viewed as simple points or using the size of spheres to display associated values.
- GIS data can be viewed in its native form, on the topography or as part of a custom topography view.

Many objects in Leapfrog Works can be displayed evaluated on other objects. See Evaluations.

Presentation describes how to display data and create scenes, movies and scene files for presentation purposes.

The Shape List and Shape Properties Panel

Once objects have been added to the scene window, they will appear in the shape list, which can be treated as a working set of objects:

You can use controls in the shape list and the shape properties panel to change the way those objects are displayed. This is useful in interpreting data and making modelling decisions.

Changing how you view objects in the scene window does not change those objects in the project tree.
This topic is divided into:

- Removing Objects from the Scene
- The View List
- Colour Options
- Opacity
- Property Buttons
- Legends
- The Shape Properties Panel

**Removing Objects from the Scene**

All objects in the shape list have a button (×) that will remove the object from the scene. Most objects also have a visibility button (●) that can temporarily hide that object in the scene. It is often easier to make an object temporarily invisible than to remove it from the list. Some objects have an edit button (✏) that you can click to begin editing the object.

**The View List**

The view list is available for objects that can be displayed in different ways. For example, a lithology data table may contain several columns and the column displayed can be selected from the view list:

![View List Example](image)

Geological and numeric model evaluations are also selected from the view list. See Evaluations.
Colour Options

The colour options for an object depend on the type of object. Three different colour display options are shown below:

- The Contaminant table uses a continuous colourmap to display the numeric data. See Colourmaps and Colour Gradients for more information.
- The collar table is displayed using a single colour. Click the colour chip to change the colour. See Display Colours.
- The Geology table is displayed according to a colourmap of the categories in the table. These colours can be changed by clicking on the Edit Colours button, then clicking on each colour chip in the Legend window.

If your organisation uses standard colour coding for category and numeric data, you can import colourmaps for these data types. See Colourmap Import and Colour Gradients in Colourmaps and Colour Gradients.

Opacity

The opacity slider controls the transparency of objects in the scene:
Property Buttons

Property buttons vary according to the type of object. For example, property buttons can show or hide the triangles on a mesh, render points as spheres or display a surface clipped to a model boundary. You can always find out what a button does by holding the cursor over the button:

Legends

You can display a legend for many objects, including lithologies. To do this, click the legend button in the shape list:

To remove the legend from the scene, either click the legend button again or click the red X in the scene window:

The Shape Properties Panel

The shape properties panel adjacent to the shape list provides more detailed control of the appearance of the selected object:
Slice Mode

The properties available depend on the type of object, but the Slice mode appears for all objects. See Displaying Sliced Data for more information.

Filtering Data Using Queries

When a data table is selected in the shape list, you can use the controls in the shape properties panel to apply filters to the data in the scene. If query filters are available for the selected object, they will be listed in the Query filter list:

Filtering Data Using Values and Categories

You can also filter the range of values displayed by ticking the Value filter box, then setting the upper and lower limits of the range of data displayed:

If the data includes date information, you can use the Value filter option to restrict the display to a range of dates.
Selecting Multiple Objects

You can select multiple objects in the shape list and change their display properties using the shape properties panel. To do this, hold down the Shift or Ctrl key while clicking each object you wish to change:

Only controls common to the selected objects are available.

Display Colours

Many objects viewed in the scene are displayed using a single colour. To change the colour, add the object to the scene window, then click on the colour chip in the shape list. A window will appear in which you can change the colour:

You can:

- Click and drag the ring to pick a colour, then select the darkness or lightness of the colour from the triangle.
- Click on the eyedropper tool ( ), then click on something elsewhere on the screen to select the colour of that part of the screen.
- Select a colour chip from the palette.
- Set a random colour.
- Enter specific values for the colour to use.

Changes made are automatically applied to the scene. The Revert button changes back to the colour assigned when the window was first opened.
Colourmaps and Colour Gradients

Some objects viewed in the scene are displayed using a colourmap based on continuous colour mapping or discrete categories. Leapfrog Works automatically generates a colourmap based on the data, but manually altering a colourmap often helps in understanding the data. In addition, if your organisation uses standard colourmaps, you can import colourmaps and colour gradients to standardise the display of data across projects.

- Category data colourmaps can be edited by adding the data column to the scene, then clicking on the Edit Colours button in the shape list, as described in Colour Options. Then click on each colour chip in the Legend window. Category colourmaps can also be imported and exported.
- Numeric data colourmaps can be continuous and discrete and can also be used to display date information. Numeric colourmaps can be imported and exported and can also use imported colour gradients.

This topic describes how to use colourmaps and colour gradients. It is divided into:

- Colourmap Import and Export
  - Colourmap Import
  - Colourmap Export
- Editing a Colourmap
  - Continuous Colourmaps
  - Discrete Colourmaps
  - Displaying Dates
- Colour Gradients
- Deleting Colour Gradients

For information on the colour display options available for different objects, see Colour Options in The Shape List and Shape Properties Panel.

Colourmap Import and Export

Colourmaps for category and numeric data can easily be shared between projects on a column-by-column basis. To import or export a colourmap, expand the data object in the project tree and right-click on a column. The Import and Export options are available from the Colours menu:
Colourmap Import

When you import a colourmap:

- For category colourmaps, the existing colourmap will be overwritten.
- For numeric colourmaps, the imported colourmap will be added to those already defined.

To import a colourmap, right-click on the data object and select **Colours > Import**. Navigate to the folder containing the colourmap file and click **Open**.

If the object has more than one colourmap associated with it, you will be prompted to choose which one to overwrite.

If the column you expected is not listed, check to see if you have selected the correct file. The columns displayed are those that correspond to the type of data in the selected file (category or numeric).

Click **Import**.

Leapfrog Works will map the information in the file to the information in the selected data column.

Colourmap Export

To export a colourmap, right-click on the data object and select **Colours > Export**. If more than one colourmap is associated with the selected object, you will be prompted to choose from those available. Click **Export**.

In the window that appears, navigate to the folder where you wish to save the colourmap. Enter a filename and click **Save**. The colourmap will be saved in *.lfc format.

Editing a Colourmap

To edit the colourmap for an object, add the object to the scene. Click on the colourmap in the shape list and select **Edit Colourmaps**:

The **Edit Colourmaps** window will display the colourmap that is currently being used to display the data. Changes you make in this window will be updated in the scene.

To save the currently displayed colourmap and return to the main window, click **Close**.

Clicking **Revert All** deletes all custom colourmaps and cannot be undone.
Continuous Colourmaps
When using a continuous colourmap, the Gradient list includes built-in gradients as well as any that have been imported into the Colour Gradients folder. The scene will be updated to reflect the changes you make in this screen.

Once you have selected a gradient, you can change how it is used to display the data by adjusting the limits and the curve points.

The values that lie outside the Limits are coloured with the last colour at the relevant end of the colourmap. If the Dynamic box is ticked, the gradient will be updated when the data is updated, such as when borehole data is appended. If the box is unticked, the values manually set for the Minimum and Maximum limits will control the lower and upper bounds of the colourmap. Reducing the range of the upper and lower bounds is useful if the bulk of the data points have values in a range much smaller than the overall range of the data. This is common in skewed data.

The From Input Data button automatically adjusts the Minimum and Maximum Limit values so that the colourmap would follow the actual data distribution of the input data. Click this button and see if these values are adjusted.

The transformation of the colourmap can be adjusted by dragging the dots:

![Colourmap Transformation](image)

It can be helpful to view the histogram of the data when adjusting the curve points. Both the Properties window and the Edit Colourmaps window can be open at the same time.

Discrete Colourmaps
When you create new colourmaps, there are two types to choose from: continuous and discrete.
When you create a discrete colourmap, categories are defined and applied to the data displayed in the scene:

Click the **Add** button to add new categories. The scene will be updated to reflect the new categories:

**Displaying Dates**

A colourmap can be used to display date information:
If a date is displayed using a continuous colourmap, the curve points represent the start and end dates.

If you use a discrete colourmap, you can use the colours to show the different stages of, for example, a drilling campaign:

**Colour Gradients**

Colour gradients can be imported in the following formats:

- Geosoft Colour Files (*.tbl)
- ERMapper Lookup Tables (*.lut)
- MapInfo Colour Files (*.clr)
- Leapfrog Colour Files (*.lfc)

Perceptually uniform colourmaps are available at [http://peterkovesi.com/projects/colourmaps/](http://peterkovesi.com/projects/colourmaps/), where they can be downloaded in ERMapper (*.lut), Geosoft (*.tbl) and Golden Software Surfer (*.clr) format.

To import a colour gradient right-click on the **Colour Gradients** folder in the project tree and select **Import Gradient**. In the window that appears, navigate to the folder containing the gradient file and click **Open**. The gradient will be added to the **Colour Gradients** folder.
To apply a gradient to a colourmap, add an object to the scene and click on the colourmap in the shape list. Select **Edit Colourmaps**. All colour gradients in the **Colour Gradients** folder are available from the **Gradient** list:

![Image of Edit Colourmaps dialog]

**Deleting Colour Gradients**

If you delete a colour gradient from the **Colour Gradients** folder and it is in use in the project, you will need to select a replacement gradient for all colourmaps that use that gradient. Select the replacement colour gradient from those available in the project:

![Image of Confirm Delete dialog]

**Displaying Boreholes**

Viewing borehole data in the scene is an important part of refining borehole data and building a geological model. Therefore, Leapfrog Works has a number of different tools for displaying borehole data that can help in making borehole data processing and modelling decisions. This topic describes those display options and is divided into:

- **Displaying Boreholes as Lines or Cylinders**
- **Hiding Lithologies**
- **Displaying a Legend**
- **Changing Colourmaps**
- **Viewing Multiple Interval Tables**
- **Selecting from Multiple Columns**
- **Displaying Interval Data in the Scene**

Display borehole data in the scene by dragging the **Boreholes** object into the scene. You can also drag individual tables into the scene.

Once borehole data is visible in the scene, click on a borehole to view the data being displayed. You can also display the data associated with each interval by clicking on the **Show text** button ( ☑️ ) in the shape list. Here, data display is enabled for two interval tables:

![Image](image_url)

The **Show trace lines** button ( ▾️ ) in the shape list displays all trace lines, even if there is no data defined for some intervals. The **Filter trace lines** option in the shape properties panel displays only trace lines for boreholes selected by a query filter. See [Query Filters](#) for more information.
Displaying Boreholes as Lines or Cylinders

You can display boreholes as lines or points. You can also display the data associated with each segment. Here, the boreholes are displayed as flat lines:

The width of the lines is set in the shape properties panel.

When the **Make lines solid** button is enabled, the borehole data is displayed as cylinders and the property that can be controlled is the **Line radius**.
Hiding Lithologies

When lithology tables are displayed, you can hide some of the lithologies to help make better sense of the information in the scene. Click on the Edit Colours button in the shape list. In the window that appears, use the Show/Hide buttons (●) to determine what segments are displayed:

To select multiple lithologies, use the Shift or Ctrl keys while clicking. You can then change the visibility of all selected lithologies by clicking one of the visibility (●) buttons.

Hiding lithologies in this way only changes how the data is displayed in the scene. Another way of limiting the data displayed is to use a query filter (see Query Filters), which can later be used in selecting a subset of data for further processing.

Displaying a Legend

To display a legend in the scene, click the Show legend button (●) for the table:

The legend in the scene will be updated to reflect lithologies that are hidden in the scene when you click Edit Colours and hide some lithologies.
Changing Colourmaps

To change the colours used to display lithologies, click on the Edit Colours button in the shape list. In the window that appears, click on the colour chip for each lithology and change it as described in Display Colours.

To set multiple lithologies to a single colour, use the Shift or Ctrl keys to select the colour chips you wish to change, then click on one of the colour chips. The colour changes you make will be made to all selected lithologies.

You can also import a colourmap, which is described in Colourmap Import.

Viewing Multiple Interval Tables

When viewing multiple interval tables, use the line and point size controls and the transparency settings to see all the data at once. For example, here, the geology table has been made transparent to show the contaminant intervals inside:

Selecting from Multiple Columns

When an interval table has more than one column of data, select the column to view from the view list:
Some columns are editable, in which case you can click on the Edit button (✏️) to start editing the table:

![Editable Table](image)

### Displaying Interval Data in the Scene

Boreholes can be displayed with the data associated with each segment. For example, in the scene below, contaminant values are displayed along the borehole:

![Borehole Data](image)

To view data in this way, select the table in the shape list, then click on the Format Text button. In the Text Format window, click Insert Column to choose from the columns available:

![Text Format Window](image)

You can display multiple columns and add text:

![Multiple Columns](image)

Click OK to update the formatting in the scene. You can conceal the formatting in the scene by clicking on the Show text button (Arial) in the shape list:

![Show Text](image)

Clear text formatting by clicking on the Format Text button, then on Clear.
Displaying Points

Points data can be displayed using a single flat colour, using a colour gradient (see Colourmaps and Colour Gradients) or using the points values. You can also import a colourmap, which is described in Colourmap Import.

As with boreholes, points data can be displayed as flat points or as spheres. When Make points solid button (●) is enabled for points data, the data points are displayed as spheres. Here, the values are displayed as flat points:

You can restrict the range of values displayed using the Value filter in the properties panel.

When using the spheres option (●), the points can be displayed using the values. To do this, the Radius values list displays the columns available:

Select the column that will be used to determine the point size.
The **Point radius** control then determines the maximum point size displayed in the scene.

## Displaying Surfaces

Leapfrog Works assigns different colours to each side of a surface.

A basic mesh will have an inside (coloured red) and an outside (coloured blue):

![Image of mesh with inside and outside colours]

In the case of contact surfaces, each side will be assigned a lithology. "Unknown" will be used if multiple lithologies are contacted. Contact surfaces can be displayed using the assigned lithologies or the younging direction:

![Image of contact surfaces with multiple lithologies and younging direction]

Surfaces that are part of a geological model or interpolant are, by default, displayed clipped to the model boundary:

![Image of clipped surfaces that are part of a model]

Disable the **Clipped surface** button (1) to view the surface unclipped.

## Displaying Structural Data

Planar structural data is displayed as disks and lineations are displayed as cones. There are several ways to change how this data is displayed.

![Image of structural data with disks and lineations]
Planar Structural Data

In the scene below, planar structural data is displayed using the **Flat colour** option, with positive (red) and negative (blue) sides shown:

You can change the colours used to display the positive and negative sides using the controls in the shape list. You can also display the data points as **Thick disks**, **Flat disks** or as **Outlined flat disks**. You can change the **Disk radius** and the **Disk size** using the controls in the shape properties panel.

Another way of displaying planar structural data is to display the categories as different colours:

You can change the colours used to display the different categories by clicking on **Edit Colours** in the shape list. In the window that appears, click on the colour chip for each category and change it as described in **Display Colours**.

To set multiple categories to a single colour, use the Shift or Ctrl keys to select the colour chips you wish to change, then click on one of the colour chips. The colour changes you
make will be made to all selected categories.

The categories displayed can also be filtered by other columns in the data table, as described in Filtering Data Using Values and Categories.

**Lineations**

In the scene below, lineations are displayed using the Flat colour option in green:

Click the colour chip to change the colour used to display the cones in the shape list or select one of the table’s columns:
The length of the cones displayed in the scene is set in the properties panel. This can be a **Fixed Length**, defined by the **Cone length** setting, or it can be scaled using the values from one of the table’s columns:

Another way of displaying lineations is to display the categories as different colours:

You can change the colours used to display the different categories by clicking on **Edit Colours** in the shape list. In the window that appears, click on the colour chip for each category and change it as described in **Display Colours**.

To set multiple categories to a single colour, use the Shift or Ctrl keys to select the colour chips you wish to change, then click on one of the colour chips. The colour changes you make will be made to all selected categories.

The categories displayed can also be filtered by other columns in the data table, as described in **Filtering Data Using Values and Categories**.
Displaying Sliced Data

When you draw a slice in the scene, how objects in the scene are displayed in relation to the slicer is controlled in the properties panel:

The From Scene setting is the default; the object is sliced according to the properties set for the slicer.

By changing the Slice mode for objects in the scene, you can illustrate how a model has been constructed:

Displaying GIS Data

In Leapfrog Works, there are three ways of viewing GIS data:

- In its “native” form, as it was imported to the project. Add the GIS data object to the scene as you would any other object.
- On the topography. GIS data objects added to a project are automatically projected onto the topography and saved in the Topographies > Draped GIS Objects folder. Add the draped GIS object to the scene.
Combined with other data draped on the topography. See Custom Topography Views below.

The reason for having different ways of displaying GIS data is the difficulty posed by inconsistent height data. Not all height data is correct or wanted. In practice, it is important for all the data to be consistent. For this reason, a single elevation field is defined as part of the topography and available data is assigned heights from this object. The native height information is available and can be used to define the height of layers in the models.

Custom Topography Views

In Leapfrog Works, topography can be displayed with any of the GIS data and images available in the project. With a custom view, you can display multiple GIS data objects, maps and aerial photos.

To create a custom view, add the topography object to the scene. Select Views > Edit views from the GIS data list:

The Edit GIS Views window will appear. Click New to create a new view. Enter a name for the new view and click Create:
The new view will be created in the **Edit GIS Views** window, together with a list of **Available layers**. Click the **Add** button to move layers into the **Current layers** list and use the **Raise** and **Lower** buttons to arrange them:

![Edit GIS Views window](image)

Use the transparency and point and line size controls to emphasise data. Click **Close**. The topography will be displayed in the scene with the new view applied:
Evaluations

Many objects in Leapfrog Works can be evaluated on geological models, interpolants, blocks, models, flow models, points, and surfaces. To do this, right-click on an object and select Evaluations:

See Back-flagging Borehole Data for information on evaluating geological models on boreholes.

See Evaluating Sections for information on evaluating surfaces on cross sections and fence sections.

See Evaluating Points Data for information on evaluating surfaces on points.

A window will appear listing all objects in the project that can be used for an evaluation. Once you have selected one or more objects, click OK.

The evaluations will be added to the object in the project tree:

When you display objects in the scene, you can select the evaluations from the view list:
Leapfrog Works uses fixed 25%/75% quartiles.

Leapfrog Works has a number of tools that help you to statistically analyse your data. The most basic information about an object is contained in the object’s Properties window, which is specific to the type of object. See:

- For RBF interpolants, see RBF Interpolant Statistics.
- For multi-domained RBF interpolants, see Sub-interpolant Statistics.

The rest of this topic describes:

- Statistics on Interval Tables and Points Tables
- Statistics on Composites
- Correlation Statistics on Back-flagged Boreholes
- Statistics Visualisations
  - Scatter Plots
  - Q-Q Plots
  - Box Plots
- Interval Length Statistics
- Univariate Graphs
- Compositing Comparison
- Compositing Interval Lengths
- Statistics

Statistics on Interval Tables and Points Tables

Right-click on an interval table or points table and select Statistics to choose from the following options:

- Scatter Plots
- Q-Q Plots
- Box Plots
Interval tables also have the *Interval Length Statistics* option:

Right-click on a numeric column and select **Statistics** to open a univariate graph for that column. See [Univariate Graphs](#).

**Statistics on Composites**

Right-click on numeric columns on compositied tables and select **Statistics** to choose from the following options:

- **Univariate Graphs**
- **Compositing Comparison**
- **Compositing Interval Lengths**

**Correlation Statistics on Back-flagged Boreholes**

Right-click on a borehole data evaluation and select **Statistics**.
For complete information on how to use this table, see:

- Comparing Modelled Values to Drilling Lithologies
- Comparing Drilling Lithologies to Modelled Values
- Refining the Geological Model to Improve Correlation Statistics

**Statistics Visualisations**

**Scatter Plots**

Scatter plots are useful for understanding relationships between two variables. Two additional variables can be introduced by setting the **Colour** and **Size** options to the required data column. The example below plots the two variables against each other, with the colour indicating the lithology and the size of the dots relative to the sample length.
You can enable **Show equation** to annotate the chart with the **Regression**, **Pearson Correlation**, and **Log Correlation**:

You can zoom in and out of the graph to inspect it in more detail:

- Use the mouse’s scroll wheel to zoom in and out.
- Click and drag the chart to pan.
- Click the **Reset** button (бросить) to reset the view.
Click on a data point in the plot to select that data point in the scene. Use the **Select points** button ( gridView ) in the toolbar to select multiple points on the scatter plot. Selected points are highlighted in the scene.

If you accidentally select the wrong point, either:

- Click the **Remove Points** button ( gridView ) and draw across the point once again.
- Hold the **Ctrl** key while drawing across the point.

Selections cannot be saved.
Q-Q Plots

Quantile-Quantile plots are useful for validating your assumptions about the nature of distributions of data. Select the data columns to show on the X Axis and Y Axis (which can optionally be set as Log scales). You can also choose Show Y=X line for ease of comparison, especially when one axis is a log scale. Show circles indicates where binned data points have been used to plot the line and is useful to identify when data used to plot the chart is sparse.

The toolbar above the chart has tools for zooming in and out (🔍), panning (🏞️) and resetting the view (🔄).

- Zoom in to a specific section of the graph by clicking the zoom button (🔍) and then clicking and dragging a box around part of the graph.
- Pan the zoomed graph by clicking the pan button (🏞️) arrows button and then dragging in the graph.
- Return to the original view by clicking the reset button (🔄).

Box Plots

The box plot (or box-and-whisker plot) provides a visualisation of the key statistics for a data set in one diagram.

Select a Numeric data column to display, enabling Log scale if it helps to visualise the data more clearly. If the table includes category data, set Category to one of the category columns to help visualise the data. The visibility button allows you to select which categories in the
selected column you want to include in the chart. You can also use a pre-defined Query filter to limit the data included in the chart.

Note these features of the plot:

- The median is indicated by the red diamond.
- The box encloses the interquartile range around the median.
- The Notched option adds a v-shaped notch either side of the mean. Showing the mean provides a way of visualising how close it is to the median (the red diamond). The width of the notch is proportional to the confidence interval and is useful when comparing means; there is no significant relationship between the means when the notches do not overlap.
- The whiskers extend out to lines that mark the extents you select, which can be the Minimum/Maximum, the Outer fence or the Inner fence. Outer and inner values are defined as being three times the interquartile range and 1.5 times the interquartile range respectively. Outliers beyond the selected fence are displayed as circles.

Note that a reminder of the reference for the Outer fence and Inner fence can be found by holding your mouse cursor over these fields to see the tooltip.
Enable **Show Table** to display a table of statistics below the chart. This option is only available when **Horizontal** is disabled.
The *Interval Length Statistics* graph is a univariate graph, so for more information on the options, see **Univariate Graphs**.

### Univariate Graphs

There are several different visualisation options. **Histogram** shows a probability density function for the values, and **Cumulative Histogram** shows a cumulative distribution function for the values as a line graph:
There are three options that show the charts with a log scale in the X-axis:

- Select **Histogram** and enable **Histogram of the log** to see the value distribution with a log scale X-axis.
- Select **Cumulative Histogram** and enable **Histogram of the log** to see a cumulative distribution function for the values with a log scale X-axis.
- **Log Probability** is a log-log weighted cumulative probability distribution line chart.

**Percentage** is used to change the Y-axis scale from a length-weighted scale to a percentage scale.

**Bin width** changes the size of the histogram bins used in the plot.

The **Box Plot** options control the appearance of the box plot drawn under the primary chart. The whiskers extend out to lines that mark the extents you select, which can be the **Minimum/maximum**, the **Inner fence** or the **Outer fence**. Inner and outer values are defined as being 1.5 times the interquartile range and 3 times the interquartile range respectively. Outliers beyond the selected fence are displayed as circles.

Some univariate graphs may include a **Filtering** option containing where a **Query filter** defined for the data set can be selected.

The **Limits** fields control the ranges for the X-axis and Y-axis. Select **Automatic X axis limits** and/or **Automatic Y axis limits** to get the full range required for the chart display. Untick these and manually adjust the **X limits** and/or **Y limits** to constrain the chart to a particular region of interest. This can effectively be used to zoom the chart.

The bottom left corner of the chart displays a table with a comprehensive set of statistical measures for the data set.

© 2017 ARANZ Geo Limited t/a Seequent
Compositing Comparison

The double histogram, one displaying the distribution of the raw data and one displaying the distribution of the composited data, enables comparison of the two distributions of the same element before and after the compositing transformation. Impacts on the symmetry of distributions will be evident.

In the **Histogram** settings, **Bin width** changes the size of the histogram bins used in the plot. **Percentage** is used to change the Y-axis scale from a length-weighted scale to a percentage scale.

The **Box Plot** options control the appearance of the box plot drawn under the primary chart. The whiskers extend out to lines that mark the extents you select, which can be the **Minimum/maximum**, the **Inner fence** or the **Outer fence**. Inner and outer values are defined as being 1.5 times the interquartile range and 3 times the interquartile range respectively. Outliers beyond the selected fence are displayed as circles.

The **Limits** fields control the ranges for the X-axis and Y-axis. Select **Automatic X axis limits** and/or **Automatic Y axis limits** to get the full range required for the chart display. Untick these and manually adjust the **X limits** and/or **Y limits** to constrain the chart to a particular region of interest. This can effectively be used to zoom the chart.

The bottom left corner of the chart displays a table with a comprehensive set of statistical measures for the data set.
Compositing Interval Lengths

This graph shows a double histogram of distributions of the interval lengths before and after compositing.

In the Histogram settings, Bin width changes the size of the histogram bins used in the plot. Percentage is used to change the Y-axis scale from a length-weighted scale to a percentage scale.

The Box Plot options control the appearance of the box plot drawn under the primary chart. The whiskers extend out to lines that mark the extents you select, which can be the Minimum/maximum, the Inner fence or the Outer fence. Inner and outer values are defined as being 1.5 times the interquartile range and 3 times the interquartile range respectively. Outliers beyond the selected fence are displayed as circles.

The Limits fields control the ranges for the X-axis and Y-axis. Select Automatic X axis limits and/or Automatic Y axis limits to get the full range required for the chart display. Untick these and manually adjust the X limits and/or Y limits to constrain the chart to a particular region of interest. This can effectively be used to zoom the chart.

The bottom left corner of the chart displays a table with a comprehensive set of statistical measures for the data set.
Borehole Correlation Tool

With the borehole correlation tool, you can view and compare selected boreholes in a 2D view. You can then create interpretation tables in which you can assign and adjust intervals and create new intervals. Interpretation tables are like any other interval table in a project and can be used to create models. You can also save and export correlation set layouts and styles that can be exported and used in other Leapfrog Works projects.

This topic describes creating correlation sets and creating interpretation tables. It is divided into:

- Selecting Collars
- The Correlation Set Window
- Correlation Column Layouts
- Managing Styles
- Interpretation Tables

Selecting Collars

To select collars, you need to create a borehole correlation set, which you can do from the scene. First, add the collars you wish to work with to the scene. A useful way of limiting the number of collars displayed is to draw a slice in the scene and set it to a thick slice ( ), and set the slice width to hide collars on either side of the slice.

Next, right-click on the Borehole Correlation folder and select New Borehole Set. The new set will be created and opened, but is empty until you select collars. Click the Select Collars button ( ) to switch to the scene and begin selecting collars:

The line in the scene indicates the order in which collars will appear in the set.
To select collars one-by-one, click on the **Select collar** button (工作任务). Then, click on the **Add collar** button (工作任务). Click on a collar to add it to the nearest end of the set. Hold down the Ctrl key while clicking to remove a collar from the set.

To temporarily switch to the **Select** button (工作任务), hold down the Shift key while clicking.

To select all collars visible in the scene, click on the **Select all collars** button (工作任务). This will select collars using the best fit line.

To remove a collar from the selection, click on the **Remove collar** button (工作任务), then click on the collar you wish to remove from the set.

To clear the selection, click on the **Clear collar selection** button (工作任务).

If you want to change the order, you can easily do so in the set tab once you have selected collars.

Once you have selected the required collars, click the **Save** button (工作任务). The selected collars will be added to the set window:

**The Correlation Set Window**

Remove collars from the correlation set by either editing the set in the scene, as described in **Selecting Collars** above, or right-click on a column and select **Remove collar**.
You can change how data is displayed by clicking on the column header, then selecting **Format**:

The options available depend on the type of column being formatted.

Click on boreholes and drag them in the correlation set window to change the order in which they appear:

Add columns to the set by dragging them from the project tree into the set window. Here, four columns have been added to the set. From right to left they are a lithology column, an assay data column, a points data column formatted as a line and a points data column formatted as points:
You can then format the columns to get a better view of relationships between them. Format columns by right-clicking on their headers and selecting **Format**:

The styles used to display columns can be used by other sets in the project and can be exported to other projects. See [Managing Styles](#) below.

You can also drag some types of columns on top of other columns, although it is not possible to display category data on top of other category data. You can select multiple columns using the Shift and Ctrl keys.

### Navigating in the Correlation Set Window

Navigate in the correlation set window using the following mouse and keyboard combinations:

- Use the scroll wheel to move up and down.
- Hold down the Shift key while scrolling to move right and left.
- Hold down the Ctrl key while scrolling to zoom in and out.
- Hold down the Alt key while scrolling to stretch the data vertically.
Correlation Column Layouts

Once you have organised data columns and how they are displayed, you can save this information as a column layout that can be applied to other correlation sets. To do this, click the Layout button in the toolbar and select Save Current Layout from the list:

You will be prompted for a name. Click OK to save the layout, which can then be applied to other correlation sets by selecting the layout from the list.

To view the layouts available in the project, right-click on the Borehole Correlation folder in the project tree and select Layout Manager. In the window that appears, you can easily see what columns are used for each layout and apply a layout to all correlation sets in a project:

You can also export column layouts for use in other projects and import layouts from other projects. Clicking Export all exports layouts as a text file.
Managing Styles

The styles used to display data columns can also be exported to other projects. To view the styles used in the project, right-click on the Borehole Correlation folder in the project tree and select Style Manager:

Click Edit to change a style, which will update objects that use the selected style throughout the project.

Click Export all to export the styles in the project as a text file that can be imported into other projects.

Interpretation Tables

With interpretation tables, you can assign and adjust intervals and create new intervals. Interpretation tables are like any other interval table in a project and can be used to create models.

To create an interpretation table, click the New Interpretation button in the correlation set window. The New Interpretation Table window will be displayed:
There are three options for creating an interpretation table:

- Create the table without using a base table. Each borehole will have an empty legend and a single empty interval from 0 to its maximum depth. Select <None> for the **Source Column**.
- Create the table from a base column but have no intervals. This copies the base column’s legend but no intervals. Select the **Source Column**, then select **Empty Table**.
- Create a copy of a table. Select the **Source Column**, then select **All Intervals**.

Click **OK** to create the table. A new interpretation table will be added to the project tree under the **Boreholes** object and the column will be added to the correlation set window:

**Assigning Lithologies**

If you have created the interpretation table without using a base table, you will need to assign lithologies to the new table. Do this as part of working with the table in the correlation set window, which is described below.

**Modifying the Interpretation Table**

In the correlation set window, the blue line is used to create intervals. Position the blue line then right-click on it and select one of the options:
- The **Copy from** option assigns intervals from the base table.
- The **Insert interval** option adds an empty interval that overrides any intervals already defined.
- The **Unassign interval** option clears the lithology assigned to the interval.
- The **Assign interval** option opens the legend for the interpretation table so you can select a lithology to assign to the interval. If you need to add lithologies, you can do so in this window.

For example, to create an interval at the top of the table called “High Density”, move the blue line near to where you wish to create the interval. You do not need to be precise as you can adjust the interval once you have added it. Right-click and select **Insert interval**:

In the legend window, click the **Add** button and add a lithology called “High Density”:

© 2017 ARANZ Geo Limited t/a Seequent
Click **OK**, then select the new lithology to close the legend window. The new lithology has been assigned to the interval:

![Legend Window](image)

To resize the interval, click and drag the interval end points:

![Interval End Points](image)

You can move the interval end point and snap it to a data point in another column. To do this:

1. Click on the interval end point and drag it into position without releasing the mouse button.
2. Move the mouse across to the data point you wish to snap to.
3. Release the mouse.

You can also snap to points along the depth axis.

Continue making changes to the interpretation table, using the **Undo** button to step backwards if necessary. Save changes to update the table.
Stereonets

Stereonets are useful for visualising structural data and identifying trends in 2D. Errors in categorisation of structural data can also become apparent when the data is viewed on a stereonet.

This topic describes how to work with stereonets in Leapfrog Works. It covers:

- Creating a Stereonet
- Displaying the Stereonet in the 3D Scene
- Plot Options
- Data Display Options
- Viewing Stereonet Statistics
- Selecting Data in the Stereonet
  - Using the Scene Window with the Stereonet
- Exporting a Stereonet

Creating a Stereonet

Create a stereonet by right-clicking on the Stereonets folder (in the Structural Modelling folder) and selecting New Stereonet. The stereonet is created and opened in a new tab. Click the Add button to add any structural data table in the project to the stereonet:

You can also drag and drop structural data objects from the project tree into the stereonet.
Displaying the Stereonet in the 3D Scene

You can display the stereonet in the 3D scene by dragging the stereonet from the project tree into the scene or by clicking on the View button (균) in the stereonet window:

You can display planes and poles in the 3D scene, but not contours. In the shape list, you can control whether planes or poles are displayed in the scene:

Otherwise, the appearance of the stereonet in the 3D scene is controlled from the stereonet window.

You can also:

- Resize the stereonet. Click on it and use the green arrows to resize it.
- Move the stereonet around in the scene. The controls are the same as those for the moving plane.
- Centre the stereonet on its input data. To do this, click on the stereonet in the shape list and then select from its inputs in the Move to list.
Plot Options

Click **Options** to change plot options:

You can change the title and axes labels and select between Schmidt (equal area) and Wulff (equal angle) plot types.

The **Desample rate** affects how quickly data is displayed by combining points with duplicate orientations, as determined by the **Desample rate** value. A low value will filter fewer data points, whereas a higher value will filter out more data. Setting the **Desample rate** to 0 plots all points, which may be slow for very large data sets that have not been declustered. The **Desample rate** applies only to how data is displayed; it does not affect the data in the table.

**Data Display Options**

Planar structural data can be displayed as planes ( ), poles ( ) or contours ( ), using the colouring from any column in the structural data table. Lineations can be displayed as poles ( ) or contours ( ). Contour methods available are **Schmidt**, **Exponential Kamb** and **Kamb**, and contours can be displayed filled or outlined.
Click on a line or pole to view information about the data point:

The information displayed includes whether or not there are duplicates of the selected data point in the data set.

Click the mean button (○) to view the mean on the stereonet, which is displayed as a line for planar structural data and as an X for lineations.
A legend can be displayed for the stereonet as a whole and for the contours. The stereonet’s legend is generated from the categories that are visible in the list of colourings. Here, the categories displayed are from the Bedding column:

You can also apply query filters from those available in the project.

Declustered data can be viewed on stereonets in two ways:

- Declustered data can be viewed directly on the stereonet. Simply drag the declustered table into the stereonet.
- If the declustered data’s parent data table is displayed on the stereonet, the declustered data is available as a filter.

For example, here a structural data table is displayed on a stereonet along with a declustered table. The declustered table is available as a query filter for its parent object:
Viewing Stereonet Statistics

Click the **Statistics** button to view statistics on the data displayed on the stereonet:

You can select specific rows and copy them to the clipboard or copy all data to the clipboard.

Selecting Data in the Stereonet

You can select data in the stereonet and assign it to new categories or existing ones. To do this, click on the data table in the stereonet window and select **New selection** from the colouring list:
The **New Category Selection** window will appear:

![New Category Selection Window](image)

The poles will be displayed in the stereonet, if they are not already visible, and the data table will also be added to the scene window, together with tools for selecting points in the scene.

Organising the stereonet tab and the **Scene View** tab so they are displayed side-by-side can be useful in working with the data as you can select data in the stereonet or in the scene window. This is described further in [Using the Scene Window with the Stereonet](#) below.

If you select an existing column as the **Source Column**, you can assign selected points to the existing categories or create new categories. If you select `<None>` for the **Source Column**, you will have to define each category manually.

When you click **OK**, a set of tools for selecting data will be added to the stereonet window:

![Selecting Data Tools](image)

There are two tools for selecting data in the stereonet, the polygon tool (①) and the bullseye (②) tool.

- Use the polygon tool (①) to draw around the points you wish to select. Closing the polygon will select the points, and you can click on the vertices to refine the shape of the selection. Click outside of the selection to clear the polygon.
- Use the bullseye tool (②) to:
  - Click on points one-by-one.
  - Click and drag around points.

The **Add** button (③) and the **Remove** button (④) determine whether selected points are being added to or removed from the selection. For example, if you draw a polygon around a set of points with the **Add** button enabled, the points will be added to the selection.
You can also:

- Remove points from a selection while the **Add** button (●) is enabled by holding down the Ctrl key and selecting points.
- Select all visible points by clicking on the **Select All** button (■) or by pressing Ctrl+A.
- Clear all selected points by clicking on the **Clear Selection** button (□) or by pressing Ctrl+Shift+A.
- Swap the selected points for the unselected points by clicking on the **Invert Selection** button (□) or by pressing Ctrl+I.
- Show or hide all unassigned points using the **Unspecified Measurements** button (□).

Statistics are shown for the currently selected set of points:
Once you have selected a set of points, click the **Assign to** button in the stereonet window, then select **Create New Category**. In the window that appears, enter a name for the category and assign a colour:

Click **OK**. The new category will be created and the stereonet will be updated to reflect the changes:

The scene window will also be updated.
Once you have created a new category, you can add to it by selecting further points, then selecting the category from the **Assign to** list.

When you are finished, click the **Save** button and close the category editor. You can make further edits by clicking the **Edit** button in the stereonet window.

### Using the Scene Window with the Stereonet

You can also select points in the scene window by clicking on the **Select points** tool, then drawing over those points in the scene:

Controls for assigning points to categories will remain in the stereonet window, and both the stereonet window and the scene window will be updated to reflect the selected and assigned points.

### Exporting a Stereonet

Stereonets can be exported in the following formats:

- PDF Files (*.pdf)
- Scalable Vector Graphics Files (*.svg)
- PNG Image Files (*.png)

Click the **Export** button. Select a format and navigate to the folder where you wish to save the file. Enter a name and click **Save**.
Form Interpolants

A form interpolant is an RBF interpolant that uses planar structural data to control the RBF gradient. The RBF gradient resembles the geology orientation, which makes form interpolants useful for visualising structural data and identifying broad trends in 3D. The form interpolant’s meshes can then be used to control other surfaces in the project.

This topic describes how to work with form interpolants in Leapfrog Works. It covers:

- Creating a Form Interpolant
- The Form Interpolant in the Project Tree
- Form Interpolant Statistics

Once a form interpolant has been created, experiment with different Distance values. To do this, double-click on the interpolant in the project tree and click on the Outputs tab.

Creating a Form Interpolant

To create a form interpolant, right-click on the Form Interpolants folder (in the Structural Modelling folder) and select New Form Interpolant. In the window that appears, click the Add button to add structural data tables to the interpolant:
Data can be filtered using the query filters defined for the selected structural data tables:

![Interpolant Window](image)

Once you have created the interpolant, you can easily add and remove structural data tables and change the filtering.

When generating the form interpolant, you can use the tangents and polarity or only the tangents. To use both, leave the Use Polarity box ticked. To use only the tangents, untick the box.

The Boundary filter setting determines how data is handled when it lies outside the interpolant’s boundary:

- **Boundary filter** enabled. The interpolant is only influenced by the data that falls inside the boundary.
- **Boundary filter** disabled. The interpolant is influenced by the data both inside and outside the boundary.

### Setting a Trend

In the Trend tab, you can set a trend using the moving plane or by entering the required values. You can also use the Set to list to choose different options used in the project. **Isotropic** is the default option used when the function is created.

The Ellipsoid Ratios determine the relative shape and strength of the ellipsoids in the scene, where:

- The **Maximum** value is the relative strength in the direction of the green line on the moving plane.
- The **Intermed.** value is the relative strength in the direction perpendicular to the green line on the moving plane.
- The **Minimum** value is the relative strength in the direction orthogonal to the plane.

### Adding Isosurfaces

The isosurfaces generated for the form interpolant are determined by the settings in the Outputs tab. If you wish to add more isosurfaces to the interpolant, click the Add button and
enter the required Iso Value. Click on an isosurface and then on the Remove button to delete it. The Default resolution setting is used for all new isosurfaces.

The Form Interpolant in the Project Tree

In the project tree, the form interpolant contains objects that represent different parts of the interpolant:

- The Extents object represents the interpolant’s boundary settings, from the Boundary tab.
- The Trend object describes the trend applied in the interpolant. See Global Trends for more information.
- The structural data object contains a link to the data used in generating the interpolant. See Form Interpolant Statistics for more information.
- The Isosurfaces folder contains the isosurfaces defined in the Outputs tab.

To display the form interpolant:

- Drag the interpolant into the scene.
- Right-click on the interpolant and select View Isosurfaces.

Form Interpolant Statistics

To view information about the data used for the form interpolant, right-click on the structural data object under the interpolant and select Properties. The General tab includes
information about how the data has been declustered:

![Diagram of declustering data](image)

You cannot change how data is declustered in the form interpolant, but if you wish to have more control over this, create a declustered structural data set and use it as the input for the form interpolant. See [Declustering Planar Structural Data](#) for more information.
Planning Boreholes

In Leapfrog Works, you can plan boreholes, view prognoses for models in the project and export planned boreholes in .csv format.

Planned boreholes are added to a project from the Planned Boreholes folder, which is in the Borehole Data folder. When displayed in the scene, the planned borehole is made up of a collar point, a target location and a path defined by lift and drift parameters:

The rest of this topic is divided into:

- Adding Planned Boreholes
- Planning Options
- Drilling Prognoses
- Exporting Planned Boreholes
- Importing Planned Boreholes
Adding Planned Boreholes

To plan a borehole, first add the data objects to the scene that you will use in helping to define the borehole, such as the topography and any existing boreholes. Next, right click on the Planned Boreholes folder and select Plan Borehole. In the window that appears, you can define the borehole by specifying its collar or its target:

![Borehole Planning Window](image)

You can change whether Collar or Target is selected when this window is opened by clicking on the Defaults button. See Planning Options below.

A name is automatically generated for the new planned borehole based on the IDs in the collar table. If there is more than one phase available, you can select a different phase from the list.

There are three ways to define the borehole collar or target:

- Click in the scene to set the collar or target location. First, click on the Select button for the Collar or Target, then click in the scene to define the Collar or Target. The borehole will appear in the scene and you can adjust the coordinates using the controls in the Borehole Planning window. Click the Slice along borehole button to draw a slice in the scene. This is useful in adjusting the borehole path and in defining subsequent boreholes.

- Draw the borehole in the scene. Click on the Select button for the Collar or Target, then click and drag in the scene to define a basic path for the borehole. If you are defining the borehole from the collar down, click first on or near the topography. Likewise, if you are defining the borehole from the target up, click first at or near the target point.

- Enter the coordinates for the Collar or the Target in the Borehole Planning window.

Clicking the Move collar onto the Topography button adjusts the elevation of the borehole so that it lies on the topography.
Click the Next Hole button to create another planned borehole. The new planned borehole will be created at a specific distance from the currently displayed planned borehole using the Path settings for the currently displayed borehole. The distance is determined by the Offset To Next Hole settings in the Borehole Planning Options window. See Planning Options below.

Once you have specified the collar or target, adjust the borehole path:

- **Lift** is how much the borehole deviates upward.
- **Drift** is how much the borehole deviates laterally.
- Leapfrog Works automatically calculates the **Depth** value when the borehole is defined by the Target location.
- Adding an **End of hole** length extends the borehole past the Target location.

Planned boreholes will appear in the Planned Boreholes folder. You can change a planned borehole by right-clicking on it and selecting Edit Borehole.

**Planning Options**

When planning boreholes using the Borehole Planning window, the Path values entered apply only to the current borehole. If you wish to set default values for these parameters for new planned boreholes, either right-click on the Planned Boreholes folder and select Edit Planned Boreholes Defaults or click on the Defaults button in the Borehole Planning window. The Borehole Planning Options window will appear:

Select whether new planned boreholes are specified by the Collar or by the Target.

In the Borehole Planning window, clicking Next adds a new planned borehole. In the Borehole Planning Options window, the Offset To Next Hole values determine how far the new planned borehole is from the selected planned borehole.
Enter the information required and click **OK**. The new settings will be applied to the next new planned borehole added to the project.

**Drilling Prognoses**

Planned boreholes can be evaluated against any model in the project. To view drilling prognoses for a borehole, right-click on it and select **Drilling Prognoses**. The **Drilling Prognoses** window will appear:

You can display prognoses for different models by selecting them from the list. For numeric models, you can view a plot of the data by clicking on the **Plot** tab.

In each tab, you can copy the information displayed to your computer’s clipboard by clicking the **Copy to Clipboard** button. The information in the **Data** tab will be copied as tab delimited text, which can be copied into a spreadsheet application such as Excel. The plot displayed in the **Plot** tab will be copied as a bitmap image.

**Exporting Planned Boreholes**

To export planned boreholes, either right-click on the **Planned Boreholes** object and select **Export Planned Boreholes** or right-click on a planned borehole and select **Export**. The **Export Planned Boreholes** window will appear:

Selecting a phase from the **Show Phase** list will select all planned boreholes in that phase. The total length will be updated as you add or remove boreholes.
In Leapfrog Works, positive dip points down for planned boreholes. To invert the dip for exported planned boreholes so that negative dip points down, tick the box for Invert dip on export.

Click Export. You will be prompted for a filename and location.

**Importing Planned Boreholes**

Leapfrog Works imports planned boreholes from files in CSV format. The columns expected are:

- A borehole identifier
- X-Y-Z coordinates for the planned borehole
- Azimuth
- Dip
- Lift rate
- Drift rate
- Distance
- Extension
- Target Depth
- Comment

To import planned boreholes, right-click on the Planned Boreholes folder and select Import Planned Boreholes. If the IDs in the file are already in the project, you will be prompted to resolve the conflict:

![Resolve Naming Conflict](image)

You can:

- Rename the imported boreholes. Leapfrog Works will automatically assign new names and import the planned boreholes.
- Exclude planned boreholes that already exist in the project. Planned boreholes will only be imported if they have an identifier that does not already exist in the project.
- Replace existing planned boreholes with the imported boreholes. Use this option if you are importing information previously exported from the project and subsequently updated in an external application.

Click OK to process the file.

If there are no conflicts, the planned boreholes will be imported and added to the Planned Boreholes folder.
Modelling

This section describes how to build models in Leapfrog Works.

- Geological models can be built from lithology data or from any other suitable data in the project. Visualising data in the scene is an important step in determining the model that will be built, and the tools for doing this are described in Visualising Data. Once this has been determined, the next step is to define a basic geological model and refine its boundaries. Modelling contact surfaces and setting their cutting relationships determine how the basic model volume is divided into lithologies.
- With the Numeric Models folder, you can interpolate downhole numeric data, composited borehole data and points data.
- Combined models use information from up to four geological models, interpolants and distance functions in order to visualise relationships between different types of data in the project.
- When you have a licence for the Hydrogeology Solutions Kit, geological models created in Leapfrog Works can be used as the basis for ModFlow and FEFLOW models. You can create flow models directly in Leapfrog Works and assign hydrological/material properties based on the lithologies in the geological model. Flow models can be exported for use in other applications, and you can import existing flow models and use them as the basis for the construction of new models. Flow models can be displayed in the scene, and time-dependent data can also be visualised.
Geological Models

The model building process involves several key steps:

- Creating the project and setting up the modelling environment
- Importing borehole data and correcting errors
- Importing other required data
- Visualising the data in the scene and inspecting it to make sense of the model that will be built. It is at this stage that you might create new borehole data columns to select data that will be the basis of geological models.
- Creating a basic GM, then refining its boundary and defining a fault system
- Modelling the contact surfaces
- Setting the cutting relationships between the different contact surfaces and generating volumes

A fault system can also be defined that divides the geological model into subunits in which the internal structure can be defined independent of the other subunits in the model. This is described in Faulted Models.

The rest of this topic describes the process of creating a geological model. It is divided into:

- Creating a New Geological Model
  - Surface Resolution
  - Model Extents
- The Geological Model in the Project Tree
- Geological Model Display
- Copying a Geological Model
- Creating a Static Copy of a Geological Model
- Geological Model Volumes and Surfaces Export Options

A geological model can be created using only a basic set of parameters. The only parameter that cannot be changed once the model has been created is the base lithology.

Creating a New Geological Model

To create a new geological model, right-click on the Geological Models folder and select New Geological Model. The New Geological Model window will open, together with a set of controls in the scene that help in defining the model extents.

The Base Lithology

Select the borehole data column that will be used as the basis of a model from the Base Lithology Column list. If you do not wish to use lithology data as the basis for the model, select <None>. This may be the case if, for example, you want to build a model from points data or
from an imported map. If you select <None>, you will need to manually define the lithologies that will be modelled.

If more than one column of lithology data is available for creating models, be sure to choose the correct one as it cannot be changed once the initial model has been created. If after creating and modifying the model, you find you need to modify the borehole data, resulting in a new lithology column, you can use that new column to create contact surfaces using Other Contacts options.

You can also filter the borehole data used to build the geological model using query filters. To do so, tick the Filter data box and select the required query filter from the list. Once the model has been created, you can remove the filter or select a different filter.

**Surface Resolution**

The surface resolution setting Leapfrog Works automatically uses as the default is based on the data available in the project. Set the surface resolution for the model as a whole and choose whether or not the resolution will be adaptive. See Surface Resolution in Leapfrog Works for more information on the effects of these settings.

Later, while refining the model, you can change the resolution of each surface and enable or disable adaptive resolution. See Surface Resolution for a Geological Model.

**Model Extents**

A geological model is initially created with a basic rectangular set of extents aligned with the south/north and east/west axes. You can define the model’s extents in three ways:

- Enter the coordinates.
- Select Enclose Object and choose from the list of objects in the project. If the model is based on borehole data, select the lithology segments from the Enclose Object list.
- Use the controls that appear in the scene. The orange handle adjusts the centre of the plane and the red handles adjust the size.

See Object Extents for more information.

Enter a Name for the model that describes the purpose of the model. This Name will be used in naming the objects that will be added to the model. Click OK to create the new model. The new geological model will be created and added to the Geological Models folder.

See Editing a Geological Model for information on how to change the basic settings for the model.
The Geological Model in the Project Tree

The objects under the geological model in the project tree represent different parts of the model:

- The **Boundary** object defines the limits of the geological model. When the model is first created, this is the rectangular model extents. If a topography has been defined, it is automatically used for as the upper boundary. See [Modifying a Geological Model’s Boundary](#) for more information about modifying the boundary.

- The **Fault System** object defines faults and their interactions in the model. See [Faulted Models](#).

- The **Lithologies** object describes all the lithological units to be modelled and the colours that are used to display them on the screen. It is generated automatically from all the lithologies identified in borehole data selected when the model is created. If no column was selected, you will need to define the lithologies manually before you start modelling the lithology layers.

- The **Surface Chronology** object describes the contact surfaces in the model, organised in chronological order, from youngest to oldest. These surfaces and their chronology determine how the volume inside the model extents is divided into lithological units. When the model is first created, the **Surface Chronology** is empty, but it will eventually hold all contact surfaces and inputs to them.

- The **Output Volumes** folder contains all the volumes generated in building the geological model. When the model is first created, the **Surface Chronology** is empty and so there is only a single output volume in the **Output Volumes** folder. This volume fills the model’s extents and is called “Unknown”. Once contact surfaces have been generated and added to the **Surface Chronology** object, new volumes will be generated and added to the **Output Volumes** folder.

Geological Model Display

Right-click on the geological model in the project tree to view its display options:

- The **View Object** option adds the geological model to the shape list as a single object. You can also display the geological model in this way by dragging it from the project tree into the scene. Change the visibility of the model’s volumes by clicking the **Edit Colours** button in the shape list.
• The View Output Volumes option adds the model to the scene as a series of output volumes. It is the equivalent of dragging the Output Volumes folder into the scene. Change the visibility of the model’s volumes individually.

• The View Surface Chronology option displays the surfaces that are used to divided up the model.

• The View Fault Block Boundaries option is only available when a fault system has been defined and enabled for the model. Selecting View Fault Block Boundaries displays the fault blocks without displaying the lithology layers.

Copying a Geological Model

Creating a copy of a geological model is a useful way of experimenting with changes to a model.

To copy a geological model, right-click on it in the project tree and select Copy. Enter a name for the copy of the model and click OK. The copy will be added to the project tree.

Creating a Static Copy of a Geological Model

Creating a static copy preserves a snapshot of a geological model that does not change, even when changes are made to the data on which the original model was dependent. This is a useful way of storing historical models and comparing models. Static copies can be exported from Leapfrog Works, as described in Geological Model Volumes and Surfaces Export Options below.

To create a static copy of a geological model, right-click on it in the project tree and select Static Copy. Enter a name for the copy of the model and click OK. The copy will be added to the Geological Models folder.

In the project tree, the static copy (▲) is made up of a Legend object (▼), the output volumes (▲) and all surfaces created in building the model.

To view the date a static copy was created, right-click on it in the project tree and select Properties. The date the copy was created is shown in the General tab.

Geological Model Volumes and Surfaces Export Options

There are three options for exporting a geological model’s output volumes and surfaces. These are:

• Export an output volume or a surface as a mesh. Right-click on it in the project tree and click Export. You will be prompted for a file name and location. See Exporting a Single Mesh.

• Export an output volume as a thickness grid. Right-click on it in the project tree and click Export Thickness Grid. See Thickness Grid Export.

• Export multiple output volumes and surfaces. Right-click on the geological model in the project tree and select Export. See Exporting Multiple Meshes from Models.
When exporting output volumes, the **Merge output lithology volumes** setting in the geological model’s **General** tab (see [Editing a Geological Model](#)) determines how the output volumes are handled when they are exported. If this setting is enabled, internal walls and surface seams will be removed from volumes of the same lithology.

### Editing a Geological Model

Once a geological model has been created, you can change the model’s resolution and other basic settings by double-clicking on the model in the project tree. The **Geological Model** window will open with the **General** tab selected. The other tabs in the **Geological Model** window represent the different parts of the geological model. It is generally more useful, however, to work with these parts of the model on an individual basis by either double-clicking on the object in the project tree or right-clicking and seeing what options are available.

The rest of this topic describes how to change the basic settings for a geological model. It is divided into:

- **Changing the Query Filter**
- **Surface Generation Options**
- **Volume Generation Options**

#### Changing the Query Filter

Although the **Base lithology column** cannot be changed once a geological model has been created, you can change the filters applied to the data. Any filters defined for the lithology table used to define the model can be applied to the **Base lithology column**.

Individual surfaces in the geological model can inherit the query filter from the parent geological model or can use a different filter. To change what query filter is used for a surface, double-click on the points used to create the surface and change the **Query filter** setting in the **Lithology** tab:

#### Surface Generation Options

The **Surface resolution** and **Adaptive** settings in the **General** tab apply to the model as a whole. These settings can be overridden for individual surfaces. See [Surface Resolution in Leapfrog Works](#) and [Surface Resolution for a Geological Model](#).

Surfaces created in building the geological model can be set to snap to the data used in the model. There are three options:

- **Off**. Surfaces do not snap to the data used to create them.
- **All data**. Surfaces snap to all data within the **Maximum snap distance**, which includes borehole data and any data added to surfaces as part of the model refinement process.
- **Drilling only**. Surfaces snap to borehole data within the **Maximum snap distance** but not to other data used to modify surfaces.

Snapping to data is off by default. Although you can snap to all data, doing so not
recommended as it increases the possibility that errors in the data or assumptions inherent in interpretations (e.g. polylines) will cause distortions in the meshes. If you do enable snapping, is best to snap only to drilling data.

If you need surfaces to honour borehole data but treat other data objects as interpretations, select **Drilling only**. If you want finer control over what objects are snapped to, you can do this on a surface-by-surface basis. See:

- **Surfacing Options for Deposits and Erosions**
- **Surfacing Options for Intrusions**
- **Surfacing Options for Veins**

When **Exact clipping** is enabled, model surfaces will be generated without “tags” that overhang the model boundary. This setting is enabled by default when you create geological model.

**Volume Generation Options**

The **Merge output volumes** setting determines whether or not output volumes of the same lithology are merged when the volumes are exported. If **Merge output volumes** is set to **Fast** or **Robust**, internal walls and surface seams will be removed from volumes of the same lithology. Either option is suitable when you are using output volumes as extents for other models.

The difference between **Fast** and **Robust** is the algorithm used:

- **Fast** removes back-to-back triangles before generating output volumes. This option is new in Leapfrog Works version 2.0 and is the default option selected when a geological model is created.
- **Robust** is the **Merge output lithology volumes** option from versions of Leapfrog Works before 2.0. **Robust** uses the volume cutter, which tracks where the triangles originated and is, therefore, a slow option for building output volumes.

If there are issues with surfaces exported to other modelling packages using the **Do not merge output volumes** setting, try the **Fast** setting. If there are still issues, try the **Robust** setting.

When projects created in earlier versions of Leapfrog Works are opened in Leapfrog Works 2.0, the **Volume Generation** setting for any existing geological models will not be changed.

**Surface Resolution for a Geological Model**

When you create a geological model (see [Creating a New Geological Model](#)), the surface resolution is set for the model as a whole. When surfaces and boundaries are created as part of the model-building process, their resolution is inherited from the geological model:

- For deposit and erosion contact surfaces, stratigraphic sequences and model boundaries, the resolution is the same as the geological model.
- For intrusion contact surfaces, the resolution is half that set for the geological model.
To change the resolution settings for a contact surface, double-click on the surface in the project tree, then click on the **Surfacing** tab:

![Surfacing tab](image)

For a lateral extent or fault, simply double-click on the surface in the project tree to change its resolution settings.

Untick the **Inherit resolution from GM** box to change the resolution settings for a surface. This setting may be disabled, depending on the data used to create the boundary or surface.

The resolution of intrusion contact surfaces is also affected by the point generation parameters. See [Intrusion Point Generation Parameters](#) for more information.

### Modifying a Geological Model’s Boundary

Geological models are created with a basic set of rectangular extents that can then be refined using other data in the project. These extents usually correspond to the ground surface and known boundaries. Creating extents can also be used to restrict modelling to a particular area of interest; for example, modelling can be restricted to a known distance from boreholes by applying a distance function as a lateral extent. Extents do not need to be strictly vertical surfaces, and can be model volumes. It is also possible to define a base that serves as the geological model’s base.

When a topography is defined for the project, it will be automatically applied as a geological model’s upper boundary when the model is created.

The rest of this topic describes how to create and work with geological model extents. It is divided into:

- **Creating Extents for a Geological Model**
  - Extent from a Polyline
  - Extent from GIS Vector Data
  - Extent from Points
  - Extent from Structural Data
  - Extent from a Surface
  - Extent from Distance to Points
Creating Extents for a Geological Model

To create an extent, expand the geological model in the project tree. Right-click on the **Boundary** object and select from the **New Lateral Extent** or **New Base** options. Follow the prompts to create the extent, which will then appear in the project tree under the model’s **Boundary** object. For example, this geological model has two lateral extents, one from a polyline and the other from GIS data:

New extents are automatically applied to the boundary being modified. Leapfrog Works usually orients a new extent correctly, with red presenting the inside face of the extent and blue representing the outside face. If this is not the case, you can change the orientation by right-clicking on the extent in the project tree and selecting **Swap Inside**.
Extent from a Polyline

You can create an extent from a polyline that already exists in the project or you can draw a new one. If you want to use an imported polyline, import it into the Polylines folder before creating the new extent.

To create a new extent from a polyline, right-click on the model’s Boundary object and select New Lateral Extent > From Polyline or New Base > From Polyline. In the window that appears, select whether you will create a new polyline or use an existing one:

For lateral extents, you can create the extent as a Vertical Wall or Surface. If you create the lateral extent as a Surface, you will be able to modify it using additional data, as described below. A lateral extent created as a Vertical Wall, however, cannot be modified. A base is always created as a surface and so can be modified as described below.

Click OK to generate the new extent. If you have chosen to create a New Drawing, the drawing controls will appear in the scene and you can begin drawing, as described in Drawing in the Scene.

The new extent will appear in the project tree as part of the Boundary object.

If the surface generated does not fit the polyline adequately, you can increase the quality of the fit by adding more points to the polyline. See Drawing in the Scene for information on adding points to polylines.

Extents created from polylines can be modified by adding points data, GIS vector data and structural data. You can also add polylines and structural data to the extent. See Adding Data to an Extent, Editing an Extent with a Polyline and Editing an Extent with Structural Data for more information.
Extent from GIS Vector Data

GIS data in the project can be used to create a lateral extent or a base for a geological model. Once the data you wish to use has been imported into the project, right-click on the model’s Boundary object and select New Lateral Extent > From GIS Vector Data or New Base > From GIS Vector Data.

In the window that appears, select the data object you wish to use:

For lateral extents, you can create the extent as a **Vertical Wall** or **Surface**. If you create the lateral extent as a **Surface**, you will be able to modify it using additional data, as described below. A lateral extent created as a **Vertical Wall**, however, cannot be modified. A base is always created as a surface and so can be modified as described below.

If you select the **Surface** option, you can use the GIS data object with its own elevation data or projected onto the topography:

Using the **On Topography** option makes sense for GIS data as it is, by nature, on the topography. The **On Topography** option also mitigates any issues that may occur if elevation information in the GIS data object conflicts with that in the project.

Click **OK** to create the new extent. The new extent will appear in the project tree as part of the Boundary object.

Extents created from GIS data can be modified by adding points data, GIS vector data and structural data. You can also add polylines and structural data to the extent. See **Adding Data**.
to an Extent, Editing an Extent with a Polyline and Editing an Extent with Structural Data for more information.

**Extent from Points**
To create a new extent from points data, right-click on the **Boundary** object for the model you are working on and select **New Lateral Extent > From Points** or **New Base > From Points**. The **Select Points To Add** window will be displayed, showing points data available in the project:

Select the information you wish to use and click **OK**.

The new extent will appear in the project tree as part of the **Boundary** object.

Extents created from points can be modified by adding points data, GIS vector data and structural data. You can also add polylines and structural data to the extent. See Adding Data to an Extent, Editing an Extent with a Polyline and Editing an Extent with Structural Data for more information.

**Extent from Structural Data**
Planar structural data can be used to create a lateral extent or a base for a geological model. You can create a new structural data table or use a table that already exists in the project. If you want to use categories of structural data in creating the extent, use an existing table and create filters for those categories before creating the lateral extent.

To start, right-click on the **Boundary** object for the model you are working on and select **New Lateral Extent > From Structural Data** or **New Base > From Structural Data**. The **New Structural Data** window will be displayed, showing structural data available in the project:

Select the **New Drawing** option to draw the structural data points directly in the scene.
Select the **Existing Structural Data** option to use a table in the **Structural Modelling** folder. With this option, you will be able to select from the categories available in the data table, if query filters have been created for those categories:

![New Structural Data](image)

Click **OK** to generate the new extent. If you have chosen to create a **New Drawing**, the drawing controls will appear in the scene and you can begin drawing, as described in [Creating New Planar Structural Data Tables](#). To share the new structural data table, right-click on it and select **Share**. The table will be saved to the **Structural Modelling** folder.

The new extent will appear in the project tree as part of the **Boundary** object.

Extents created from structural data can be modified by adding points data, GIS vector data and structural data. You can also add polylines and structural data to the extent. See [Adding Data to an Extent](#), [Editing an Extent with a Polyline](#) and [Editing an Extent with Structural Data](#) for more information.

### Extent from a Surface

To use a surface as an extent for a geological model, right-click on the model’s **Boundary** object and select **New Lateral Extent > From Surface** or **New Base > From Surface**. The **Select Boundary** window will appear, showing all the meshes that can be used as an extent:

![Select Boundary Mesh](image)

Select the required mesh and click **OK**. The extent will be added to the model’s **Boundary** object.

You cannot modify an extent created from a mesh by adding data, editing with polylines or structural data or by applying a trend. However, the extent is linked to the mesh used to create it, and updating the mesh will update the extent.
Extent from Distance to Points

Leapfrog Works can calculate the distance to set of points and use the resulting distance buffer as a lateral extent for a geological model. To create a new lateral extent from a distance buffer, right-click on the Boundary object for the model you are working on and select New Lateral Extent > From Distance To Points. The Smoothed Distance Buffer window will appear:

Select the Distance and set an Anisotropy, if required.

The Ellipsoid Ratios determine the relative shape and strength of the ellipsoids in the scene, where:

- The Maximum value is the relative strength in the direction of the green line on the moving plane.
- The Intermed. value is the relative strength in the direction perpendicular to the green line on the moving plane.
- The Minimum value is the relative strength in the direction orthogonal to the plane.

You can also use the Set to list to choose different options Leapfrog Works has generated based on the data used to build the model. Isotropic is the default option used when the model is created.

Click OK to create the new extent, which will appear in the project tree as part of the Boundary object.

To change the extent’s settings, expand the model’s Boundary object in the project tree and double-click on the extent.

Adjust the Distance and Anisotropy, if required.

The resolution of extents is automatically inherited from the geological model. You can change the resolution for an extent if you want more or less detail than for the geological model as a whole. To do so, untick the box for Inherit resolution from GM and change the setting.
Extents created from a distance to points function can be modified by adding points data and GIS vector data. See Adding Data to an Extent.

Extent from a Distance Function

A distance function calculates the distance to a set of points and can be used to bound a geological model. You can use an existing distance function as a lateral extent or create a new one.

To use a distance function as a lateral extent, right-click on the Boundary object for the model you are working on and select New Lateral Extent > From Distance Function. If there are no distance functions in the project, you will be prompted to create a new one. See Distance Functions for information on defining and editing the distance function.

When there are already distance functions in the project, you will be prompted to choose between creating a new function or using an existing one:

To use an existing function, select it from the list and set a Buffer distance. Click OK to create the lateral extent.

When you create a new distance function, it will be part of the model’s Boundary object and will not be available elsewhere in the project. To share it within the project, expand the lateral extent in the project tree and right-click on the distance function. Select Share. The distance function will be saved to the Numeric Models folder.

To change the extent’s settings, expand the model’s Boundary object in the project tree and double-click on the extent.

Adjust the Distance and Anisotropy, if required.

The resolution of extents is automatically inherited from the geological model. You can change the resolution for an extent if you want more or less detail than for the geological model as a whole. To do so, untick the box for Inherit resolution from GM and change the setting.
Base from Lithology Contacts

To create a base from lithology contacts, right-click on the **Boundary** object and select either **New Base > From Base Lithology** or **New Base > From Other Contacts**.

The only difference in the two methods is that when creating a base from other contacts, you must first select the lithology column from those available in the project.

When defining the base, select the primary lithology and the contacts to use:

![New Contact Points](image)

For complex geologies, the up and down directions for the base may not be clear. If this is the case, untick the **Horizontal Plane** box. A reference plane will appear in the scene, with the up-facing surface labelled A and the downward-facing surface labelled B. Controlling the position of the reference plane is similar to controlling the position of the moving plane:

- Use the handles in the scene window to move the plane.
- Set the **Dip** and **Dip Azimuth** values in the **New Contact Points** window. The reference plane will be updated in the scene.

Once the reference plane is correctly oriented, click the **Set From Plane** button.

Click **OK** to create the base, which will appear under the **Boundary** object. The new base will automatically be added to the model.

Each geological model can have only one base defined, so if you wish to define a new base, you must first delete the existing base from the model. Do this by right-clicking on the **Base** object and selecting **Delete**. You can also choose not to use the base you have defined. See
Removing an Extent from a Geological Model for more information.

Changing an Extent’s Settings
For geological model extents created from from polylines, GIS data, points and structural data, you can change the extent’s settings by double-clicking on it in the project tree.

In the Surfacing tab, you can change surface resolution and contact honouring options, which are described below. In the Trend tab, you can apply a trend to the extent, which is described in Applying a Trend.

Surface Resolution
For geological models, the resolution of extents and whether or not the adaptive isosurfercer is used is automatically inherited from the geological model. You can change these settings for an extent if you want more or less detail than for the geological model as a whole. To do so, untick the box for Inherit resolution from GM and make the required changes.

Contact Honouring
Often, surfaces should honour borehole data and treat data objects such as polylines and GIS data as interpretations. For extents, the Snap to data setting in the Surfacing tab determines whether or not the extent honours the data used to create it. Options are:

- **Off.** The extent does not snap to the data used to create it. This is the default setting.
- **All data.** The extent snaps to all data within the Maximum snap distance, which includes borehole data and any data added to the extent.
- **Drilling only.** The extent snaps to borehole data and data objects derived from borehole data within the Maximum snap distance, but not to other data used to modify the extent. For example, the extent will honour points data derived from borehole data, but not points data imported into the Points folder.
- **Custom.** The extent snaps to the data objects indicated in the Inputs tab that are within the Maximum snap distance.

Snapping to data is off by default. Although you can snap to all data, doing so not
recommended as it increases the possibility that errors in the data or assumptions inherent in interpretations (e.g. polylines) will cause distortions in the meshes. If you do enable snapping, is best to snap only to drilling data.

The snap setting for the geological model will be used if Snap to data is set to Inherit from GM. Whatever the setting, you can see what objects are snapped to by clicking on the Inputs tab.

If you need the extent to honour borehole data but treat other data objects as interpretations, select Drilling only. To honour some data objects while treating others as interpretations, select Custom, then click on the Inputs tab to enable snapping for individual objects.

**Applying a Trend**

You can adjust an extent created from polylines, GIS data, points and structural data by applying a trend to it. To do this, add the extent to the scene. Next, double-click on the extent in the project tree and click the Trend tab.

Often the easiest way to apply a trend is to click on the Draw plane line button and draw a plane line in the scene in the direction in which you wish to adjust the surface. You may need to rotate the scene to see the plane properly.

The Ellipsoid Ratios determine the relative shape and strength of the ellipsoids in the scene, where:

- The **Maximum** value is the relative strength in the direction of the green line on the moving plane.
- The **Intermed.** value is the relative strength in the direction perpendicular to the green line on the moving plane.
- The **Minimum** value is the relative strength in the direction orthogonal to the plane.

Once you have adjusted the plane to represent the trend you wish to use, click the Set From Plane button to copy the moving plane settings.

The Set to list contains a number of different options Leapfrog Works has generated based on the data used in the project. Isotropic is the default option used when the extent was created. Settings made to other surfaces in the project will also be listed, which makes it easy to apply the same settings to many surfaces.

Click OK to apply the changes.

See Global Trends for more information.

**Adding Data to an Extent**

Extents created from polylines, GIS data, points and structural data can be modified by adding points data objects, GIS vector data and structural data. Extents created from a distance to points function can be modified by adding points data and GIS vector data. To add data to an extent, right-click on the extent in the project tree and select the data type you wish to use from the Add menu.
• Points data. Select from the points data objects available in the project and click OK.
• GIS vector data. Select from the GIS vector data available in the project and click OK.
• Structural data. Select from the structural data tables available in the project. If the selected table has query filters defined, you can apply one of these filters by ticking Use query filter and then selecting the required filter from the list. Click OK to add the selected data to the extent. An alternative to adding an existing structural data table to an extent is to edit the extent with structural data. This is described in Editing an Extent with Structural Data below.

You can also add a polyline that already exists in the project. To do this, right-click on the extent in the project tree and select Add > Polyline. You will be prompted to choose from the polylines in the Polylines folder.

Editing an Extent with a Polyline
You can edit an extent using a polyline, which is described in Surfaces. A polyline used to edit an extent will be added to the project tree as part of the extent. To edit the polyline, right-click on it and select Edit Polyline or add it to the scene and click the Edit button (+) in the shape list. If you wish to remove the polyline from the extent, right-click on it in the project tree and select Delete or Remove.

To add an existing polyline to a geological model extent, use the Add > Polyline option.

Editing an Extent with Structural Data
You can edit an extent using structural data, which is described in Surfaces. A structural data table will be added to the project tree as part of the extent. To edit the table, right-click on it and select Edit In Scene or add it to the scene and click the Edit button (+) in the shape list. If you wish to remove the table from the extent, right-click on it in the project tree and select Delete or Remove.

Removing an Extent from a Geological Model
If you have defined an extent and want to remove it from the model, there are two options. The first is to right-click on the extent in the project tree and click Delete. This deletes the extent from the model, but does not delete parent objects from the project unless they were created as part of the model, e.g. a polyline used as a lateral extent but not shared within the project. Use this option only if you are sure you do not want to use the extent.
The second method is useful if you are making changes to the extent and do not want to recompute the model with each change. Double-click on the model’s Boundary object or double-click on the model and click on the Boundary tab. The Boundaries part of the window lists all objects used as extents for a geological model:

![Boundary window](image)

Untick the box for extents to temporarily disable them in the model. The model will be reprocessed, but you can then work on the extent without reprocessing the model. Disabled extents will be marked as inactive in the project tree:

![Inactive extents](image)

### Model Lithologies

To view the lithologies used for a geological model, you can:

- Double-click on the geological model in the project tree and then click on the Lithologies tab.
- Double-click on the Lithologies object for the geological model in the project tree.
All the lithologies defined for the geological model are displayed, together with the colours used to display them:

Click a colour chip to change the colours used to display the lithologies.

To set multiple lithologies to a single colour, use the Shift or Ctrl keys to select the colour chips you wish to change, then click on one of the colour chips. The colour changes you make will be made to all selected lithologies.

If the geological model was created from borehole data, the lithologies are automatically generated from that data. There is also an additional lithology, “Unknown”, which is used to label lithologies that cannot be labelled using known lithologies. This is the case when a geological model is first created and no contact surfaces have been defined. The entire model volume has no identified lithologies and so is assigned as “Unknown”.

An alternative to setting unidentified lithologies to “Unknown” is to select one of the defined lithologies as the “background lithology”. To do this, double-click on the model’s Surface Chronology and set Background lithology to one of the available lithologies. When you set the background lithology for a geological model and then enable the fault system, the background lithology will be copied to each fault block.

If there is no borehole data in the project or if the model is not based on borehole data, you will need to define the lithologies one-by-one. To do this, click on the Add button, enter a name for the lithology and choose a colour.

**Faulted Models**

This topic describes how to use the fault system to create and organise faults:

- [The Fault System](#)
- [Fault Interactions](#)
- [Activating the Fault System](#)
Each geological model is created with a **Fault System** object that is used to construct faults. Once the faults are active in the geological model, the geological model will be divided into separate fault blocks, which will appear in the project tree as part of the model:

- **Copy the Surface Chronology to an Empty Fault Block**
- **Faulted Model Display Options**

Each fault block has its own **Surface Chronology**, which can be modified without affecting other fault blocks in the geological model. There is no top-level **Surface Chronology** for the geological model once the **Fault System** has been activated. This means that lithology layers can be constructed for a faulted model in two ways:

- Define the **Surface Chronology** before enabling the **Fault System**. All surfaces defined for the unfaulted model will automatically be copied to each fault block. Some surfaces defined for the model as a whole will not occur in every fault block, which can be corrected by working with the surfaces in each fault block.
- Enable the **Fault System** before any surfaces are defined in the unfaulted model, then define the **Surface Chronology** for each fault block. An aid to working with a faulted model in this way is the ability to copy contact surfaces from one faulted block to another. See **Copying the Surface Chronology to an Empty Fault Block** below.

Which approach is best depends on the model being built. You may already know where the faults are and choose to define them and subdivide the geological model before defining any lithology layers. On the other hand, sometimes it is not apparent where the faults are until the layers have been built, in which case you can add the new fault, activate it in the model, then work with the surfaces in each fault block.

**The Fault System**

When a geological model is first created, the **Fault System** object is empty. To create faults, right-click on the **Fault System** object and select from the options available. Many of these options are similar to those for creating lateral extents. For more information, see:

- **Extent from a Polyline**
- **Extent from GIS Vector Data**
- **Extent from Points**
Faults created from polylines and GIS vector data can be created as vertical walls or surfaces. Faults created as surfaces can be modified by adding further data, as described in Editing Faults.

Creating a fault from the base lithology or other contacts is similar to creating contact surfaces. See Deposits and Erosions From the Base Lithology and Deposits and Erosions From Other Lithology Contacts for more information.

Faults will appear in the project tree as part of the Fault System object and can be expanded to show how they were created:

Once faults have been created, you can modify them as described in Editing Faults.
Fault Interactions

Once all the faults required have been created, you can start defining the interactions between the faults by double-clicking on the Fault System object. The Geological Model will be opened with the Fault System tab displayed:

To add an interaction, click on a fault, then click the Add button. Select the Interaction Type and set how the faults interact:
Once you have defined each fault interaction, click **OK** to generate the fault system. Add the **Fault System** object to the scene to check that the faults interact correctly.

You can also edit fault interactions by double-clicking on individual faults. The **Edit Fault** window will open, which shows only the interactions for the selected fault:

![Edit Fault window](image)

Faults are not active in the geological model until the box is ticked for each fault in the **Fault System** window, as described in **Editing Faults**. This means you can check the fault system without regenerating the geological model.

### Activating the Fault System

Activating the fault system divides the geological model into fault blocks, which can result in considerable processing time for complex models. It is important, therefore, to define fault interactions before enabling the fault system, otherwise a large number of fault blocks could be generated that significantly increase processing time. See **Fault Interactions** above.

To activate the fault system in the geological model, double-click on the **Fault System** object once again and tick the box for each fault. The model will be divided into separate fault blocks that can be worked with in a similar manner to the geological model as a whole.

### Copying the Surface Chronology to an Empty Fault Block

If you are working with a faulted model and have defined the **Surface Chronology** for one fault block, you can copy the **Surface Chronology** to the empty fault blocks. To do this, right-click on the **Surface Chronology** for which you have defined surfaces and select **Copy Chronology To**. In the window that appears, select the fault blocks you want to copy contacts to and click **OK**. The surfaces will be copied and you can modify them without affecting the surfaces in the other fault blocks.
Faulted Model Display Options

Drag the model into the scene or right-click on it and select View Object; these options add the model to the shape list as a single object and you can change the visibility of each lithology by clicking the Edit Colours button. You can also add the model to the scene as a series of output volumes by right-clicking on the model and selecting View Output Volumes.

Another display option lets you view the individual fault blocks without displaying the lithology layers. Right-click on the model and select View Fault Block Boundaries.

To work with a specific fault block, click on it in the scene. The window that appears displays the name of the selected fault block:

You can also view the output volumes for each individual fault block by right-clicking on the fault block in the project tree and selecting View Output Volumes.

Editing Faults

Once a fault has been defined, you can refine it in several ways:

- Add other data. This option is available for faults created as surfaces, but not for those created as vertical walls. Right-click on the surface to see the options available, which will depend on how the surface was created.
- Edit the surface with a polyline. Right-click on the surface in the project tree and select either Edit > With Polyline. See Editing Surfaces with Polylines for more information.
- Edit the surface using structural data. Right-click on the surface and select Edit > With Structural Data. See Editing Surfaces with Structural Data for more information.

The rest of this topic describes other options for editing faults. It is divided into:

- Surfacing Options for Faults
  - Boundary Filtering
  - Snapping to Data
- Changing Fault Inputs
  - Replacing Fault Inputs with a Single Mesh
  - Adding Data to the Fault
Surfacing Options for Faults

To change surfacing options for a fault, double-click on the fault in the project tree, then click on the Surfacing tab.

See Surface Resolution for a Geological Model and Contact Honouring for information about the settings in the Surfacing tab.

The settings in the Surfacing tab will be disabled if the fault inputs have been replaced with a mesh.

Boundary Filtering

When data objects are added to a fault, there are two ways to handle the data that lies outside the fault boundary:

- Filter the data. The fault is only influenced by the data that falls inside the fault boundary.
- Leave the data unfiltered. The fault is influenced by the data both inside and outside the fault boundary.

The Boundary filter setting determines how data used to define the fault is filtered:

- Off. Data is not filtered.
- All data. All data is filtered.
- Drilling only. Only borehole data and data objects derived from borehole data are filtered.
- Custom. Only the data objects specified in the Inputs tab are filtered.

Snapping to Data

There is a Snap to data setting for a geological model as a whole that is set in the Geological Model > General tab (see Editing a Geological Model). Snap-to-data can also be set on a surface-by-surface basis by double-clicking on the surface in the project tree and then clicking on the Surfacing tab.

For faults, the options are:

- Inherit from GM. The setting for the geological model as a whole is used. This is the default setting.
- Off. The fault does not snap to the data used to create it.
- All data. The fault surface snaps to all data within the Maximum snap distance, which includes borehole data and any data added to the fault.
- Drilling only. The fault surface snaps to borehole data and data objects derived from borehole data within the Maximum snap distance but not to other data used to modify the
fault. For example, the fault surface will honour points data derived from borehole data, but not points data imported into the Points folder.

- **Custom.** The fault snaps to the data objects indicated in the Inputs tab.

Snapping to data is off by default. Although you can snap to all data, doing so not recommended as it increases the possibility that errors in the data or assumptions inherent in interpretations (e.g. polylines) will cause distortions in the meshes. If you do enable snapping, is best to snap only to drilling data.

If you need the fault surface to honour borehole data but treat other data objects as interpretations, select **Drilling only.** To honour some data objects while treating others as interpretations, select **Custom**, then click on the Inputs tab to enable snapping for individual objects.

### Changing Fault Inputs

For faults, the Inputs tab shows all the data objects used to create the fault and whether the Snap and Boundary filter options are enabled for each object used to define the fault:

![Fault Inputs Tab](image)

You can also replace the fault’s inputs with a single mesh or add more data to the fault.

### Replacing Fault Inputs with a Single Mesh

To replace the fault inputs with a single mesh, click on the Mesh option, then select from the meshes available in the project.

When you select a single mesh to define the fault, all other inputs listed in the Inputs tab will be removed from the fault. This can result in objects being deleted from the project. For example, if the fault has been edited using a polyline, the polyline will be deleted when the inputs are replaced with the mesh. If you wish to retain such inputs, be sure to share the object before changing the inputs. See [Sharing Objects](#) for more information.

The snap and boundary filtering controls in the Surfacing tab will be disabled as the settings from the geological model will be used. The settings in the Trend tab will also be disabled as it is not possible to set a trend for a fault defined from a mesh.
Adding Data to the Fault
To add more data to the fault, click on the Select Objects button, then select from the suitable objects available in the project.

Snap Settings for Individual Inputs
The Snap setting determines whether or not the faults surface honours a particular data object. Often, surfaces should honour borehole data and treat data objects such as polylines and GIS data as interpretations, as discussed in Contact Honouring. To change snap settings for a fault, click on the Surfacing tab and set Snap to data to Custom. You will then be able to change Snap settings in the Inputs tab.

Boundary Filtering Settings for Individual Inputs
When data objects are added to a fault, there are two ways to handle the data that lies outside the fault boundary:

- Filter the data. The fault is only influenced by the data that falls inside the fault boundary.
- Leave the data unfiltered. The fault is influenced by the data both inside and outside the fault boundary.

To change the Boundary filter settings for each object used to define a fault, click on the Surfacing tab and set Boundary filter to Custom. You will then be able to change Boundary filter settings in the Inputs tab.

Applying a Trend to a Fault
To apply a trend to a fault, either:

- Double-click on the fault in the project tree, then click on the Trend tab.
- Right-click on the fault in the project tree and select Adjust Surface. This opens the Edit Fault window with the Trend tab displayed.

See Global Trends for information on using the controls in this tab.

The settings in the Trend tab will be disabled if the fault inputs have been replaced with a mesh.
Contact Surfaces

Defining the internal structure of a geological model involves generating contact surfaces that correspond to the boundaries between lithological units, refining the contact surfaces, arranging them in chronological order and then using the surfaces and the chronological order to divide the geological model into units. The Surface Chronology object represents the collection of contact surfaces and defines how they interact to produce the volumes of the geological model. Factors that influence the interaction of contact surfaces with the volumes of the geological model are:

- The order of the contact surfaces in the Surface Chronology. See Contact Surfaces in the Surface Chronology.
- The type of contact surface. See Contact Surfaces Types for more information.
- The orientation of the older and younger sides of the surface. See Younging Direction.

The remainder of this topic describes how the different types of contact surface interact and will help you in deciding how to model different units. For specific information on creating the different types of contact surfaces, see:

- Deposits and Erosions
- Intrusions
- Veins
- Vein Systems
- Stratigraphic Sequences

Contact Surfaces in the Surface Chronology

When a geological model is first created, it is simply a volume that is assigned the background lithology. This background lithology is initially "Unknown", as although the model has lithologies defined, Leapfrog Works cannot determine what lithology to use for the background lithology.
The contact surfaces and their order in the **Surface Chronology** determine how they divide this larger "Unknown" volume into known lithological units. The scene below shows the **Surface Chronology** for four deposit contact surfaces and two intrusion contact surfaces, bounded by the geological model extents (pink). The two intrusion contacts are labelled as Unknown on the outside and the intrusion lithology on the inside:

The **Surface Chronology** is open, showing the contact surfaces in chronological order, with the youngest at the top of the list. This is the order in which contact surfaces will be used to cut the "Unknown" volume of a newly created model. The different types of contact surfaces cut older volumes in different ways, which are described below in **Contact Surfaces Types**.

For the model shown above, the first contact surface to cut the geological model volume is the oldest surface, D5 - D4 contacts. The volume is divided into D5 (red) below and D4 (green) above:
When the next contact surface (D4 - D3 contacts) is enabled in the model, the volume above the contact surface is labelled with the lithology assigned to the surface's younger side (blue):

Therefore, any volume in a geological model is labelled with the lithology assigned to the youngest side of the surface that last cut the volume.

With a simple deposit geological model, as long as each side of each contact surface is assigned a lithology, all volumes will be labelled with known lithologies. Intrusive contact surfaces, however, are often of unknown lithology on the outside, as they contact multiple lithologies. When the two intrusive surfaces in the model above are enabled but all deposit surfaces are disabled, the unknown lithology is replaced with each intrusive lithology on the inner sides of each contact surface, but outside each intrusive contact surface the lithology is not known:

If the outside of the older contact surface (green) is assigned a lithology (red), the volume outside each intrusion is known and, therefore, the surrounding volume can be labelled:
If, however, the outside of the younger intrusion is known but the outside of the older intrusion is unknown, it is not possible to determine the lithology of the surrounding volume as the lithology on the outer side of the surface making the first cut is not known:

Contact Surfaces Types

The different types of contact surfaces result in different shapes and cut older volumes in different ways. The contact surface types are:

- **Deposit.** Deposit contact surfaces tend to be sheet-like, with the primary lithology on the young side and the contacting/avoided lithologies on the older side. Deposits do not cut older volumes. A volume defined by a deposit contact surface will, therefore, appear conformably on top of older volumes.

- **Erosion.** Erosion contact surfaces are similar to deposits, but cut away other contact surfaces on the older side of the erosion contact surface.

- **Intrusion.** Intrusion contact surfaces are rounder in shape, with an interior lithology that represents the intrusion lithology. The intrusion removes existing lithologies and replaces them with the intrusive lithology on the younger side of the contact surface. Often, the older side of an intrusion contact surface is labelled “Unknown” as typically intrusions displace multiple older lithologies.

- **Vein.** Vein contact surfaces remove existing lithologies and replace them with the vein lithology within the boundaries defined by hangingwall and footwall surfaces and points and a reference surface.

These terms are indicative of the resulting shape and cutting behaviour of a surface rather than of the geological formations that can be modelled. In fact, it might make sense to model something like basement granite as a deposit rather than as an intrusion when it forms the lowest layer in the geological model. If there are no older layers for an intrusion-type contact surface to remove and it is apparent from the borehole data that the lithology simply fills the lowermost parts of the model, then it makes sense to model it as a deposit.
An important consideration in building contact surfaces is that they have an older side and a younger side. This is described in more detail in Younging Direction below, but it is sufficient to understand, at this point, that younging direction is one factor in determining how the different types of contact surfaces cut older surfaces.

Deposit and Erosion Contact Surfaces

Deposits and erosions are both roughly flat surfaces. The difference between the two is that deposits appear conformably on top of underlying older volumes and do not occur in regions defined by older deposits, while erosions remove existing lithologies on the older side of the erosion. This difference is illustrated here, using a model made up of three deposits, A, B and C:

The contact surfaces that define the three output volumes are the B-C contacts surface (pink) toward the top of the model extents and the A-B contacts surface (gold) lower down:

An erosion contact surface (C-D contacts) added to the model cuts across the A-B and B-C contacts. The younger (purple) side of the C-D contact surface faces up:
Once the model is recalculated, the erosion (D) has cut away the deposits on the older side of the erosion:

However, if the C-D contact surface is changed to be a deposit surface, D only occurs on the younger side of the C-D contact surface and does not cut away the A, B and C volumes:

See Deposits and Erosions for information on techniques for creating deposits and erosions.

**Intrusion Contact Surfaces**

An **intrusion** is a type of contact surface that removes existing lithologies and replaces them with the intrusive lithology. Intrusions are rounder in shape than deposits and erosions, with an interior lithology that represents the intrusion lithology on the inside of the shape.

Adding an intrusion (E) surface added to the example model above as the youngest surface cuts away the other lithologies on the inside of the surface:

Note that the intrusion contacts multiple units. This is typical of intrusion contact surfaces as an intrusion will usually displace multiple older lithologies. Although the outside of the intrusion is
not labelled with a lithology, the lithology of each volume the intrusion comes into contact with can be known from the lithologies assigned to the deposit contact surfaces.

However, when all contact surfaces are intrusions, the lithology of the surrounding volume cannot be known, which results in intrusion volumes surrounded by an Unknown volume:

In this instance, the contact surfaces each have a known side and an unknown side:

Adding the boreholes to the scene helps in understanding what lithology the outside of each intrusion should be:
In this case, opening the **Surface Chronology** and assigning AvT as the background lithology results in a model for which all volumes are labelled with a known lithology:

See [Intrusions](#) for information on techniques for creating intrusions.

**Vein Contact Surfaces**

**Veins** remove existing lithologies and replace them with the vein lithology within the boundaries defined by hangingwall and footwall surfaces and points and a reference surface. Here, a slice has been made horizontally through a model made up of three deposits:
Adding five dykes modelled as veins and enabling them in the model results in the veins cutting away each deposit at the point of contact:

Here the sliced deposits are displayed but the veins are hidden in order to show how they cut away the deposits:

See [Veins](#) for information on techniques for creating veins.

**Younging Direction**

An important factor in determining how surfaces interact is the younging direction of each surface. Each contact surface has a younger side and an older side. For deposit and erosion contact surfaces, Leapfrog Works will, by default, put the younger side up, since this is geologically reasonable in most situations. If, for example, you know that the geology is overturned, you can change the younging direction once the surface has been created.

For intrusion contact surfaces, the younger side of the surface is the inside, although this can be swapped if Leapfrog Works has assigned it incorrectly, as may be the case with flatter intrusion surfaces.

When contact surfaces are displayed in the scene, you can choose whether to display the surfaces using the lithology or the younging direction. When the younging direction is displayed, the younger side is typically green and the older side is brown:
When a contact surface is displayed using the younging direction, Leapfrog Works by default colours the younger side green and the older side brown.

**Deposits and Erosions**

This topic describes creating and editing deposits and erosions. The topic is divided into:

- **Creating Deposits and Erosions**
  - Deposits and Erosions From the Base Lithology
  - Deposits and Erosions From Other Lithology Contacts
  - Deposits and Erosions From Other Data
- **Deposits/Erosions in the Project Tree**
- **Refining Deposits and Erosions**
- **Surfacing Options for Deposits and Erosions**
  - Boundary Filtering
  - Snapping to Data
  - Setting the Surface Resolution
  - Applying a Trend to a Deposit/Erosion

For a general introduction to how deposits and erosions interact with other contact surfaces, see [Deposit and Erosion Contact Surfaces](#) in [Contact Surfaces](#).

**Creating Deposits and Erosions**

Lithology data is often the most reliable data source to use when building geological surfaces, and it is best to derive contact surfaces from lithology data when it is available. If no lithology data is available, you can create deposits and erosions from other data in the project. You can also create offset surfaces from other surfaces in the project, which is useful for creating a series of surfaces. See [Offset Surfaces](#) for more information.

**Deposits and Erosions From the Base Lithology**

It is best to derive contact surfaces from lithology data, when it is available. There are two ways to create contact surfaces from lithology data:

- Using the base lithology column assigned when the model was created. This is the process described below.
- Using other lithology information available in the project. This is useful when you have created an additional lithology column as part of correcting and working with the borehole data. For example, if when building a geological model it becomes apparent that changes need to be made to the borehole data, you can import additional data or create a new column using the split lithology, group lithology or interval selection tools. See [Deposits and Erosions From Other Lithology Contacts](#) for more information.
Selecting the **From Base Lithology** option opens the **New Contact Points** window:

![New Contact Points window](image)

Select the lithology you wish to use to create the surface from the **Select primary lithology** list; this will be the older lithology (lower down) in the geological model. The **Contacting/Avoided lithologies** list shows the lithologies that contact the primary lithology and the number of contacts. This helps in selecting which contacts to use to create the contact surface.

The options in the **Lithology** tab are useful for creating a surface when one lithology is interbedded with another. For example, here we can see that the coarse sand is interbedded with alluvium.
The solution to this is to create two surfaces from the Alluvium contacts, one using the contacts above (younger contacts) and the other using the contacts below (older contacts):
Note that the gravel contacts should be excluded for the surface created from the Use contacts below option, as we can see from the borehole data that gravel appears lower down in the model than the surface we are creating. Do this by dragging the contacts that should be excluded to the Ignored lithologies list:

Unspecified intervals are intervals that have no data. By default, unspecified intervals are ignored when creating a contact surface, but you can also treat them as the primary lithology or as avoided lithologies.
For complex geologies, the up and down directions for the surface may not be clear. If this is the case, untick the **Horizontal Plane** box. A reference plane will appear in the scene, with the up-facing surface labelled A and the downward-facing surface labelled B:

Controlling the position of the reference plane is similar to controlling the position of the moving plane:

- Use the handles in the scene window to move the plane.
- Set the **Dip** and **Dip Azimuth** values in the **New Contact Points** window. The reference plane will be updated in the scene.

Once the reference plane is correctly oriented, click the **Set From Plane** button.

Setting a reference plane for contact points is different from applying a global trend to a surface. To apply a global trend to a surface, double-click on the surface in the project tree and click on the **Trend** tab. See [Global Trends](#).

Data can be composited at the borehole level or on a surface-by-surface basis. To composite the data used to generate the contact surface, click on the **Compositing** tab. See [Category Composites](#) for more information.

Click **OK** to create the contact surface, which will appear in the project tree under the **Surface Chronology**. See [Refining Deposits and Erosions](#) below for more information on refining the contact surface.
Deposits and Erosions From Other Lithology Contacts

Creating deposit and erosion contact surfaces using the From Other Contacts option is useful when you have created an additional lithology column as part of correcting and working with the borehole data. For example, if when building a geological model it becomes apparent that changes need to be made to the borehole data, you can import additional data or create a new column using the split lithology, group lithology or interval selection tools. See Splitting Lithologies, Grouping Lithologies and Interval Selection for more information.

The process is similar to creating a surface from the base lithology column, but you must first select the lithology column you will use:

Select the First Lithology and Second Lithology, if known. Click OK. The New Contact Points window will appear. Assign the Primary lithology, Contacting/Avoided lithologies and the Ignored lithologies. These can only be selected from the model’s base lithology.

The rest of the process is similar to defining a contact surface from the base lithology. See Deposits and Erosions From the Base Lithology above for more information.

Be sure to add the contact surface to the scene to view it and check that it is oriented correctly.

See Refining Deposits and Erosions below for more information on the different techniques that can be used for adjusting a contact surface.

Deposits and Erosions From Other Data

If suitable lithology data is not available, deposits and erosions can be created from other data in the project, such as GIS data, structural data, points, polylines and surfaces. The steps for creating deposits and erosions from other data are similar, regardless of the data used to create the surface:

- Right-click on the Surface Chronology and select one of the data types from the New Deposit/Erosion menu.
- Select the data object that will be used to define the surface. This must already be in the project, unless you are using a polyline, in which case you are given the option to create a new polyline.
- Select the First lithology and Second lithology. These are the lithologies that will be assigned to each side of the contact surface. The lithologies you can choose from are those defined for the geological model in the Lithologies object (see Model Lithologies).
Set whether the **First lithology** is older or younger than the **Second lithology**. Leapfrog Works will, by default, put the younger side of a contact surface up, but this can be changed later.

Here, a points data object is being used to create a deposit:

For polylines, you first set the lithologies and the younging order:

Click **OK** to move on to the next step:

You can draw the polyline in the scene directly by selecting the **New Drawing** option. You can also use any polyline in the project by selecting the **Existing Polyline** option. You can then select the required polyline from the list.

The new contact surface will appear in the project tree under the **Surface Chronology**. Add the contact surface to the scene to view it and check that it is oriented correctly.

Expand the surface in the project tree to see how it was made. Here, a number of surfaces have been created using different types of data:
If creating a surface from a new polyline, the polyline will not be able to be used elsewhere in the project unless it has been shared. To share the polyline, expand the contact surface in the project tree, right-click on the polyline and select **Share**. The polyline will then be available elsewhere in the project.

As further refinements are made to the surface, that information will also be added to the contact surface in the project tree.

**Deposits/Erosions in the Project Tree**

The name Leapfrog Works automatically assigns to a deposit or an erosion is the lithologies assigned to each side of the surface. In the project tree, expand the surface to see how it was made:

![Surface tree]

Double-click on the surface to edit it. Double-click on the contact points object (◧) to edit the lithology and change compositing parameters.

As further refinements are made to the surface, that information will also be added to the project tree. See **Refining Deposits and Erosions** below for more information.

**Refining Deposits and Erosions**

You can refine deposits and erosions in several ways:

- Add other data. Right-click on the surface to see the options available, which will depend on how the surface was created. See **Adding Data to Surfaces** for more information.
- Edit the surface with a polyline. Right-click on the surface in the project tree and select either **Edit > With Polyline**. See **Editing Surfaces with Polylines** for more information.
- Edit the surface using structural data. Right-click on the surface and select **Edit > With Structural Data**. This option is available for deposits and erosions created from lithology data and other data in the project, but not for offset surfaces. See **Editing Surfaces with Structural Data** for more information.

To edit the surface’s settings, double-click on it in the project tree. In the **Lithologies** tab, change the lithologies assigned to each side of the surface, if required.

You can swap the younging direction if the direction was assigned incorrectly when the surface was created. The change will be reflected in the scene. Note that changing the younging direction does not change which lithology is older or younger.

The difference between deposit and erosion contact surfaces is how they cut older lithologies, as described in **Contact Surfaces**. For this reason, it is possible to change between the two types using the **Contact Type** setting.
For information on other techniques for refining deposits and erosions, see:

- Surfacing Options for Deposits and Erosions
- Offset Surfaces

**Surfacing Options for Deposits and Erosions**

Surfacing options for deposits and erosions can be changed by double-clicking on the surface in the project tree and then clicking on the Surfacing tab. There are additional settings related to boundary filtering and snapping to data in the Inputs tab.

**Boundary Filtering**

When data objects are added to a surface, there are two ways to handle the data that lies outside the surface’s boundary:

- Filter the data. The surface is only influenced by the data that falls inside the surface’s boundary.
- Leave the data unfiltered. The surface is influenced by the data both inside and outside the surface’s boundary.

The **Boundary filter** setting determines how data used to define the surface is filtered:

- **Off.** Data is not filtered.
- **All data.** All data is filtered.
- **Drilling only.** Only borehole data and data objects derived from borehole data are filtered.
- **Custom.** Only the data objects specified in the Inputs tab are filtered.

**Snapping to Data**

Often, surfaces should honour borehole data and treat data objects such as polylines and GIS data as interpretations. See [Contact Honouring](#).

There is a **Snap to data** setting for a geological model as a whole that is set in the Geological Model > General tab (see [Editing a Geological Model](#)). Snap-to-data can also be set on a surface-by-surface basis by double-clicking on the surface in the project tree and then clicking on the Surfacing tab.

For individual contact surfaces, the options are:

- **Inherit from GM.** The setting for the geological model as a whole is used. This is the default setting.
- **Off.** Surfaces do not snap to the data used to create them.
- **All data.** Surfaces snap to all data within the Maximum snap distance, which includes borehole data and any data added to the surfaces.
- **Drilling only.** Surfaces snap to borehole data and data objects derived from borehole data within the Maximum snap distance but not to other data used to modify the surfaces.
- **Custom.** Surfaces snap to the data objects indicated in the Inputs tab for each surface.
Snapping to data is off by default. Although you can snap to all data, doing so is not recommended as it increases the possibility that errors in the data or assumptions inherent in interpretations (e.g. polylines) will cause distortions in the meshes. If you do enable snapping, it is best to snap only to drilling data.

If you need a surface to honour borehole data but treat other data objects as interpretations, select Drilling only. To honour some data objects while treating others as interpretations, select Custom, then click on the Inputs tab to enable snapping for individual objects.

Setting the Surface Resolution
See Surface Resolution for a Geological Model for information about the surface resolution settings in the Surfacing tab.

Applying a Trend to a Deposit/Erosion
There are two ways to change the trend for a deposit or an erosion:

- Right-click on the surface in the project tree and select Adjust Surface.
- Double-click on the surface in the project tree and then click on the Trend tab.

See Global Trends for more information.

Intrusions
This topic describes creating and editing intrusions. The topic is divided into:

- Creating Intrusions
  - Intrusions from Lithology Contacts
  - Intrusions from Other Data
- Intrusions in the Project Tree
- Displaying Intrusion Points
- Refining Intrusions
- Surfacing Options for Intrusions
  - Boundary Filtering
  - Snapping to Data
  - Surface Resolution
- Applying a Trend to an Intrusion
- Clipping Values for Intrusions
- Interpolation Settings
For a general introduction to how intrusions interact with other contact surfaces, see Intrusion Contact Surfaces in Contact Surfaces.

Creating Intrusions

Lithology data is often the most reliable data source to use when building geological surfaces, and it is best to derive contact surfaces from lithology data when it is available. If no lithology data is available, you can create intrusions from other data in the project.

One thing to keep in mind for all intrusion contact surfaces is that an intrusion removes all the existing material on the younger side of the contact surface. Therefore:

- An intrusion should always have the younger side of its surface labelled with the intruded material. This is called the “interior lithology”.
- The older side will typically be labelled “Unknown” as an intrusion will usually displace multiple older lithologies. This is called the “exterior lithology”.

Intrusions from Lithology Contacts

Lithology data is often the most reliable data source to use when building geological surfaces, and it is best to derive contact surfaces from lithology data when it is available. There are two ways to create intrusions from lithology data:

- Using the base lithology column assigned when the model was created.
- Using other lithology information available in the project. This is useful when you have created an additional lithology column as part of correcting and working with the borehole data. For example, if when building a geological model it becomes apparent that changes need to be made to the borehole data, you can import additional data or create a new column using the split lithology, group lithology or interval selection tools.

To create a new intrusion from lithology contacts, right-click on the Surface Chronology object and select either New Intrusion > From Base Lithology or New Intrusion > From Other Contacts. The only difference in the two methods is that when creating an intrusion from other contacts, you must first select the lithology column from those available in the project and specify the First lithology and the Second lithology.
Select the intrusive lithology as the interior lithology. Other lithologies will be displayed in the **Exterior lithologies** list. Drag any younger lithologies to the **Ignore** list.

Unspecified intervals are intervals that have no data. By default, unspecified intervals are ignored when creating an intrusion, but you can also treat them as the interior lithology or as exterior lithologies.

Sometimes intrusive boundaries are poorly defined, with fragments of country rock intermixed with the intrusive body. This can result in very small segments near the edges of the intrusion. Modelling the fine detail is not always necessary, and so compositing can be used to smooth these boundaries. Compositing parameters are set in the **Compositing** tab:

The settings in this tab are described in **Category Composites**.
Click **OK** to create the intrusion, which will be added to the project tree as part of the **Surface Chronology** object.

**Intrusions from Other Data**

If suitable lithology data is not available, intrusions can be created from other data in the project, such as GIS data, structural data, points, polylines and surfaces. The steps for creating intrusions from other data are similar, regardless of the data used to create the surface:

- Right-click on the **Surface Chronology** and select one of the data types from the **New Intrusion** menu.
- Select the data object that will be used to define the surface. This must already be in the project, unless you are using a polyline, in which case you are given the option to create a new polyline.
- Select the **First lithology** and **Second lithology**. These are the lithologies that will be assigned to each side of the contact surface. The lithologies you can choose from are those defined for the geological model in the **Lithologies** object (see **Model Lithologies**).
- Set whether the **First lithology** is older or younger than the **Second lithology**. Leapfrog Works will, by default, put the younger side of a contact surface up, but this can be changed later.

Here, a points data object is being used to create an intrusion:

For polylines, you first set the lithologies and the younging order:

Click **OK** to move on to the next step:
You can draw the polyline in the scene directly by selecting the **New Drawing** option. You can also use any polyline in the project by selecting the **Existing Polyline** option. You can then select the required polyline from the list.

The new intrusion will appear in the project tree under the **Surface Chronology**. Add the contact surface to the scene to view it and check that it is oriented correctly.

Expand the surface in the project tree to see how it was made.

If creating a surface from a new polyline, the polyline will not be able to be used elsewhere in the project unless it has been shared. To share the polyline, expand the contact surface in the project tree, right-click on the polyline and select **Share**. The polyline will then be available elsewhere in the project.

As further refinements are made to the surface, that information will also be added to the contact surface in the project tree.

**Intrusions in the Project Tree**

The name Leapfrog Works automatically assigns to an intrusion is the name of the intrusive lithology. In the project tree, expand the intrusion to see how it was made:

![Project Tree Example](image)

Double-click on the intrusion to edit it. Double-click on the points object ( mời) to edit the intrusion lithology, change compositing parameters and change point generation options.

As further refinements are made to the surface, that information will also be added to the project tree. See **Refining Intrusions** below for more information.
Displaying Intrusion Points

When you view the intrusion points in the scene, you can display only the contact points or all the points used in creating the intrusion. To display all points, click on the points object (بيب) in the shape list and tick the box for Show volume points:

When the volume points are displayed, points with negative values are those outside the surface, while points with positive values are those inside.

You can change the way intrusion points are generated by double-clicking on the points object (بيب) in the project tree. See Intrusion Point Generation Parameters.

Refining Intrusions

You can refine intrusions in several ways:

- Add other data. Right-click on the surface to see the options available, which will depend on how the surface was created. See Adding Data to Surfaces for more information.
- Edit the surface with a polyline. Right-click on the surface in the project tree and select either Edit > With Polyline. See Editing Surfaces with Polylines for more information.
- Edit the surface using structural data. Right-click on the surface and select Edit > With Structural Data. See Editing Surfaces with Structural Data for more information.

To edit an intrusion’s settings, double-click on it in the project tree. In the Lithologies tab, change the lithologies assigned to each side of the surface, if required.

Surfacing Options for Intrusions

Surfacing options for an intrusion can be changed by double-clicking on the surface in the project tree and then clicking on the Surfacing tab. There are additional settings related to
boundary filtering and snapping to data in the **Inputs** tab.

**Boundary Filtering**
When data objects are added to a surface, there are two ways to handle the data that lies outside the surface’s boundary:

- Filter the data. The surface is only influenced by the data that falls inside the surface’s boundary.
- Leave the data unfiltered. The surface is influenced by the data both inside and outside the surface’s boundary.

The boundary of an intrusion can be the geological model boundary or a fault block boundary.

The **Boundary filter** setting determines how data used to define the surface is filtered:

- **Off.** Data is not filtered.
- **All data.** All data is filtered.
- **Drilling only.** Only borehole data and data objects derived from borehole data are filtered.
- **Custom.** Only the data objects specified in the **Inputs** tab are filtered.

**Snapping to Data**
Often, surfaces should honour borehole data and treat data objects such as polylines and GIS data as interpretations, as discussed in [Contact Honouring](#).

There is a **Snap to data** setting for a geological model as a whole that is set in the **Geological Model > General** tab (see [Editing a Geological Model](#)). **Snap-to-data** can also be set on a surface-by-surface basis by double-clicking on the surface in the project tree and then clicking on the **Surfacing** tab.

For individual contact surfaces, the options are:

- **Inherit from GM.** The setting for the geological model as a whole is used. This is the default setting.
- **Off.** Surfaces do not snap to the data used to create them.
- **All data.** Surfaces snap to all data within the **Maximum snap distance**, which includes borehole data and any data added to the surfaces.
- **Drilling only.** Surfaces snap to borehole data and data objects derived from borehole data within the **Maximum snap distance** but not to other data used to modify the surfaces.
- **Custom.** Surfaces snap to the data objects indicated in the **Inputs** tab for each surface.

Snapping to data is off by default. Although you can snap to all data, doing so not recommended as it increases the possibility that errors in the data or assumptions inherent in interpretations (e.g. polylines) will cause distortions in the meshes. If you do enable snapping, is best to snap only to drilling data.

If you need a surface to honour borehole data but treat other data objects as interpretations, select **Drilling only.** To honour some data objects while treating others as interpretations, select **Custom**, then click on the **Inputs** tab to enable snapping for individual objects.
Surface Resolution
See [Surface Resolution for a Geological Model](#) for information about the surface resolution settings in the Surfacing tab.

Clicking Additional options adds Value Clipping and Interpolant tabs to the window and also allows the use of a structural trend in the Trend tab:

![Surfacing window with Additional options highlighted](image)

These are described in [Applying a Trend to an Intrusion](#), [Clipping Values for Intrusions](#) and [Interpolation Settings](#) below.

**Applying a Trend to an Intrusion**

There are two ways to change the trend for an intrusion:

- Right-click on the surface in the project tree and select Adjust Surface.
- Double-click on the surface in the project tree and then click on the Trend tab.

See [Global Trends](#) for more information.
You can also use a structural trend for an intrusion. To do this, click the **Additional options** button in the **Surfacing** tab, then click on the **Trend** tab.

Click on **Structural Trend**, then select the required trend from the list. See [Structural Trends](#) for more information.

**Clipping Values for Intrusions**

You can change settings for intrusions by double-clicking on the contact surface in the project tree. The **Value Clipping** tab is only available for intrusion contact surfaces.

In the **Value Clipping** tab, you can manipulate the data distribution by clipping the data:
Clipping caps values that are outside the range set by the **Lower bound** and **Upper bound** values. For example, if you change the **Upper bound** from 16.00 to 10.00, distance values above 10.00 will be regarded as 10.00.

The **Automatic clipping** setting has different effects based on whether a global trend or structural trend is set in the **Trend** tab:

- When a global trend is applied, Leapfrog Works automatically clips the values. That is, the **Automatic clipping** setting is **Do clipping** and Leapfrog Works sets the **Lower bound** and **Upper bound** from the data. To disable clipping, untick **Automatic clipping**, then untick **Do clipping**. To change the **Lower bound** and **Upper bound**, untick **Automatic clipping**, then change the values.
- When a structural trend is applied, Leapfrog Works automatically does not clip the values. To clip values, untick **Automatic clipping**, then tick **Do clipping**. Again, Leapfrog Works sets the **Lower bound** and **Upper bound** values from the data and you can change them, if required.

### Interpolation Settings

You can change settings for an intrusion by double-clicking on the intrusion in the project tree and clicking on the **Interpolant** tab. For more information on the settings in this tab, see:

- **Interpolant Functions**
- **The Spheroidal Interpolant Function**
- **The Linear Interpolant Function**

### Veins

This topic describes creating and editing veins. It is divided into:

- **Creating Veins**
  - **Veins From Lithology Contacts**
  - **Veins From Other Data**
- **Veins in the Project Tree**
- **Displaying Veins**
- **Refining Veins**
- **Surfacing Options for Veins**
  - **Boundary Filtering**
  - **Snapping to Data**
  - **Surface Resolution**
  - **Vein Thickness**
  - **Vein Pinch Out**
- **The Vein Reference Surface**
  - **Adding Data to the Reference Surface**
  - **Using a Planar Reference Surface**

© 2017 ARANZ Geo Limited t/a Seequent
The Vein Boundary

- Adding a Polyline to the Vein Boundary
- Adjusting the Vein Boundary Plane

Editing Vein Segments

For a general introduction to how veins interact with other contact surfaces, see Vein Contact Surfaces in Contact Surfaces.

A vein is a type of contact surface that removes existing lithologies and replaces them with the vein lithology within the boundaries defined by hangingwall and footwall surfaces constructed from selected input data. A reference surface is defined that is the best fit for the hangingwall and footwall surfaces. The reference surface can be curved or planar.

Creating Veins

Options for creating veins are:

- From lithology data, using the base lithology used to define the geological model or other contacts available in the project. See Veins From Lithology Contacts below.
- From GIS vector data, point data and polylines. See Veins From Other Data below.
- Creating a vein system. This results in a single lithology that represents all the veins in a model. Veins and their interactions are defined within the vein system. See Vein Systems.

Veins From Lithology Contacts

To create a new vein from lithology contacts, right-click on the Surface Chronology object and select either New Vein > From Base Lithology or New Vein > From Other Contacts. The only difference in the two methods is that when creating a vein from other contacts, you must first select the lithology column from those available in the project and specify the Vein lithology and Outside lithology.

In the New Vein window, select the Vein lithology:

![New Vein Window]

When extracting the hangingwall and footwall points, Leapfrog Works automatically includes points at the ends of the boreholes. To exclude these points, uncheck the Include points at the ends of holes. Once the vein has been created, this setting can be changed by double-clicking on the vein segments object (\(\wedge\)) in the project tree.
Click **OK** to create the vein, which will be added to the project tree as part of the **Surface Chronology** object.

**Veins From Other Data**

If suitable lithology data is not available, veins can be created from other data in the project, such as GIS data, points and polylines. The steps for creating veins from other data are similar, regardless of the data used to create the surface:

- Right-click on the **Surface Chronology** and select one of the data types from the **New Vein** menu.
- Select the data objects for the **Hangingwall** and **Footwall**. These objects must already be in the project.
- Select the **Vein lithology** and the **Outside lithology**. The lithologies you can choose from are those defined for the geological model in the **Lithologies** object (see **Model Lithologies**).

Here, a points data object is being used to create a vein:

Click **OK** to create the new vein. The new contact surface will appear in the project tree under the **Surface Chronology**. Expand the vein in the project tree to see how it was made.

**Veins in the Project Tree**

Veins are stored in the project tree as part of the **Surface Chronology** object. Further modifications can be made to the vein by working on the objects that make up the vein. Expand the vein in the project tree to view these objects.
Here, the hangingwall and footwall surfaces and points are displayed in the scene for a vein defined from lithology data. The reference surface (yellow) and the vein segments (red and blue cylinders) used to create the vein are also shown:

This vein is made up of:

- Hangingwall and footwall surfaces (.), which, when expanded, show the hangingwall and footwall data objects used to create the surfaces.
  - Export hangingwall and footwall surfaces as described in [Mesh Export](#) and [Elevation Grid Export](#).
  - Add points and GIS vector data to the meshes by right-clicking on them and selecting **Add**.
  - Edit the hangingwall and footwall surfaces with polylines by right-clicking on the surface and selecting one of the **Edit** options.
  - Change contact honouring and boundary filtering options as described in [Surfacing Options for Veins](#) below.
- Vein segments and pinch out segments (.) extracted from borehole data. These are only included when a vein is created from lithology contacts.
- A reference surface (.) calculated as the best fit surface using the hangingwall and footwall surfaces.
  - The reference surface can be curved or planar.
  - You can add points, GIS vector data and polylines to a curved reference surface.
  - If a curved reference surface is made up of multiple objects, you can switch between the objects and change how they are filtered in order to see the effects on the vein.
- A boundary object (.), which is empty when the vein is first created.
Displaying Veins
You can change the way the different objects that make up the vein are displayed using options in the shape list:

Refining Veins
To edit a vein’s settings, double-click on it in the project tree. In the Lithologies tab, change the lithologies assigned to each side of the surface, if required. For information on the settings in the Surfacing and Inputs tabs, see Surfacing Options for Veins below.

Surfacing Options for Veins
Surfacing options for veins can be changed by double-clicking on the surface in the project tree and then clicking on the Surfacing tab. There are additional settings related to boundary filtering and snapping to data in the Inputs tab.

Boundary Filtering
When data objects are added to a surface, there are two ways to handle the data that lies outside the surface’s boundary:

- Filter the data. The surface is only influenced by the data that falls inside the surface’s boundary.
- Leave the data unfiltered. The surface is influenced by the data both inside and outside the surface’s boundary.

The boundary of a vein can be the geological model boundary or a fault block boundary.

The Boundary filter setting determines how data used to define the surface is filtered:

- Off. Data is not filtered.
- All data. All data is filtered.
- Drilling only. Only borehole data and data objects derived from borehole data are filtered.
- Custom. Only the data objects specified in the Inputs tab are filtered.

The Filter segments by boundary setting in the Inputs tab is enabled by default when the Boundary filter setting in the Surfacing tab is All data or Drilling only. When Filter segments by boundary is enabled, the vein surface will only be influenced by the segments that falls inside the vein boundary.
Snapping to Data
Often, surfaces should honour borehole data and treat data objects such as polylines and GIS data as interpretations, as discussed in Contact Honouring.

There is a Snap to data setting for a geological model as a whole that is set in the Geological Model > General tab (see Editing a Geological Model). Snap-to-data can also be set on a surface-by-surface basis by double-clicking on the surface in the project tree and then clicking on the Surfacing tab.

For individual contact surfaces, the options are:

- **Inherit from GM.** The setting for the geological model as a whole is used. This is the default setting.
- **Off.** Surfaces do not snap to the data used to create them.
- **All data.** Surfaces snap to all data within the Maximum snap distance, which includes borehole data and any data added to the surfaces.
- **Drilling only.** Surfaces snap to borehole data and data objects derived from borehole data within the Maximum snap distance but not to other data used to modify the surfaces.
- **Custom.** Surfaces snap to the data objects indicated in the Inputs tab for each surface.

Snapping to data is off by default. Although you can snap to all data, doing so not recommended as it increases the possibility that errors in the data or assumptions inherent in interpretations (e.g. polylines) will cause distortions in the meshes. If you do enable snapping, is best to snap only to drilling data.

If you need a surface to honour borehole data but treat other data objects as interpretations, select Drilling only. To honour some data objects while treating others as interpretations, select Custom, then click on the Inputs tab to enable snapping for individual objects.

Surface Resolution
Note that although you can change the Surface resolution for a vein, the Adaptive option is not available, even when the resolution for the geological model is set to be Adaptive.

Vein Thickness
Veins have two thickness settings that force the vein to maintain a minimum or maximum thickness. If footwall and hangingwall points are in pairs, it is not usually necessary to set the Minimum thickness or Maximum thickness.

- If the vein intersects itself, set the Minimum thickness to a value that is less than the minimum distance between any two contact points.
- If the vein widens out toward the edges of the geological model set the Maximum thickness to a value that limits the effects of long segments.

If the Pinch out option is enabled, you will not be able to set the Minimum thickness.
If you set the Maximum thickness and Pinch out, the Pinch out is applied before the Maximum thickness.
Vein Pinch Out

Vein walls can be set to pinch out where borehole data indicates they do not occur. This is achieved by creating ‘outside’ intervals on boreholes that do not have an interior vein segment. These intervals are then flipped with respect to interior vein intervals, which, in effect means the footwall and hangingwall orientation has the opposite sense to the nearest interior intervals. This forces the hangingwall and footwall surfaces to cross, thereby pinching out.

The **Pinch out** option is disabled when a vein is first created. To enable it, double-click on the vein in the project tree and click on the **Surfacing** tab. Tick the box for **Pinch out**. Click OK to process the changes. The vein will be updated and pinch out points (闯) will be added to the vein in the project tree.

For this vein, the surface occurs even where the vein lithology (green cylinders) does not occur and terminates at the boundary of the geological model:

![Vein Pinch Out Diagram 1](image1)

When the vein is set to pinch out, it tapers out where the vein lithology does not occur:

![Vein Pinch Out Diagram 2](image2)
You can change how much the vein pinches out by excluding some pinch out segments. To do this, right-click on the pinch out segments (✓) in the project tree and select Edit in Scene. The Pinch Out Properties window will appear in the scene. Click on a segment to view information about it and set it to be Excluded, if required. Note that the segments displayed in the scene below are the pinch out segments rather than the borehole segments shown in earlier scenes. The grey segments are excluded and the currently selected segment is highlighted in the scene:

Click the Save button (✓) to view the effect of the excluded pinch out segments on the vein. Excluding the two segments results in the vein terminating at the boundary of the geological model:

The Vein Reference Surface

A vein includes a reference surface (∇) that is the best fit for the objects that make up the hangingwall and footwall surfaces. There are two types of reference surface.

- **Curved.** A curved reference surface can be used to make a vein follow the medial trend of the source data, which leads to a more natural modelled shape. This is the type of reference surface used by default for veins created from lithology data. A curved reference surface can be used for veins created from other types of data by adding data to the reference surface, as described in Adding Data to the Reference Surface.

- **Planar.** A planar reference surface is simply the best linear fit between the hangingwall and footwall surfaces. See Using a Planar Reference Surface.
To adjust the reference surface, double-click on it in the project tree or right-click on it and select **Open**. The **Reference Surface** window will appear, showing the data used to for the reference surface. This is the reference surface for a vein created from lithology data, and so the midpoints for the vein lithology are used as **Input values**:

![Reference Surface window]

Boundary filtering for the midpoints used to create a curved reference is controlled by the setting for the vein itself. See **Boundary Filtering** in **Surfacing Options for Veins** for more information.

**Adding Data to the Reference Surface**

In order for a vein created from data other than lithology data to use a curved reference surface, other data must be added to it. To add data, right-click on the reference surface in the project tree and select **Add** or **Edit**. Once you have added data, the **Curved reference surface** option will be enabled in the **Reference Data** window and the objects used to adjust the surface will appear in the list of **Input values**:

![Reference Data window]

You can enable or disable the different data objects to see their effects on the vein by ticking and unticking the **Active** box.
The **Boundary filter** setting for each object determines whether or not the data that lies outside the reference surface’s boundary is filtered.

- Tick **Boundary filter** so that the surface is only influenced by the data that falls inside the reference surface’s boundary.
- Untick **Boundary filter** if you want the surface to be influenced by the data both inside and outside the reference surface’s boundary.

Click **OK** to process the changes.

**Using a Planar Reference Surface**

Veins created from objects other than lithology data use a planar reference surface, and this option can also be selected for veins created from lithology data. To use a planar reference surface, select the **Planar reference surface** option in the **Reference Surface** window. The plane will be displayed in the scene, together with handles that can be used to adjust it:

These handles work in the same manner as the moving plane controls, as described in **The Moving Plane**.

Click **OK** to update the reference surface and view the results.

**The Vein Boundary**

Once a vein has been created, you can change its boundary by:

- Adding a Polyline to the Vein Boundary
- Adjusting the Vein Boundary Plane
Adding a Polyline to the Vein Boundary
To change the boundary using a polyline, right-click on the boundary object ( Deposits ) in the project tree and select Edit. The current vein boundary will appear in the scene, together with drawing controls. Begin drawing the new boundary, as described in Drawing in the Scene, ensuring that the polyline drawn closes and does not intersect itself.

When you save the boundary, the vein will be updated to reflect the changes to the boundary. If you want to revert to the original boundary, right-click on the boundary object ( Deposits ) and select Delete Polyline.

Adjusting the Vein Boundary Plane
To adjust the boundary plane, right-click on the boundary object ( Deposits ) in the project tree and select Adjust Plane. The Adjust Boundary Plane window will appear and handles to adjust the plane will appear in the scene:
Click **OK** to apply the changes to the vein. To revert to the original boundary plane, right-click on the boundary object and select **Adjust Plane**. In the **Adjust Boundary Plane** window, click on the **Set to Default** button and click **OK**.

**Editing Vein Segments**

When a vein has been created from contact points, you can change the vein segment settings by double-clicking on the vein segments object (black rectangle) in the project tree. This opens the **Edit Vein** window.

When extracting the hangingwall and footwall points, Leapfrog Works automatically includes points at the ends of boreholes. To exclude these points, untick the **Include points at the ends of holes**.

**Vein Segment Orientation**

If you need to change the orientation of individual vein segments, e.g. for curved veins, you can do this by right-clicking on the vein segments object (black rectangle) in the project tree and selecting **Edit In Scene**. If the vein segments object is already in the scene, you can edit it by clicking the **Edit** button (white circle) in the shape list.

The **Vein Segment Orientations** window will appear in the scene. Click on a vein segment to view information about that segment:

![Vein Segment Orientations window](image)

Points A and B are labelled in the scene and can be changed by unticking the box for each point and choosing whether to exclude the point or make it a hangingwall or footwall point. Once you have finished editing vein segments, click the **Save** button (white circle).

If you wish to return to the default settings, ensure the **Auto** box is ticked for each point.

**Vein Systems**

This topic describes creating a vein system for a geological model. The topic is divided into:

- **Creating a Vein System**
- **Adding Veins to the Vein System**
- **Editing the Veins**
- **Vein System Lithology Settings**
- **Vein Interactions**

An alternative to defining veins one-by-one is to create a vein system. The vein system represents a single lithology within the geological model. For example, for a model of a sedimentary system cross-cut by vertical intersecting dykes, we could model the veins one-by-one, in which case each “vein” in the model is represented by a separate lithology:

Modelled as a vein system, however, the veins are grouped into a vein system object that defines the lithology for the vein system as a whole:

Note that the individual veins are part of the vein system.

The vein system defines how the veins interact, and veins can be added to it using the same techniques used to create individual veins.
Creating a Vein System
To create a vein system, right-click on the Surface Chronology and select New Vein System. In the window that appears, select the Vein lithology:

If the vein system contacts only one lithology, set the Outside lithology. Otherwise, leave Outside lithology set to Unknown.

Click OK. An empty vein system (𝄢) will be added to the project tree under the Surface Chronology. Double-click on it to change the lithologies.

Adding Veins to the Vein System
Once the vein system has been created, you can create veins using the same techniques described in Veins From Lithology Contacts and Veins From Other Data.

To add veins to the vein system, right-click on the vein system and select one of the New Vein options. Veins will appear in the project tree as part of the vein system object and can be expanded to show how they were created.

Editing the Veins
The techniques for editing vein system veins are the same as those for veins created one-by-one. See Refining Veins.

Vein System Lithology Settings
You can change the lithology settings for a vein system by double-clicking on the vein system (𝄢) in the project tree. In the Lithology tab, change the Vein lithology or the Outside lithology.
Vein Interactions

Once all the veins required have been created, you can start defining the interactions between them by double-clicking on the vein system ( ), then clicking on the Vein System tab:

The veins appear in the list from highest priority to lowest. Organise the veins in chronological order before defining interactions. You cannot define an interaction for the highest priority vein in the list.

To add an interaction, click on a vein, then click the Add button. Select the Interaction Type and set how the veins interact:
Once you have defined the required vein interactions, tick the box for each vein, then click **OK**. Add the **Vein System** object to the scene to check that the veins interact correctly.

You can also edit vein interactions by double-clicking on the individual veins.

Veins and the vein system are not active in the geological model until the box is ticked for each vein in the **Edit Vein System** window and the vein system is enabled in the **Surface Chronology**. This means you can check the vein system without regenerating the geological model.

**Stratigraphic Sequences**

When you have a series of continuous layers in a geological model, you can model each layer separately, as part of a single stratigraphic sequence or using the offset surface tool. Modelling a stratigraphic sequence works best for sequences uniform in thickness with a consistent stacking order. If a layer varies in thickness, the contact surface may not match the contact points in some places. This will be a consideration when choosing whether to model layers as separate layers, as offset surfaces or as part of a stratigraphic sequence. For information on the offset surface tool, see **Offset Surfaces**.

Once you have created a stratigraphic sequence, you can refine it by adding and removing layers and by adjusting the surfaces produced.

This topic describes using the stratigraphic sequence tool and is divided into:

- **Creating a Stratigraphic Sequence**
  - Boundary Filtering
  - **Snapping to Data**
  - Surface Stiffness
- **Editing the Stratigraphic Sequence**
  - Correcting Pinch-out Errors
  - Surfacing Options
  - **Applying a Trend**
- **Editing Individual Surfaces**
  - Contact Honouring and Boundary Filtering for Individual Surfaces
  - Adding Data to Individual Surfaces
  - Editing Surface Contacts
Creating a Stratigraphic Sequence

To create a stratigraphic sequence, right-click on the Surface Chronology object and select New Stratigraphy. The New Stratigraphic Sequence window will appear:

Select the lithologies at the top and bottom of the stratigraphic sequence. To do this, select the Lithology Above and Lithology Below from the lithologies available in the geological model:
Next, click the Add Lithologies button to view available lithologies:

Select the lithologies that you want to use in the stratigraphic sequence, then click OK to add the layers to the Stratigraphic Lithologies list. Make sure they arranged in the correct order.

In the New Stratigraphic Sequence window, select whether the Bottom Contact Type is an erosion or a deposit.

When the Surfaces avoid borehole segments option is enabled, the surfaces in the stratigraphic sequence will not cut through intervals of lithologies that are selected for the stratigraphic sequence.

Next, click on the Surfacing tab to set the surfacing settings for each surface created for the sequence:

For the Boundary filter and Snap to data options, it is possible to override these settings for the individual contact surfaces that are part of the stratigraphic sequence. To do this, select Custom. Once the stratigraphic sequence has been created, expand it in the project tree and double-click on each surface to change its surfacing options, as described in Contact Honouring and Boundary Filtering for Individual Surfaces below.
Boundary Filtering

When data objects are added to a surface, there are two ways to handle the data that lies outside the surface’s boundary:

- Filter the data. The surface is only influenced by the data that falls inside the surface’s boundary.
- Leave the data unfiltered. The surface is influenced by the data both inside and outside the surface’s boundary.

The Boundary filter setting determines how data used to define the surface is filtered:

- Off. Data is not filtered.
- All data. All data is filtered.
- Drilling only. Only borehole data and data objects derived from borehole data are filtered.
- Custom. Only the data objects specified in the Inputs tab are filtered.

All contact surfaces that make up a stratigraphic sequence will inherit the Boundary filter setting from the stratigraphy unless Boundary filter is set to Custom.

Snapping to Data

There is a Snap to data setting for a geological model as a whole that is set in the Geological Model > General tab (see Editing a Geological Model). Snap-to-data can also be set on a surface-by-surface basis by double-clicking on the surface in the project tree and then clicking on the Surfacing tab.

For a stratigraphic sequence, the options are:

- Inherit from GM. The setting for the geological model as a whole is used. This is the default setting.
- Off. Surfaces do not snap to the data used to create them.
- All data. Surfaces snap to all data within the Maximum snap distance, which includes borehole data and any data added to the surfaces.
- Drilling only. Surfaces snap to borehole data and data objects derived from borehole data within the Maximum snap distance but not to other data used to modify the surfaces.
- Custom. Surfaces snap to the data objects indicated in the Inputs tab for each surface.

Snapping to data is off by default. Although you can snap to all data, doing so not recommended as it increases the possibility that errors in the data or assumptions inherent in interpretations (e.g. polylines) will cause distortions in the meshes. If you do enable snapping, is best to snap only to drilling data.

All contact surfaces that make up a stratigraphic sequence will inherit the Snap to data setting from the stratigraphy unless Snap to data is set to Custom.
Surface Stiffness
The **Surface Stiffness** controls the smallest bend a surface will make, where a higher value will result in a smoother surface that bends less. The default value is 0, which is no stiffening.

Click **OK** to create the stratigraphy, which will be added to the project tree as part of the **Surface Chronology** object.

Editing the Stratigraphic Sequence
The objects that make up the stratigraphic sequence include the generated contact surfaces and any points that result in pinch-out errors:

Correcting Pinch-out Errors
Add the pinch-out errors object ( mô ) to the scene to view the points that are causing errors. To find out more about the errors, right-click on the sequence and select **List Errors**.

In the **Stratigraphic Errors** window, information is provided about the different errors that occur in the stratigraphic sequence, with pinch-out errors and other errors listed separately:

Use this information, together with the pinch-out error points, to either remove lithologies from the sequence or adjust surfaces using any of the tools available for individual surfaces, as described in **Editing Individual Surfaces** below.
Remove lithologies from the sequence by double-clicking on the sequence in the project tree, then reorganising the lithologies in the **Chronology** tab. For example, here, the pinch-out errors shown in the window above have been corrected by removing the affected surfaces from the sequence and changing the **Lithology Above** and **Lithology Below**:

You can also ignore an error by ticking the **Ignored** box in the **Stratigraphic Errors** window.

**Surfacing Options**

To change a stratigraphic sequence’s surfacing options, double-click on the sequence in the project tree and click on the **Surfacing** tab. See **Boundary Filtering** and **Snapping to Data** above for more information on the settings in this tab. Note that boundary filtering and snap settings can also be set for the individual surfaces that make up the stratigraphic sequence, which is described in **Contact Honouring and Boundary Filtering for Individual Surfaces** below.

**Applying a Trend**

To apply a global trend to a stratigraphic sequence either right-click on it in the project tree and select **Adjust Surface** or double-click on the stratigraphic sequence and then click on the **Trend** tab. You can then apply a trend to the surface as described in **Global Trends**.

**Editing Individual Surfaces**

Individual surfaces that make up a stratigraphic sequence can be modified by:

- **Contact Honouring and Boundary Filtering for Individual Surfaces**
- **Adding Data to Individual Surfaces**
- **Editing Surface Contacts**

**Contact Honouring and Boundary Filtering for Individual Surfaces**

There are general boundary filtering and snap settings for the stratigraphic sequence as a whole, but it is possible to override these settings for the individual surfaces that are part of the
stratigraphic sequence. To do this, first double-click on the stratigraphic sequence itself, then click on the Surfaces tab.

- To change boundary filtering for an individual surface, Boundary filter must be set to Custom for the stratigraphic sequence.
- To change the snap setting for an individual surface, Snap to data must be set to Custom for the stratigraphic sequence.

Next, double-click on an individual surface in the project tree. The window that appears shows all the data objects used to create the surface:

![Edit Stratigraphic Surface](image)

See Boundary Filtering and Snapping to Data for more information.

Adding Data to Individual Surfaces
You can also refine the individual surfaces in a stratigraphic sequence in several ways:

- Add other data. Right-click on the surface to see the options available, which will depend on how the surface was created. See Adding Data to Surfaces for more information.
- Edit the surface with a polyline. Right-click on the surface in the project tree and select either Edit > With Polyline. See Editing Surfaces with Polylines for more information.
- Edit the surface using structural data. Right-click on the surface and select Edit > With Structural Data. See Editing Surfaces with Structural Data for more information.

Editing Surface Contacts
You can edit the contacts used to generate the surface by expanding the contact surface in the project tree and double-clicking on the points object. See Extracting Contact Points from Borehole Data for more information on the settings in the Edit Contacts window.
Offset Surfaces

The offset surface tool is a useful way of creating a series of deposit or erosion contact surfaces from a reference mesh. The surface can be offset from the reference mesh by points or by a fixed distance, and additional options for offsetting to points can be adjusted once the surface has been created.

Here a deposit contact surface (blue) has been created using the reference mesh (green) offset to points (red):

Important considerations when creating offset surfaces is the characteristics of the reference mesh, especially in relation to the geological model’s boundary.

- It is best to use a reference mesh that extends beyond the model’s boundary. If the reference mesh is too small, the offset surface may be distorted where the reference mesh does not occur.
- If the reference mesh changes significantly near the model’s boundary, offset surfaces may show unexpected changes. Offset surfaces are projected in the direction the reference mesh is going, and if the reference mesh changes direction just inside the boundary, that change will be reflected in the offset surface. This is normal if there is data that takes the reference mesh in a different direction, but if this is not desirable for the offset surface, consider making the geological model’s boundary smaller.

The rest of this topic describes creating and working with an offset surface. It is divided into:

- Creating an Offset Surface
- The Offset Surface in the Project Tree
- Refining an Offset Surface
Creating an Offset Surface

To start creating an offset surface, right-click on the Surface Chronology and select New Deposit/Erosion > From Offset Surface. The New Offset Surface window will appear:

In the window that appears, you need to select a reference mesh, then either select Surface points to offset to or set a Constant offset.

Click Select reference mesh to view the meshes available in the project.

If you wish to offset from the reference mesh using a fixed distance, click Constant offset and set the Distance. For Direction, selecting Forward offsets the surface on the younger side of the reference mesh, and selecting Backward offsets on the older side.

If you wish to offset to points, click Add. You can offset to:

- Base lithology contacts or other lithology contacts in the project.
- Other data in the project. GIS data, points data and polylines can be used.

If you offset to points, you will be able to set additional options such as distance limits once the surface has been created. See Changing Offset Limits below for more information.
Select the First Lithology and Second Lithology from the lithologies defined for the model. If you have added base lithology contacts or other contacts to the surface, these will be set automatically from the data used.

Click OK to create the surface, which will appear in the project tree as part of the Surface Chronology.

The Offset Surface in the Project Tree

The name Leapfrog Works automatically assigns to an offset surface is the lithologies assigned to each side of the surface. In the project tree, expand the surface to see how it was made:

Double-click on the surface to edit it. Double-click on the contact points object (🔗) to edit the lithology and change compositing parameters.

As further refinements are made to the surface, that information will also be added to the project tree. See Refining an Offset Surface below for more information.

Refining an Offset Surface

You can refine an offset surface by:

- Adding other data. Right-click on the surface to see the options available, which will depend on how the surface was created. See Adding Data to Surfaces for more information.
- Editing the surface with a polyline. Right-click on the surface in the project tree and select either Edit. See Editing Surfaces with Polylines for more information.

To edit the surface’s settings, double-click on it in the project tree. In the Lithologies tab, change the lithologies assigned to each side of the surface, if required.

You can swap the younging direction if the direction was assigned incorrectly when the surface was created. The change will be reflected in the scene. Note that changing the younging direction does not change which lithology is older or younger.

An offset surface can be created as a deposit or as an erosion. The difference between deposit and erosion contact surfaces is how they cut older lithologies, as described in Contact Surfaces. For this reason, it is possible to change between the two types using the Contact Type setting.

An offset surface cannot be adjusted by applying a trend.

Changing Surfacing Options for an Offset Surface

Surfacing options for an offset surface can be changed by double-clicking on the surface in the project tree and then clicking on the Surfacing tab. There are additional settings related to
boundary filtering and snapping to data in the **Inputs** tab.

**Boundary Filtering**
When data objects are added to a surface, there are two ways to handle the data that lies outside the surface’s boundary:

- Filter the data. The surface is only influenced by the data that falls inside the surface’s boundary.
- Leave the data unfiltered. The surface is influenced by the data both inside and outside the surface’s boundary.

The **Boundary filter** setting determines how data used to define the surface is filtered:

- **Off.** Data is not filtered.
- **All data.** All data is filtered.
- **Drilling only.** Only borehole data and data objects derived from borehole data are filtered.
- **Custom.** Only the data objects specified in the **Inputs** tab are filtered.

**Snapping to Data**
Often, surfaces should honour borehole data and treat data objects such as polylines and GIS data as interpretations, as discussed in **Contact Honouring**.

There is a **Snap to data** setting for a geological model as a whole that is set in the **Geological Model > General** tab (see **Editing a Geological Model**). **Snap-to-data** can also be set on a surface-by-surface basis by double-clicking on the surface in the project tree and then clicking on the **Surfacing** tab.

For individual contact surfaces, the options are:

- **Inherit from GM.** The setting for the geological model as a whole is used. This is the default setting.
- **Off.** Surfaces do not snap to the data used to create them.
- **All data.** Surfaces snap to all data within the **Maximum snap distance**, which includes borehole data and any data added to the surfaces.
- **Drilling only.** Surfaces snap to borehole data and data objects derived from borehole data within the **Maximum snap distance** but not to other data used to modify the surfaces.
- **Custom.** Surfaces snap to the data objects indicated in the **Inputs** tab for each surface.

Snapping to data is off by default. Although you can snap to all data, doing so not recommended as it increases the possibility that errors in the data or assumptions inherent in interpretations (e.g. polylines) will cause distortions in the meshes. If you do enable snapping, is best to snap only to drilling data.

If you need a surface to honour borehole data but treat other data objects as interpretations, select **Drilling only**. To honour some data objects while treating others as interpretations, select **Custom**, then click on the **Inputs** tab to enable snapping for individual objects.
There is also a snap setting that can be used when offset limits are used. This option is discussed in Offset Surfaces below.

Surface Resolution

The surface resolution for an offset surface can be inherited from the geological model or it can be set specifically for the surface. To change the surface resolution for an offset surface, double-click on the surface in the project tree and then click on the Surfacing tab. See Surface Resolution for a Geological Model for information about the surface resolution settings in the Surfacing tab.

Smoothing

The Smoothing parameter in the Surfacing tab can be used for all offset types other than Constant. If your reference surface is highly curved, you may see distortions in the offset surface. If this is the case, set Smoothing to a higher value.

Increasing the Smoothing parameter will generally result in faster processing when offsetting to large distances. If you are finding that processing time is excessively long for an offset surface, consider increasing Smoothing. In some situations, however, increasing Smoothing can exaggerate imperfections in the reference surface.

If you are offsetting by a small distance and processing is taking longer than expected, consider setting Smoothing to None.

Changing Offset Limits

There are four options for Offset limits in the Surfacing tab. Three relate to offsetting to points and the fourth to offsetting to a fixed distance from the reference mesh.

- The None option is the default setting used when a surface is created as an offset to points. No distance limits are used in creating the offset surface, and it simply follows the points used.
- The Unidirectional limits option allows you to set distance limits in one direction. Points outside the limits will be disregarded.
- The Bidirectional limits option allows you to set distance limits in both directions, and points outside these limits are disregarded. This setting is useful for modelling folded surfaces such as veins.
- The Constant offset option offsets the surface to a fixed distance from the reference mesh.

The Forward direction is the younger side of the reference mesh.

If the Snap to data outside limits setting is enabled, the surface will honour data, even if it is outside the distance limits. This option will be greyed out if Snap to data is off.

Changing to a Constant Offset

To use a constant offset rather than points, select the Constant offset option and set the Distance and Direction to offset the surface. Selecting Forward offsets the surface on the younger side of the reference mesh, whereas selecting Backward offsets on the older side.
If you created a surface as an offset to points and switch to using a constant offset, the points added to the surface when it was created will be disabled.

Changing to an Offset to Points
If you created an offset surface using a constant offset, you can change the surface to offset to points, but you must first add data to it. Do this by right-clicking on it in the project tree and selecting Add. Once you have added the data you wish to use, double-click on the surface and click on the Surfacing tab. Change the Offset limits option from Constant offset to one of the other three options.

Changing the Reference Mesh
To change the surface used as the reference mesh, click on the Inputs tab, then click on the reference mesh:

Select from the surfaces available in the project, keeping in mind the considerations discussed in Changing the Reference Mesh.

Editing the Reference Mesh
You can also edit the reference mesh as you would other surfaces. All dependent offset surfaces will be updated as you make changes to the reference mesh.

Changing the younging direction of the reference mesh affects how offset surfaces are generated.

- For a constant offset surface, the younging direction of the reference mesh determines the forward and backward direction of the offset surface and, therefore, determines the location of the offset surface. Changing the younging direction of the reference mesh results in dependent offset surfaces changing location; the updated offset surface will be the mirror image of the original relative to the reference mesh.
- For surfaces offset to points, the location is determined by the points themselves. If the reference mesh's younging direction is changed, the offset surface's younging direction will also be flipped. The offset surface will still honour the contact data and will still appear at the same location relative to the reference mesh.

Structural Surfaces
A structural surface uses contact data and non-contact structural data to create a surface. A structural surface can interact with other volumes in the model as a deposit, an erosion or an
Creating a Structural Surface

The shape of the structural surface is suggested by the non-contact structural data used.

When creating a structural surface, there are two options for declustering the non-contact structural data:

- The input data is automatically declustered as part of creating the structural surface. There are no additional controls that determine how the data is declustered.
- Use a declustered structural data set as the non-contact input to the surface. This approach is recommended over the first approach as you can change how the data is declustered.

The rest of this topic describes how to create and work with a structural surface. It is divided into:

- Creating a Structural Surface
- The Structural Surface in the Project Tree
- Refining a Structural Surface
- Surfacing Options for a Structural Surface
  - Setting the Surface Resolution
  - Boundary Filtering
  - Snapping to Input Data
- Non-contact Structural Inputs Settings
- Applying a Trend to a Structural Surface
- Value Clipping

Creating a Structural Surface

To create a new structural surface, right-click on the Surface Chronology and select New Structural Surface. The New Structural Surface window will appear:
Use the **Add** buttons to add non-contact structural data and on-surface contacts, then set the **First lithology** and **Second lithology**. Other settings are:

- **Query Filter.** Select from the query filters defined for the selected structural data object.
- **Use Polarity.** Untick the box to use tangents only.
- **Contact Type.** Structural surfaces can be deposit, erosion or intrusion contacts. The same algorithm is used for each setting; the only difference is in how the surface interacts with other surfaces.

### The Structural Surface in the Project Tree
The name Leapfrog Works automatically assigns to a structural surface is the lithologies assigned to each side of the surface. In the project tree, expand the surface to see how it was made:

![Project Tree](image)

As further refinements are made to the surface, that information will also be added to the project tree. See [Refining a Structural Surface](#) below for more information.

To add more non-contact structural data to the surface, right-click on it in the project tree and select **Add > Structural Data**. In the window that appears, tick the box for **Non-contact Structural Data**:

![New Structural Data](image)

### Refining a Structural Surface
You can refine structural surfaces in several ways:

- Add other data. Right-click on the surface to see the options available, which will depend on how the surface was created. See [Adding Data to Surfaces](#) for more information.
- Edit the surface with a polyline. Right-click on the surface in the project tree and select either **Edit > With Polyline**. See [Editing Surfaces with Polylines](#) for more information.
- Edit the surface using structural data. Right-click on the surface and select **Edit > With Structural Data**. See [Editing Surfaces with Structural Data](#) for more information.
To edit the surface’s settings, double-click on it in the project tree. In the Lithologies tab, change the lithologies assigned to each side of the surface, if required.

You can swap the younging direction if the direction was assigned incorrectly when the surface was created. The change will be reflected in the scene. Note that changing the younging direction does not change which lithology is older or younger.

The Contact Type setting determines how the structural surface interacts with other lithologies, as described in Contact Surfaces. A structural surface can be a deposit, erosion or intrusion contact surface.

For information on other techniques for refining structural surfaces, see Surfacing Options for a Structural Surface below.

**Surfacing Options for a Structural Surface**

Surfacing options for a structural surface are accessed by double-clicking on the surface in the project tree and clicking on the Surfacing tab. There are additional settings related to boundary filtering and snapping to data in the Inputs tab.

**Setting the Surface Resolution**

See Surface Resolution for a Geological Model for information about the surface resolution settings in the Surfacing tab.

**Boundary Filtering**

When data objects are added to a surface, there are two ways to handle the data that lies outside the surface’s boundary:

- Filter the data. The surface is only influenced by the data that falls inside the surface’s boundary.
- Leave the data unfiltered. The surface is influenced by the data both inside and outside the surface’s boundary.

The boundary of a structural surface can be the geological model boundary or a fault block boundary.

The Boundary filter setting determines how data used to define the surface is filtered:

- **Off.** Data is not filtered.
- **All data.** All data is filtered.
- **Drilling only.** Only borehole data and data objects derived from borehole data are filtered.
- **Custom.** Only the data objects specified in the Inputs tab are filtered.

**Snapping to Input Data**

Often, surfaces should honour borehole data and treat data objects such as polylines and GIS data as interpretations. See Contact Honouring.

There is a Snap to data setting for a geological model as a whole that is set in the Geological Model > General tab (see Editing a Geological Model). Snap-to-data can also be set on a
surface-by-surface basis by double-clicking on the surface in the project tree and then clicking on the **Surfacing** tab.

For individual contact surfaces, the options are:

- **Inherit from GM.** The setting for the geological model as a whole is used. This is the default setting.
- **Off.** Surfaces do not snap to the data used to create them.
- **All data.** Surfaces snap to all data within the **Maximum snap distance**, which includes borehole data and any data added to the surfaces.
- **Drilling only.** Surfaces snap to borehole data and data objects derived from borehole data within the **Maximum snap distance** but not to other data used to modify the surfaces.
- **Custom.** Surfaces snap to the data objects indicated in the **Inputs** tab for each surface.

Snapping to data is off by default. Although you can snap to all data, doing so not recommended as it increases the possibility that errors in the data or assumptions inherent in interpretations (e.g. polylines) will cause distortions in the meshes. If you do enable snapping, is best to snap only to drilling data.

If you need a surface to honour borehole data but treat other input data objects as interpretations, select **Drilling only**. To honour some data objects while treating others as interpretations, select **Custom**, then click on the **Inputs** tab to enable snapping for individual objects.

### Non-contact Structural Inputs Settings

For the non-contact structural inputs, you can:

- Change the **Query Filter** setting. Select from the query filters defined for the selected structural data object.
- Change the **Use Polarity** setting. Untick the box to use tangents only.
- Change the **Boundary filter** setting, if the **Boundary filter** setting in the **Surfacing** tab is set to **Custom**.

### Applying a Trend to a Structural Surface

There are two ways to change the trend for a structural surface:

- Right-click on the surface in the project tree and select **Adjust Surface**.
- Double-click on the surface in the project tree and then click on the **Trend** tab.

See [Global Trends](#) for more information.

### Value Clipping

In the **Value Clipping** tab, you can manipulate the data distribution by clipping the data. Clipping caps values that are outside the range set by the **Lower bound** and **Upper bound** values. For example, if you change the **Upper bound** from 16.00 to 10.00, distance values above 10.00 will be regarded as 10.00.
When **Automatic clipping** and **Do clipping** are enabled, Leapfrog Works sets the **Lower bound** and **Upper bound** from the data. To change the **Lower bound** and **Upper bound**, untick **Automatic clipping**, tick **Do clipping** and then change the values.

### The Surface Chronology

When you create a contact surface, it appears in the project tree under the **Surface Chronology** object, but it is not enabled and, therefore, does not affect the geological model volumes. This means you can work on the surface without having to reprocess the model whenever you make a change to the surface. In Leapfrog Works, you can easily define, enable and remove contact surfaces from a model, and you can experiment with modelling lithologies using different techniques in order to arrive at a geologically reasonable model.

To add a contact surface to the surface chronology, double-click on the **Surface Chronology** object. The **Surface Chronology** window will be displayed:

![Surface Chronology window](image)

In the project tree, the surfaces are also arranged in chronological order:

![Surface Chronology tree](image)

The **Surface Chronology** determines the overall chronological order of the contact surfaces in the model. If you build your models from the bottom up, you will find that often the contact surfaces are in the correct chronological order when you first open the **Surface Chronology** window. However, you can easily rearrange the chronology using the **Younger** and **Older** buttons. Tick the boxes for surfaces you wish to include in the model. When you click **OK**, the
included surfaces will be used to subdivide the geological model into lithological volumes. The volumes will appear in the **Output Volumes** folder.

Output volumes are named according to the lithologies assigned to each side of the contact surfaces that bound each volume. If the lithology assigned to an output volume cannot be determined, it will be assigned the **Background lithology**.

If you are working with a faulted model and have defined the **Surface Chronology** for one fault block, you can copy the **Surface Chronology** to the empty fault blocks. See [Copying the Surface Chronology to an Empty Fault Block](#).

### Refined Lithological Volumes

When you have built a geological model and want to model further within one of the volumes, you can do this by creating a refined geological model. This changes the way the original (parent) geological model is organised in the project tree and makes it possible to create a sub-model within one or more of the lithological volumes.

Before starting to refine lithological volumes, it is a good idea to make a copy of the original geological model.

To start refining a lithological volume, first create the refined geological model. To do this, right-click on the **Geological Models** folder and select **New Refined Model**:

![Image of the New Refined Model window](image)

In the window that appears, select the geological model to refine and then select from its lithologies.

Next, set the **Base lithology column**, **Filter data** and **Surface resolution**. You cannot change the **Base lithology column** once the refined geological model has been established, but you will be able to change the resolution and data filter settings.

Click **OK** to create the refined lithology.
A new refined model will be created in the project tree and the parent geological model will be moved into it. Here, a model called "M Campaign GM" has been used to create a new refined model, with the QzP volume selected as the refined lithology:

![Refined Lithological Volumes](image)

The sub-model is created inside the refined geological model and has its own **Boundary**, **Lithologies**, **Surface Chronology** and **Output Volumes** objects.

You can work with the sub-model in the same manner you would a normal geological model. The exceptions are:

- The sub-model’s boundary cannot be refined directly. However, changes to the parent geological model will be updated in the sub-model’s boundary.
- The sub-model cannot have its own fault system. If the parent geological model is faulted, the sub-model will have its own fault blocks in which you can work.

See [Editing the Sub-Model](#) for information on refining the sub-model.

You can still work with the parent geological model in the usual manner. Any changes to the parent geological model that change the extents of the sub-model will be reflected in the sub-model’s boundary.

You can create additional sub-models by right-clicking on the refined model and selecting **Refine Lithology**.

A sub-model can be viewed and evaluated in the same manner as normal geological models. However, sub-models cannot be used as layer guides for flow models.

Deleting the refined geological model deletes all models it contains. To return to the original project tree organisation for a geological model, delete the sub-models:
Once there are no more sub-models, the refined model object is also deleted, leaving the parent geological model.

The refined model has its own Lithologies table, which contains all the lithologies from the parent model and any sub-model lithologies. You cannot add lithologies to this table, but you can change the colours used to display them in the scene, as described in Model Lithologies. To add more lithologies to a refined model, add them to the lithology table in either the sub-model or the parent geological model.

The refined model also has its own Output Volumes folder that combines information from the parent geological model and the sub-model. If no surfaces have been created in the sub-model, adding the refined model to the scene will simply display the volumes from the parent geological model. If surfaces have been created in the sub-model, then the volumes of the sub-model will be displayed alongside the volumes from the parent geological model.

**Editing the Sub-Model**

Work with the sub-model in the same manner described in Editing a Geological Model. See Contact Surfaces and The Surface Chronology.

The sub-model can have resolution settings that are different from those of the parent model. See Surface Resolution in Leapfrog Works and Surface Resolution for a Geological Model.
To change the lithology's resolution settings, double-click on the sub-model (️) in the project tree. The **Geological Model** window appears:

![Geological Model Window](image)

This window has only three tabs:

- There is no **Boundary** tab because the sub-model’s boundary can only be modified by modifying the parent geological model.
- There is no **Fault System** tab because a sub-model cannot have its own fault system.
Numeric Models

The FastRBF™ algorithm employs interpolation functions to estimate values from known data. From these estimated values, geological surfaces are constructed as part of the model-building process.

With the **Numeric Models** folder, you can create numeric models and change their parameters.

- An RBF interpolant describes a physical quantity that varies continuously in space. An RBF interpolant can be used to model, for example, RQD data, with isosurfaces values set to represent both high-quality and low-quality rock. See [RBF Interpolants](#).
- A multi-domained RBF interpolant is an RBF interpolant that has a number of individual sub-interpolants that are bounded by the fault blocks or output volumes of a selected geological model. Changes to all sub-interpolants can be made by editing the parent interpolant, while sub-interpolants can be edited to account for local influences on the values used, the trend and interpolation parameters. See [Multi-domained RBF Interpolants](#).
- A distance function calculates the distance to a set of points, which is useful for restricting processing to a specific region. To do this, create a distance function, select the objects to use, then add at least one buffer. You can then use one of the distance function’s isosurfaces as a lateral extent for another model. See [Distance Functions](#).

Values that can be interpolated include downhole numeric data, composited borehole data and points data. See [Interpolant Functions](#) for a general introduction to interpolation.

The rest of this topic describes:

- [Copying a Numeric Model](#)
- [Creating a Static Copy of a Numeric Model](#)
- [Exporting Numeric Model Volumes and Surfaces](#)
- [Exporting Numeric Model Midpoints](#)

Importing a Variogram Model

Leapfrog Works can import spheroidal variogram models exported from Snowden Supervisor. The settings that can be imported are:

- The anisotropy settings in the **Trend** tab
- The **Nugget**, **Total Sill**, **Base Range** and **Alpha** settings in the **Interpolant** tab

To import a variogram model, first create an interpolant. Next, right-click on the interpolant and select **Import Variogram Parameters**. In the window that appears, navigate to the folder that contains the XML file and select it. Click **Open**. The interpolant will be updated with the parameters in the XML file.

The imported variogram model overwrites the parameters in the interpolant, which cannot be undone. If you wish to save the original settings, make a copy of the interpolant before importing the new parameters.
Once the interpolant has been updated, you can edit it further by double-clicking on the interpolant in the project tree.

**Copying a Numeric Model**

Creating a copy of a numeric model is a useful way of experimenting with changes to a model.

To copy a numeric model, right-click on it in the project tree and select **Copy**. Enter a name for the copy of the model and click **OK**. The copy will be added to the project tree.

**Creating a Static Copy of a Numeric Model**

Creating a static copy preserves a snapshot of a numeric model that does not change, even when changes are made to the data on which the original model was dependent. This is a useful way of storing historical models and comparing models. Static copies can be exported from Leapfrog Works, as described in **Exporting Numeric Model Volumes and Surfaces** below.

To create a static copy of a numeric model, right-click on it in the project tree and select **Static Copy**. Enter a name for the copy of the numeric model and click **OK**. The copy will be added to the **Numeric Models** folder.

The objects that make up a static copy of a numeric model depend on the type of model:

- For an RBF interpolant, a static copy is made up of a **Legend** object, a **Boundary** object, and all isosurfaces and output volumes created in building the model.
- For a multi-domained RBF interpolant, a static copy is made up of a **Legend** object, a **Boundary** object, and the output volumes created in building the model. There are also static copies of the sub-interpolants, which are the same as static copies of RBF interpolants.

To view the date a static copy was created, right-click on it in the project tree and select **Properties**. The date the copy was created is in the **General** tab.

**Exporting Numeric Model Volumes and Surfaces**

There are three options for exporting a numeric model’s output volumes and surfaces. These are:

- Export an output volume or a surface as a mesh. Right-click on it in the project tree and click **Export**. You will be prompted for a file name and location. See **Exporting a Single Mesh**.
- Export an output volume as a thickness grid. Right-click on it in the project tree and click **Export Thickness Grid**. See **Thickness Grid Export**.
- Export multiple output volumes and surfaces. Right-click on the interpolant in the project tree and select **Export**. See **Exporting Multiple Meshes from Models**.
Exporting Numeric Model Midpoints

To export interval midpoints from a numeric model, right-click on the model’s values object and select Export. Interval midpoints can be exported in the following formats:

- CSV text file (*.csv)
- DXF file (*.dxf)
- Snowden Supervisor CSV file (*.csv)
- Isatis 3D points file (*.asc)

The values exported are the midpoints of each segment, the X-Y-Z values and the hole ID. The Snowden Supervisor and Isatis 3D points formats also include the interval length, when the model has been created from borehole data.

In each case, you will be prompted for a filename and location.

You can extract interval midpoints from borehole data and then export them from the Points folder. See Extracting Interval Midpoints from Borehole Data for more information.

RBF Interpolants

If the data is both regularly and adequately sampled, different RBF interpolants will produce similar results. In practice, however, it is rarely the case that data is so abundant and input is required to ensure an interpolant produces geologically reasonable results. For this reason, only a basic set of parameters are required when an RBF interpolant is first created. Once the interpolant has been created, you can refine it to factor in real-world observations and account for limitations in the data.

The rest of this topic describes how to create and modify RBF interpolants. It is divided into:

- Creating an RBF Interpolant
  - Values Used
  - The Interpolant Boundary
  - Compositing Options
  - General Interpolant Properties
- The RBF Interpolant in the Project Tree
- Interpolant Display
- RBF Interpolant Statistics
- Modifying an RBF Interpolant’s Boundary with Lateral Extents
  - Creating Lateral Extents
  - Changing a Lateral Extent’s Settings
  - Adding Data to an Extent
  - Editing an Extent with a Polyline
Creating an RBF Interpolant

To create an RBF interpolant, right-click on the **Numeric Models** folder and select **New RBF Interpolant**. The **New RBF Interpolant** window will be displayed:

![New RBF Interpolant Window](image)

This window is divided into four parts that determine the values used to create the interpolant, the interpolant boundary, any compositing options and general interpolant properties.

If you are unsure of some settings, most can be changed later. However, the **Numeric values** object selected when the interpolant is created cannot be changed.

**Values Used**

In the **Values To Interpolate** part of the **New RBF Interpolant** window, you can select the values that will be used and choose whether or not to filter the data and use a subset of those values in the interpolant.

You can build an interpolant from either:
• Numeric data contained in imported borehole data.
• Points data imported into the Points folder.

All suitable data in the project is available from the Numeric values list.

Applying a Query Filter
If you have defined a query filter and wish to use it to create the interpolant, select the filter from the Query filter list. Once the interpolant has been created, you can remove the filter or select a different filter.

Applying a Surface Filter
All available data can be used to generate the interpolant or the data can be filtered so that only the data that is within the interpolant boundary or another boundary in the project influences the interpolant. The Surface Filter option is enabled by default, but if you wish to use all data in the project, untick the box for Surface Filter. Otherwise, you can select the Interpolant Boundary or another boundary in the project.

You can use both the Query Filter option and the Surface Filter option together.

The Interpolant Boundary
There are several ways to set the Interpolant Boundary:
• Enter values to set a Custom boundary.
• Use the controls in the scene to set the Custom boundary dimensions.
• Select another object in the project from the Enclose Object list, which could be the numeric values object being interpolated. The extents for that object will be used as the basis for the Custom boundary dimensions.
• Select another object in the project to use as the Interpolant Boundary. Click the Existing model boundary or volume option and select the required object from the list.

Once the interpolant has been created, you can further modify its boundary. See Modifying an RBF Interpolant’s Boundary with Lateral Extents and Adjusting the Interpolant Boundary below.

Compositing Options
When numeric values from borehole data are used to create an interpolant, there are two approaches to compositing that data:
• Composite the borehole data, then use the composited values to create an interpolant. If you select composited values to create an interpolant, compositing options will be disabled.
• Use borehole data that hasn’t been composited to create an interpolant, then apply compositing settings to the interpolated values. If you are interpolating values that have not been composited and do not have specific Compositing values in mind, you may wish to leave this option blank as it can be changed once the model has been created.

If you are interpolating points, compositing options will be disabled.
General Interpolant Properties

Set the Surface resolution for the interpolant and whether or not the resolution is adaptive. See Surface Resolution in Leapfrog Works for more information on the effects of these settings. The resolution can be changed once the interpolant has been created, so setting a value in the New RBF Interpolant window is not vital. A lower value will produce more detail, but calculations will take longer.

The Volumes enclose option determines whether the interpolant volumes enclose Higher Values, Lower Values or Intervals. Again, this option can be changed once the interpolant has been created.

Enter a Name for the new interpolant and click OK.

Once you have created an RBF interpolant, you can adjust its properties by double-clicking on it. You can also double-click on the individual objects that make up the interpolant.

See also:

- Copying a Numeric Model
- Creating a Static Copy of a Numeric Model
- Exporting Numeric Model Volumes and Surfaces

The RBF Interpolant in the Project Tree

The new interpolant will be created and added to the Numeric Models folder. The new interpolant contains objects that represent different parts of the interpolant:

- The Boundary object defines the limits of the interpolant. See Adjusting the Interpolant Boundary.
- The Trend object describes the trend applied in the interpolant. See Changing the Trend for an RBF Interpolant.
- The points data values object contains all the data used in generating the interpolant. See Adjusting the Values Used.
The Isosurfaces folder contains all the meshes generated in building the interpolant.

The Output Volumes folder contains all the volumes generated in building the interpolant. Other objects may appear in the project tree under the interpolant as you make changes to it.

**Interpolant Display**
Display the interpolant by:

- Dragging the interpolant into the scene or right-clicking on the interpolant and selecting View Output Volumes. Both actions display the interpolant’s output volumes.
- Right-clicking on the interpolant and selecting View Isosurfaces.

**RBF Interpolant Statistics**
You can view the approximated mean for each output volume by right-clicking on the interpolant and selecting Properties. Click on the Statistics tab:

![Statistics tab](image)

You can copy the information displayed in the Statistics tab to the clipboard for use in other applications.

**Modifying an RBF Interpolant’s Boundary with Lateral Extents**
RBF interpolants are created with a basic set of rectangular extents that can then be refined using other data in the project. These extents usually correspond to the ground surface and known boundaries. Creating extents can also be used to restrict modelling to a particular area of interest; for example, modelling can be restricted to a known distance from boreholes by applying a distance function as a lateral extent. Extents do not need to be strictly vertical surfaces and can be model volumes.

**Creating Lateral Extents**
To create an extent, expand the RBF interpolant in the project tree. Right-click on the Boundary object and select from the New Lateral Extent options. Follow the prompts to create the extent, which will then appear in the project tree under the interpolant’s Boundary object.
New extents are automatically applied to the boundary being modified. Leapfrog Works usually orients a new extent correctly, with red presenting the inside face of the extent and blue representing the outside face. If this is not the case, you can change the orientation by right-clicking on the extent in the project tree and selecting **Swap Inside**.

**Extent from a Polyline**

You can create an extent from a polyline that already exists in the project or you can draw a new one. If you want to use an imported polyline, import it into the **Polylines** folder before creating the new extent.

To create a new extent from a polyline, right-click on the interpolant’s **Boundary** object and select **New Lateral Extent > From Polyline**. In the window that appears, select whether you will create a new polyline or use an existing one:

You can create the extent as a **Vertical Wall** or **Surface**. If you create the lateral extent as a **Surface**, you will be able to modify it using additional data, as described below. A lateral extent created as a **Vertical Wall**, however, cannot be modified.

Click **OK** to generate the new extent. If you have chosen to create a **New Drawing**, the drawing controls will appear in the scene and you can begin drawing, as described in **Drawing in the Scene**.

The new extent will appear in the project tree as part of the **Boundary** object.

If the surface generated does not fit the polyline adequately, you can increase the quality of the fit by adding more points to the polyline. See **Drawing in the Scene** for information on adding points to polylines.

Extents created from polylines can be modified by adding points data, GIS vector data and structural data. You can also add polylines and structural data to the extent. See **Adding Data to an Extent**, **Editing an Extent with a Polyline** and **Editing an Extent with Structural Data** for more information.
Extent from GIS Vector Data

GIS data in the project can be used to create a lateral extent for an RBF interpolant. Once the data you wish to use has been imported into the project, right-click on the interpolant’s **Boundary** object and select **New Lateral Extent > From GIS Vector Data**.

In the window that appears, select the data object you wish to use:

You can create the extent as a **Vertical Wall** or **Surface**. If you create the lateral extent as a **Surface**, you will be able to modify it using additional data, as described below. A lateral extent created as a **Vertical Wall**, however, cannot be modified.

If you select the **Surface** option, you can use the GIS data object with its own elevation data or projected onto the topography:

Using the **On Topography** option makes sense for GIS data as it is, by nature, on the topography. The **On Topography** option also mitigates any issues that may occur if elevation information in the GIS data object conflicts with that in the project.

Click **OK** to create the new extent. The new extent will appear in the project tree as part of the **Boundary** object.

Extents created from GIS data can be modified by adding points data, GIS vector data and structural data. You can also add polylines and structural data to the extent. See **Adding Data to an Extent**, **Editing an Extent with a Polyline** and **Editing an Extent with Structural Data** for more information.
Extent from Points

To create a new extent from points data, right-click on the interpolant’s Boundary object and select New Lateral Extent > From Points. The Select Points To Add window will be displayed, showing points data available in the project:

Select the information you wish to use and click OK.

The new extent will appear in the project tree as part of the Boundary object.

Extents created from points can be modified by adding points data, GIS vector data and structural data. You can also add polylines and structural data to the extent. See Adding Data to an Extent, Editing an Extent with a Polyline and Editing an Extent with Structural Data for more information.

Extent from Structural Data

Planar structural data can be used to create a lateral extent for an RBF interpolant. You can create a new structural data table or use a table that already exists in the project. If you want to use categories of structural data in creating the extent, use an existing table and create filters for those categories before creating the lateral extent.

To start, right-click on the interpolant’s Boundary object and select New Lateral Extent > From Structural Data. The New Structural Data window will be displayed, showing structural data available in the project:

Select the New Drawing option to draw the structural data points directly in the scene.
Select the **Existing Structural Data** option to use a table in the **Structural Modelling** folder. With this option, you will be able to select from the categories available in the data table, if query filters have been created for those categories:

![Image](image.png)

Click **OK** to generate the new extent. If you have chosen to create a **New Drawing**, the drawing controls will appear in the scene and you can begin drawing, as described in **Creating New Planar Structural Data Tables**. To share the new structural data table, right-click on it and select **Share**. The table will be saved to the **Structural Modelling** folder.

The new extent will appear in the project tree as part of the **Boundary** object.

Extents created from structural data can be modified by adding points data, GIS vector data and structural data. You can also add polylines and structural data to the extent. See **Adding Data to an Extent**, **Editing an Extent with a Polyline** and **Editing an Extent with Structural Data** for more information.

### Extent from a Surface

To use a surface as lateral extent for an RBF interpolant, right-click on the interpolant’s **Boundary** object and select **New Lateral Extent > From Surface**. The **Select Boundary** window will appear, showing all the meshes that can be used as an extent:

![Image](image.png)

Select the required mesh and click **OK**. The extent will be added to the interpolant’s **Boundary** object.

You cannot modify an extent created from a mesh by adding data, editing with polylines or structural data or by applying a trend. However, the extent is linked to the mesh used to create it, and updating the mesh will update the extent.
Extent from Distance to Points

Leapfrog Works can calculate the distance to a set of points and use the resulting distance buffer as a lateral extent for an RBF interpolant. To create a new lateral extent from a distance buffer, right-click on the interpolant’s Boundary object and select New Lateral Extent > From Distance To Points. The Smoothed Distance Buffer window will appear:

![Smoothed Distance Buffer window]

Select the Distance and set an Anisotropy, if required.

The Ellipsoid Ratios determine the relative shape and strength of the ellipsoids in the scene, where:

- The Maximum value is the relative strength in the direction of the green line on the moving plane.
- The Intermed. value is the relative strength in the direction perpendicular to the green line on the moving plane.
- The Minimum value is the relative strength in the direction orthogonal to the plane.

You can also use the Set to list to choose different options Leapfrog Works has generated based on the data used to build the interpolant. Isotropic is the default option used when the interpolant is created.

Click OK to create the new extent, which will appear in the project tree as part of the Boundary object.

To change the extent’s settings, expand the interpolant’s Boundary object in the project tree and double-click on the extent. Adjust the Distance and Anisotropy, if required.

Extents created from a distance to points function can be modified by adding points data and GIS vector data. See Adding Data to an Extent.

Extent from a Distance Function

A distance function calculates the distance to a set of points and can be used to bound an RBF interpolant. You can use an existing distance function as a lateral extent or create a new one.

To use a distance function as a lateral extent, right-click on the interpolant’s Boundary and select New Lateral Extent > From Distance Function. If there are no distance functions in the project, you will be prompted to create a new one. See Distance Functions for information on defining and editing the distance function.
When there are already distance functions in the project, you will be prompted to choose between creating a new function or using an existing one:

To use an existing function, select it from the list and set a **Buffer distance**. Click **OK** to create the lateral extent.

When you create a new distance function, it will be part of the interpolant’s **Boundary** object and will not be available elsewhere in the project. To share it within the project, expand the lateral extent in the project tree and right-click on the distance function. Select **Share**. The distance function will be saved to the **Numeric Models** folder.

To change the extent’s settings, expand the interpolant’s **Boundary** object in the project tree and double-click on the extent. Adjust the **Distance** and **Anisotropy**, if required.

**Changing a Lateral Extent’s Settings**

For lateral extents created from from polylines, GIS data, points and structural data, you can change the extent’s settings by double-clicking on it in the project tree.

In the **Surfacing** tab, you can change surface resolution and contact honouring options, which are described below. In the **Trend** tab, you can apply a trend to the extent, which is described in **Applying a Trend**.

**Surface Resolution**

For RBF interpolants, the resolution of lateral extents is inherited from the settings in the interpolant’s **Outputs** tab, but the adaptive isosurfercer is automatically disabled. Enter a different **Surface resolution** value, if required, and tick **Adaptive** to enable the adaptive isosurfercer.
Contact Honouring

Often, surfaces should honour borehole data and treat data objects such as polylines and GIS data as interpretations. For extents, the **Snap to data** setting in the **Surfacing** tab determines whether or not the extent honours the data used to create it. Options are:

- **Off.** The extent does not snap to the data used to create it. This is the default setting.
- **All data.** The extent snaps to all data within the **Maximum snap distance**, which includes borehole data and any data added to the extent.
- **Drilling only.** The extent snaps to borehole data and data objects derived from borehole data within the **Maximum snap distance**, but not to other data used to modify the extent. For example, the extent will honour points data derived from borehole data, but not points data imported into the **Points** folder.
- **Custom.** The extent snaps to the data objects indicated in the **Inputs** tab that are within the **Maximum snap distance**.

Snapping to data is off by default. Although you can snap to all data, doing so not recommended as it increases the possibility that errors in the data or assumptions inherent in interpretations (e.g. polylines) will cause distortions in the meshes. If you do enable snapping, is best to snap only to drilling data.

Whatever the setting, you can see what objects are snapped to by clicking on the **Inputs** tab.

If you need the extent to honour borehole data but treat other data objects as interpretations, select **Drilling only**. To honour some data objects while treating others as interpretations, select **Custom**, then click on the **Inputs** tab to enable snapping for individual objects.

Applying a Trend

You can adjust an extent created from polylines, GIS data, points and structural data by applying a trend to it. To do this, add the extent to the scene. Next, double-click on the extent in the project tree and click the **Trend** tab.

Often the easiest way to apply a trend is to click on the **Draw plane line** button ( ), and draw a plane line in the scene in the direction in which you wish to adjust the surface. You may need to rotate the scene to see the plane properly.

The **Ellipsoid Ratios** determine the relative shape and strength of the ellipsoids in the scene, where:

- **The Maximum** value is the relative strength in the direction of the green line on the moving plane.
- **The Intermed.** value is the relative strength in the direction perpendicular to the green line on the moving plane.
- **The Minimum** value is the relative strength in the direction orthogonal to the plane.

Once you have adjusted the plane to represent the trend you wish to use, click the **Set From Plane** button to copy the moving plane settings.
The **Set to** list contains a number of different options Leapfrog Works has generated based on the data used in the project. **Isotropic** is the default option used when the extent was created. Settings made to other surfaces in the project will also be listed, which makes it easy to apply the same settings to many surfaces.

Click **OK** to apply the changes.

See [Global Trends](#) for more information.

### Adding Data to an Extent

Extents created from polylines, GIS data, points and structural data can be modified by adding points data objects, GIS vector data and structural data. Extents created from a distance to points function can be modified by adding points data and GIS vector data. To add data to an extent, right-click on the extent in the project tree and select the data type you wish to use from the **Add** menu.

- Points data. Select from the points data objects available in the project and click **OK**.
- GIS vector data. Select from the GIS vector data available in the project and click **OK**.
- Structural data. Select from the structural data tables available in the project. If the selected table has query filters defined, you can apply one of these filters by ticking **Use query filter** and then selecting the required filter from the list. Click **OK** to add the selected data to the extent. An alternative to adding an existing structural data table to an extent is to edit the extent with structural data. This is described in [Editing an Extent with Structural Data](#) below.

You can also add a polyline that already exists in the project. To do this, right-click on the extent in the project tree and select **Add > Polyline**. You will be prompted to choose from the polylines in the **Polylines** folder.

### Editing an Extent with a Polyline

You can edit an extent using a polyline, which is described in **Surfaces**. A polyline used to edit an extent will be added to the project tree as part of the extent. To edit the polyline, right-click on it and select **Edit Polyline** or add it to the scene and click the **Edit** button (🔗) in the shape list. If you wish to remove the polyline from the extent, right-click on it in the project tree and select **Delete** or **Remove**.

To add an existing polyline to a lateral extent, use the **Add > Polyline** option.

### Editing an Extent with Structural Data

You can edit an extent using structural data, which is described in **Surfaces**. A structural data table will be added to the project tree as part of the extent. To edit the table, right-click on it and select **Edit In Scene** or add it to the scene and click the **Edit** button (🔗) in the shape list. If you wish to remove the table from the extent, right-click on it in the project tree and select **Delete** or **Remove**.
Removing an Extent from an Interpolant

If you have defined an extent and want to remove it from the interpolant, there are two options. The first is to right-click on the extent in the project tree and click **Delete**. This deletes the extent from the interpolant, but does not delete parent objects from the project unless they were created as part of the interpolant, e.g. a polyline used as a lateral extent but not shared within the project. Use this option only if you are sure you do not want to use the extent.

The second method is useful if you are making changes to the extent and do not want to recompute the interpolant with each change. Double-click on the interpolant’s **Boundary** object or double-click on the interpolant and click on the **Boundary** tab. The **Boundaries** part of the window lists all objects used as extents for the interpolant. Untick the box for extents to temporarily disable them in the interpolant. The interpolant will be reprocessed, but you can then work on the extent without reprocessing the interpolant. Disabled extents will be marked as inactive in the project tree.

Changing the Settings for an RBF Interpolant

To change the settings for an RBF interpolant, you can either double-click on the interpolant in the **Numeric Models** folder or right-click and select **Open**. When creating an RBF interpolant, only a basic set of parameters is used. The **Edit RBF Interpolant** window provides finer controls over these basic parameters so you can refine the interpolant to factor in real-world observations and account for limitations in the data.

For a multi-domained RBF interpolant, these parameters can be changed for the parent interpolant, and the trend, clipping, transformation and interpolation settings can be changed for the sub-interpolants.

Adjusting the Values Used

The **Values** tab in the **Edit Interpolant** window shows the values used in creating the interpolant and provides options for filtering the data. Although you cannot change the values used to create an interpolant, you can filter the values using the **Query filter** and **Surface filter** options.

You can adjust the values using a contour polyline or by adding points. Both options are available by expanding the interpolant in the project tree, then right-clicking on the values object:
These options are described below in Adding a Contour Polyline and Adding Points.

To apply a query filter, tick the Query filter box in the Values tab and select the available queries from the list.

To change the object used as the Surface filter, select the required object from the list. Note that the list contains an object that defines the interpolant’s own boundary, which can be adjusted in the Boundary tab.

Adding a Contour Polyline
Adding a contour polyline is a useful tool for manually adjusting a surface to make it more geologically reasonable. To start adding a contour polyline, draw a slice where you wish to adjust the surface and decide what value you will assign to the contour line. Next, right-click on the values object and select New Contour Polyline. The next step is to choose whether you will draw a new polyline or use one already in the project:

Only GIS lines, polylines imported into Leapfrog Works or polylines created using the straight line drawing tool can be used to create contour lines.

Enter the value to be used for the contour and a name for it. Click OK. If you have chosen the New Drawing option, the new object will be created in the project tree and drawing tools will appear in the scene. Start drawing in the scene as described in Drawing in the Scene. When you have finished drawing, click the Save button. The new contour will automatically be added to the interpolant and will appear in the project tree as part of the interpolant’s values object.
To change the value assigned to a contour polyline, double-click on the interpolant in the project tree. In the Values tab, contour polylines and their assigned values are shown in the User contour values table:

![User contour values table](image)

To change the value on a contour, click in the **Value** column and edit the entry.

To edit the polyline, right-click on it in the project tree and select **Edit Polyline** or add it to the scene and click the **Edit** button (дон) in the shape list. If you wish to remove a contour polyline from the interpolant, right-click on it in the project tree and select **Delete** or **Remove**.

**Adding Points**

To add points to an RBF interpolant, right-click on the values object in the project tree and select **Add Values**. Leapfrog Works will display a list of all suitable points objects in the project. Select an object and click **OK**.

A hyperlink to the points object will be added to the values object in the project tree. To remove the points object, right-click on the points object and select **Remove**.
Compositing Parameters for an RBF Interpolant

When an RBF interpolant has been created from data that has not been composited, compositing parameters can be changed by double-clicking on the interpolant in the project tree, then clicking on the Compositing tab.

The Compositing tab will only appear for interpolants created from borehole data that has not been composited.

You can composite in the entire borehole or only where the data falls inside the interpolant boundary. See Numeric Composites for more information on the effects of the Compositing length, For end lengths less than and Minimum coverage settings.
### Adjusting the Interpolant Boundary

See [Modifying an RBF Interpolant’s Boundary with Lateral Extents](#) above for information on creating and working with lateral extents.

To change an RBF interpolant’s boundary, double-click on the interpolant in the project tree, then click on the **Boundary** tab:

![Edit RBF Interpolant](image)

Controls to adjust the boundary will also appear in the scene.

Tick the **Use Topography** box to use the topography as a boundary. The topography is normally not used as a boundary for interpolants and so this option is disabled when an interpolant is first created.

The **Boundaries** list shows objects that have been used to modify the boundary. You can disable any of these lateral extents by unticking the box.
Lateral extents can be used to restrict modelling to a particular area of interest; for example, modelling can be restricted to a known distance from boreholes by applying a distance function as a lateral extent.

**Clipping and Transforming Values for an RBF Interpolant**

To clip data and apply a transformation to an RBF interpolant, double-click on the interpolant in the project tree, then click on the **Value Transform** tab:

![Value Transform tab](image)

The options for **Transform Type** are **None** and **Log**. **Log** uses a natural logarithm to compress the data values to a smaller range. This may be useful if the data range spans orders of magnitude. The function used is:

\[ \ln(x+s) + c \]

where \( s \) is the **Pre-log shift** and \( c \) is a constant. In order to avoid issues with taking the logarithm of zero or a negative number, **Pre-log shift** is a constant added to make the minimum value positive. The value of the pre-log shift will automatically be chosen to add to the minimum value in the data set to raise it to 0.001. This constant is then added to all the data samples. You can modify the value of the **Pre-log shift**, as increasing this value further away from zero can be used to reduce the effect of the natural logarithm transformation on the resultant isosurfaces.

Note that a further constant, \( c \), is added to the natural logarithm of the data with the pre-log shift added to it. If there are any negative numbers that result from taking the natural log of the data, the absolute value of the most negative number is taken and added to all the transformed data results. This will raise the value of all the data so the minimum data value is zero. The value of \( c \) is chosen automatically and cannot be modified.

**Bin count** defines the number of bins, where a larger bin count results in a finer histogram.

If you tick the **Do pre-transform clipping** option, you can set the **Lower bound** and the **Upper bound** to cap values that are too low or too high. For example, if you set the **Upper bound** from 14.00 to 10.00, grade values above 10.00 will be regarded as 10.00.
Changing the Trend for an RBF Interpolant

You can apply a global trend or a structural trend to an RBF interpolant. To do this, add the interpolant to the scene, then double-click on the interpolant in the project tree. Click on the Trend tab in the Edit RBF Interpolant window.

See:

- Using a Global Trend
- Using a Structural Trend

Using a Global Trend

The easiest way to change the trend applied to an interpolant is using a global trend set from the moving plane.

Click View Plane to add the moving plane to the scene, then click on the plane to view its controls. You may need to hide part of the interpolant to click on the moving plane:

![Image of Edit RBF Interpolant window]

You can also use the Set to list to choose different options Leapfrog Works has generated based on the data used to build the interpolant. Isotropic is the default option used when the interpolant is created.

The Ellipsoid Ratios determine the relative shape and strength of the ellipsoids in the scene, where:

- The Maximum value is the relative strength in the direction of the green line on the moving plane.
- The Intermed. value is the relative strength in the direction perpendicular to the green line on the moving plane.
- The Minimum value is the relative strength in the direction orthogonal to the plane.

Click OK to regenerate the interpolant and view changes.
Using a Structural Trend

You can also set the trend for an RBF interpolant from a structural trend. First, you must create or import the required mesh and create a structural trend. See Structural Trends for more information.

Once the structural trend has been created, add it to the interpolant by double-clicking on the interpolant in the project tree, then clicking on the Trend tab. Select the Structural Trend option, then select the required trend from the list:

![Image of the Edit RBF interpolant window](image)

Click OK. The trend will be added to the interpolant and will appear as part of the interpolant, as shown:

![Image of the project tree with the Structural Trend applied](image)

When you apply a structural trend, you cannot use the Linear interpolant. See Interpolant Functions for more information.

Once a structural trend has been defined for the interpolant, you can edit it by clicking on the trend hyperlink in the project tree, then opening the structural trend applied to the interpolant. The Structural Trend window will appear. See Structural Trends for information on the settings in this screen.
When a structural trend that is **Strongest along meshes** or **Blending** is used, the interpolant will regress to the global mean trend away from the meshes. The global trend that will be used is set in the **Global Trend** tab for the structural trend.

**Adjusting Interpolation Parameters**

To adjust interpolation parameters for an RBF interpolant, double-click on the interpolant in the project tree, then click on the **Interpolant** tab:

![Interpolant tab](image)

Two models are available, the spheroidal interpolant and the linear interpolant. See [The Spheroidal Interpolant Function](#) and [The Linear Interpolant Function](#) for more information on the settings in this tab.
Output Settings for an RBF Interpolant

You can change the parameters used to generate RBF interpolant outputs by double-clicking on the interpolant, then clicking on the Outputs tab.

The Evaluation limits apply when interpolants are evaluated against other objects in the project. When the limits are enabled, all values outside the limits will be set to the Minimum and Maximum.

When Exact clipping is enabled, the interpolant isosurface will be generated without “tags” that overhang the interpolant boundary. This setting is enabled by default when you create an interpolant.

To add a new isosurface, click the Add button and enter the required value. To delete an isosurface, click on it in the list, then click the Remove button. You can also change the colours used to display the isosurfaces by clicking on the colour chips.

If you find that grade shells are overlapping, the resolution may be too coarse. Set Default resolution to a lower value or enable adaptive resolution in the Outputs tab. See Surface Resolution in Leapfrog Works.

Multi-domained RBF Interpolants

This topic describes creating and editing multi-domained RBF interpolants:

- Creating a Multi-domained RBF Interpolant
- Compositing and Filtering the Values Used
- Selecting Domains
- Clipping and Transforming Values
- Setting the Trend
Creating a Multi-domained RBF Interpolant

- **Interpolation Parameters**
- **Output Options**
- **The Multi-domained RBF Interpolant in the Project Tree**
- **Interpolant and Sub-interpolant Display**
- **Sub-interpolant Statistics**

A multi-domained RBF interpolant is an RBF interpolant that has a number of individual sub-interpolants bounded by the domains of a geological model.

- Changes to all sub-interpolants can be made by editing the parent interpolant.
- Sub-interpolants can be edited to account for local influences on the values used, the trend and interpolation parameters.

A multi-domained RBF interpolant is a single object that can be evaluated as a single column on points and block models.

**Creating a Multi-domained RBF Interpolant**

Creating a multi-domained RBF interpolant is a two-step process:

- Selecting the values to be used and the domains in which sub-interpolants will be created.
- Setting the multi-domained RBF interpolant’s properties.

To start creating a multi-domained RBF interpolant, right-click on the Numeric Models folder and select **New Multi Domained RBF Interpolant**. The **New Multi-domained RBF Interpolant** window will be displayed:

In this window, select the basic parameters for the multi-domained RBF interpolant. You will be able to set additional properties once you click **OK**.

- Select the **Values To Interpolate** from the suitable data available in the project. You will be able to change how data is filtered at the next step, but you will not be able to change the values used.
Select the domains used to generate sub-interpolants. These options cannot be changed once the multi-domained RBF interpolant has been created, although you will be able to select which volumes are used to generate sub-interpolants.

Select from the geological models available in the project.

If the selected Model has no faults defined, the Volume Type will be set to output volumes.

If the selected Model is a faulted model, the Volume Type can be output volumes, faulted output volumes or fault blocks.

Click OK to move on to the next step. The Edit RBF Interpolant window will appear:

### Compositing and Filtering the Values Used

In the Values tab, you can apply any query filters that have been defined for the data used. When numeric values from borehole data are used to create an interpolant, there are two approaches to compositing that data:

- Compose the borehole data, then use the composited values to create an interpolant. If you select composited values to create an interpolant, compositing options will be disabled.
- Use borehole data that hasn’t been composited to create an interpolant, then apply compositing settings to the interpolated values. If you are interpolating values that have not been composited and do not have specific Compositing values in mind, you may wish to leave this option blank as it can be changed once the model has been created.

If you are interpolating points, compositing options will be disabled.

See Numeric Composites for more information on the effects of the Compositing length, For end lengths less than and Minimum coverage settings.
Selecting Domains

In the Domains tab, you can select the volumes in which sub-interpolants will be generated. You cannot, however, change the geological model or the types of volumes used.

Clipping and Transforming Values

In the Value Transform tab, clip data and apply a transformation, if required. See Clipping and Transforming Values for an RBF Interpolant for more information about the settings in this tab.

You will be able to change the Value Transform settings for individual sub-interpolants once the parent interpolant has been created.

Setting the Trend

In the Trend tab, you can apply a global or structural trend to the interpolant. See Changing the Trend for an RBF Interpolant for more information about these options.

You will be able to change the Trend settings for the interpolant and individual sub-interpolants once the parent interpolant has been created.

Interpolation Parameters

In the Interpolant tab, you can change interpolation parameters. See Adjusting Interpolation Parameters for more information about these options.

You will be able to change the Interpolant settings or import variogram parameters for the interpolant and individual sub-interpolants once the parent interpolant has been created.

Output Options

In the Outputs tab, you can change the parameters used to generate interpolant outputs.

The Evaluation limits apply when interpolants are evaluated against other objects in the project. When the limits are enabled, all values outside the limits will be set to the Minimum and Maximum.

Set the Default resolution for the interpolant and whether or not the resolution is adaptive. See Surface Resolution in Leapfrog Works for more information on the effects of these settings. The resolution can be changed once the interpolant has been created, so setting a value when creating the parent interpolant is not vital. A lower value will produce more detail, but calculations will take longer.

When Exact clipping is enabled, the interpolant isosurface will be generated without “tags” that overhang the interpolant boundary. This setting is enabled by default when you create an interpolant.
To add a new isosurface, click the Add button and enter the required value. To delete an isosurface, click on it in the list, then click the Remove button. You can also change the colours used to display the isosurfaces by clicking on the colour chips.

The Volumes enclose option determines whether the interpolant volumes enclose Higher Values, Lower Values or Intervals. This option can be changed once the interpolant has been created.

Enter a Name for the new interpolant and click OK.

Once you have created a multi-domained RBF interpolant, you can adjust its properties as described in Changing the Settings for an RBF Interpolant. You can also change trend, clipping, transformation and interpolation settings for a sub-interpolant. To do this, double-click on a sub-interpolant. For the settings you wish to change, untick the Inherit parameters from parent box:

See also:
- Importing a Variogram Model
- Copying a Numeric Model
- Creating a Static Copy of a Numeric Model
- Exporting Numeric Model Volumes and Surfaces
The Multi-domained RBF Interpolant in the Project Tree

The new multi-domained RBF interpolant will be created and added to the **Numeric Models** folder. It contains objects that represent different parts of the interpolant:

- There is a link to the geological model from which domains are selected for the sub-interpolants.
- The **Trend** object describes the trend applied in the interpolant. See [Changing the Trend for an RBF Interpolant](#) for more information.
- The points data values object contains all the data used in generating the interpolant. See [Adjusting the Values Used](#) for more information.
- The **Sub-interpolants** folder contains the sub-interpolants, which can be edited to change the trend, clipping, transformation and interpolation settings.
- The **Output Volumes** folder contains all the volumes generated in building the interpolant.

Other objects may appear in the project tree under the interpolant as you make changes to it.

### Interpolant and Sub-interpolant Display

Display the interpolant by:

- Dragging the interpolant into the scene or right-clicking on the interpolant and selecting **View Output Volumes**. Both actions display the parent interpolant’s output volumes.
- Right-clicking on the interpolant and selecting **View Isosurfaces**. This displays the isosurfaces of each sub-interpolant.
Sub-interpolant Statistics

You can view the approximated mean for each output volume of a sub-interpolant by right-clicking on the sub-interpolant and selecting Properties. Click on the Statistics tab:

You can copy the information displayed in the Statistics tab to the clipboard for use in other applications.

Distance Functions

A distance function calculates the distance to a set of points. This topic describes how to create and modify distance functions. It is divided into:

- Creating a Distance Function
- The New Distance Function in the Project Tree

Creating a Distance Function

To create a distance function, right-click on the Numeric Models folder and select New Distance Function. The New Distance Function window will be displayed:
Click **Select objects** to choose from the objects available in the project. For boreholes, points, GIS points and imported GIS lines, you can apply any filter that has been defined for that object.

If any of the objects selected are closed surfaces, you can choose whether these surfaces are treated as **Volumes** or as **Surfaces**.

- When treated as **Volumes**, buffers will be generated only on the outside of the mesh. If the mesh is inverted, buffers will appear on its inner surface.
- When treated as **Surfaces**, buffers will be generated on both sides of the mesh.

For example, here a distance function has been created using a sphere and one isosurface set to 100. The inner surface of the sphere is red, indicating that it is the inside of the mesh. The sphere is treated as a volume and there is a single isosurface (yellow) outside of the sphere:

When the orientation of the sphere is reversed, the isosurface (yellow) is generated on the inner surface of the sphere:
However, when the sphere is treated as a surface rather than as a volume, isosurfaces are generated on both sides of the sphere:

If you are unsure of some settings, most can be changed later. For a basic distance function click **Select Objects** to select from the suitable objects available in the project, then click on the **Buffers** tab to define at least one buffer so that the distance function can be visualised in the scene.

See:

- **Setting the Boundary**
- **Setting a Trend**
- **Adding Buffers**
- **The New Distance Function in the Project Tree**

**Setting the Boundary**

In the **Boundary** tab, you can set whether the function boundary is clipped or unclipped. **No distance buffer clipping** is the default setting, but if you choose to clip the buffers, you can choose between:

- Sharing another object’s extents
- Defining a set of extents that is independent of other objects in the project.

When you select the **Shared with** option, the distance function will be updated when the extents object it shares is updated.

**Setting a Trend**

In the **Trend** tab, you can set a trend using the moving plane or by entering the required values. You can also use the **Set to** list to choose different options used in the project. **Isotropic** is the default option used when the function is created.
The **Ellipsoid Ratios** determine the relative shape and strength of the ellipsoids in the scene, where:

- The **Maximum** value is the relative strength in the direction of the green line on the moving plane.
- The **Intermed.** value is the relative strength in the direction perpendicular to the green line on the moving plane.
- The **Minimum** value is the relative strength in the direction orthogonal to the plane.

### Adding Buffers

To add buffers, click on the **Buffers** tab, then click the **Add** button:

Enter the required value. To delete a buffer, click on it in the list, then click the **Remove** button. You can also change the colours used to display the buffers by clicking on the colour chips.

There are two options for **Volume Type** that affect how the buffers are calculated when more than one buffer is used. Selecting **Concentric** produces higher distance buffers that include the lower distance buffers, whereas selecting **Intervals** produces discrete, non-intersecting buffers.

The **Default resolution** setting is used for all new buffers and for existing buffers that use the default resolution.

### The New Distance Function in the Project Tree

Click **OK** to create the distance function, which will be added to the **Numeric Models** folder. The new distance function contains objects representing different parts of the function, which can be expanded to show the inputs to each part of the function:
The Trend object that describes the trend applied.

Hyperlinks to objects used for the distance function.

An Isosurfaces folder that contains all the meshes generated in building the distance function.

An Output Volumes folder that contains all the distance buffer meshes.

Other objects may appear in the project tree under the function as you make changes to it.

Display the function by dragging it into the scene or by right-clicking on it and selecting View Buffers.

Once you have created a distance function, you can adjust its properties by double-clicking on it. You can also double-click on the individual objects that make up the function.
Combined Models

This topic describes creating and working with combined models. It is divided into:

- Creating a Combined Model
- The Combined Model in the Project Tree
- Editing a Combined Model
- Displaying a Combined Model
- Creating a Static Copy of a Combined Model
- Combined Model Export

A combined model uses information from up to four geological models, interpolants and distance functions in order to visualise relationships between different types of data in the project. For example, you could combine a geological model with an interpolant to see what lithologies higher grades are occurring in.

Creating a Combined Model

To create a combined model, right-click on the Combined Models folder in the project tree and select New Combined Model. In the window that appears, select the models you wish to combine, then click OK.

Once you have created a combined model, you cannot edit it to add new models or remove existing ones.
The next step is to select the output volumes to use in the combined model and arrange them in order of priority. For this combined model, the Q2P volume from the selected geological model will be subdivided using information from the Au interpolant:

If you are using a distance buffer with concentric buffers, you will be able to select only one volume.

Click **OK** to generate the model, which will appear in the project tree in the **Combined Models** folder.

Add the model to the scene to view the results:

**The Combined Model in the Project Tree**

In the project tree, the combined model includes hyperlinks to the models used to create the combined model:
Editing a Combined Model

Changes made in the original models will be reflected in the combined model.

Editing a Combined Model

To change how the volumes from the source models are combined, double-click on the combined model in the project tree. Once you have created a combined model, you cannot add new models to it, nor can you remove a selected model.

Displaying a Combined Model

To change the colours used to display the model, double-click on the Legend object ( ). In the window that appears, click on the colour chip for each category and change it as described in Display Colours.

To set multiple categories to a single colour, use the Shift and Ctrl keys to select the colour chips you wish to change, then click on one of the colour chips. The colour changes you make will be made to all selected categories.

Creating a Static Copy of a Combined Model

Creating a static copy preserves a snapshot of a combined model that does not change, even when changes are made to the data on which the original model was dependent. This is a useful way of storing historical models and comparing models. Static copies can be exported from Leapfrog Works, as described in Combined Model Export below.

To create a static copy of a combined model, right-click on it in the project tree and select Static Copy. Enter a name for the copy of the model and click OK. The copy will be added to the Combined Models folder.

The static copy ( ) is made up of a Legend object ( ) and the output volumes ( ).

To view the date a static copy was created, right-click on it in the project tree and select Properties. The date the copy was created is in the General tab.

Combined Model Export

There are two options for exporting a combined model’s output volumes. These are:

- Export an output volume as a mesh. Right-click on it in the project tree and click Export. You will be prompted for a file name and location. See Exporting a Single Mesh.
- Export multiple output volumes. Right-click on the combined model in the project tree and select Export. See Exporting Multiple Meshes from Models.
Flow Models

Working with ModFlow and FEFLOW models is available as part of the Hydrogeology Solutions Kit. Contact Customer Support as described in Getting Support for more information about licensing the Hydrogeology Solutions Kit.

If the Flow Models folder appears in the project tree as Restricted, you will be able to display models in the scene and change how they are displayed, but you will not be able to make changes to the models themselves.

All tools for building flow models are accessed by right-clicking on the Flow Models folder and the objects in it. Imported objects and objects created while building a flow model are also stored in the Flow Models folder, and more complex functions can be carried out by right-clicking on individual objects.

ModFlow Models

These features are only available as part of the Hydrogeology Solutions Kit. See Flow Models for more information.

Once you have created a geological model, you can use it as the basis for a ModFlow model. You can also import existing ModFlow models and assign lithologies from a geological model.

Steps for creating a ModFlow model that can be exported and run outside Leapfrog Works are:

1. Create a geological model.
2. Create the ModFlow model using the geological model to set the grid spacing and layers.
3. Evaluate the new model against a geological model, if it wasn’t when it was created.
4. Edit the hydrological properties.
5. Export the ModFlow model to ModFlow or Groundwater Vistas.

Once the model has been processed outside of Leapfrog Works, the model can be imported into Leapfrog Works and visualised in the scene.

Creating ModFlow models in Leapfrog Works has the advantage that the resolution can be easily changed and the properties of the grid can be made to honour boundaries defined in geological models. See Creating a ModFlow Model.

See ModFlow Model Display for information on options for displaying models in the scene.

Models created in Leapfrog Works can be evaluated against a geological model when they are created. Models imported into Leapfrog Works or that were not evaluated when they were created can be evaluated as described in ModFlow Evaluations.

Once a model has been defined and evaluated against a geological model, hydrological properties can be assigned and the grid can be exported. See ModFlow Hydrological Properties and ModFlow Model Export.
Creating a ModFlow Model

This feature is only available as part of the Hydrogeology Solutions Kit. See Flow Models for more information.

To create a new ModFlow model, you must first have at least one geological model defined in the project. Once this has been defined, add the geological model to the scene. Right-click on the Flow Models folder and select New ModFlow Model. The New ModFlow Model window will be displayed, together with controls in the scene that will help you to set the grid extents:

![New ModFlow Model window](image)

The new ModFlow grid will be based on the geological model in the Gridding from setting. If you wish to use a geological model other than the one selected when the window is opened, select it from the list. The grid dimensions will be updated in the scene.

If the Evaluate Gridded Model box is ticked, the selected geological model will be evaluated on the new grid and set as the evaluation for export. If you do not wish to evaluate the geological model on the grid, untick the box. You will still be able to use the layers in the geological model to control the grid layers.

The Preserve Existing Grid Lines option is used when setting a non-uniform grid in the scene window. If you are going to define a non-uniform grid in this way, create the model with the Default Cell Size set to the smallest cell size you wish to use, then edit it as described in Editing a ModFlow Model.

The grid should be slightly smaller than the selected geological model. Any ModFlow cells that exist outside the geological model will be marked as inactive when the grid is exported to ModFlow.
Horizontal Grid Spacing

By default, the horizontal grid for the model is uniform, with the size of each cell set by the Default Cell Size value. You can change the horizontal grid by editing row and column spacings. When you click on Row Spacings or Column Spacings, the Edit Spacings window will be displayed:

Changes made in the Edit Spacings window will be reflected in the scene.

There are four ways to change the spacings:

- Click on a value to edit it.
- Divide a row or column. Click on a row or column, then on the Divide Row or Divide Column button. Two new rows or columns will appear in the list.
- Merge rows or columns. Hold down the Shift key while clicking on each item, then click on the Merge Rows or Merge Columns button. The selected items will be combined.
- Set uniform spacing on selected rows or columns. You will be prompted to enter the number of cells you wish to create from the selected rows or columns.
Click OK.

For example, here, the rows and columns away from the model boundary have been divided to provide more detail. The different spacings are reflected in the scene:

Use close spacing for steep gradients and increase or decrease spacing gradually.

**Vertical Grid Layering**

The vertical grid layers are based on the geological model selected in the New ModFlow Model window. Click on the Layers tab to view the layers:
Initially, there are two layers equally spaced between the topography and the geological model. Change the layers by clicking on Select Layer Guides button. The Layer Guides window will appear, showing the layers available in the selected geological model:

If the grid is required to follow a geological model lithology contact surface, move the layer into the Selected list and it will be honoured in the gridding process.

Click OK to return to the New ModFlow Model window, in which the selected layers will be displayed:

Click OK to create the new ModFlow grid, which will appear in the Flow Models folder. You can edit the model by expanding it in the project tree and double-clicking on the grid object (). See Editing a ModFlow Model.
Editing a ModFlow Model

This feature is only available as part of the Hydrogeology Solutions Kit. See Flow Models for more information.

Once you have created a ModFlow model, you can edit it by expanding the model in the project tree and double-clicking on the grid object (اظ). The Edit ModFlow Grid window will appear. You can edit the grid spacings as described in Creating a ModFlow Model, using the information in the scene window as a guide.

Another way to edit the grid is to use the controls in the scene to apply different cell size settings in different parts of the grid. For example, you may want to define a grid that has smaller cells in the centre than at the outer edges:

To set cell sizes in this way, it is best to start with a ModFlow model where the Default Cell Size is set to the smallest cell size you will use in the model.
For this example, we will start with a new grid with a **Default Cell Size** of 50. We will set the adjacent cell size to 100 and the cell size at the outer boundary to 200.

First, we need to reduce the area that uses the cell size of 50 by using the red handles in the scene:

The blue box in the scene is the geological model extents for the model used to define the ModFlow model and represents the unedited boundary of the ModFlow model.

Next, enter the cell size to use for the area adjacent to the 50.0 cells in the **New Cell Size** field. Then, drag the red handles to enlarge the grid. The centre part of the grid is still set to 50, while the new area is set to 100:

If the **Preserve Existing Grid Lines** option is enabled, grid lines for cells already defined will not be moved to account for new cells.
Enter the next cell size in the **New Cell Size** field and then use the handles to enlarge the grid again:

Click **OK** to update the grid.

For further information on working with the new model, see:

- ModFlow Model Display
- ModFlow Evaluations
- ModFlow Hydrological Properties
- Head Values and MT3D Concentrations
- Generating a Head Value Mesh
- ModFlow Model Export

**Importing a ModFlow Model**

This feature is only available as part of the Hydrogeology Solutions Kit. See Flow Models for more information.

Leapfrog Works imports .nam files and .mfi and .mfn variations of .nam files.

To import a ModFlow model, right-click on the Flow Models folder and select Import ModFlow Model. Leapfrog Works will ask you to specify the file location, and then will display the data in the file in the Import ModFlow Model window:

If the world origin is available, the Grid Position will be displayed but cannot be edited.
Click OK to import the grid. The new ModFlow model will appear in the project tree in the Flow Models folder. See ModFlow Model Display for information on displaying the model.

If the world origin was not available when the model was imported, you can change the Grid Position. To do this, expand the imported model in the project tree and double-click on its grid object (⊙).

To associate lithologies with the grid, see ModFlow Evaluations.

ModFlow Evaluations

This feature is only available as part of the Hydrogeology Solutions Kit. See Flow Models for more information.

When a ModFlow model is exported, the evaluated geological model is used to assign lithologies to the cells in the grid. If the grid has not been evaluated against a geological model, you must do so before you can edit the hydrological properties and before you can export the grid.

To evaluate a ModFlow model, expand the model in the project tree, then right-click on the grid object (⊙) and select Evaluations. Although you can evaluate an interpolant or distance function, they cannot be exported with the grid and are simply used for displaying the grid in Leapfrog Works.

A window will appear listing all objects in the project that can be used for an evaluation. Once you have selected one or more objects, click OK. You will then be able to select the evaluations from the view list, as described in Evaluations.

Assigning an Evaluation for Export

For ModFlow models created in Leapfrog Works, the evaluation used when creating the model will automatically be assigned as the evaluation for export. A hydrological properties table (□) will appear in the project tree as part of the model.

If the model was imported into Leapfrog Works or created without being evaluated against a geological model, you will need to manually set the evaluation for export. To do this:

- Evaluate the grid against one or more geological models, as described above.
- Right-click on the model (□ or □) in the project tree and select Set Evaluation for Export. The Select Evaluation window will appear showing all geological models evaluated on the grid. Select the required evaluation and click OK.

A hydrological properties table will be added to the model in the project tree. Edit hydrological properties by double-clicking on the table. See ModFlow Hydrological Properties.

Combined Evaluations

You can combine geological models and set the priority used for evaluation. This is useful when you have geological models available that describe different parts of the area of interest or if you have a refined geological model for part of the model. To combine geological models for
evaluation, select the required models in the Select Models To Evaluate window, then click on the Combined Evaluation button.

In this example, there are three geological models selected:

The GM and GM from contacts models describe similar areas, but GM has more detail. The GM larger model describes a larger area but with less detail. Tick the models to combine them and set their priority. Click OK to create the combined evaluation, then click OK in the Select Models To Evaluate window. The combined evaluation will be available from the view list and can be selected as the evaluation for export.

To delete a combined evaluation, click on the Delete Combined button in the Select Models To Evaluate window.

**ModFlow Hydrological Properties**

This feature is only available as part of the Hydrogeology Solutions Kit. See Flow Models for more information.

When a ModFlow model is evaluated against a geological model, a hydrological properties table is added to the model in the project tree. You can edit hydrological properties by double-clicking on the table. You can also open the table by right-clicking on the model in the project tree and selecting Edit Hydrological Properties.

If the model has been imported into Leapfrog Works and has not yet been evaluated against a geological model, you will be prompted to do so. Expand the model in the project tree, right-click on the grid object and select Evaluations. See ModFlow Evaluations for more information.

Hydrological properties are assigned to model blocks based on the position of the block’s centroid relative to the geological model used to evaluate the grid. The position of the centroid is calculated and Leapfrog Works then determines which lithology the centroid falls inside. The K values for the assigned lithology are assigned to the entire block; there is no averaging.
If more than one object has been evaluated on the grid, you can set hydrological properties separately for each evaluation. Select the required evaluation from the **Evaluation** list:

![Screen Shot](image)

However, the only hydrological properties information that will be exported is that set for the evaluation to be exported.

**Setting Hydrological Properties**

In the **Edit Modflow Parameters** window, you can enter the values for hydrological properties manually or you can use the values from an interpolant.

To enter values manually, click on a cell, then enter the value in the **Value** field:

![Screen Shot](image)

Press the Enter key to move down the columns.
To use the values from an interpolant, click the **Interpolant** button, then select an interpolant from the list. The interpolant that will be used for the selected value will be displayed in the field:

![Interpolant Selection](image)

To use the interpolant for all the values in the selected column, click the **All Lithologies** button. The window will be updated to show that the interpolant values will be used for that column:

![All Lithologies Selection](image)
Zone Numbers
When the model is exported, the zone numbers are used to indicate the assignment of lithologies to blocks and are written to the ModFlow zoned layer properties flow (*.lpf) file. In the Edit Modflow Parameters window, you can change the zone number for a lithology by clicking in a cell and entering a different zone number. If you reorder the zones in this way, zone number conflicts will be highlighted in red:

Zone numbers must be unique and you will not be able to close the window and save data if there are conflicts.

If you click on the Sort Zone Numbers button, the zone numbers will be ordered from top to bottom.

Zone numbers should not be sorted once a model has been exported as the new numbers will not be reflected in the exported model.

Click OK to update the grid.

ModFlow Model Display

If you do not have a licence for the Hydrogeology Solutions Kit, ModFlow models will appear in the project tree as Restricted. You can change how ModFlow models are displayed, but you will not be able to make changes to the models themselves.

In the project tree, ModFlow models are made up of a grid object, a Simulation Outputs folder and a hydrological properties table object. If there is no hydrological properties table, an evaluation has not yet been set for export. See ModFlow Evaluations for more information.

For ModFlow models created in and imported into Leapfrog Works, dragging the model itself into the scene will display the grid object. The different parts of the model can also be displayed.
Grid Display Options

Dragging a ModFlow model into the scene displays its grid object. Here, an imported model has been evaluated against a geological model and added to the scene:

The viewing options available are the flat colour option, the evaluated geological model and zone data imported with the model. Other inputs imported with a model will also be available from this list, and once the model has been evaluated against a geological model or interpolant, you can also display the model using the grid’s hydrological properties.

Grids are displayed as cells. When a geological model evaluation or lithological zone information is displayed, you can also display a legend for the grid.

When Show edges is enabled, the edges of the cells will be displayed.

The Show inactive blocks option displays inactive cells in grey:
To display a single layer, tick the One layer box in the shape properties panel, then select the layer to display.

Head values and MT3D concentrations can also be imported and displayed. See Head Values and MT3D Concentrations.

Viewing Block Information
When a ModFlow model is displayed in the scene, you can view information about the individual cells in the model by clicking on a block. The window that appears shows information about the selected block, including its centroid and the lithology assigned to the block from the evaluated geological model. Information from all geological models and interpolants the grid has been evaluated against will be displayed:

Head Values and MT3D Concentrations
This feature is only available as part of the Hydrogeology Solutions Kit. See Flow Models for more information.

Leapfrog Works imports the following output file formats:
- Head values files in *.hds, *.hhd and *.hed formats
- MT3D concentrations files in *.ucn format

To import head values or MT3D concentration files for a ModFlow model, right-click on the Simulation Outputs folder and select the required option. Navigate to select the file, then click Open.
The information will be added to the ModFlow grid, and you can then select the head values and MT3D concentrations in the shape list when you display the grid in the scene. If the output is time-dependent, a timestep slider will be available from the shape properties panel. Click and drag the slider or click along the timeline to view the different timesteps available:

Imported head values and MT3D concentrations are stored in the project tree in the Simulation Outputs folder:

To delete head values or MT3D concentrations, right-click on the object in the project tree and select Delete.

Once head values have been imported, you can generate a head value mesh. See Generating a Head Value Mesh.

Generating a Head Value Mesh

This feature is only available as part of the Hydrogeology Solutions Kit. See Flow Models for more information.

Once head values have been imported for a ModFlow model, you can generate a head value mesh. To do this, expand the Simulation Outputs folder. Right-click on the head values object and select Generate Head Value Mesh. The Generate Head Value Mesh window will appear, showing the layers in the model and the timesteps available. Select the layer of the model you wish to generate a head value mesh for, then choose the heads. Click OK to create the mesh, which will be saved to the Meshes folder.

ModFlow Model Export

This feature is only available as part of the Hydrogeology Solutions Kit. See Flow Models for more information.

Leapfrog Works has three options for exporting ModFlow grids:

- Export the grid as a ModFlow file.
- Export for Groundwater Vistas. Use this option the first time you export a grid for use in Groundwater Vistas.
• Export a Groundwater Vistas update. Use this option to generate a set of files that can be imported into Groundwater Vistas as an update.

The Groundwater Vistas options include a zoned layer properties flow (*.lpf) file that includes information about the zones in the grid.

**As a ModFlow File**

To export a grid as a ModFlow file for use in a package other than Groundwater Vistas, right-click on the grid in the project tree and select Export to ModFlow. You will be prompted to choose a File name and location. Select the options required, then click Save.

**For Groundwater Vistas**

To export a grid for use in Groundwater Vistas for the first time, right-click on the grid in the project tree and select Export to ModFlow for GWV. You will be prompted to choose a File name and location. Select the options required, then click Save.

If you have previously exported the grid to Groundwater Vistas and have made changes to the grid, use the Export to GWV Updates option.

**As a Groundwater Vistas Update**

If you have exported a grid to Groundwater Vistas but then make changes to the Leapfrog Works model, you can export the changes to the model. The set of files containing the changes can then be imported to Groundwater Vistas.

To export a Groundwater Vistas update, right-click on the grid in the project tree and select Export GWV Updates. The Update Groundwater Vistas window will appear listing the files that will be exported. Enter a Base file name to differentiate the original files from the updates. Click Export. The files will be saved in the specified directory.

**FEFLOW Models**

These features are only available as part of the Hydrogeology Solutions Kit. See Flow Models for more information.

In Leapfrog Works, creating a 3D FEFLOW model requires:

• A geological model that will be used to assign lithologies to the FEFLOW model’s blocks.
• A 2D grid that defines the block size, boundaries and surface features.

Steps for creating a 3D FEFLOW model that can be exported and run outside Leapfrog Works are:

1. Create a geological model.
2. Create and refine a 2D model in Leapfrog Works or import a FEFLOW model.
3. Create the 3D model from the 2D model or another 3D model in the project.
4. Evaluate the new 3D model against a geological model.
5. Edit the material types.

6. Export the 3D FEFLOW model.

Once the model has been processed outside of Leapfrog Works, a results file can be saved that can be imported into Leapfrog Works and visualised in the scene.

A 2D grid can be created in or imported into Leapfrog Works. A 3D grid can also be used, in which case the layer information is not used in creating the 3D grid. Creating the 2D grid in Leapfrog Works provides the most flexibility, as the block sizes can easily be changed, the boundaries modified and features added to provide finer resolution where there is more data available.

For information about creating 2D and 3D grids, see Creating a 2D FEFLOW Model and Creating a 3D FEFLOW Model.

You can also import FEFLOW problem files and result files, visualise them in Leapfrog Works and use them as the basis for new models. See Importing a FEFLOW Grid.

See FEFLOW Model Display for information on options for displaying FEFLOW models in the scene.

3D grids created in Leapfrog Works can be evaluated against a geological model when they are created. Grids imported into Leapfrog Works or that were not evaluated when they were created can be evaluated as described in FEFLOW Evaluations.

Once a model has been defined and evaluated against a geological model, material types can be assigned and the grid can be exported. See FEFLOW Material Types and FEFLOW Model Export.

**FEFLOW Model Display**

If you do not have a licence for the Hydrogeology Solutions Kit, FEFLOW models will appear in the project tree as Restricted. You can change how FEFLOW models are displayed, but you will not be able to make changes to the models themselves.

In the project tree, 3D FEFLOW models are made up of a grid object representing the finite elements, a nodes object and a material types table object. If there is no material types table, an evaluation has not yet been set for export. See FEFLOW Evaluations for more information.

A 2D FEFLOW grid is made up of a grid object and a nodes object. Here, three types of FEFLOW models are shown expanded in the project tree:

- Feflow 3D Simulation is a 3D model created in Leapfrog Works.
- Feflow 2D Simulation is a 2D model created in Leapfrog Works.
- Feflow Results is an imported 3D model (DAC file).
From the information in the project tree, we can see that:

- The 3D simulation created in Leapfrog Works (GM) uses the GM geological model to define the layers.
- The 2D simulation created in Leapfrog Works (GM) uses the GM geological model as a boundary and has had collar points added as a feature.
- The imported results model (GM) includes a number of simulation outputs.

For each type of FEFLOW model, dragging the model itself into the scene will display the grid (GM) object. The different parts of the model can also be displayed.
Displaying a 3D Model

Dragging a 3D simulation into the scene displays its grid object, which represents the finite elements. Here, a 3D model created in Leapfrog Works has been added to the scene:

For 3D models imported into Leapfrog Works, you can display the model using other information available for the grid, such as conductivity data. This is available from the view list.

Grids for 3D models are displayed as blocks. You can also display a legend for the grid when a geological model evaluation is displayed.

When Show edges is enabled, the edges of the blocks will be displayed.

To display a single layer, tick the One layer box in the shape properties panel, then select the layer to display.
You can display the nodes by adding the nodes (●) object to the scene. When a model with results is displayed, the simulation outputs can be displayed when the nodes are viewed in the scene. Here, the nodes for an imported results file have been added to the scene. The heads are displayed for a single layer:

When the results are time-dependent, a timestep slider will be available from the shape properties panel. Click and drag the slider or click along the timeline to view the different timesteps available.

Displaying a 2D Model
As with 3D models, dragging a 2D model into the scene displays its grid object. Here, a 2D model created in Leapfrog Works (●) has been added to the scene and viewed from above:

Also in the scene is a collar points object that shows collar points that have been added to the grid as a feature.

2D grids can be viewed as points or as blocks. As with imported 3D grids, an imported 2D grid can also be displayed using other information available for the grid.
Other viewing options are available for 2D grids created in Leapfrog Works. These are useful in refining a 2D grid and are described in Creating a 2D FEFLOW Model.

**Viewing Block Information**

When a FEFLOW model is displayed in the scene, you can view information about the individual blocks in the model by clicking on a block. The window that appears shows information about the selected block, including its centroid and the lithology assigned to the block from all evaluated geological models and interpolants:

Information from all geological models and interpolants the grid has been evaluated against will be displayed:

**Importing a FEFLOW Grid**

This feature is only available as part of the Hydrogeology Solutions Kit. See Flow Models for more information.

You can import 2D and 3D FEFLOW grids and use them as the basis for new models. Leapfrog Works imports two types of FEFLOW files:

- FEFLOW problem files (*.fem) in ASCII format. Importing these files results in a new 2D or 3D model with a grid and nodes.
- FEFLOW results files (*.dac). Importing these files results in a new 3D model with a grid, nodes and simulation outputs.

To import a FEFLOW grid or results file, right-click on the Flow Models folder and select one of the Import FEFLOW options. Leapfrog Works will ask you to specify the file location. Click Open to import the file.

The new FEFLOW grid will appear in the project tree under the Flow Models folder. To use the imported grid or results file as the basis for a new FEFLOW model, see Creating a 3D FEFLOW Model.

To associate lithologies with a 3D grid, see FEFLOW Material Types.
See FEFLOW Model Display for information about displaying the FEFLOW grid in the scene window.

Creating a 2D FEFLOW Model

This feature is only available as part of the Hydrogeology Solutions Kit. See Flow Models for more information.

A 2D FEFLOW model defines the block size, boundaries and surface features for a 3D FEFLOW model. Although existing 2D grids can be imported into Leapfrog Works and used for creating 3D models, creating the 2D grid in Leapfrog Works provides the most flexibility, as the block sizes can easily be changed, the boundaries modified and features added to provide finer resolution where there is more data available.

It is not necessary to create a geological model before creating a 2D grid. However, you will not be able to create a 3D grid until a geological model has been created. Therefore, it is a good idea to create the geological model first, and its dimensions can be used in defining the boundary of the 2D grid.

To create a 2D grid, right-click on the Flow Models folder and select New 2D FEFLOW Model. The New 2D FEFLOW Grid window will appear:

All settings can be changed once the grid has been created. It is, therefore, reasonable to accept the default settings and create the grid, then add it to the scene and begin refining it. Click OK to create the initial grid.

In the project tree, a 2D FEFLOW grid is made up of a grid object and a nodes object, as described in FEFLOW Model Display. Here, a newly-created grid with a rectangular boundary appears in the project tree:
Expand the grid in the project tree and double-click on the grid object ( Resume ) to open the Edit 2D FEFLOW Grid window. The Features tab will be displayed. When a grid is first created, this window will be empty, but once features have been added, you can enable them in this tab.

Click on the Boundary tab to modify the boundary:

![Boundary Options](image)

Click the Apply button to view the effect of changes made without closing this window.

**Boundary Options**

When setting the Boundary, you can set a rectangular boundary defined by the From rectangle settings. You can use the extents of any other object in the project by selecting from the Enclose Object list, but the grid boundary will always be a rectangle.

To define a non-rectangular boundary, use the From another object options and select from the list of objects available in the project. This is useful if, for example, you wish to define a grid using the boundary of a geological model.

The Simplify boundary option reduces the number of points along the boundary. Reducing the Tolerance value increases the number of points along the boundary. The two settings together let you define a basic boundary with elements that are roughly uniform in size, set by the value of Element size. Here, a grid has been created from a geological model with the Simplify boundary option enabled:

![Boundary Options](image)
Disabling the **Simplify boundary** option results in more detail around the edges of the grid:

![Grid with simplified boundary](image)

**Element Size**

The **Element size** setting determines the basic size of the triangles that make up the grid, although the size will vary according to features applied to the grid and the **Feature vertex snapping distance**. The size will also vary if the **Simplify boundary** option is unticked, in which case the **Element size** setting is the maximum size of the triangles.

The **Feature vertex snapping distance** is automatically set to 1 percent of the **Element size**. To use a smaller snapping distance, untick the **Auto** box and set the value required. You cannot set a value that is larger than 1 percent of the **Element size**.

The effects of the **Feature vertex snapping distance** do not become apparent until features have been added to the grid.

**Adding Features to the Grid**

To add features to the grid, right-click on the grid in the project tree and select **New Feature**. The **New FEFLOW Feature** window will appear:

![New FEFLOW Feature window](image)

You can add **Point**, **Line** and **Polygon** features, and the **Feature Object** list will display all suitable objects available in the project. Ticking the **Simplify Feature** option will reduce the number of points used.
Adding Features to the Grid | 450

Click **OK** to add the feature, which will appear in the project tree under the FEFLOW grid object:

You can edit the feature by double-clicking on it or by right-clicking and selecting **Open**. However, the feature has not yet been applied to the grid. To enable the feature, double-click on the grid to open the **Edit 2D FEFLOW Grid** window. Tick the box to enable the feature, then adjust the number of **Refinement Steps**:

More **Refinement Steps** will produce more detail near the feature.

Click **Apply** or **OK** to view the effect the feature and its settings have on the grid.

If you want to modify a feature without having to reprocess the grid, untick it in the **Features** tab. If you want to delete a feature, right-click on it in the project tree and select **Delete**.

The images below show a grid displayed with collar points (in red) to demonstrate the effects of no features and collars applied with different refinement steps:

<table>
<thead>
<tr>
<th>No features</th>
<th>Collars with 2 refinement steps</th>
<th>Collars with 10 refinement steps</th>
</tr>
</thead>
</table>
To view all features added to a grid, right-click on the grid and select **View Snapped Features**. A **Snapped Features** object will appear in the shape list that represents all objects used to add features to the grid:

Here, four snapped objects appear in the scene: the three features listed in the **Features** tab and the grid’s boundary.

See [Creating a 3D FEFLOW Model](#) for information on using the 2D grid as the basis for a 3D model.

**Creating a 3D FEFLOW Model**

This feature is only available as part of the Hydrogeology Solutions Kit. See [Flow Models](#) for more information.
To create a new 3D FEFLOW model, you must first create or import a 2D FEFLOW grid as described in Creating a 2D FEFLOW Model and Importing a FEFLOW Grid.

Once you have created or imported a 2D FEFLOW grid, right-click on the Flow Models folder and select New FEFLOW Model. The Extrude 3D FEFLOW Grid window will appear:

The dimensions and resolution of the grid are set by the 2D or 3D grid selected from the FEFLOW Grid list. See Creating a 2D FEFLOW Model for information on creating and refining a 2D grid that can be used as the basis for a 3D grid.

The Gridding from setting determines the geological model used for layer guides. Ticking the Evaluate Gridded Model box will evaluate the new 3D model against the selected geological model and set it as the evaluation for export. See FEFLOW Evaluations for more information. If you do not wish to evaluate the geological model on the grid, untick the box. You will still be able to use the layers in the geological model to control the grid layers.
The FEFLOW grid is initially made up of two layers equally spaced between the topography and the geological model, with the minimum thickness of each layer determined by the **Minimum Thickness** setting. You can add layers to the grid by clicking on the **Select Layer Guides** button and then selecting from the layers available in the geological model:

If the grid is required to follow a geological model lithology contact surface, move the layer into the **Selected** list and it will be honoured in the gridding process.

Click **OK** to return to the **Extrude 3D FEFLOW Grid** window. The selected layers will be displayed:

Click **OK** to generate the new FEFLOW grid, which will appear in the project tree under the **Flow Models** folder.

Once the model has been created, you can edit it by expanding the model in the project tree and double-clicking on its grid object. The layer guides selected, the number defined and the **Minimum Thickness** can be modified, but the FEFLOW grid on which the model is based and the geological model used for gridding cannot be changed.
The boundaries of the selected geological model must be larger than the FEFLOW grid used as the basis for the new model. If this is not the case, you can change the geological model’s extents so that they enclose the FEFLOW grid.

For further information on working with the new grid, see:
- FEFLOW Model Display
- FEFLOW Evaluations
- FEFLOW Material Types
- FEFLOW Model Export

FEFLOW Evaluations

This feature is only available as part of the Hydrogeology Solutions Kit. See Flow Models for more information.

When a 3D FEFLOW model is exported, the evaluated geological model is used to assign lithologies to the blocks in the grid. If the grid has not been evaluated against a geological model, you must do so before you can edit the material types and before you can export the grid.

To evaluate a FEFLOW grid, expand the model in the project tree. Right-click on the grid object (ería) and select Evaluations. Although you can evaluate an interpolant or distance function, they cannot be exported with the grid and are simply used for displaying the grid in Leapfrog Works.

A window will appear listing all objects in the project that can be used for an evaluation. Once you have selected one or more objects, click OK. You will then be able to select the evaluations from the view list, as described in Evaluations.

Assigning an Evaluation for Export

For 3D grids created in Leapfrog Works, the evaluation used when creating the grid will automatically be assigned as the evaluation for export. A material types table (ssé) will appear in the project tree as part of the 3D grid.

If the grid was imported into Leapfrog Works or created without being evaluated against a geological model, you will need to manually set the evaluation for export. To do this:

- Evaluate the grid against one or more geological models, as described above.
- Right-click on the model (éra) or (ší) in the project tree and select Set Evaluation for Export. The Select Evaluation window will appear showing all geological models evaluated on the grid. Select the required evaluation and click OK.

A material types table will be added to the FEFLOW grid in the project tree. Edit material types by double-clicking on the table. See FEFLOW Material Types.
Combined Evaluations
You can combine geological models and set the priority used for evaluation. This is useful when you have geological models available that describe different parts of the area of interest or if you have a refined geological model for part of the model. To combine geological models for evaluation, select the required models in the Select Models To Evaluate window, then click on the Combined Evaluation button.

In this example, there are three geological models selected:
The GM and GM from contacts models describe similar areas, but GM has more detail. The GM larger model describes a larger area but with less detail. Tick the models to combine them and set their priority. Click OK to create the combined evaluation, then click OK in the Select Models To Evaluate window. The combined evaluation will be available from the view list and can be selected as the evaluation for export.

To delete a combined evaluation, click on the Delete Combined button in the Select Models To Evaluate window.

FEFLOW Material Types
This feature is only available as part of the Hydrogeology Solutions Kit. See Flow Models for more information.

When a FEFLOW model is first evaluated against a geological model, a material types table is added to the FEFLOW grid in the project tree. You can edit material types by double-clicking on the table. You can also open the table by right-clicking on the grid and selecting Edit Material Types.

If the grid has been imported into Leapfrog Works and has not yet been evaluated against a geological model, you will be prompted to do so. Expand the model in the project tree, right-click on the grid object and select Evaluate Geological Model. See FEFLOW Evaluations for more information.
If more than one object has been evaluated on the grid, you can set material types separately for each evaluation. Select the required evaluation from the **Evaluation** list:

![Material types selection](image)

However, the only material types information that will be exported is that set for the evaluation to be exported.

In the **Edit Material Types** window, you can enter the values for material types manually or you can use the values from an interpolant.

To enter values manually, click on a cell, then enter the value in the **Value** field:

![Material value entry](image)

Press the Enter key to move down the columns.
To use the values from an interpolant, click the **Interpolant** button, then select an interpolant from the list. The interpolant that will be used for the selected value will be displayed in the field:

![Interpolant selection](image)

To use the interpolant for all the values in the selected column, click the **All Lithologies** button. The window will be updated to show that the interpolant values will be used for that column:

![All Lithologies selection](image)

Click **OK** to update the grid.

**FEFLOW Model Export**

This feature is only available as part of the Hydrogeology Solutions Kit. See [Flow Models](#) for more information.

To export a 3D FEFLOW model as an ASCII format FEFLOW file (*.fem), right-click on the grid in the project tree and select **Export To FEFLOW**. You will be prompted to choose a **File name** and location. Select the options required, then click **Save**.

2D FEFLOW grids cannot be exported.
Presentation

Leapfrog Works has a number of tools for displaying and presenting data for use in reports and presentations.

- Create and export cross sections, fence sections and serial sections.
- Create and export contours.
- Render and save images for use outside of Leapfrog Works.
- Save scenes that demonstrate different aspects of the model and the model-building process. These scenes can then be saved as a movie or as a scene file that can be opened in Leapfrog Viewer.

See Visualising Data for information about the tools available in Leapfrog Works for changing how data is displayed.
Sections

There are four types of sections in Leapfrog Works:

- A typical cross section is a vertical plane with an image or geologic cross section applied to it. In Leapfrog Works, this type of cross section can be created directly in the scene, from the slicer or from an imported image.
- A fence section deviates. In Leapfrog Works, a fence section can be created from a polyline drawn in the scene or from any line object in the project.
- A serial section is a series of typical cross sections taken at an offset from a single base section.
- An alignment serial section uses an imported alignment to create a series of sections along the alignment.

Evaluating Sections

Sections can be evaluated against different objects in the project, as described in Evaluations. All sections can be evaluated against:

- Geological models
- Numeric models
- Distance functions
- Surfaces
- Combined models

When evaluating objects on sections, you can limit the evaluation to the section extents. To do this, enable the Clip evaluations to section extents option when selecting what objects you are evaluating.

Flow models can be evaluated on cross sections but not on serial sections and fence sections. Objects a section is evaluated on can be included when the section is exported.

Exporting Sections

There are two options available for exporting sections: Export in DXF Format and Export Section Layouts.

Export in DXF Format

Exporting a section as a DXF file (*.dxf) exports a series of DXF lines created from the intersection of the evaluation volumes and the section plane. The lines generated from each volume are saved as separate layers in the file.

For serial sections, the section will be exported in a single file with a collection of DXF lines based on intersections between the selected evaluation and the section planes.
To export a section in DXF format, right-click on it in the project tree and select **Export**. You will be prompted to select an evaluation to export with the section. Enter a filename and location, then click **Save**.

**Export Section Layouts**

Another way to export a section is to create a section layout and then export it as a PDF file (*.pdf), Scalable Vector Graphics file (*.svg), PNG image (*.png) or GeoTIFF (*.tiff, *.tif). This option is more flexible than exporting the section as a DXF file as you have more control over the section layout. You can customise the page layout and include multiple evaluations and annotations. For typical cross sections and serial sections, you can also display boreholes and planned boreholes.

For serial sections and alignment serial sections, you can batch export multiple section layouts. All selected sections can be exported as a single PDF or individually in PDF file (*.pdf), Scalable Vector Graphics file (*.svg), PNG image (*.png) or GeoTIFF (*.tiff, *.tif) formats. When section layouts are exported individually, all outputs can be combined into a zip archive. To do this, right-click on the section and select **Batch Export Layouts**.

See [Section Layouts](#) for more information.

**Creating Cross Sections**

To create a cross section in the scene, add a model to the scene. Next, right-click on the **Cross Sections and Contours** folder and select **New Cross Section**. The **New Cross Section** window will appear, together with a section plane and controls in the scene that let you adjust the position of the section plane:

If the slicer is already in the scene when you select **New Cross Section**, the position of the slicer will be used to define the initial orientation of the section. This is an effective way of creating a section from the slicer: add the model to the scene, draw a slice and then create a cross section.

The front (F) and back (B) of the section plane is indicated in the scene. To swap the front and back, click the **Swap Front** button ( ).

Use the handles in the scene to position the section plane. The handles work in the same manner as the moving plane controls, as described in [The Moving Plane](#).
Two buttons in the **New Cross Section** window let you create a cross section that is aligned north-to-south (north-south) or east-to-west (east-west):

![New Cross Section window](image)

The other two buttons are active when the slicer is in the scene. Clicking the **Set section to slicer** button (set) creates a cross section from the position of the slicer in the scene. When the **Lock section to slicer** button (lock) is enabled, moving the position of the slicer will update the position of the cross section in the **New Cross Section** window.

Once the section plane is positioned as required, click **OK** to create the new cross section, which will appear in the **Cross Sections and Contours** folder. Display it by clearing the scene, then adding the cross section to the scene.

Cross sections can be evaluated against geological models, interpolants, distance functions and surfaces in the project, as described in [Evaluations](#). Objects a cross section or fence section is evaluated on can be included when the section is exported.

### Importing Cross Sections

To import an image and use it to create a new cross section, right-click on the **Cross Sections and Contours** folder and select **New Cross Section From Image**. Leapfrog Works supports the following file formats for creating cross sections:

- PNG files (*.png)
- JPEG files (*.jpg, *.jpeg)
- TIFF and GeoTIFF files (*.tiff, *.tif)
- Windows Bitmap files (*.bmp)
- Graphics Interchange Format files (*.gif)

Select an image, then click **Open**. The **Import Section Image** window will be displayed.

Cropping the image to only the area of interest will reduce video RAM usage and may improve graphics performance. To crop the image, click on the **Crop Image** button (crop) at the top of the window, then drag around the part of the image you wish to use. Click on the **Remove Crop** button (cancel) to clear the cropping.

If the image is georeferenced and you are satisfied that this information is correct, click **Import**. The new cross section will be created and added to the **Cross Sections and Contours** folder.

If the image does not contain georeferencing information, you will need to add it manually by adding reference markers and then entering coordinates. First, tick the box for any **Section**
**Type** options as these constrain the markers that need to be set. For example, selecting **East facing section** means you will only need to enter the **East (X)** coordinates once.

To add coordinates to the image, click on a marker and move it to the required location. Then enter the coordinates for the marker:

The **Image (X)** and **Image (Y)** fields give you fine control over the location of the marker on the image.

If the image is georeferenced and you wish to discard the information, tick the **Override georeference data from image** box and edit the markers.

Once the coordinates for each marker have been set, click **Import**. The new cross section will be created and added to the **Cross Sections and Contours** folder. Display it by dragging it into the scene or by right-clicking on the cross section and selecting **View Object**.

Once you have georeferenced an image, you can export it as a GeoTIFF. To do this, right-click on it in the project tree and select **Export**. You will be prompted for a filename and location. Click **Save**.

Once you have created a cross section, you can edit it or use it to evaluate geological models, interpolants, distance functions and surfaces. See **Evaluations**.
Fence Sections
You can draw a polyline or use any existing line object in the project to create a cross section that deviates. To do this, right-click on the Cross Sections and Contours folder and select New Fence Section. The New Fence Section window will be displayed:

You can draw the polyline in the scene directly by selecting the New Polyline option. You can also use any polyline in the project by selecting the Existing Polyline option.

Only GIS lines, polylines imported into Leapfrog Works or polylines created using the straight line drawing tool can be used to create fence sections.

Click OK to create the fence section. If you chose to create a New Polyline, the drawing controls will appear in the scene and you can begin drawing, as described in Drawing in the Scene.

The fence section will appear under the Cross Sections and Contours folder and you can edit it by double-clicking on it. You can also use it to evaluate geological models, interpolants, distance functions and surfaces, as described in Evaluations.

If you create a section layout for a fence section, you can include multiple evaluations and annotations on the section layout. See Section Layouts.

Serial Sections
This topic describes the process of creating a serial section, which is a series of cross sections taken at an offset from a single base section. The topic is divided into:

- Setting the Base Section
- Setting the Offset Sections
- The Serial Section in the Project Tree
- Displaying a Serial Section
- Exporting a Serial Section
To create a serial section, add a model to the scene. Next, right-click on the **Cross Sections and Contours** folder and select **New Serial Section**. The **New Serial Section** window will appear and planes representing the base section and the offset sections will be added to the scene:

If the slicer is already in the scene when you select **New Serial Section**, the position of the slicer will be used to define the initial orientation of the base section.

### Setting the Base Section

The handles in the scene control the position of the base section and work in the same manner as the moving plane controls (see [The Moving Plane](#)).

The front (F) and back (B) of the base section plane are indicated in the scene. To swap the front and back, click the **Swap Front** button ( ).
Two buttons in the **New Serial Section** window let you create a base section that is aligned north-to-south (\(\uparrow\)) or east-to-west (\(\rightarrow\)). The other two buttons are active when the slicer is in the scene. Clicking the **Set section to slicer** button (\(\%\)) creates a cross section from the position of the slicer in the scene. When the **Lock section to slicer** button (\(\#\)) is enabled, moving the position of the slicer will update the position of the cross section in the **New Serial Section** window.

**Setting the Offset Sections**

The number of offset sections is determined by the value of the **Spacing** setting and the **Front** and **Back Extents**:

![New Serial Section window](image)

You can change the number of offset sections by:

- Changing the **Spacing** setting. The number of offset sections will be recalculated and updated in the scene.
- Changing the **Front** or **Back** settings. For example, increasing the **Front** setting adds an offset section on the front of the base section, increasing the extents by the value of **Spacing**.
- Changing the object used to define the extents. Select an object from the **Enclose Object** list. The base section will be moved to the centre of the selected object.
The Serial Section in the Project Tree

Click **OK** to create the section. In the project tree, the serial section includes the individual cross sections:

![Project Tree](image)

The serial section can be evaluated against geological models, interpolants, distance functions and surfaces in the project, as described in [Evaluations](#).

### Displaying a Serial Section

When you display a serial section in the scene, you can add the slicer to the scene and use it to move easily between the sections in the stack. To do this, click on the slicer in the shape list, then select the base section from the **Set to** list:

![Slicer](image)

Next, set the **Step size** to the **Spacing** setting used to create the section. You can then use the < and > keys to view each individual cross section.

### Exporting a Serial Section

The options for exporting serial sections differ for the section itself and the offset sections:

- A serial section cannot be used to create a section layout. When exported as a DXF file, the serial section will be exported in a single file with a collection of DXF lines based on
intersections between the selected evaluation and the section planes.

- The offset sections that make up a serial section can be exported in DXF format or as a section layout. See Exporting Sections and Section Layouts for more information.

### Alignment Serial Sections

An alignment serial section can be created using an alignment imported into the Designs folder, a polyline or a GIS line. When creating an alignment serial section from a polyline, you can use an existing polyline or draw a new one.

This topic describes the process of creating and working with an alignment serial section. It is divided into:

- Creating an Alignment Serial Section
  - Using an Existing Line
  - Using a New Polyline
- Displaying an Alignment Serial Section
- Exporting an Alignment Serial Section

### Creating an Alignment Serial Section

To create an alignment serial section, right-click on the Cross Sections and Contours folder and select New Alignment Serial Section. The New Alignment Serial Section window will appear. Select whether you will use an existing line or create a new one.
Using an Existing Line

If you select an existing line, planes representing the base section and the offset sections will be added to the scene:

Once you have created an alignment serial section, you can change all settings except the line used.

The Base Section parameters determine the size of the sections and the Offset Section parameters determine how the sections are distributed along the selected line.

- Swap the start and end points of the selected line by clicking the Swap Start button.
- Generate sections along only part of the line by selecting Line Section, then changing the Start Chainage and End Chainage.

You can set a Start Chainage value that will be assigned to the first point of the line being used for the alignment.

All changes you make in the New Alignment Serial Section window will be displayed in the scene.

Click OK to create the section.

Using a New Polyline

If you have chosen to create a New Polyline, set the Base Section and the Offset Section parameters, then click OK. Drawing controls will appear in the scene and you can begin drawing, as described in Drawing in the Scene.
Once you have finished drawing the polyline, click the Save button. The offset sections will be generated and will appear in the project tree. Double-click on the section in the project tree to edit its settings.

**The Alignment Serial Section in the Project Tree**

In the project tree, the alignment serial section includes the individual offset sections and the line used to create it:

The serial section can be evaluated against geological models, numeric models and surfaces in the project, as described in Evaluations.

**Displaying an Alignment Serial Section**

Add the top-level section to the scene to view all the offset sections. You can also view individual offset sections.

If a master section layout has been created for an alignment serial section, dragging the master section layout into the scene displays all sections that use that layout.

**Exporting an Alignment Serial Section**

The options for exporting alignment serial sections differ for the section itself and the offset sections:

- An alignment serial section can be exported as a DXF file. This exports a single file with a collection of DXF lines based on intersections between the selected evaluation and the section planes.
- The offset sections that make up an alignment serial section can be exported in DXF format or as a section layout. See Exporting Sections and Section Layouts for more information.
Section Layouts

With the **Section Layout Editor**, you can create a section layout for an existing section and then export the section. You can customise the section layout by:

- Adding models and surfaces the section has been evaluated against
- Adding boreholes and planned boreholes
- Changing the page size, orientation and margins
- Adding titles, a scale bar, legends, annotations and images, such as a standard form or logo

The appearance of all objects can be customised without changing how objects from the project tree are displayed in the scene.

This topic describes how to work with section layouts. It is divided into:

- **Creating New Section Layouts**
- **Creating Master Section Layouts** (alignment serial sections only)
- **The Section Layout Editor**
  - **Object Names and Colours**
  - **Styling Layout Objects**
  - **Setting Up the Page**
  - **Organising the Section**
  - **Organising the Legend Group**
  - **Adding and Organising Annotations**
- **Displaying Section Layouts**
- **Exporting Section Layouts**
- **Batch Exporting Section Layouts**
- **Copying Section Layouts**
Once you have created a section but before you start creating the section layout, take the following steps.

1. Check the section’s extents and orientation.

The initial dimensions of the section on the page are determined by the size of the section plane, and its orientation on the page is determined by the front (F) and back (B) faces of the section plane. Here, the front and back faces of the section have been swapped, which results in the section displayed on the page being flipped:

2. Check that the section has been evaluated against objects you wish to display on the page.

To do this, right-click on the section in the project tree and select **Evaluations** or **Evaluate Surface**.

3. Add planned boreholes to the project.

Planned boreholes can be displayed on the section, but these must be defined before you start the process of laying out the section.
Creating New Section Layouts

To create a new section layout, right-click on an existing section in the project tree and select **New Section Layout**. The **New Section Layout** window will appear, together with the **Section Layout Editor**.

The settings in the **New Section Layout** window determine the basic section layout. Each setting is described below. All settings in the **New Section Layout** window can be changed once the layout has been created.

Changing how objects are displayed on the section page does not change those objects in the project.

As you add objects to the section, the preview in the **Section Layout Editor** window will be updated.

Click **OK** to close the **New Section Layout** window. You can then make further changes to the page layout in the **Section Layout Editor**. See *The Section Layout Editor*.

**Scale**

The **Scale** settings determine the scale used to display the section on the page. As you change the scale settings, the layout of the section on the page will be updated in the preview. If you want a specific page size, select **Fit to Page** to set a scale that best fits the page width. You will be able to change the page margins once you have closed the **New Section Layout** window.
**Page Properties**

The Page Properties settings determine the page size and orientation. If you wish to use a specific Scale, select the Orientation required, then click Fit to Section to choose the best page size.

**Evaluations**

For Evaluations, select from the models and surfaces the section has been evaluated against. When you select a model or surface, it will be added to the preview. Note that when you add a model to the page, a legend for the model is also added.

If you wish to use the extents from a model evaluation, select only that model and then select the Section Extents option below. Once you have closed this window, you will be able to add further models using the section layout editor.

**Extents**

For Extents, choose whether to use the Section Extents or Evaluation Extents.

**Creating Master Section Layouts**

For alignment serial sections, you can create a master section layout and apply this master layout to all the child sections of an alignment section. When the master layout is updated, changes will be reflected wherever it has been applied. To create the master section layout, right-click on the top-level section and select New Master Section Layout.

The master section layout editor works the same way as the standard layout editor. When you save the layout, it will be stored as part of the alignment section, separately from the child sections and evaluations. To copy the master layout to child sections, right-click on it and select Copy Master Layout To. The master layout will be applied to the selected child sections.

You can edit the child layouts that are linked to the master layout, but doing so will break the link to the master layout; the child layout will no longer be updated when changes to the master layout are made.
The Section Layout Editor

In Section Layout Editor, the Layout Tree shows the different layers that can be added to the page. The different parts of the Layout Tree as they relate to the page preview are shown below:

For more information about working with the different parts of the section layout, see:

- Setting Up the Page
- Organising the Section
- Organising the Legend Group
- Adding and Organising Annotations
Click on an object in the page preview to move or resize it. This will also select the object in the Layout Tree and you can see what properties can be changed. For example, in the preview, click on the Title to view its styling options:

The Section object controls all the models and surfaces displayed on the section:
Models and surfaces selected in the **New Section Layout** window are automatically added to the page preview. Further objects can be added by right-clicking on **Models**, **Boreholes** or **Surfaces**. When models are surfaces are added to the layout, entries are automatically made in the **Legend Group**.

**Object Names and Colours**

The names and colours of objects in the layout are linked to their parent objects in the project tree. You can override them by selecting the object in the **Layout Tree**, then ticking the **Edit** box:

If **Edit** is disabled for an object’s text or colour and changes are made to the parent object while the **Section Layout Editor** window is open, the changes will not be reflected in the section layout until it is next opened.

If **Edit** is enabled for an object’s text or colour, then that property will not change when the parent object’s colour or title are changed.

**Styling Layout Objects**

All layout objects are styled by clicking on them in the **Layout Tree**, then adjusting their appearance in the properties panel.
Text displayed in the section layout is controlled by a style sheet that can be accessed whenever you are editing a text object. For example, clicking on Edit Styles for the Title opens the list of Text Styles with the Title selected, but also allows you to change the appearance of styles used for other text objects visible in the preview:
Line, border and swatch properties are also changed in the properties panel. Swatches for output volumes can be displayed using a hatched fill, which is enabled by clicking on the output volume in the project tree, then changing its properties:
The styling of objects in the **Layout Tree** controls how they appear in their associated legend. The **Legend Group** object controls the position and size of the legend, but not the colour, line style and fill used to display each object. For example, the appearance of the volume <0.5 in the interpolant is controlled from the **Models** object (left). Whether or not the legend is visible on the page and how it is displayed is controlled from the **Legend Group** object (right):

When a model or other object is added to the section, a legend for that object is added to the **Legend Group**.

Some objects, such as models, boreholes and surfaces, occupy the same space on the page. These objects can be organised into layers, and opacity settings changed to emphasise relevant information. To change the order of objects on the page, right-click on them and select how you wish to organise the layers:
To change the opacity of an object, click on it, then adjust the object’s **Opacity** using the slider:

### Setting Up the Page

**Page Properties** are set in the New Section Layout window, but these can be changed in the Layout Tree. Click on the Page object to change the Page Size, Orientation and Margins:

If you wish to use a specific **Scale**, select the **Orientation** required, then click **Fit to Section** to choose the best page size.

### Organising the Section

The **Section** object controls the appearance of the section and the objects in the project that are displayed on the section. The properties for the **Section** object itself control the size of the section on the page and how the axes are displayed. Any changes made in these tabs are displayed in the preview so you can experiment with these settings.

- The **Section** tab includes the **Scale** settings from the New Section Layout window.
- The **Extents** tab includes the settings from the New Section Layout window and additional options for displaying **Additional sky** and end point labels.
The settings in the **X-Axis** and **Y-Axis** tabs determine how the axes are displayed. By default, the axes are displayed only on the left-hand side and along the bottom of the section. To display axes along the right-hand side and above the section, tick the **Secondary** option.

The other objects that are part of the **Section** object are used to add models and surfaces that are displayed on the section and to customise how they are displayed. For cross sections and serial sections, you can also add boreholes and planned boreholes.

Changing how objects are displayed on the section layout does not change those objects in the project.

### Adding and Styling Models

If you selected models and surfaces in the **New Section Layout** window, these are automatically added to the **Models** and **Surfaces** objects in the **Layout Tree**. To add more models, right-click on the **Models** object and select **Add Model**. The models the section has been evaluated on will be listed. Select those required and click **OK**. The new models will be added to the **Models** object and legend items added to the **Legend Group**.

Sections can be evaluated against different objects in the project, as described in **Evaluations**. All sections can be evaluated against:

- Geological models
- Numeric models
- Distance functions
- Surfaces
- Combined models

When evaluating objects on sections, you can limit the evaluation to the section extents. To do this, enable the **Clip evaluations to section extents** option when selecting what objects you are evaluating.

Flow models can be evaluated on cross sections but not on serial sections and fence sections.

If you selected a geological model with a fault system, the faults will automatically be added to the section and to the **Legend Group**. Change a fault system’s properties by expanding the geological model in the **Layout Tree** and clicking on the **Fault System** and its faults.

When you display multiple models on the section:

- Use the **Opacity** setting for each model to expose and emphasise information.
- Right-click on the models to move them up or down in the layer hierarchy.
- Expand each model in the **Layout Tree** to change the **Fill** and **Hatch** for each output volume to make some volumes more apparent.
- Hide some of the **Output Volumes**.
A single line style is used to display a model’s output volumes. There is, however, a **Highlight** option that can be enabled to make a volume of interest stand out from the other volumes:

Click **Options** to change the colours used to display the model:

- For category evaluations, you can change what categories are visible and the colours used to display them.
For numeric evaluations, you can filter values and use a different colourmap.

If a flow model is too big for the section layout, changing the section extents or the section layout extents will effectively “crop” the flow model and make it small enough to display on the section layout. There are two ways to do this:

- Change the section layout extents by clicking on Section in the Layout Tree, then clicking on the Extents tab. If Extents is set to Evaluation Extents, change it to Section Extents.
- Change the size of the section by double-clicking on it in the project tree and then editing its dimensions in the scene.

Adding and Styling Boreholes and Planned Boreholes

Boreholes and planned boreholes can be added to the cross section. Up to three columns of data can be displayed, and numeric data can be displayed as a graph.

To add boreholes to the section, right-click on the Boreholes object and select either Add Boreholes or Add Planned Boreholes.

For adding boreholes, you will be prompted to select the interval table to display.

For both boreholes and planned boreholes, you can filter the boreholes based on a minimum distance from the section plane:

This is the minimum distance to any point on each borehole trace.

If you tick the Clip geometry to filter distance option, only parts of the borehole within the filter distance will be included in the section layout. Select the required boreholes and click OK.

When boreholes and planned boreholes are added to a curved section, a projection is made based on the locations of neighbouring segments of the section, using the bisectors of the angles between each segment and its neighbour. These determine the projection point of origin for a given segment of the section. When boreholes are filtered by the distance to the section plane, the distance is measured at 90 degrees from the section. Some boreholes may report a distance that is greater than the specified minimum distance; if this is the case, it is because the evaluation distance is relative to the projection origin.
On the inside of a tight corner, a single borehole may be projected multiple times onto the section. If this is the case, the multiple instances of the borehole will appear in the boreholes list and you can turn individual instances off, if required.

When a fence section is updated, borehole evaluations are updated. If there are multiple instances of a borehole evaluation, how they appear on the section may change when the section is updated:

- If all instances of a borehole evaluation have been enabled, then all remain enabled when the section is updated.
- If all instances of a borehole evaluation have been disabled, then all will remain disabled when the section is updated.
- If only some instances of a borehole evaluation have been enabled, then all instances will be enabled when the section is updated.

When a section layout is copied to another section from a fence section, borehole evaluations will not be copied with the section layout.

How boreholes are displayed is controlled by the **Colourings** settings in the **Lines** tab:
Click the **Options** button for a column to filter values or display data on the boreholes:

For columns of numeric data, you can display data as a bar graph or line graph. These options are available in the **Display style** tab. Here, data is displayed as a bar graph:
Select a **Max length** that means that displayed data does not interfere with other boreholes or data displayed on the section layout. This is especially useful when two graphs are displayed:

![Edit Colouring Right](image)

If you only want to plot a limited range of data, tick the **Axis limit** box and set the required range.

Displaying data with the logarithmic scale enabled may enhance differences in the values, and negative values can be scaled.

The bar and line graph options are not available for the centre of the borehole, although the solid option can be used.

**Adding and Styling Surfaces**

To add a surface to the section, right-click on the **Surfaces** object and select **Add Surface**. The surfaces the section has been evaluated on will be listed. Select those required and click **OK**.

The options for styling surfaces are the same as for lines. A surface can be displayed in the legend, if required.
Organising the Legend Group

The **Legend Group** controls how the legend is displayed on the page.

When you add a model, surface or borehole object to the section, a legend for that object will be added to the **Legend Group**. For example, here, legends have been added for an interpolant, the surfaces and borehole data objects:

Note that:

- The **Surfaces** that appear on the section have been added to a single legend.
- Because the boreholes displayed on the section use **Left** and **Right Colourings**, a legend has been added for each, a lithology legend and a numeric data legend.
Changing the Legend Group Layout

Select the Legend Group itself to change its layout. These settings apply to the Legend Group as a whole. **Columns** can be laid out vertically or horizontally:

You can also change the swatch size and gradient and add a **Boundary box**.

For each individual legend, you can change the number of **Rows** used to display the values.

The order in which legends appear in the Legend Group is the order in which they appear in the Layout Tree. To change the order in which the legends appear, right-click on them and select a **Move** option.
Use the **Legend GroupLayout > Columns** setting and the **Rows** setting for each individual legend to make the best use of the space available on the page.

**Styling Legend Swatches**

The colours, line widths, fills and hatches displayed in the **Legend Group** are controlled by the objects themselves. For example, to change how the < 0.5 shell is displayed for the interpolant, click on the output volume, under the **Models** object:
Making Legends Visible and Invisible

If you do not wish to include a legend in the Legend Group, click on it in the Legend Group and untick Visible:

This does not change whether or not the object itself is visible, it simply excludes it from the Legend Group.

Adding and Organising Annotations

Once you have laid out the main Section object and organised the Legend Group, you can add a number of different types of annotation to the layout.

Title

The Title object formats the title displayed on the page. To move the title, click on it in the layout preview. The text used for the Title is the name for the section in the project tree, but this can be changed in the properties panel.
Title Block
The Title Block object adds a title block based on ISO 7200:

To display the Title Block on the section, select it in the Layout Tree, then tick the Visible box.

Scale Bar
The Scale Bar object controls the size and format of the scale bar. Its position is controlled by moving it in the preview.

Location
The Location object controls how location information is displayed.
**Text Boxes**

With the **Text Boxes** object, you can add text boxes and arrows to highlight information and details on the section:

Arrows are connected to text boxes, and so initially only text boxes can be added. Right-click on a text box to add an arrow to it. When the **Automatic anchoring** option is enabled for an arrow, the arrow’s anchor will move when its associated text box is moved. If this option is disabled, the arrow will move when you move the text box, but you will have to place its anchor manually.

**Images**

If you wish to import an image such as a logo or map, right-click on the **Images** object and select **Add Image**. Navigate to the folder that contains the image file and select the file. Click **Open** to import the file, which will automatically be added to the section layout.
Displaying Section Layouts

You can display section layouts in the scene. Dragging a layout into the scene displays the layout evaluated on the section:

Some sections will be too large to display in the scene, which will be indicated in the section layout editor.

Displaying section layouts in the scene is useful when you are editing a section layout and wish to see the effect of changes. Detach the section layout tab from the main window and position it adjacent to the scene window. Periodically save your changes to the section layout to see the effects of those changes in the scene.

Exporting Section Layouts

Once you have finished adjusting the section layout, you can export it in one of the following formats:

- PDF Files (*.pdf)
- Scalable Vector Graphics Files (*.svg)
- PNG Image Files (*.png)
- GeoTIFF Files (*.tiff, *.tif)

Click the Save and Export button ( ) at the top of the window. You will be prompted for a filename and location.

Batch Exporting Section Layouts

You can export multiple section layouts as a single PDF or individually in the formats shown in Exporting Section Layouts above. To do this, right-click on the Cross Sections and Contours folder and select Batch Export Layouts.
In the window that appears, selection the layouts you wish to export, then select a format. If you select a format other than Single PDF, you can combine all outputs into a zip archive. Select where you wish to save the outputs, then click Export. Progress will be displayed at the top of the Batch Export Section Layouts window:

Copying Section Layouts

If you have already created a section layout and wish to reuse it, you can copy it to other sections.

For alignment serial sections, creating a master section layout is an alternative to duplicating and managing multiple section layouts. See Creating Master Section Layouts for more information.

Copying a section layout copies the evaluations used in the original section layout, together with the page size and orientation and the position of the Layout Tree objects on the page. How models, surfaces and boreholes are copied depends on the section to which the layout is being copied:

- All models and surfaces that can be displayed on the section will be copied.
- The boreholes copied to the layout will depend on the type of section the layout is being copied from and whether or not a filter is set for the layout:
  - If no distance filter was set for the original layout, all boreholes selected for the original layout will be copied.
  - If a distance filter was applied to the original section, the filter will be applied and boreholes selected that are within that distance of the section to which the layout is being copied.
  - When the original layout is from an alignment serial section or a fence section, borehole evaluations will not be copied with the section layout.

To copy a layout, right-click on the layout you wish to copy and select Copy Layout To. In the window that appears, a summary of the information that will be copied is displayed so you can see what information will be copied to the selected sections. Move the sections you wish to copy the layout to into the Selected Sections list, then click OK. A copy of the layout will appear in the project tree under each section you selected. The layout copies are not linked to the original layout and so will not be updated when the original is updated.

Copying section layouts to multiple sections can result in numerous section layouts in a project, which can be difficult to work with. The recommended workflow for creating a
section layout that you intend to make multiple copies of is to first get the layout right on one section before copying it to other sections.
Rendered Images

Leapfrog Works can render high-quality images that you can save on your computer in a format that can be used in presentations and documents.

To save a rendered image, click on the **Leapfrog Works** menu and select **Render Image**. Leapfrog Works renders an image from the current scene window, then displays it in the **Render Image** window:

Use the zoom tools to view the rendered image. You can change the image settings by:

- Selecting a new image size. To constrain the image's proportions when changing size, tick the **Keep aspect** box.
- Changing supersampling options to smooth jagged edges. Select the required option from the list. The highest sampling option (4x4) will take longer to process than the lowest sampling option or turning supersampling off.
- Viewing the image with or without overlays. See **Overlay Settings** for more information about further customising the overlays displayed in the scene.

Click **Render** to render a new image with the updated settings. Once you are satisfied with the rendered image, click **Save**. You will be prompted to enter a filename and location.

**Background Rendering**

You can keep the **Render Image** tab open while continuing to work in your project, which is useful for rendering a series of images. To work in this way, dock the **Render Image** tab adjacent
to the scene window. When you have set up your scene, right-click on the **Render Image** tab and choose one of the options:

The **Render and Copy Image** option will render a new image from the scene and copy it to the clipboard.

The **Render and Save Image** option will render a new image and prompt you for a filename and location.
Saved Scenes

A saved scene is a way of storing the shape list and settings so that the scene can be retrieved later. Saved scenes are the basis of scene files exported to Leapfrog Viewer and Leapfrog Aspect. Saved scenes are also used in creating movies, which is described in the Movies topic.

This topic describes:
- Saving Scenes
- Exporting Scenes
- Exporting Scenes for Leapfrog Aspect
- Linking to Scene Files

A saved scene is, in effect, a bookmark of a specific view of the project data. A saved scene does not maintain an independent copy of the data in the project, and so if the data changes, then the appearance of the scene will also change.

When a scene is saved, comments can be entered documenting what is in the scene. Saved scenes provide a stable point of reference in a project and can explain important aspects of the project, which is especially useful for explaining aspects of a model to others using the project or viewing scene files.

Saving Scenes

To save the current scene, right-click on the Saved Scenes and Movies folder and select Save Current Scene. The Save Scene window will be displayed:

Enter a name and description for the scene and click OK. The scene will be saved and added to the Saved Scenes and Movies folder.

When you save a scene, the properties settings in the shape list are saved for the objects displayed in the scene. For example, if a lithology table is displayed with the legend in the scene, the legend will be displayed when the scene is restored. However, saved scenes do not store copies of the objects in the project tree, and objects deleted from the project tree are no longer available in saved scenes.

To edit a scene, double-click on it. The Edit Saved Scene window will be displayed and you can update the information.
To display a scene, drag it into the scene.

Exporting Scenes
Once you have a series of saved scenes, you can use them to create a scene file that can be opened in Leapfrog Viewer or Leapfrog Aspect. See Exporting Scenes for Leapfrog Aspect for points to consider when creating scene files that will be opened in Leapfrog Aspect.

To export a scene, right-click on the Saved Scenes and Movies folder and select Export Scenes. The Export Scenes window will be displayed:

![Export Scenes window](image)

Move the scenes you wish to export to the Selected scenes list and reorder them, if required.

If you tick the Export hidden shapes box, objects in the shape list that are not visible in the scene window will be included in the exported scene.

You can also export the data associated with the objects in the scene window, if required. To do so, select the Export all data that appears when I click option. If viewing the data is not required, or if you wish to keep sensitive data secure, select the Export shapes only option.

When the Export all data that appears when I click option is selected, all data represented by shapes in the exported scene will be accessible when the scene is opened in Leapfrog Viewer.

When you have the scenes arranged, click Export. You will be prompted for a filename and location.

Exported scenes cannot be reimported to the project.
Exporting Scenes for Leapfrog Aspect

When exporting scenes for use in Leapfrog Aspect, keep in mind the following:

- When viewing 3D data on a 2D screen, objects may appear closer or further from the viewer than expected. For this reason, it is a good idea to include a current topographic surface in the dataset to aid in orienting the view relative to the camera feed.

- Although newer Android devices have a significant amount of processing power, they are not as graphically capable as a typical desktop computer. Try to limit the amount of data to be displayed as there are likely to be issues if a scene contains 10,000 boreholes or a million points.

- Scenes with complex wireframes will load more slowly than simple wireframes. It is a good idea to make a simplified copy of a wireframe in Leapfrog Works and use that wireframe to create a scene.

- Both Export all data that appears when I click and Export shapes only options will work for Leapfrog Aspect. If you wish to display collar IDs, use the Export all data that appears when I click option, but keep in mind that displaying hole IDs can be slow and choppy.

Linking to Scene Files

Links to scene files can be included in HTML files using the following format:

```
<a href="LeapfrogViewer:[path or URL]">link text</a>
```

Linked scene files will be opened directly in Leapfrog Viewer only from browsers that support custom URI schemes.
Movies

Once you have a series of saved scenes (see Saved Scenes), you can use them to create a storyboard and export a movie.

To create a new movie, right-click on the Saved Scenes and Movies folder and select New Movie. A tab will open in which you can create a storyboard and edit how each scene and transition is displayed. You can detach the tab from the main window and create scenes in the main window while working on scenes in the movie tab. Click the Refresh Scenes button to refresh the scenes in the movie tab when you have made changes.

Select the saved scenes you wish to add to the movie by clicking on them in the list, then click the Add To Storyboard button. When subsequent scenes are added, transitions will be added to separate the scenes:

Change properties for the selected scene or transition, then click the play button to preview the settings. To preview the whole movie, click the Select Whole Movie button, then click play.

You can make changes to the included scenes without having to close and reopen the movie window. Simply update the scenes, then, in the movie editor, click the Refresh Scenes button.

Enter a name and description for the movie and click the Save button. The movie will be saved in the Saved Scenes and Movies folder.
To export the movie, click the **Save and Export** button ( ). The **Export Movie** window will appear:

If you tick **Export frame images**, individual frames will be saved as images, together with the movie file. Click **Export**. You will be prompted to select a filename and location. Click **Save** to export the movie. Leapfrog Works will then save the movie in the specified location, which may take some time.
Contour Lines

You can create contour lines from surfaces in the project and export those contour lines to GIS packages.

Creating Contour Lines

To create contour lines from a surface, right-click on the Cross Sections and Contours folder and select New Contour Lines From Surface. In the New Contours window, select the surface to contour from the list. Adjust the Contour Spacing, if required.

If you want to offset the contours by a vector, enter a Contour offset value.

Click OK to generate the contours.

The new contours will appear in the project tree under the Cross Sections and Contours folder.

You can edit the contours by double-clicking on them.

Exporting GIS Contours

To export a contour lines object, right-click on the contour lines in the Cross Sections and Contours folder and select Export. Select whether or not to export the contours in 2.5D format, then click Export. You will be prompted for a filename and location.